What is the NeuroShell Trader?

The NeuroShell Trader and NeuroShell Trader Professional are revolutionary products for building and testing sophisticated
trading systems. They are so pow erful that beginners as w ell as professionals w ill be able to handle a w ide range of complex
tasks. You can utilize the most pow erful and advanced artificial intelligence techniques, like neural netw orks and genetic
algorithms, as easily as you use indicators and optimizers. You'll be running circles around artificial intelligence Ph.D.s and
statisticians.

Use the NeuroShell Trader for the follow ing tasks:

. Predicting prices, price changes, and indicators into the future

. Developing buy/sell signals and discovering trends

. Using our library of over 700 indicators, including regression, arithmetic, rules, logic, to build pow erful trading rules
. Building complex technical indicators from our base library w ithout using a programming language

e Backtesting of trading w ith your ow n rules, predictions, and/or indicators

. Building neural netw ork financial models that are optimized by either increasing profit or minimizing prediction error
. Graphing prices, indicators, and predictions

. Exporting predictions and indicators for use by other programs

o Discovering multidimensional patterns in time series data that are too complex to be visualized

The NeuroShell Trader is revolutionary because it w as built from the beginning for predicting financial markets. It is not a neural
netw ork package that has been adapted for finance, nor is it a financial or charting package that has been adapted for neural
netw orks. The neural nets, charting, indicators, and backtest trading are elegantly blended together so that they all w ork
seamlessly together. In one w ord, it is "ergonomic".

The NeuroShell Trader is revolutionary for another reason, too. The neural netw orks used in the NeuroShell Trader are new,
state-of-the-art, and unlike any others you may have seen before. They are the result of several years of research. There are
absolutely no parameters to set and no neural netw ork know ledge w hatsoever is required to use them. They are very, very fast
and accurate. If you do have previous neural netw ork know ledge, you should forget it because you w on’t need it for these nets.
There is nothing to know and no complicated testing process.

The NeuroShell Trader includes the tools that can make neural nets w ork for you. The nets train in seconds rather than hours so
you can test your trading systems in a reasonable amount of time. The Trader’s ability to mix data streams (exchange rates to
predict stocks, for example) enables you to build complex models. You can seamlessly blend several neural nets or other
models into a single trading system that is robust over changing market conditions. You can use the NeuroShell Trader to
enhance your existing trading system, a technique used by many successful traders.

In the NeuroShell Trader, all prices, indicators, and predictions are data streams that can be operated on just as raw data.
Indicators can be fed into predictions and other indicators. Predictions can also be fed into indicators and other predictions. Both
nested indicators and nested neural netw orks are not only possible but also easy. The possibilities are endless.

A complete portfolio of stocks, futures, or other issues can be loaded into one multiple page chart (limited by memory). Any
indicators or predictions you make to the first issue in the chart are automatically applied to all of them, saving you hours of w ork
that you w ould have spent using other neural netw ork programs.

You can fine-tune your trading system before you trade it by "w alking forw ard" w ith every neural netw ork prediction. That is,
you can train the netw ork on a couple of years of data back in time and then test the predictions on the next year. Then,
automatically, the program w ill step forw ard in time to train and test again for you on more recent data. This continuing process
show s you how consistently predictive your indicators and other input variables have been through the past.

In the NeuroShell Trader Professional, you have all features of the NeuroShell Trader, plus pow erful optimization done by
evolutionary genetic algorithms. You can use the optimizer for finding the best indicators, parameters for those indicators, and
trading rules. You can also use it to find the best inputs for neural netw ork predictions and for trading rules.

The optimizations in the NeuroShell Trader Professional are not "exhaustive search" processes, meaning that they don't w ork by
trying every combination in turn. This enables far more parameters, rules, etc., to be optimized at once in a reasonable period of
time.

Here is a very important feature of the trading strategy optimizer: you can run backtesting on more recent time periods than those
upon w hich the optimizations w ere performed. This means that you can have true out of sample testing to prevent you from
trading w ith "over fit" models.

In the NeuroShell Trader Professional, you will have a choice of several optimization objectives other than minimizing error or
maximizing net profit. For example, minimizing draw dow n, maximizing return on trades, maximizing correlation of predictions, and

many more.

The NeuroShell Trader Professional also gives you more advanced indicators, like Principal Component Analysis, w avelets, and



Fourier analysis. It features alerts you can set to notify you of important trading situations. Finally, you have control over how
many hidden neurons are used in the neural netw orks both during and after optimization.
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What the NeuroShell Trader is NOT

The NeuroShell Trader and NeuroShell Trader Professional are not get rich quick schemes. They will require that you find
effective trading strategies that w ork best for you. This wiill take some effort on your part.

These products do not offer a predeveloped trading strategy that is guaranteed to make money. They do, how ever, provide you
w ith state-of-the-art artificial intelligence tools so you can make your ow n customized models that no one else possesses. This
w ill require some experimentation, and even the optimization techniques in the NeuroShell Trader Professional are not turnkey
moneymakers. It should be understood that trading can result in losses, and that past performance of a trading system is no
guarantee of future performance.

Our systems w ere not designed to be a replacement for classic charting packages that feature extensive graphics capabilities,
and they w ere not intended to have the most advanced or comprehensive charting features.
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Installing NeuroShell Trader

System Requirements

NeuroShell Trader requires a Pentium (or equivalent) 1.4 GHz (or faster) computer, 128MB of RAM, at least 40MB of hard disk
space and Window s 200 or XP operating system (NOT 95, 98, ME or NT).

To install NeuroShell Trader from a CD
1. Insert the CD into your CD-ROM player.

2. Click the Start button and choose the Run command (Steps 2 - 4 may be unnecessary if your CD-ROM is able to detect a
new CD-ROM automatically).

3. In the Open box, type: d:setup (or replace d: with the drive letter associated w ith you CD-ROM drive).
Press the OK button to start the installation.
5. Follow the installation instructions.

To run NeuroShell Trader

1. Choose Programs from the Start menu.
2.  Choose NeuroShell Trader 4 group.

3. Choose NeuroShell Trader.

If you receive an error w hen trying to run NeuroShell Trader please refer to Troubleshooting.



NeuroShell Trader Activation

When the NeuroShell Trader softw are protection is not already activated on a computer, the NeuroShell Trader Authorization
screen is displayed w hen the program is first run. This screen allow s you to activate the NeuroShell Trader softw are. Only
one computer can be activated at any given time for a given NeuroShell Trader softw are license.

To activate the NeuroShell Trader:

1.
2.
3.

Enter the product Serial Number.
Enter the Password that you setup w ith the Ward Systems Group Sales Department.

If you frequently run one NeuroShell Trader license on multiple computers, select the Dis play deactivation dialog when
NeuroShell Trader is closed option at the bottom, so you w on’t forget to deactivate one computer before running on
another computer. You should leave this option unchecked if you will be running NeuroShell Trader on only one computer.

Select the OK button.

After activating, the NeuroShell Trader w ill run normally.

If there are problems using the internet authorization, you wiill receive an appropriate message and a Manual Authorization
tab will appear. If you continue to have troubles using internet authorization, press the Manual Authorization tab and follow the
instructions for manually deactivating the product w ith Ward Systems Group.

Deactivation:

The softw are protection method allow s you to run the softw are on different computers. You can install the softw are on
multiple computers, but you can not run the softw are on the computers at the same time. Once activated on a given
computer, you w ill need to deactivate that computer before you can activate and run the softw are on a different
computer. REMEMBER, only one computer can be activated at any given time and if you forget to deactivate the first
computer, you w ill be unable to activate the second computer until the first computer has been deactivated.

If you are frequently running one license on multiple computers, it is suggested that you select the Dis play deactivation
dialog when NeuroShell Trader is closed option at the bottom of the activation dialog, so you don’t forget to
deactivate one computer before running on another computer.

If you permanently move the softw are from one computer to another or move the softw are from an old hard drive to a
new hard drive, you must first deactivate the softw are before uninstalling or moving it.

You must deactivate the softw are if you decide to return NeuroShell Trader w ithin the 30-day return period.

To deactivate the NeuroShell Trader:

1.
2.

Select the About NeuroShell Trader menu item from the Help menu.
Press the Authorization button



Printing the NeuroShell Trader Manual

The NeuroShell Trader manual is everything you see in the Help Contents. Note that the Help Contents is divided into books,
similar to the w ay a manual is divided into chapters. Printing of one or more Help Books/Topics may be desirable if you w ant to
view the topics in printed format.

Getting to the NeuroShell Help Contents
1. Select Contents from the Help Menu.

Tutarial ...
Yideos ...

Inkeractive Tukar Chrl+T
Shiow Wideos on Startup

Conkents ...

Search for Help On L.
Indicators ...
Seatch for Indicatar ...

Conneck to Advanced User's Tips & Techniques Website
Technical Support

About Meuroshell Trader ...

Printing a Book from the Help Contents

1. Place the cursor in the Help Book you w ish to print.
2. Press the Print button.

3. Under Page Range, select All.

4. Press the OK button.

Printing a Topic from the Help Contents

1. Place the cursor in the Help Topic you w ish to print.
2.  Press the Print button.

3.  Under Page Range, select All.

4. Press the OK button.

Printing a Topic from within a Topic
1. Press the Print button.

2. Under Page Range, select All.

3. Press the OK button.

Troubleshooting:

. If your help file is printing in the incorrect orientation(Landscape vs. Portrait) use the properties button on the Print Dialog to
select the desired print orientation.



Tutorial

NeuroShell Trader Tutorial

Tutorial overview

The NeuroShell Trader is trading system building softw are. It is not a trading system in its ow n right, it is a toolkit of both
traditional and artificial intelligence (Al) techniques you can combine to form computerized trading models. The models can
consist of indicators and rules like traders have used for years, artificial intelligence techniques, or hybrids of both. It will build
models for equities, futures, commodities, options, FOREX, indexes and more. You can build models for exchanges all over the
w orld, like the NYSE, AMEX, FTSE, DAX, ASX, TSX, SFE, and many more. To build models you just need to be able to obtain
data for the instrument or exchange in w hich you are interested. Then the models you build w ill automatically back-test, and
continue to give signals into the future as new data arrive.

Advanced degrees and skills not necessary

To use NeuroShell you do not need to be a programmer, a Ph.D., an Al expert, a mathematician, or a statistician. In fact,
sometimes it is better that you are NOT one of those things. That is because neural netw ork experts, for example, frequently
cannot come to grips w ith how easy and fast it is to train our neural netw orks. They are usually tied to the old style neural nets
that require lots of "tw eaking" to even get a net w orking. Often they think there must be something inferior about our technology
because w e have made it simple enough for traders and other novices to use.

Artificial intelligence study not required

Many people think they must have to read books about neural netw orks, genetic algorithms, and fuzzy logic or take a course
before they can effectively utilize our softw are. That is just not true. We have already done all that studying for you starting in
1988, and created softw are that allow s you to concentrate on the business end, not the science end. Our genetic algorithms,
for example, act almost like other traditional optimizers. The main difference is you don't have to give them search increments,
because they don't search the same w ay. With our advanced neural nets, you mainly w orry about w hat to feed them, instead
of how to get them configured and running. We let you drive w ith an automatic transmission, pow er window s, pow er steering,
and pow er seats instead of making you learn to shift gears and do everything else manually.

Not a "silver bullet"

Although w e have made artificial intelligence easier to use, it does not instantly build w onderful trading systems. How ever, we
do provide a number of examples and there are many traditional systems designed by others available in the Trader Tips from
Stocks and Commodities section of our advanced users w ebsite: http://w w w .w ard.net/ in the Trader Tips from Stocks and
Commodities section.

The NeuroShell DayTrader Professional is like the NeuroShell Trader Professional, except that it reads and displays intraday
(real time) data bars. There are also some additional indicators to define time based events. For example you can specify you
only w ant to trade betw een 10 am and 11am.

Everything is chart based

Charts are the major component of NeuroShell. You may open many charts at one time, either new ones or ones you have
previously built and saved. When you create a new chart, you specify their periodicity w ith w hich you w ant to see and
process the data, as well as how far back in time you w ant to load the data. Next you specify the related instruments w hose
historical data should be loaded into the chart. They are the target instruments for w hich you w ish to create trading signals.
Multiple instruments in the chart show up in their ow n chart page. For the rest of the discussion in this document, let's say you
load IBM, DELL, HPQ, and AAPL as your target instruments. (They don't have to be stocks; they can be FOREX pairs,
commodities, E-minis, options, etc).

Data streams

Charts contain data streams, w hich can be plotted or hidden. Of course, the first data streams loaded w ill be open, high, low,
close, volume, and possibly more raw data for the target instruments. You can also insert other data streams called other
instrument data that w ill be available in each chart page, like indexes or Data Sources for other stocks. This other instrument
data is information you w ant to use to create trading signals. For discussion, let's say you believe that the Dow Jones US
Computer Index ($DJUCR on eSignal) and INTC w ill be useful for deciding how the target computer stocks should be traded.
You would then load these as other instrument data so that they w ill be available data streams in all chart pages.

Indicators

The next data streams you w ill w ant to include w ill probably be indicators. Models generally are built using indicators based
upon the raw data and the other instrument data. Let's say you believe that the follow ing indicators w ill be useful in models that
w ill produce trading signals, because you have heard people in your investment club talking about them:

1. The spread betw een each target stock and INTC
2. The relative strength betw een each target stock and $DJUCR
3. A stochastic %k indicator applied to each target stock


http://www.ward.net/

Therefore, the next thing you might do is insert the indicators above into your chart using the Indicator Wizard.

Sometimes you may have in mind indicators that are too complex even for our Indicator Wizard to construct. In that case, you
can program your ow n in standard languages.

You may or may not have a clue about w hat the indicators above do - read on.

Models

Once the chart loads up w ith the requested data, you are ready to define one or more models in the chart. Any model that you
build in the chart automatically applies to all instruments in the chart. Your model can be optimized the same for all chart pages,
or custom optimized for each chart page. Models can be either Trading Strategies or Predictions.

You may or may not have a clue about how the indicators you have chosen w ork. If you do, you probably have some idea
about how they would be used to generate trading signals, rules like "Buy w hen the relative strength betw een the stock and
the $DJUCR is high, and the spread with INTC is low ." In this case you w ill w ant your model(s) to be Trading strategies, even if
you are unsure w hat values should be considered high and low above. The genetic algorithm optimizer wiill find the values for
you.

If you either have no clue about how the indicators w ork, or no clue about appropriate rules for them, you w ill probably w ant to
build a Prediction w ith a neural net for your model(s), because neural nets find their ow n rules.
Note that you can insert several models in a chart. Once you insert a model, it automatically applies to all chart pages.

Trading Strategies

The Trading Strategy Wizard is a fast mechanism for entering trading rules w ithout having to type messy formulas or write in
some algorithmic programming-like language. The Wizard is all point and click. You just list the rules for long entry, long exit,
short entry, and short exit (cover). Each of these rules is in fact an indicator you build just like any other indicator - w ith the
Indicator Wizard. You can also enter indicators for stop and limit price levels, including trailing stops.

If you w ant to optimize your trading strategies, the genetic algorithm optimizer w ill do these things for you:

1. Find w hich of the rules you have listed should be used in combination
2. Find out w hat the parameters of the indicators in your rules should be set to
3. Perform 1. and 2. above at the same time (w e call this full optimization)

Even your stops and limits can be optimized.

When the Trading strategy is complete, it will show you historical buy and sell signals. As new data is entered into the future,
those buy and sell signals w ill continue to appear w ith each new bar. You can insert a variety of indicators to plot how your
profit is grow ing.

Predictions
Predictions are neural nets made w ith the Prediction Wizard. That's w hat our standard neural nets do, they make predictions
about the future value of a data stream, usually a price or change in price, but any data stream can be predicted.

Here is basically all you have to do to make a prediction model:

1. Choose some inputs - data streams, usually indicators, that you believe are leading indicators of the market
2. Decide w hat you w ant to predict, usually change or percent change of the open or close

3. Decide how much historical data will be used to train the neural net

4. Decide how much historical data you w ant to use to test how w ell the neural net has learned

If you w ant to optimize your prediction, the genetic algorithm optimizer w ill do these things for you:

1. Find w hich of the inputs you have listed should be used in combination

2. Find out w hat the parameters of the indicators in your inputs should be set to
3. Perform 1. and 2. above at the same time (w e call this full optimization)

4. Find neural netw ork thresholds for trading

When the prediction is complete, it will show you historical buy and sell signals. As new data arrive in the future, those buy and
sell signals w ill continue to appear w ith each new bar. You can insert a variety of indicators to plot how your profit is grow ing.

Back-testing

Sometimes w hen you build traditional models, neural net models, or optimized models of any type, it is possible to make a model
so good that it does not hold up w ith future market conditions. This is called over-fitting. Therefore, NeuroShell contains facilities
that w ill automatically backtest w ith out-of-sample data for you, so you can gain confidence that your model w ill hold up in the
future.




Alerts

NeuroShell lets you take almost any condition, not just trading signals, and define an alert to let you know w hen that condition
has just occurred.

Further Learning
Your next step should be to view the training videos that w e have provided. They are just a few minutes each and w ill make
learning NeuroShell so much easier than trying to learn from our help file.

After you have w atched the videos a few times, load our example charts in order and read the accompanying explanations
carefully.

Finally, if you need help, contact our technical support department.



Videos

Watching the follow ing videos is the fastest w ay to learn the mechanics of using the NeuroShell Trader. Once you’ve
mastered the mechanics, you can begin to craft successful trading systems.

You must have a speaker and sound card on your computer to properly view these video files. You must also
have the NeuroShell Trader Video CD inserted into your CD rom/DVD drive because the video files are on that
CD and are not copied to your com puter.

If you wish to have access to the videos w ithout the CD you can copy the videos from the CD to a videos subdirectory of the
NeuroShell Trader program directory (i.e. C:\NeuroShell Trader\Videos).

Click on the each topic below to view the corresponding video. The script for each video is included in a help topic w ith the
same name in the NeuroShell Trader help file.

The videos are displayed in the Camtasia Player. If you’re having trouble seeing the entire video, select the Play Menu, and
click on Full Screen. When you’re view ing in Full Screen mode, you need to right mouse click anyw here on the screen to view
a list of Camtasia Player controls.

Overview
Getting Started — Tips to get NeuroShell Trader up and running as soon as possible. Getting Started Video Script

Charts

Open a Price Chart — Start w ith either price or price and volume and then add indicators, Trading Strategy rules, and/or
predictions. Open a Price Chart Video Script

Save Your Ow n Chart Template — Store your favorite charts for later use. Save Your Ow n Chart Template Video Script

Charts Analysis Templates — Apply standard studies such as MACD, Stochastic, and Moving Average Crossovers to build a
trading system. Charts Analysis Templates Video Script

Workspaces — Save and load a collection of charts. Workspaces Video Script

Format Data Series — Change names, line colors, and graph styles, as w ell as use gradient color bars. Format Data Series
Video Script

Draw ing Tools — Add trend lines, channels, Fibonacci retracements, lines, text and more. Draw ing Tools Video Script

Different Chart View s — Choose from chart, snapshot, portfolio and historical view s. Different Chart View s Video Script

Zoom Controls — Get a closer view of specific data in your chart. Zoom Controls Video Script

Existing Data and Other Instrument Data — Add other stocks, indexes, etc. to your chart. Existing Data and Other Instrument
Data Video Script

Rearranging Charts — Move subgraphs on the chart using drag and drop. Rearranging Charts Video Script

Format Menu — Layout the chart by hiding data, moving subgraphs, adding or removing issues, or changing dates. Format Menu
Video Script

Add Chart Pages — Apply your model to other stocks, futures, etc. Add Chart Pages Video Script

Additional Formatting and Multiple Charts — Rename data and view multiple charts. Additional Formatting and Multiple Charts
Video Script

Indicators

Inserting Simple Indicators — Insert one of the more than 800 indicators. Inserting Simple Indicators Video Script

Modifying Indicator Default Parameters — Change time periods, etc. Modifying Indicator Default Parameters Video Script

Indicator Shortcuts — Create more than one indicator at a time, etc. Indicator Shortcuts Video Script

Indicator Options — Move categories, change colors, day boundaries. Indicator Options Video Script

Complex Indicators — Combine them to create intricate studies. Complex Indicators Video Script

Indicators Bottom Up Method — Create smaller parts, and then combine indicators. Indicators Bottom Up Method Video Script

Indicators Top Dow n Method — Build the overall indicator. Indicators Top Dow n Method Video Script




Write Your Ow n Custom Indicators — Create a collection of your favorites (Trader Professional and DayTrader ONLY). Write
Your Ow n Custom Indicators Video Script

Trading Strategies

Build a Trading Strategy — Use the Trading Strategy Wizard to generate buy/sell signals. Build a Trading Strategy Video Script

Save Your Trading Strategy Template — Develop a library of trading rules that may be applied to any market. Save Your Trading
Strategy Template Video Script

Trading Strategies Analysis Templates — Choose basic systems such as long and short entry or popular systems such as RSI
or Moving Average Crossovers. Trading Strategies Analysis Templates Video Script

Applying Trading Strategies — Apply rules to new data. Applying Trading Strategies Video Script

Apply Trading Strategies to other stocks, futures, options, etc. — Add additional chart pages. Apply Trading Strategies to other
stocks, futures, options, etc Video Script

Trading Strategy Options — Change the number of shares, dates (paper trading), costs, optimization objective, etc. Trading
Strategy Options Video Script

Optimizing Trading Strategies — Set parameter ranges. Optimizing Trading Strategies Video Script

Predictions
Create Your Ow n Prediction — Forecast prices, change, etc. with the Prediction Wizard. Create Your Ow n Prediction Video
Script

Save Your Neural Netw ork — Apply your custom model to many different markets. Save Your Neural Netw ork Video Script

Prediction Analysis Templates — Create neural netw ork forecasts w ith familiar indicators. Prediction Analysis Templates Video
Script

Neural Nets Overview — Nets learn patterns in past data. Neural Nets Overview Video Script

Prediction Results — Examine the results of your models. Prediction Results Video Script

What to Predict and Which Inputs to Use — Select the best stocks, futures, or options for success. What to Predict and Which
Inputs to Use Video Script

Panel of Experts — Combine nets w ith other predictions, trading rules. Panel of Experts Video Script

Prediction Options — Change w hat to predict, optimization objective, dates (paper trading), costs, types of positions, training
criteria, etc. Prediction Options Video Script

Ticker Scanning
Ticker Scanning — Scan a large number of ticker symbols based on the rules you define. Ticker Scanning Video Script

Alerts

Alerts — Add sound or screen w arnings to your trading system (Trader Professional and DayTrader Professional ONLY).
Alerts Video Script

Integrated Trading

Integrated Trading — Integrated Brokerage Trading allow s trades from a Trading Strategy to be sent directly to a brokerage or to
a list of email address. Integrated Trading Video Script

Portfolio Analysis

Using Chart Page Calculations — These calculations can help you decide w hich stocks, futures, etc. to buy and w hich to sell in
order to maximize your portfolio equity. Portfolio Analysis Using Chart Page Calculations Video Script

Data Details

Data Overview — Use existing data, dow nload new data. Data Overview Video Script

Mapping Directories — Set up the NeuroShell Trader to automatically read your data files and assign issue categories to the
data. Mapping Directories Video Script_

Data File Formats — Use ASCII or text files, as w ell as files in the CSI and MetaStock formats. Data File Formats Video Script

Modifying Raw Data — Use this utility to correct values in your data file. Modifying Raw Data Video Script




Data Servers — Select a data server for intraday and end of day data. Data Servers Video Script

Quote.com QCharts Basic — Choose for use w ith the NeuroShell DayTrader, Trader Pro, or Trader. Quote.com QCharts
Basic Video Script

eSignal — Choose eSignal for any version of NeuroShell Trader. eSignal Video Script

Prophet.net — Select Prophet Connect for any version of NeuroShell Trader. Prophet.net Video Script

DialData — Sign up for Track Data’s end of day feed for the NeuroShell Trader Professional or Trader.

Part A — Enter your userid and passw ord. DialData Part A Video Script
Part B — Create a dow nload list. DialData Part B Video Script

Part C — Dow nload data for use w ith your models. DialData Part C Video Script

Options

Options — Set preferences for your trading style. Options Video Script

Summary
Video Summary — Additional resources for w orking w ith the NeuroShell Trader. Summary Video Script

Note:

e If this help topic is displayed w henever the NeuroShell Trader runs, you can turn it off after you have view ed all the
videos by unchecking the Show Videos on Startup menu item in the Help menu.



Using the CD-ROM

The CD-ROM provided w ith NeuroShell Trader includes historical data that starts in 1987. Any time that you w ant to access
this data you wiill need to have the NeuroShell Trader Data CD-ROM in your CD-ROM drive.

If you haven’t installed the current version of NeuroShell Trader, inserting the program CD-ROM w ill start the installation
procedure. How ever, if you have already installed NeuroShell Trader and insert the data CD-ROM NeuroShell Trader w ill
immediately recognize the CD-ROM and have the CD-ROM data available.

If you only need specific stocks and don’t wish to keep the NeuroShell Trader CD-ROM in your CD-ROM drive, you may copy
the files from the NeuroShell Trader CD-ROM onto your hard disk and map the directories that you copy them to by Setting Up
Data Directories.



Customizing Your Environment

You may w ant to customize your environment to hide data streams that you may never use or configure your environment to
display data streams at certain times automatically.

1. Select Options from the Tools menu. This activates the Options Dialog, w hich allow s you to customize your
environment.

Expart Chart/Data ...

Data Sources ...

Cpkions ...




Options - Trading Orders

Use the trading orders options to select new order sound, pop-up notification and sending of orders to a brokerage.

To set the Actions taken for new or revised trading orders, select one of the options show n:

Play sound file - When selected, causes a sound to play w henever an active trading strategy generates a trading
order. Choose the desired sound from the dropdow n list.

Popup order prompt/confirmation — When selected, causes a pop-up order notification message (for example: Buy
100 Shares of Dell) w henever an active trading strategy generates a trading order.

Send orders to brokerage — When selected, causes orders to be sent to the brokerage server selected in the
Brokerage drop dow n list w henever an active trading strategy generates a trading order.

Note: If Popup order prom pt/confirmation is checked, then NeuroShell Trader w ill ask you if you w ant to send
orders before sending them to the brokerage, otherw ise it will simply send orders w ithout user interaction to the
brokerage.

The follow ing are the brokerage servers distributed w ith NeuroShell Trader that can be selected in the Brokerage drop
dow n list:
Interative Brokers — Sends trades to Interactive Brokers. For more detailed information see: Interactive Brokers
Order Emailer — Emails trades to a list of email addresses. For more detailed information see: Order Emailer

Ticker/Exchange Mapping — Loads the ticker/exchange mapping dialog w hich enables the specification of the brokerage
ticker symbol and exchange for different data feed ticker symbols. Note that if no appropriate maps exist w hen a trading
strategy is selected to be actively traded, NeuroShell Trader w ill prompt for an appropriate ticker and exchange mapping at
that time.

Notes:

Only active trading strategies w ill play sound files, show pop-up order messages, or send orders to a brokerage. To
activate a trading strategy, select the Alerts and Orders Window menu item from the View menu and select the trading
strategy on the Active Trading tab.

Additional brokerage servers may be available from third party developers or developed using the NeuroShell Trader
Brokerage API. Once installed, additional brokerage servers wiill be listed in the Brokerage drop dow n list.

The list of available sounds is compiled from all the .WAV sound files located in the Sounds subdirectory (C:\NeuroShell
Trader\Sounds). If you w ould like to use a custom sound not provided w ith NeuroShell Trader, simply copy the desired
.WAV sound file into the Sounds subdirectory prior to running NeuroShell Trader.



Options - Wizards

Use the w izards options tab to select Default Wizard Interface Options.

The wizard interface options control the complexity of the trading strategy, prediction and indicator wizard interfaces.

By selectively turning on only desired interface options, you can customize the interface to show only those trading strategy,
prediction, and indicator parameters and options that you will use. With the majority of the interface options turned off, you
have a simple and easy to understand interface for creating basic trading strategies, predictions, and indicators. With the
majority of the options turned on, you have an extensive interface for creating complex trading strategies, predictions, and
indicators.

To avoid being overw helmed by the vast capabilities of the NeuroShell Trader, w e recommended that new users start w ith all
the options turned off. Once you become comfortable w ith the simple interface, slow ly begin experimenting w ith the more
advanced options.

To choose Default Wizard Interface Options:
1. Use the + and - to expand or collapse categories in the list.
2. Click in the box to the left of the option text to select or deselect an option.

For detailed information on each of the wizard interface option see:
Trading Strategy Wizard Interface Options

Prediction Wizard Interface Options

Indicator Wizard Interface Options



Options - Charts

Use the chart options to select the Open Chart retrain/rebacktest prompt sensitivity and chart autosaving.

To set the Open chart retrain/rebacktest prompt sensitivity, select one of the options show n:

. Least Sensitive — Prompt upon stock splits or other major price adjustments. This means you w ill be prompted
to retrain/rebacktest w hen the NeuroShell Trader detects a split or a major price change. This is triggered w hen the last
date of your prediction or Trading Strategy (w hen trained or backtested), changes its price by five percent or more.

. Recommended Sensitivity — Prompt if last trading position has changed due to changes in data. This means
that if for some reason you’re trading position does not match the same trading position as w hen you last saved your
chart, you will be prompted to retrain/rebacktest. For example, this will prompt you if w hen you saved your chart you
w ere "long" on the last day of training/backtesting and w hen you load your "new " data w ith the chart you are no longer
"long" (short or no position) at the same date/time. This w ould happen if your data has changed and a trading signal w as
triggered w ith the new data, but it wasn’t with the data you had loaded the previous time that you saved the chart. This
option will also prompt you w hen the Least Sensitive option w ould have.

. Sensitive — Prompt when data does not extend as far back in time as when previously saved. This means
that if your request for data w as not filled back to the original date the Trading Strategy or Prediction w ere backtested or
trained over you will be prompted to see if you w ant to retrain/rebacktest. This option w ill also prompt you w hen either of
the low er sensitivities w ould have.

. Most Sensitive — Prompt if data is not exactly the same as previously saved. This means that even the slightest
change in data w ill prompt a retrain/rebacktest message. This option may not be desirable if you are using the DayTrader
w ith Quote.com because the data has been know n to change based on w hich server you attach to. Quote.com know s
about this issue, but at the moment there appears to be no resolution in site. This option w ill also prompt you w hen any of
the low er sensitivities w ould have.

Chart autosaving allow s unsaved changes you have made to a chart to be recovered in the event of a pow er failure, system
crash, or other unexpected termination of NeuroShell Trader execution. If such a unexpected termination occurs, the next time
the NeuroShell Trader is run, you w ill be prompted as to w hether or not you wish to load the autosaved chart(s). While the
NeuroShell Trader is running, the autosaved charts are saved in the \NeuroShell Trader\Charts directory under the name of
_NSTTempXX.cht (w here XX represents a number not already used for saving other temporary charts). If no unexpected
termination occurs, the autosaved chart(s) for the current session are deleted upon closing a chart or w hen exiting the
NeuroShell Trader.

To set Chart autosaving, select one of the options show n:

. On —Charts will be autosaved after every major change made to the charts and prior to the start of prediction training or
trading strategy backtesting.

. Off — Charts w ill not be autosaved.

When you are satisfied w ith the Options press the OK button.



Options - Advanced

Use the advaced options to select w hich data series get displayed w hen completing a prediction and w hich data series to
display in the Existing Data/Calculations list.

For more information regarding the prediction data series versus the prediction signal data series refer to Using Predictions.

Choose the Insert new prediction settings:

. Insert prediction signal data series — After you have finished creating a prediction, using this option will display the
prediction data series on the chart with predicted data values on the same bar they w ere predicted (For example the
2-day prediction for July 5th w ould be show n on July 3rd.). This results in predictions that can be used in other indicators
or trading strategies prior to the actual result occurring.

. Insert prediction data series — After you have finished creating a prediction, using this option wiill display the
prediction data series on the chart w ith predicted data values on the bar for w hich they are being predicted (For example
the 2-day prediction for July 5th w ould be show n on July 5th.). This results in prediction values that can not be used in
other indicators until the actual result is already know . This also results in the prediction values being displayed on the
chart on future bars that have not yet occurred.

Select Existing data/calculations settings:

. List prediction data series - displays both the prediction and the prediction signal data series. If not selected, then only
the prediction signal data series wiill be displayed in the Existing Data/Calculations list.

Select Date interface settigns

o Allow real trading to begin before last chart date — controls w hether the optional checkbox to Start trading
before last chart date is displayed in the Dates tab of both the prediction and trading strategy parameters dialogs.

When you are satisfied w ith the Options press the OK button.



Options - Point Values

Use the point values options to specify the point values for each futures or forex ticker symbol you might use.

The point value specifies the amount by w hich the futures or forex price is multiplied to determine the dollar value of a contract.
Point value should be used in a prediction or trading strategy if you w ant the profit/loss results to reflect the actual dollars you
gained/lost instead of the points gained/lost.

To add a ticker symbol to the list, press the Add Ticker button.
To change the point value for a selected ticker, press the Point Value button.
To delete selected tickers press the Delete Ticker button.

When you have finished entering point values, press the OK button.

Note:

. In order for point values entered into this list to be utilized by a trading strategy or prediction, the Point Values for
futures, forex, etc check box must be selected on the Costs tab in the parmeters dialog of the trading strategy or
prediction.



NeuroShell Trader Help

NeuroShell Trader help wiill allow you to find answ ers about any part of the program that you have a question about. To
activate the NeuroShell Help Contents:

1. Select the Contents menu item from the Help menu.

Tutarial ...
Yideos ...

Inkeractive Tukar Chrl+T
Shiow Wideos on Startup

Conkents ...

Search for Help On L.
Indicators ...
Seatch for Indicatar ...

Conneck to Advanced User's Tips & Techniques Website
Technical Support

About Meuroshell Trader ...

Additionally, if you w ant to search for a specific item you should:

1. Select Search for Help On from the Help menu.

Tutorial | .
Yideos ..,

Interactive Tutor Chrl+T
Show Wideos on Startup

Contents ... F1

Indicatars ...
Seatch for Indicator ...

ch For Help n ...

Connect to Advanced User's Tips & Techniques Website
Technical Support

About Meuroshell Trader ...

Note:

o When you are view ing a help topic you may right-click on it using the mouse to activate options that will allow you to
Annotate, Copy, Print a Topic, change the Font, set/clear the Keep Help on Top property, or set/clear the Use System
Colors property.



Indicator Help

Indicator Help can help you understand the meaning of an indicator. To activate the Indicator Help Contents:

1. Select the Indicators menu item from the Help menu.

Tutorial ...
Yideos ...

Interactive Tutor Chel+T
Shiow Yideos on Startup

Conkents ... F1
Search for Help On L.

Indicators ...

Seatch for Indicator ...
Connect to Advanced User's Tips & Techniques Website
Technical Support

about Meuroshell Trader ...

Additionally, if you w ant to search for a specific indicator you should:

1. Select the Search for Indicator menu item from the Help menu.

Tukarial ...
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Inkeractive Tukar Chrl4+T
Show Yideos on Startup

Contents ... F1
Search for Help On ..
Indicators ...

Search For Indicator ...

Caonnect o Advanced User's Tips & Techniques Website
Technical Suppart

ahout Meurashell Trader ...

Note:

o  When you are view ing a help topic you may right-click on it using the mouse to activate options that will allow you to
Annotate, Copy, Print a Topic, change the Font, set/clear the Keep Help on Top property, or set/clear the Use System
Colors property.



Interactive Tutor

The Interactive Tutor is an option that helps you by providing you w ith information and options at every point in the NeuroShell
Trader. It teaches you how to use NeuroShell Trader by displaying instructions and troubleshooting information for each
screen you encounter. To activate the Interactive Tutor:

1. Select the Interactive Tutor menu item from the Help menu.

Tukarial ...
YWideos ..,

Interactive Tukar
Shiow Wideos on Startup

Contents ... F1
Search for Help On L

Indicators ..,

Search for Indicator ...

Connect to Advanced User's Tips & Techniques \Website
Technical Support

Ahout Neurashell Trader ...

To deactivate the Interactive Tutor:

1. Deselect the Interactive Tutor menu item from the Help menu.

Note:

o When you are view ing a help topic you may right-click on it using the mouse to activate options that will allow you to
Annotate, Copy, Print a Topic, change the Font, set/clear the Keep Help on Top property, or set/clear the Use System
Colors property.



Advanced User's Tips & Techniques Website

The Advanced User’s Tips & Techniques Website (http://w w w .w ard.net) is a w eb site dedicated to advanced topics for all of
the Ward Systems Group products. It contains private information only for the use of Ward Systems Group customers, so to
get into the product areas you will need a valid serial number for that product. The site includes the follow ing information for
NeuroShell Trader:

e Notice of major bugs found.

e Availability of fixes or updates.

e Cost and availability of new releases.

. Beta tests that are coming and how you can be involved.

e Tips, techniques, and frequently asked technical questions (FAQ).
. Other product new s.

e  User forum

. Custom programming

To activate the Advanced User’s Tips & Techniques Website:
1. Select the Connect to Advanced User’s Tips & Techniques Website menu item from the Help menu.


http://www.ward.net

Activating About NeuroShell Trader

In order to activate the NeuroShell Trader About screen, w hich show s you product information, Ward Systems Group, Inc.
contact information, and the ability to deactivate the softw are.

1. Select the About NeuroShell Trader menu item from the Help menu.

Tutarial ...
Yideos ...
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About NeuroShell Trader

This screen describes the version number, copyrights, contact information and the license agreement for NeuroShell Trader.

Use the Authorization button to deactivate the product. You wiill need to deactivate the product if you wish to activate it on a
different computer. Examples of w hen you w ould deactivate the product are w hen sw itching back and forth betw een
computers or w hen permanently moving the softw are to a different computer.

Ward Systems Group contact information is show n on the screen. You may also refer to any of the follow ing:
Ward Systems Group Corporate Headquarters

Ward Systems Group Sales Department

Ward Systems Group Technical Support



NeuroShell Trader Deactivation

To deactivate the NeuroShell Trader:
1.  Select the About NeuroShell Trader menu item from the Help menu.
2.  Press the Authorization button

This screen allow s you to deactivate the NeuroShell Trader. You wiill need to deactivate the product if you wish to activate it
on a different computer. Examples of w hen you w ould deactivate the product are w hen sw itching back and forth betw een
computers or w hen permanently moving the softw are to a different computer. Additionally, you w ill need to deactivate the
softw are if you decide to return it within the 30-day return period.

In order to deactivate your product:
Enter the product Serial Number.
Enter the Password that you setup w ith the Ward Systems Group Sales Department.

3. If you frequently run one NeuroShell Trader license on multiple computers, select the Dis play deactivation dialog when
NeuroShell Trader is closed option at the bottom, so you w on’t forget to deactivate one computer before running on
another computer. You should leave this option unchecked if you will be running NeuroShell Trader on only one computer.

4. Select the OK button.

After deactivating, the NeuroShell Trader w ill immediately exit. To reactivate the Trader, simply rerun it and you wiill be
prompted to activate the softw are.

If there are problems using the internet authorization, you wiill receive an appropriate message and a Manual Authorization
tab will appear. If you continue to have troubles using internet authorization, press the Manual Authorization tab and follow the
instructions for manually deactivating the product w ith Ward Systems Group.

Notes:

e The softw are protection method allow s you to run the softw are on different computers. You can install the softw are on
multiple computers, but you can not run the softw are on the computers at the same time. Once activated on a given
computer, you w ill need to deactivate that computer before you can activate and run the softw are on a different
computer. REMEMBER, only one computer can be activated at any given time and if you forget to deactivate the first
computer, you w ill be unable to activate the second computer until the first computer has been deactivated.

. If you are frequently running one license on multiple computers, it is suggested that you select the Dis play deactivation
dialog when NeuroShell Trader is closed option at the bottom of the activation dialog, so you don’t forget to
deactivate one computer before running on another computer.

. If you permanently move the softw are from one computer to another or move the softw are from an old hard drive to a
new hard drive, you must first deactivate the softw are before uninstalling or moving it.

e You must deactivate the softw are if you decide to return NeuroShell Trader w ithin the 30-day return period.



Data Sources

Data sources fall into one of three categories

. Data that you have on your computer (or a netw ork)
. Data that is provided by a server

. End of Day Data that you w ant to dow nload

Each of these types is unique and is setup using the Data Sources item on the Tools menu.

Taools

Expart Chart/Data ...

Data Sources ...

Options ...

The data that you have on your computer (or a netw ork) is described by any Data Files that you have. For more information on
this please see Setting Up Data Directories. Data that is provided by a server is data that a data service provides you w ith data
w hen you request it. For more information on this please see Setting Up Data Server. Data that you w ant to dow nload using
the included End of Day dow nloader w ill allow you to dow nload data from DialData. For more information on this please see
Dow nloading Data.

Topics of Interest:
Data Files
Setting Up Data Directories

Setting Up Data Server
Dow nloading Data



Setting Up Data Directories

Setting up data directories defines w here your data files are located. It is very important that you properly define your data so
that NeuroShell Trader know s the location of your data and the type of data you have. This is necessary so that w hen you
w ant to use your data NeuroShell Trader will be able to easily access your data.

1. Select Data Sources from the Tools menu. This activates the data sources dialog box from w hich you can define and
change the data sources used by NeuroShell Trader.

II:I |:||5

Export Chart/Data ...

Data Sources ...

Options ...

2. Select the Directories/Files tab. This displays the data sources tab from w hich you can define and change the data
directories and thus the data files used by NeuroShell Trader.

Data Sources

ﬁerverl End of Day Download |

Directoriez which HeuroShell Trader recogn

| Directory | Categony | Ty

Topic of Interest:
Data Files



Data Sources Dialog: Directories/Files

There are several tools on this tab to help you define your data directories. The process of defining data directories allow s
NeuroShell Trader to know the location of your data files and the type of data in each file.

You can add directories by using either the Auto Scan button or the Add Dire ctory button

Additionally, if a data directory is no longer desired, you can remove it by selecting the undesired directory and selecting the
Remove Directory button.

Finally, w hen adding directories you w ill w ant to make sure that the category column is correct before exiting the Data Sources
Dialog. NeuroShell Trader uses several techniques to attempt Auto Identification of the Category for each directory; how ever,
frequently NeuroShell Trader is unable to properly identify the correct category. If you w ant to change the category of a
directory, select the directory and then the Change Category button.

Tips:

e  When setting up NeuroShell Trader to access AlQ data map the directory that contains the master.ndx and master.adf
files. If you are having difficulty mapping or using your AlQ data you may consider using the "Rebuild Master List"
functionality in your AIQ product. Please note that NeuroShell Trader is unable to read data from AlQ’s data CD.

e When adding files to a directory that has already been listed in the Data Directories list the file will automatically be added if
the type of file (i.e., AlQ, MetaStock, ASCII, etc.) matches one of the types of files that have been previously added to the
Data Directories list. If the type of file added to a directory that is already listed in the Data Directories list does not match
any of the types of files listed for that directory, then the Directory will need to be "rescanned". To "rescan" a directory
you may use the Add Directory button or the Auto Scan button.

Topic of Interest:
Data Files



Auto Scan Dialog

The Auto Scan Dialog allow s you to scan a disk drive for files that NeuroShell Trader is able to read.

1. Select the disk drive you wish to scan.
2. Choose the type of auto scan to perform.

Note: If you choose Scan selected directory and its subdirectories, you should select the directory to be scanned.
3. Press the OK button.

Tip:
e You may w ant to verify the Category assigned to each directory.

Topic of Interest:
Data Files



Add Directory Dialog

1. Select the Drive and Directory you wish to add to your Data Directories.
2. Press the OK button.

Tip:
e You may w ant to verify Categories of directories added.

Topic of Interest:
Data Files



Categories Dialog

The Categories Dialog allow s you to group instruments into logical categories. By doing so, data becomes easily identifiable
w hen you are using NeuroShell Trader.

1. Select the category in the list that best describes the directory.
2. Press the OK button.



Data Files

The NeuroShell Trader reads ASCII files, MetaStock files, CSl files and AIQ files.

For NeuroShell trader to properly recognize and read an ASCI| file the follow ing must be true:

The extension must be: .CSV, .TXT, .PRN, or .ASC
One of the first 10 row s must be a label row .

In order for NeuroShell Trader to recognize the open, high, low, and close they must be labeled O or Open, H or High, L or
Low, and C and Close.

One of the data columns must contain dates.
The data column that contains dates must have the w ord "Date" as the column label in the files label row .

The data columns must be separated by commas, tabs, or spaces (or semi-colon if the w indow s regional settings are set
such that a semi-colon is the standard w indow s list separator).

If the file is space delimited, double quotes(") should be placed around any labels consisting of multiple w ords (i.e., "daily
price") so that NeuroShell Trader w ill not think that the w ords are labels for different columns (i.e., the column label "daily"
and the column label "price").

The data must have dates in sequential order either starting at the earliest date and progressing to the most recent date in
the last data row OR starting w ith the last date and progressing to the earliest date in the last data row . Note that this
doesn’t mean that every date must be included (i.e. Weekends, Holidays, etc.).

The file must contain valid dates in the date column. Valid date formats that NeuroShell Trader recognizes include all valid
Window s date formats for the current regional settings. For example:

English (United States) - m/d/yy, m/d/yyyy, mm/dd/yy, yy/mm/dd, etc.
German (Standard) - dd.mm.yy, dd/mm/yy, d.m.yy, d.m.yyyy, etc.

Additional valid date formats are limited to those w hich Window s can understand by adding "/" betw een the second and
third characters, as w ell as betw een the forth and fifth characters. NeuroShell Trader w ill attempt this only if the date field
is exactly six characters long and is not recognizable as a valid w indow s date for the current regional settings. For
example:

English (United States) - yymmdd and mmddyy
German (Standard) - ddmmyy
The only other valid date formats are yyyymmdd, mmddyyyy, and mmyy (for monthly data).

(DayTrader Only) Intraday data files must have either a time included in the date column or a separate time column w hich
contains a valid time. For example:

Times included in Date Column — mm/dd/yy hh:mm am

Times in separate Time Column — hh:mm am
Valid time formats that NeuroShell Trader recognizes include all valid Window s time formats for the current regional
settings. For example:

English (United States) — hh:mm am, hh:mm:ss pm, HH:mm:ss, etc.

German (Standard) — HH:mm, HH:mm:ss, etc.
Additional valid time formats are limited to those w hich Window s can understand by adding ":" betw een the second and
third characters, as w ell as betw een the forth and fifth characters (assuming 6 characters). NeuroShell Trader wiill
attempt this only if the time is not recognizable as a valid w indow s time for the current regional settings. Valid formats
include:

All Regional Settings — hhmmss, hhmm, hmmss, or hmm
The file cannot contain any extraneous data (i.e., total or summary information at the bottom of the columns).
If your file contains missing data, you must put a non numeric character or string in place of the missing data (i.e., "+").
Note that Comma separated text files wiill also recognize tw o commas (i.e., ,, or , , ) as denoting missing data.
A file by the name of XYZ.CSV w ill be read into NeuroShell Trader as an instrument w ith the name XYZ.CSV and the ticker
symbol XYZ. If you wish to more accurately specify the name and ticker symbol, NeuroShell Trader w ill recognize an
ASCII file that lists the ticker symbol on the first line of the file, the name on the second line of the file, and the label row on
the third line of the file.

Notes:

When setting up NeuroShell Trader to access AlQ data map the directory that contains the master.ndx and master.adf
files. If you are having difficulty mapping or using your AlQ data you may consider using the "Rebuild Master List"
functionality in your AIQ product. Please note that NeuroShell Trader is unable to read data from AlQ’s data CD.



Setting Up Data Server

Setting up data directories defines w here your data files are located. It is very important that you properly define your data so
that NeuroShell Trader know s the location of your data and the type of data you have. This is necessary so that w hen you
w ant to use your data NeuroShell Trader w ill be able to easily access your data.

1. Select Data Sources from the Tools menu. This activates the data sources dialog box from w hich you can define and
change the data sources used by NeuroShell Trader.

II:I |:||5

Export Chart/Data ...

Data Sources ...

Options ...

2. Select the Servers tab. This displays the data sources tab from w hich you can define and change the server and thus
the data used by NeuroShell Trader.

Data Sources

Directories/Files  Server | End of Day Download |

Data server from which HeuroShell Trader ni

[Huate. carm CChart



Data Sources Dialog: Server

There are several tools on this tab to help you define your data server and the data that will be read from the server.

Use the drop dow n list near the top to select the data server from w hich NeuroShell Trader should request data.

Once you have chosen the data server, use the list box entitled Data requested from data server to select w hich data to
receive from the data server. By selecting only the data that you wiill use, you can speed up the data mapping process w hen
NeuroShell Trader loads and also reduce the number of items in the ticker list w hen creating a chart or adding other instrument
data to a chart.

(Quote.com Only) The Connect/Disconnect button can be used to manually connect or disconnect from the data server. Itis
usually not necessary to connect manually to the server as the NeuroShell Trader w ill automatically try to connect to the server
w hen a chart is loaded that requires data from the server. How ever, you may encounter situations in w hich you w ould like to
manually disconnect from the server (for instance, w hen training or backtesting on past data and you find too much processor
time is being w asted processing new ticks).

(Quote.com Only) The Setup button can be used to setup quote.com’s interaction w ith NeuroShell Trader. By using this button
you can determine if NeuroShell Trader should automatically reconnect to Quote.com if the connection is lost, as w ell as how
the NeuroShell Trader should behave w hen the data dow nloaded from Quote.com previously doesn’t match w hat is currently
being dow nloaded.

(eSignal Only) The Setup button can be used to setup eSignal’s User ID and Passw ord.

Please Review Information for the server that you have selected:
Quote.com

eSignal

TradeStation NSTExport Server

Topic of Interest:
NeuroShell Trader Data Pump Server



Trade Station NSTExport Server

The TradeStation® Export indicator is a feature which is unsupported in NeuroShell. Although the feature
worked reasonably well when we introduced it, changes made to TradeStation® make the feature unreliable in
some situations. We continue to include it for the benefit of any user who may find it reliable, but new users
should not attem pt to use it, and our technical support personnel cannot assist with any problems it causes.
Note that if you are using daily bars, the most reliable method of obtaining data from TradeStation® is to export text files (see
the Tradestation® data w indow ) from TradeStation® and load then map and load them into NeuroShell.

NeuroShell Trader interfaces w ith TradeStaion® via the NSTExport indicator that can be imported into TradeStation. Once
tickers have been exported from TradeStation® using the NSTExport indicator they can be used just like any other data source.

If you have not initiated the TradeStation® export via the NSTExport indicator NeuroShell Trader w ill not be able to load any
data.

Note: NSTrdExport is not a viable substitute for a data feed if you regularly trade more than a few dozen issues (ticker
symbols) because the export indicator must be inserted in the chart for each issue. Furthermore, because TradeStation® does
not allow us access to their feed directly, there wiill be timing issues as w e transfer data from a TradeStation® chart to a
NeuroShell chart. This means that as new bars are transferred, bars may occasionally be a tick or so off betw een the tw o
systems.

For more information on how to import and use the NSTExport indicator please refer to one of the follow ing topics:
Installing indicators and functions into TradeStation®
Importing TradeStation® Data and Indicators



NeuroShell Trader Data Pump Server

NeuroShell Trader interfaces w ith custom data sources via the NeuroShell Data Pump. This is done via a programming
interface that is explained in detail by the DataPumpExample.zip available on http://w w w .w ard.net/.


http://www.ward.net/

(Servers Only) Adding New Data Server Ticker Symbols

The NeuroShell Trader comes w ith a very large number of predefined ticker symbols that can be requested from a data server.
How ever, you may find that there are other ticker symbols that you w ish to receive from the data server that are not already
predefined (stock options, futures contracts, initial public offerings, ...).

To add a single instrument or a small number of instruments you should add them using the Chart Wizard. To go to the chart
w izard select New Chart from the File menu. After selecting the start date, periodicity, and instrument type you may add
additional instruments by selecting the Add New Quote.com Ticker Symbol or the Add New e Signal Ticker Symbol
button.

Otherw ise, to add a large number of tickers to the universe of ticker symbols recognized by NeuroShell Trader follow the
directions below .

The universe of tickers that can be requested from a data server is defined by the ticker list files in the servers subdirectory
(C:\Neuroshell Trader\Servers\<Server Name>\). When the NeuroShell Trader loads, it reads each of the ticker list files in the
server subdirectory to determine the universe of tickers that can be requested from the data server. Each ticker list file in the
servers subdirectory corresponds to an item in the Data requested from data server list found on the Server tab of the
Data Sources dialog. By selecting or unselecting an item in the list, you are essentially selecting or deselecting all the ticker
symbols contained in the corresponding ticker list file.

Do not add new tickers to one of the preexisting ticker list files that are installed by NeuroShell Trader. If you make changes to
a ticker list file that is installed by NeuroShell Trader, all your changes w ill be overw ritten w hen new er releases of NeuroShell
Trader are installed.

To create a custom list of ticker symbols you should create one or more new ticker list files. The follow ing are the guidelines to
follow w hen creating a new ticker list file:

1. The file name must end with .LST
2. The file name w ill be displayed in the Data requested from data server list in the Data Sources dialog.

3. The ticker symbols wiill be added to the Miscellaneous Instruments category unless the file name contain the category title
(For example: Stocks.LST, My Future Symbols.LST, Custom Stock Options.LST, ...)

4. Each line of the file must be of the form Ticker Symbol, Description (i.e. MSFT, Microsoft). If no description is entered, the
ticker symbol wiill be used as the description.

5. No header line or blank lines are allow ed in the file.

Once you have created a new ticker list file in the servers subdirectory, you must restart the NeuroShell Trader before the file
w ill be selectable in the Data requested from data server list. None of tickers listed in the file w ill be available in the
NeuroShell Trader until you have selected the file from the Data Requested from data server list.



Server Setup: Time Zone

The Time Zone tab is designed to allow you to have control over w hat time zone should be used to display your data.

To change your User ID and/or passw ord:
1. Select Local Time or Eastern Time.
2. Press the OK button.

Notes:
. Local time is w hat time zone you have selected in your w indow s settings.
. Eastern time is Easter U.S. time.



Manage Realtime Data Files

The Manage Realtime Data Files dialog allow s you to view previously dow nloaded files. The information provided is the Symbol,
Frequency, Start Date, End Date, and the Size of a specific file. Additionally you can delete files that you may consider
erroneous or overly large. This provided you with a w ay to manage your disk space as w ell as data.

To select all the files press the Select All button.
To deselect all the files press the Deselect All button.
To delete selected files press the Delete Selected Files button.

When you have completed managing your realtime data files press the OK button.

Note:

. Once you press the Delete Selected Files button the selected data files will be erased from your hard drive. This will
free up space on your hard drive and clear out erroneous data, but it will also cause additional dow nload time the next
time you dow nload. Additionally, some of the data may not be able to be dow nloaded again because your data server
doesn’t support history back as far as you may have saved in your data file.



Quote.com

If an internet connection is not automatically established w hen NeuroShell Trader connect to the server, you may need to
establish an internet connection manually by loading your internet brow ser before NeuroShell Trader tries to connect to the
server.

The NeuroShell Trader comes w ith a large number of predefined ticker symbols that can be requested from a data server.
How ever, you may find that there are other ticker symbols that you w ish to receive from the data server that are not already
predefined (stock options, futures contracts, initial public offerings, ...).

To add a single instrument or a small number of instruments you should add them using the Chart Wizard. To go to the chart
wizard select New Chart from the File menu. After selecting the start date, periodicity, and instrument type you may add
additional instruments by selecting the Add New Quote.com Ticker Symbol button.

If you need to add a large number of instruments refer to Adding New Data Server Ticker Symbols for more information.

Quote.com may revise ticks that are previously inaccurately reported. This may affect your charts in various w ays including
telling you that you need to retrain predictions or rebacktest trading strategies.

Currently Quote.com collects ticks on all of their servers independently of each other. This frequently results in data the varies
betw een servers because one server records a tick in one minute (12:00:00 PM) w hile another server records in the next
minute (12:01:00 PM). This wiill result in a possible change in closing price and volume for the older minute (12:00:00 PM) and a
possible change in the opening price and volume for the new er minute.



Quote.com Setup: Automatic Reconnect

The Automatic Reconnect tab is designed to enable you to let NeuroShell Trader automatically try to reconnect w henever
disconnected from quote.com.

To enable the Automatic Reconnect functionality:
1. Select the Automatically reconnect if disconnected option.
2.  Press the OK button.

To disable the Automatic Reconnect functionality:
0. Deselect the Automatically reconnect if disconnected option.
1. Press the OK button.

Notes:
e This option should be used by users that have a continuous connection to quote.com.

. Users that use dial up may w ant to use this option, but it is only recommended bur users that leave their dial up connection
connected w hile using the NeuroShell Trader.

. If you select this and are disconnected from the internet you may receive up to tw enty requests to reconnect. This is
because NeuroShell Trader is trying to reconnect, but is unable to because of a loss of the internet connection.



Quote.com Setup: Data Replacement

The Data Replacement tab is designed to allow you to have control over w hat NeuroShell Trader should do in the event that
NeuroShell Trader detects that quote.com has sent different data than previously dow nloaded.

To choose the method of data replacement that you w ant NeuroShell Trader to use:

0. Select the option that you desire:
e Automatically replace data if NeuroShell Trader detects a difference in the data. (Default)
e Ask if NeuroShell Trader should replace the data if NeuroShell Trader detects a difference in the data.
. Don’t ever replace the data that NeuroShell Trader has previously dow nloaded.

2. Press the OK button.

Notes:

e« The option — "Automatically replace data if NeuroShell Trader detects a difference in the data. (Default)" — is the default
because this doesn’t happen that often and w hen it does you most likely w ant to dow nload the new data. If a stock split
happens you will w ant to get the new data for your charts and this option w ill handle it automatically.

¢ The option — "Ask if NeuroShell Trader should replace the data if NeuroShell Trader detects a difference in the data." — wiill
ask you with an example of the data that differs so you can determine w hether or not you w ant to replace your data. If a
stock split happens you should be able to see the difference in the data and recognize that you should reload the data so
your charts will have the correct data.

e The option —"Don’t ever replace the data that NeuroShell Trader has previously dow nloaded." — will never replace your
data. If a stock spilt occurs you wiill have a gap in you price data since the stock split will not be back adjusted. In order to
have the NeuroShell Trader redow nload the data you w ill need to delete the data manually from the Servers\Data
directory.



eSignal

NeuroShell Trader interfaces w ith eSignal via the TurboFeed Manager. NeuroShell Trader w ill connect to the TurboFeed
Manager w hen initiating a session w ith eSignal. If the TurboFeed Manager is not already running, NeuroShell Trader w ill
automatically initiate it. If you close the TurboFeed Manager at any time, NeuroShell Trader may loose any connection to eSignal
and no data will be updated.

If an internet connection is not automatically established w hen the TurboFeed Manager attempts to connect to the server, you
may need to establish an internet connection manually by loading your internet brow ser before TurboFeed Manager tries to
connect to the server.

The NeuroShell Trader comes w ith a large number of predefined ticker symbols that can be requested from a data server.
How ever, you may find that there are other ticker symbols that you w ish to receive from the data server that are not already
predefined (stock options, futures contracts, initial public offerings, ...).

To add a single instrument or a small number of instruments you should add them using the Chart Wizard. To go to the chart
wizard select New Chart from the File menu. After selecting the start date, periodicity, and instrument type you may add
additional instruments by selecting the Add New e Signal Ticker Symbol button.

If you need to add a large number of instruments refer to Adding New Data Server Ticker Symbols for more information.

Note:

. If eSignal has never been run, NeuroShell Trader w ill be unable to find it. In order for NeuroShell Trader to find it run
please run eSignal, then retry to setup eSignal as your Data Server.



eSignal
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Installing indicators and functions into Trade Station®

NOTE: This interface is included in NeuroShell Trader, but is UNSUPPORTED by Ward Systems Group since the
method of obtaining data from TradeStation is not officially sanctioned by Trade Station and it may be unreliable
in some situations. If you are using daily bars, the most reliable method of obtaining data from Trade Station is
to export text files (see the Tradestation data window) from TradeStation and load then map and load them into
NeuroShell

NeuroShell Trader has the ability to incorporate data and functions from TradeStation®. Additionally, indicators and predictions
displayed in a NeuroShell Trader chart can be incorporated into TradeStation® (Unsupported Feature). Use the follow ing
procedures to install the necessary indicators and functions into TradeStation®.

Note: NSTrdExport is not a viable substitute for a data feed if you regularly trade more than a few dozen issues (ticker
symbols) because the export indicator must be inserted in the chart for each issue. Furthermore, because TradeStation® does
not allow us access to their feed directly, there wiill be timing issues as w e transfer data from a TradeStation® chart to a
NeuroShell chart. This means that as new bars are transferred, bars may occasionally be a tick or so off betw een the tw o
systems.

To install ‘NSTrdExport’ and ‘NSTrdimport’ indicators into Trade Station®

Select Im port/Export EasyLanguage® from the File menu.
Select Import EasyLanguage file (ELD, ELS or ELA) and press the Next button.

3. Click on the Brow se button and look in your NeuroShell Trader 4 Directory for the file named NST-TS6.ELD or
NST-TS7.ELD (w hichever is appropriate) and then press the Next button.

Make sure both the Function and Indicator options are selected and press the Next button.

5. Make sure all of the listed items are checked (you can just click on Select All button) and press the Finish button. You
should receive a message that you have successfully imported your analysis techniques.

TradeStation®, EasyLanguage®, and Pow erEditor® are registered Trademarks of TradeStation Technologies, Inc. Neither
TradeStation Technologies nor any of its affiliates has reviewed, certified, endorsed, approved, disapproved or
recommended, and neither does or will review, certify, endorse, approve, disapprove or recommend, any
trading software tool that is designed to be com patible with Trade Station Open Platform.

Topics of Interest:
Importing TradeStation Data and Indicators
Exporting Data and Indicators to TradeStation



Importing Trade Station® Data and Indicators

Importing Trade Station® Data and Indicators is a feature which is unsupported in NeuroShell. Although the
feature worked reasonably well when we introduced it, changes made to Trade Station® make the feature
unreliable in some situations. We continue to include it for the benefit of any user who may find it reliable, but
new users should not attempt to use it, and our technical support personnel cannot assist with any problems
it causes. Note that if you are using daily bars, the most reliable method of obtaining data from TradeStation® is to export text
files (see the Tradestation® data w indow ) from TradeStation® and load then map and load them into NeuroShell.

NeuroShell Trader has the ability to incorporate data and functions from an Omega Research TradeStation®. Use the follow ing
procedures to import data into NeuroShell Trader from TradeStation®.

Using the NSTrdExport indicator (in TradeStation®) w ill export Date, Time, Open, High, Low, Close, Volume, Open Interest, and
up to 10 other functions that you select.

Note: The NSTrdExport indicator is capable of exporting TradeStation® functions, but can not export any TradeStation®
indicators. This is because of the differences betw een the TradeStation® indicator and TradeStation® function. The
TradeStation® manual defines an indicator as "an instruction to show a mathematical formula onscreen" and defines a function
as "a calculation w hich has been assigned a name so it can quickly be pasted into an indicator, Show Me study, PaintBar study,
or trading system". Because a TradeStation® Indicator is a graphical line and a TradeStation® function is a calculation, you will
only be able to export TradeStation® functions to NeuroShell Trader. Many third-party developers provide custom
TradeStation® indicators, but if no matching function has been provided, you wiill not be able to export these third party custom
indicators to NeuroShell Trader.

Note: NSTrdExport is not a viable substitute for a data feed if you regularly trade more than a few dozen issues (ticker
symbols) because the export indicator must be inserted in the chart for each issue. Furthermore, because TradeStation® does
not allow us access to their feed directly, there will be timing issues as w e transfer data from a TradeStation® chart to a
NeuroShell chart. This means that as new bars are transferred, bars may occasionally be a tick or so off betw een the tw o
systems.

In TradeStation®:
1.  Select Indicator from the Insert menu.

2. Select the NSTrdExport Indicator.

3. Check the Prom pt for Format option if it is not already selected.

4. Press the OK button.

5. Select the Inputs tab to change the category name or insert any additional functions. To enter additional functions enter
the functions’ formula in the Formula0, Formula1, ..., Formula9 Inputs and the corresponding plot name in the Name0,
Name1, ..., Name9 Inputs. (Note: If there is no name the function will not be exported).

. Click on the desired formula, and either type in the function or select the Dictionary button and then select the
function you desire.

. Click on the desired name and enter the name of the indicator you w ish to export inside the quotation marks.
6. Select the OK button.

Note: If you are using data that can be read by NeuroShell Trader then this functionality should only be used if you w ant to
export functions from TradeStation®. Additionally, NeuroShell Trader has the ability to build almost any indicator. If you find it
necessary to use the NSTrdExport indicator, be aw are that because of TradeStation®’s order of evaluation you may be
required to reload your TradeStation® w orkspace w hen using both NSTrdExport and NSTrdlmport. You w ill be informed of this
rare occasion w ith text messages on your TradeStation® w orkspace (w hich can be moved by dragging and dropping the text
for more readability). If the text messages are still present after reloading the w orkspace, then the NeuroShell Trader chart
from w hich you are importing does not have the most recent data (check that all the data files being used by the chart have
been updated).
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Using Exported Trade Station® Data and Indicators in NeuroShell Trader

1. Make sure you’ve selected Trade Station NSTExport Server on the Server tab of the Data Sources Dialog. For more
information Setting Up Data Server

2. Selectg from the toolbar or New Chart from the File menu. This activates the chart w izard, w hich guides you through
the process of creating a new chart.
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3. Select the chart periodicity equal to or greater than the chart that you exported from TradeStation® and press the Next
button.

Select the Category that you specified in the NSTExport Indicator and press the Next button.
5. Select the instrument that you w ant to plot and press the Finished button.

6. Select the Existing Data/Calculations from the Insert menu to insert any data or indicators that are not currently
displayed that you w ant to view .

7. Modify the chart as you desire, creating predictions, trading strategies, and indicators as you desire. Anything displayed
on a NeuroShell Trader chart can be imported back into TradeStation®.

8. Save the chart. (If you are going to import data from the chart back into TradeStation®, be sure to make a note of the
Chart Name, Ticker Symbol, and the name of the line that you w ish to Import into TradeStation®).

Note: If you re-export data from TradeStation®, but don’t include the same indicators and don’t unload the NeuroShell Trader
chart, NeuroShell Trader w ill recognize the data columns that you used before from a previous export in chart that use
exported data from TradeStation®. For example, if you exported the indicator ADX(14) the first time that you exported data



from TradeStation®, but replaced that indicator with CCI(21) the next time you exported data from TradeStation®. If you have a
NeuroShell Trader chart that uses the ADX(14) data stream for any reason (i.e. plotting, creating indicators, inputs to
predictions) and fail to unload the NeuroShell Trader chart, then NeuroShell Trader w ill mistake CCI(21) for ADX(14) and resume
accordingly.

TradeStation®, EasyLanguage®, and Pow erEditor® are registered Trademarks of TradeStation Technologies, Inc. Neither
TradeStation Technologies nor any of its affiliates has reviewed, certified, endorsed, approved, disapproved or
recommended, and neither does or will review, certify, endorse, approve, disapprove or recommend, any
trading software tool that is designed to be com patible with Trade Station Open Platform.

Topics of Interest:
Installing indicators and functions into TradeStation®
Exporting Data and Indicators to TradeStation®



Dow nload Data

Dow nloading Data will allow you to update your data to the most recent data. This will allow NeuroShell Trader to make
predictions into the future, provide up to date trading signals, and update all of your indicators.

1. Select Data Sources from the Tools menu. This activates the data sources dialog box from w hich you can define and
change the data sources used by NeuroShell Trader.

Expart Chart/Data ...

Data Sources ...

Options ...

2. Select the End of Day Dow nload tab. This displays the data sources tab from w hich you can define and change the
data that you w ant to dow nload.

Data Sources

Directoriesz/Files I Server | End of Day Download |

End of day data to be downloaded from Dial
I Sym... | i ame | Type | Marketl L




Data Sources Dialog: End of Day Dow nload

There are several tools on this tab to help you define w hat to dow nload.

You can add tickers to dow nload by pressing the Add Ticker button.

Also, if you w ant to retain a ticker’s data, but not dow nload it you can change the ticker’s status so that it won’t dow nload. To
do this, select the ticker that you w ant to retain, but not update, and press the Change Status button.

Additionally, if you no longer w ish to dow nload a ticker, you can remove it by selecting the ticker and pressing the Remove
Ticker button.

If this is the first time that you are dow nloading data you w ill w ant to press the Dow nload Setup button to setup your system
for dow nloading data.

Finally, after you have setup w hat you w ant to dow nload and your system has been configured using the Dow nload Setup
button, press the Dow nload Now button to start dow nloading the desired data.

Notes:
. NeuroShell Trader automatically detects splits and back adjusts any data that you are using, including CD-ROM data.
¢  While DialData and the dow nloader provided w ith NeuroShell Trader give you the ability to dow nload fundamental data in

addition to price and volume data, NeuroShell Trader is currently unable to read the fundamental data that DialData
provides.

Troubleshooting:

. If you are using an internet connection to dow nload data, you may need to load your brow ser before attempting to
dow nload data

. If the DialData master file is corrupted and causes errors w hen adding new tickers to be dow nloaded or w hen
dow nloading data, you may need to reinitialize and remove all previously dow nloaded data. To reinitialize DialData, press
the DialData Dow nload Reinitialization and Cleanup button. Please note that all your previously dow nloaded data w ill
be removed and the data w ill be redow nloaded next time you dow nload from DialData.



Dow nload Now

You have selected to dow nload the tickers that are in your dow nload list.

The Dial/Data Data Retrieval program w ill now update the selected tickers.

When the Dial/Data Data Retrieval program is complete it w ill send a message to Dial/Data that it is complete, then to the netw ork
provider that it is complete, process the data that it has retrieved, and w rite a "Transfer Complete" message to the screen. This
may or may not be follow ed by a set of informative messages that will inform you the dow nloader is updating your dow nload
list with dividend, stock splits, etc.

After all of this is complete you wiill need to exit the Dial/Data Data Retrieval program in order to return to NeuroShell Trader.

Troubleshooting:

. If you are having trouble connecting to Dial/Data be sure that you have setup the Dial/Data Data Retrieval program properly.
To do this exit the Dial/Data Data Retrieval program and select the Dow nload Setup button from NeuroShell Trader.

. If you receive messages at the end of dow nloading informing you that errors have occurred (i.e. Unknow n Ticker, Change
Start Date, etc.), you may need to take steps to prevent these errors from occurring again.

. If you are using an internet connection to dow nload data, you may need to load your brow ser before attempting to
dow nload data



Dow nload Setup

The Dial/Data Data Retrieval program setup involves setting up the Service and the Network. To do this you must first contact
Dial/Data to set up an account and a method (Netw ork) of connecting to Dial/Data.

Please refer to the Dial/Data Order Form for pricing information that w as included w ith NeuroShell Trader.

To contact Dial/Data call 1-800-275-5544. Be sure to inform them that you are using NeuroShell Trader developed by Ward
Systems Group. Also verify that your User ID begins w ith the letters WS. This w ill ensure that the Dial/Data Data Retrieval
program w ill w ork seamlessly w ith NeuroShell Trader.

Although the service is already selected as Dial/Data you wiill need to select the Setup button next to the Dial/Data box. This is
w here you need to enter your User ID and Password. After you are finished entering you User ID and Password select
the OK button.

After you have setup the service select the Setup button to the right of the selected Netw ork. This allow s you to setup the
chosen Netw ork so that you w ill be able to dow nload data. It is recommended that you only modify the Modem, Phone, Baud
, and Port, unless you have been otherw ise advised. After completing the setup entries select the OK button.

Once you are done w ith the setup, select the OK button and exit the Dial/Data Data Retrieval program. This w ill complete setting
up your Dial/Data Data Retrieval program.

The Market Times section has no bearing on the Dial/Data Data Retrieval program. Therefore ignore the Open, Close, and
Intraday updates options.

The Retries option tells your system how many times the Data Retrieval application is to attempt to connect to the data service
if initial connection is not successful. If, for some reason the Data Retrieval application has not made a connection to the data
service after the specified number of retries, no further attempts w ill be made. The default setting for Retries is 3.

The Timeout option specifies the length of time that the system w ill w ait w hile data is not being received before disconnecting.
In the event that no information is received for the specified period of time, the Data Retrieval interface w ill disconnect from the
data service. The Data Retrieval application will then attempt for the number of retries specified to make another connection.
The default setting is 60 seconds.

Troubleshooting:

. If you are using an internet connection to dow nload data, you may need to load your brow ser before attempting to
dow nload data



Add Ticker Wizard - Selecting an Instrument Category

Selecting the instrument category w ill set w hat type of ticker you w ant to add to your dow nload list.

1.  Select the type of instrument you wish to add to your dow nload list.
2. Press the Next button to proceed to the next w izard screen.



Add Ticker Wizard - Selecting Instruments

Selecting the instruments that you w ant to dow nload allow s you to select one or more instruments that w ill be added to your
dow nload list.

If you wish to add new tickers not already in the list:
1. Select the Add New Ticker button.

To select tickers that you w ant to dow nload:
1.  Select the instrument or instruments you w ish to dow nload.
2. Press the Finish button to end the wizard and add the tickers to the dow nload list.

Tip:
e To select a group of instruments, hold the left mouse button dow n w hile you drag the mouse over the desired
instruments.



Add New Ticker Symbol

In order to add a new ticker you must enter the Symbol, Name, First Date to Download, Market, and the Dial Data
Category and select the OK button.

If you decide that you do not w ant to add a new ticker at this time you may select the Cancel button.



Loading Examples

You may w ant to load the examples that are included w ith NeuroShell Trader in order to better understand the abilities of
NeuroShell Trader or to get a few ideas on how you might w ant to use NeuroShell Trader.

To load an example:

]
1. Select g from the toolbar or Open Chart from the File menu. This activates the file dialog box from w hich you can
select one of the example charts (i.e., Example 1 — Colors and Simple Indicators.cht).
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Example 1

Colors and Simple Indicators

This is the first of many sample tutorial charts describing NeuroShell features and techniques. It is highly recommended that you
study all charts even if you feel you will not be trading the symbols in the charts, the time frequency, or the techniques
described. That is because most techniques can be used on other symbols and frequencies. It doesn't really matter w hether
you are trying to model stocks, bonds, futures, forex, or options. Furthermore, each example gives you some small pieces of
information that you may need in the future. Most of our examples are done on daily charts, because the techniques are the
same for intraday charts. These charts are for tutorial purposes, and not intended as profitable trading models. When you are
asked during loading if you w ant to use the data saved in the chart, respond affirmatively.

In this Example 1, w e have loaded the S&P 500 ETF stock w hose symbol is SPY. We changed to default color schemes just to
show you it can be done. Gone is the black background, and the lime green o,h,l,c price symbols. We've changed to dark green
candlestick price symbols, and eliminated the gradient shading.

Next w e inserted tw o moving averages, and colored the longer one red and the shorter one blue. Our intent w as to associate
blue w ith buying and red w ith selling. Whichever color is on top w ould show the correct position to be in according to the
ancient moving average crossover strategy used by traders for years.

Just to clarify the crossover, w e inserted a subtract indicator from the Arithmetic category w here w e subtracted the long
moving average from the short one. Then w e formatted that new indicator into bars, and instructed NeuroShell to make bars
above zero blue, and those below zero red.

This example give you but a taste of the formatting possible, and w e hope you w ill explore the possibilities further.

Copyright © 1997-2006 Ward Systems Group, Inc. All rights reserved.



Exam ple 2

Crossover Alerts

(Professional Only) In this Example 2, w e started w ith the chart of Example 1. Then w e inserted tw o Alerts, one to tell us
w hen to buy, and one to tell us w hen to sell. We appropriately colored one blue and one red. Finally, w e moved both alerts to
the same subchart.

The tw o alerts each make different sounds w hen they fire. If you w ant to examine how an alerts w as coded, just double click
on one of the legends "Buy alert" or "Sell alert".

Alerts are pretty pow erful in that they can tell you w hen just about any true-false condition has occurred.

Copyright © 1997-2006 Ward Systems Group, Inc. All rights reserved.



Example 3
True Range and Multiple Pages

In this Example 3, w e demonstrate the construction of slightly more complex indicators using the Indicator Wizard. The indicator
w e will build is Wilder's True Range indicator w hose definition is:

The maximum of the follow ing three values:

1. The absolute value of the spread betw een the high and low

2. The absolute value of the spread betw een the high and yesterday's close
3. The absolute value of the spread betw een the low and yesterday's close

There is a spread indicator w e could use in the indicator category called Time Series, but since the spread is just a subtraction
of tw o values, w e elected to use the Subtract indicator in the Arithmetic category. The Absolute value is in there too.

First w e build indicators for each of the values above by slecting the Absolute value indicator, then for the operand parameter
of the Absolute value, w e re-entered the Indicator Wizard and selected subtract, then for each operand of subtract, w e chose
either high, low , or yesterday's close. Yesterday's close is itself an indicator, namely the one day lag of the close (lag is found
in the Basic category).

Then w e hid those three indicators, but you can unhide them and examine them by double clicking on their legends.

With the three vaule indicators build, it w as a simple matther to insert the Max3 indicator from the Arithmetic category, and
select each of the three values as parameters of Max 3. The final step w as to rename the resultant indicator as "True Range".

Copyright © 1997-2006 Ward Systems Group, Inc. All rights reserved.



Example 4

Complex Formulas

In this example, w e enter a formula into the Indicator Wizard. Formulas are not entered in the usual w ay, because the Indicator
Wizard is point and click. Therefore, it is hard to make the usual kinds of mistakes, like not matching parentheses. On the other

hand, if you are used to entering formulas from left to right, character by character, the Indicator Wizard may take some getting
used to.

Let us suppose that w e have read somew here that a w onderful indicator could be coded w ith the follow ing formula:

(0.6 * (high-low )/open + 0.4 * (previous high - previous low )/previous open) * 100

We can put this into the Indicator Wizard either as top-dow n, bottom-up, or a combination of the tw 0. We w ould use indicators
exclusively from the Arithmetic category.

If you w anted to make the indicator top-dow n, you'd notice that at the highest level, the indicator is a long term in parens times
100. So the first indicator you'd insert w ould be Multiply2.

How ever, w e prefered to do a combination, inserting several of the low er level terms and then combining them. So w e first built
the follow ing tw o terms:

(high-low )/open
(previous high - previous low )/previous open)

They are both made w ith the Divide indicator in w hich the numerator is a Subtract indicator. We renamed them term 1 and term
2 on the chart so you can find them. We renamed them by right clicking on each of them (or their legends) and selecting Format
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Example 5

Unoptimized Crossover

In this example w e start building traditional models. Traditional models are those built w ithout neural nets or genetic algorithms
using rules for buying and selling. We start w ith a type of system traders have used for years, the unoptimized moving average
crossover. The theory is that w hen a short moving average crosses under a long one, you are starting a dow n trend, and

w hen it crosses over the longer one, you are most likely starting into an up trend.

General Motors stock w as getting hit badly starting in 2002, but the crossover system in this chart picked up the dow ntrends,
as w ell as some breif uptrends, and made money. Crossover systems don't alw ays pick up a new trend at the exact moment it
starts, but if the trends last for a w hile, the system can be profitable. There are comapnies selling systems not much more
sophisticated than this one for thousands of dollars!

In this chart w e have inserted a 5 day and a 10 day moving average and labelled the short one Buy and the long one Sell, w ith

appropriate colors. Whichever color is on top show s the current position you should be in. You can double click on the legends
to see the indicators before they w ere renamed. You can see the lines crossing over one another better if you zoom in on the

chart.

It is a fairly simple matter to build a trading strategy using this crossover method. The Buy and Sell indicators do not even need
to be on the chart. All w e need to do is use the indicators in the category "Crossover and Breakout Identification" called:

Simple movavg crossover above
Simple movavg crossover below

WE just put one in for the Long Entry condition, and one for the Short Entry condition. Note that w e have no Exit conditions. If
NeuroShell sees no exit conditions, it goes directly from long to short (called a "reversal").

On the trading strategy you can see the signals, blue triangle for long entry and red triangle for short entry (sell short) afer a
daily bar has ended. You w ill see the fill points (blue and red Xs) on the next morning's open. These notations are the same in
intraday bars, except that the bars are shorter.

Double click on the Trading Strategy legend to see the trading stragey itself. You can go backw ard in the Wizard to examine the
conditions.

(Editors note about reversals - You can actually accomplish reversals in a dropping market even w ith the stock uptick rule. Lets
say you w ant a 100 share position. When you start out long, you go long 200 shares and short 100 shares. That's net 100
long. When you w ant to go short, you sell 200 shares. That's net short 100. When you w ant to go long again, you buy 200
shares. Etc.)
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Example 7

Optimized Crossover

(Professional Only) After reading Example 6 you may be w ondering if the crossover rules that w e picked could be improved
upon. That's w here our genetic algorithm optimizer comes into play. We can optimize the moving averge periods to see if we
can find periods that do better than the periods of 5 and 10. If you examine the trading strategy, you wiill see that w e have
chosen "Parameter optimization" in the Rules tab of "Modify Trading Strategy Parameters". Parameter optimization adjusts the
parameters of the conditions (rules) used for long entry and short entry.

When you optimize you can and should set appropriate ranges for each variable. The genetic algorithm optimizer will keep the
variables w ithin those ranges w hen it optimizes. Unlike other optimizers, you do not need an "increment" for each variable,
because genetic algorithms do not search in increments. To see the ranges for the variables, navigate to the dialog w here we
entered the long entry and short entry rules. To the left side of the rules you wiill see a plus sign (+). Click on the plus sign and
the rule will "open up" to reveal the selected ranges. Double clicking on any range allow s you to change it.

In this example, w e w anted to make sure that the averaging periods optimize to the same values on the short entry as they did
on the long entry. In other w ords, w e didn't w ant the long entry rule to be a 3 period average crossing over a 10 period one,
and the short rule to be a 6 period average crossingover a 12 period one. Not that there's anything w rong w ith that! It is just
that it w ould offend most people's sense of symmetry. Anyw ay, to accomplish the symmetry, w e gave each range a name in
the long rule so that the same name could be referenced in the short rule. You should examine how w e accomplished that. The
ranges w ere set from 2 to 20.

In the "Optimization" tab you will see a dropdow n box w here you can set various "Objective functions" of the optimization
process. The default is "maximize return on account" because that's the easiest for most people to understand. How ever, as
you get more advanced you can try different ones.

In the "Trading Strategy Results Summary" dialog (the final one in the wizard) you can press the "Detailed Analysis" button to
see a host of trading statistics about the backtest completed after the optimization w as complete. In the tab called "trading
Rules" you w ill see the crossover parameters that the optimizer determined w ere best over the time period in the chart. They
w ere averaging periods of 2 and 9.

Note that the averaging periods for the red and blue moving averages did not change on the chart. When you insert a moving
average crossover into a trading strategy, it is really a new copy, not the one on already on the chart. So w hen the otimizer
finds new averaging periods, the averages on the chart are not changed.
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Example 8

Optimization w ith Evaluation

(Professional Only) In this example w e examine a modeling problem common to all model building w ith past data.

Any time you optimize there is a possibility that you may "over-fit", w hich means that you build a model that w orked so w ell in
the past that it fit the past noise too, so that it probably w ill not w ork w ell into the future. (Editors note: some people use the

w ord "curve fitting to describe the over-fitting phenomenon, but that is a misnomer because all modeling from past data is curve
fitting - it is over curve fitting, i.e. or over-fitting, that is the problem).

Over-fitting can occur even if you do not optimize, because in fact w hen you backtest different strategies to see w hich w orks
the best, you are in fact optimizing manually! How ever, machine optimizing increases the odds of over-fitting because it is so
much more efficient. The possibility of over-fitting is reduced by not optimizing, optimizing over plenty of historical data, and/or
optimizing as few parameters as possible.

One w ay that has been traditionally used to test if over-fitting has occurred is simply to see how the model holds up on new
data. There are a couple of w ays that can be done:

1. Of course you could simply w atch your model for several w eeks or months and "paper trade" it in the traditional sense to
see if you would have made money. Few of us w ant to take the time to do that, how ever.

2. Another w ay to do this in NeuroShell is to use the check box called "Start trading before last chart date" in the Dates tab.
That will allow you to select how much time to "hold out" of the optimization for evaluation of the model after it is optimized.
Optimization w ill take place on an earlier period of the chart, and the final backtesting (evaluation) using the model w ill take
place immediately after that. The disadvantage of this "hold out" approach is that even if you are satisfied the model held
up during evaluation, you essentially have an old model, one that w as not built on the latest data (although it w as
evaluated on the latest data).

In order to use "Start trading before last chart date", you must turn on the option that enables it from the menu Tools->Options->
Advanced.

In the chart of this example w e have continued the crossover example. Recall that in the last example w e optimized over all the
data that w as available at the time. In this example, w e optimize over all data EXCEPT the data starting in 2005. Then we

allow ed the backtest on data starting w ith 2005. You should examone the chart to see the tw o separate periods, and then
examine the Dates tab in the "Modify Trading Strategy Parameters" button to see how w e accomplished the separation of the
optimization and the evaluation periods.

Now note that the trading rules (averaging periods) found prior to 2005 did not hold up w ell starting w ith 2005.
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Example 9
Optimized Paper Trading

(Professional Only) Consider the last example (Example 8) further, w here w e optimized in an earlier period and evaluated on a
later period. Using the evaluation of new data (called out-of-sample data by statisticians), w hat you w ill w ind up doing is
repeatedly optimizing models until you find the one that w orks the best on the new data, i.e. the one that show s up best during
the evaluation (out-of-sample period). This is sometimes called "data snooping" because your evaluation data is not really
out-of-sample anymore. Nevertheless it is still the most effective method to arrive at a model w hich has the best likelihood of
holding up as you trade with it in the future.

Therefore, w e have automated this process of building models, then evaluating them, keeping the one that w orks best during
evaluation. The automated method is invoked w hen you check the box called "Save optimization w hich performs best on later
paper trading" in the Dates tab.

In the chart of this example w e have done just that, creating w hat w e call in NeuroShell a paper trading period. Note that it
show s up in orange on the chart. We optimized on data before 2005, the goal being to find the best prophet before 2005.

How ever w e kept the combination w hich w orked best starting 2005, not the combination w hich w orked best before 2005. In
other w ords, each time the genetic algorithm found a new combination of averaging periods, the profit w as tested both for the
period before 2005 and the period starting 2005. NeuroShell remembered the best profit starting 2005 and lest us w ith that
combination, even though it may not have been best before 2005.

In the case of the example chart, the optimizer found the same settings for paper trading (2 and 9) that it did for optimizing over
the w hole chart, but that is not alw ays the case. The paper trading feature is designed to prevent optimization form overfitting,
and finding a solution w hich w orks the best in the future.

Of course if you data snoop, statisticians w ill say that you still haven’t properly evaluated your model w ith real out of sample
data. Of course statisticians usually assume normal distributions, and a number of other factors not present in market trading.
How ever, if you w ant to build your model w ith paper trading and still satisfy the statistician in you, you can select both of the
boxes:

"Save optimization w hich performs best on later paper trading"
"Start trading before last chart date"

That w ill enable saving the model w hich w orks best on paper trading, w hile still giving you a real out-of-sample period after the
paper trading period. The disadvantage is that you have an old model, at least as old as the out-of-sample trading period. Given
that the market is frequently changing, and w e suspect the number of statisticians w ho got rich in the market is quite small, we
suggest that you consider using the paper trading feature w ithout the added out-of-sample period.
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Example 1

Colors and Simple Indicators

This is the first of many sample tutorial charts describing NeuroShell features and techniques. It is highly recommended that you
study all charts even if you feel you will not be trading the symbols in the charts, the time frequency, or the techniques
described. That is because most techniques can be used on other symbols and frequencies. It doesn't really matter w hether
you are trying to model stocks, bonds, futures, forex, or options. Furthermore, each example gives you some small pieces of
information that you may need in the future. Most of our examples are done on daily charts, because the techniques are the
same for intraday charts. These charts are for tutorial purposes, and not intended as profitable trading models. When you are
asked during loading if you w ant to use the data saved in the chart, respond affirmatively.

In this Example 1, w e have loaded the S&P 500 ETF stock w hose symbol is SPY. We changed to default color schemes just to
show you it can be done. Gone is the black background, and the lime green o,h,l,c price symbols. We've changed to dark green
candlestick price symbols, and eliminated the gradient shading.

Next w e inserted tw o moving averages, and colored the longer one red and the shorter one blue. Our intent w as to associate
blue w ith buying and red w ith selling. Whichever color is on top w ould show the correct position to be in according to the
ancient moving average crossover strategy used by traders for years.

Just to clarify the crossover, w e inserted a subtract indicator from the Arithmetic category w here w e subtracted the long
moving average from the short one. Then w e formatted that new indicator into bars, and instructed NeuroShell to make bars
above zero blue, and those below zero red.

This example give you but a taste of the formatting possible, and w e hope you w ill explore the possibilities further.
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show you it can be done. Gone is the black background, and the lime green o,h,l,c price symbols. We've changed to dark green
candlestick price symbols, and eliminated the gradient shading.

Next w e inserted tw o moving averages, and colored the longer one red and the shorter one blue. Our intent w as to associate
blue w ith buying and red w ith selling. Whichever color is on top w ould show the correct position to be in according to the
ancient moving average crossover strategy used by traders for years.

Just to clarify the crossover, w e inserted a subtract indicator from the Arithmetic category w here w e subtracted the long
moving average from the short one. Then w e formatted that new indicator into bars, and instructed NeuroShell to make bars
above zero blue, and those below zero red.

This example give you but a taste of the formatting possible, and w e hope you w ill explore the possibilities further.

Copyright © 1997-2006 Ward Systems Group, Inc. All rights reserved.



Exam ple 2

Crossover Alerts

(Professional Only) In this Example 2, w e started w ith the chart of Example 1. Then w e inserted tw o Alerts, one to tell us
w hen to buy, and one to tell us w hen to sell. We appropriately colored one blue and one red. Finally, w e moved both alerts to
the same subchart.

The tw o alerts each make different sounds w hen they fire. If you w ant to examine how an alerts w as coded, just double click
on one of the legends "Buy alert" or "Sell alert".

Alerts are pretty pow erful in that they can tell you w hen just about any true-false condition has occurred.
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Dis playing Data

This is an example of w hat a chart looks like. The annotated features are described at the bottom of the page.
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Symbol Selector - Drop dow n list that allow s sw itching betw een chart pages. Refer to View ing a Different Chart Page

Instrument Selector - Drop Dow n list that allow s sw itching betw een chart pages. Refer to View ing a Different Chart Page

Chart View - Displays the data in a graphical format (Chart View ).

Snapshot View - Displays the data values for a specific date for the selected Chart Page (Snapshot View ).

Historical View - Displays the data values for all of the data on the current chart page (Historical View ).
Portfolio View - Displays the values for a specific date for all of the Chart Pages in the chart (Portfolio View ).



Creating a New Chart

Creating a new chart allow s you to start a new problem, to w hich you wiill be able to add indicators, predictions, trading
strategies, and other instrument data that will help you make trading decisions.

Follow ing the procedure below activates the chart wizard, w hich guides you through the process of creating a new chart.

1. Select E from the toolbar or New ... from the File menu.

] (B
Qpen ... Chrl+0

Scan Ticker Symbols ...

Exit

Note:

e You may have multiple charts displayed at any one time by simply creating more than one chart or opening more than one
existing chart.



Chart Wizard - Choosing a Chart Template

This screen show s the chart templates available for use. Chart templates are preconfigured charts that allow you to create a
chart layout and analysis quickly w ithout having to w orry about all the details of creating one from scratch.

The follow ing Analysis Templates are distributed w ith NeuroShell Trader:
Bollinger Band Strategy
MACD Crossover Strategy
Moving Average Crossover Strategy
RSI Strategy
Stochastic Crossover Strategy

To select an existing template:
1. Select the desired template from the list.

To create a chart from scratch
1. Select (No Template) located at the top of the list.

When you are satisfied w ith the template the chart will use press the Next button to proceed to the next wizard screen.

Notes:

. Any chart that is saved by selecting Save Chart as Template from the File menu will be available as a chart template in
the New Chart Wizard. Therefore, if you w ant to create your ow n custom chart templates, you need only save a
representative chart as a template.



Chart Wizard - Choosing a Chart Periodicity and First Date

Selecting the chart periodicity and first date enables you to choose the frequency and amount of data to view in the chart.

The periodicities available are daily, w eekly, monthly (DayTrader Only) or intraday hour, minute, second, tick and volume bars.
Once the chart is created, everything you do will be done in terms of the chart periodicity.

The periodicities available are as follow s:

Monthly Each bar represents one month of trading activity
Weekly Each bar represents one w eek of trading activity
Daily Each bar represents one day of trading activity

(Day Trader Only)

Hour Each bar represents trading activity for the user-specified number of hours.
Minute Each bar represents trading activity for the user-specified number of minutes.
Second Each bar represents trading activity for the user-specified number of seconds.
Tick Each bar represents trading activity for the user-specified number of trades.

Volume Each bar represents trading activity for the user-specified volume. The volume of each bar will equal the
specified volume. Each bar is created by accumulating trades until the specified volume is reached.

Range Each bar represents trading activity for the user-specified minimum price range. The high-low range of each
bar will equal the specified range. Each bar is created by accumulating trades until the high-low range is
reached. The first trade to break outside that range starts a new bar. Since price gaps are not filled w ith
phantom bars, the high-low range of a bar can exceed the specified range w hen prices gap outside the range
before a bar’s price range criteria w as met.

To choose a chart periodicity and first date:

1. Select a periodicity for the chart by clicking on the desired periodicity of either daily, w eekly, monthly, (DayTrader
Only) or intraday. If you chose intraday, you should also enter the desired intraday bar size (i.e. 1, 2, 3, ...) in the text box
and select the desicred bar type (i.e. Hour Bars, Minute Bars, Second Bars, Tick Bars, Volume Bars or Range Bars).
Choose how far back to initially load data by entering a date, using the up/dow n buttons to change the
day/month/year, or selecting the dropdow n arrow to select a date from the calendar.

2. Press the Next button to proceed to the next wizard screen.

Notes:

(DayTrader Only) Note that Second, Tick, Volume and Range bars are created from tick by tick data streams and therefore
historical data may be limited and take longer to load.

(DayTrader Only) Second, Tick, Volume and Range bars can only be created using Quote.com or eSignal and w ill therefore
not be visible w hen using other data feeds.

(DayTrader Only) When using Second, Tick and Volume bars, if you choose very small bars, your model may not execute as
fast as new bars are created, causing NeuroShell to become non-responsive or even crash. If this happens, use larger bars,
load less data, or simplify the model(s) in your chart.

NeuroShell Trader will handle all data conversion if you choose a chart periodicity different from the data files upon w hich
the chart is based.

Example #1: If you create a monthly chart based upon daily data files, NeuroShell Trader w ill set the monthly open equal
to the first daily open, the monthly high equal to the highest daily high, the monthly low equal to the low est daily low,
and the monthly close equal to the last daily close. Additionally, the monthly volume & open interest equal to the sum of
all daily volumes & open interests, and all other monthly data values equal to the last daily data value.

Example #2: If you create a daily chart based upon monthly data files, data points will only be displayed once a month.
How ever, if you insert other instrument data that comes from a daily data file, the new instrument w ill display data
every day and the original data will be extended so that each day displays the last monthly value.
If you choose a periodicity greater than the data files upon w hich the chart is based, NeuroShell Trader will display a partial
bar even if all data is not yet available. For example, if the current day is a Thursday and a w eekly chart is created using a
daily data file, a partial bar will be displayed using the data from Monday through Thursday, even though Friday’s data is not
yet available.



Chart Wizard - Selecting an Instrument Category

Selecting the instrument category w ill select w hat type of chart you w ant to view. From this point on everything on your chart
w ill be based on this type of instrument data (you w ill alw ays be able to view other instrument data on any chart, but your
chart will be based upon this type of instrument data).

1. Select the type of instrument you wish to chart.
2. Press the Next button to proceed to the next wizard screen.

Troubleshooting:

. If you think the categories listed are incorrect or some categories are missing, you w ill need to change your data sources
settings. To do this, press the Cancel button and select Data Sources from the Tools menu. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.



Chart Wizard - Selecting Instruments

Selecting the instruments that you w ant to view allow s you to choose w hich instruments you w ant to view on your chart. You
can alw ays Add/Remove Chart Pages at a later time.

1. Select the instrument or instruments you wish to chart.
2. Press the Finish button to end the wizard and display the chart.

To sort by ticker symbol:
1.  Select the Sort by Symbol option.

To sort by name/description:
1. Select the Sort by Name option.

To show only the items selected in your list:
1.  Select the Selected items only option.

To show all the items in the list (both selected and not selected):
1. Deselect the Selected items only option.

If you are using Quote.com, eSignal or Prophet.net as your data source, you have the option of adding instruments that are not

already listed. To add a new ticker symbol:

1. Press the Add New Quote.com Ticker Symbol, the Add New eSignal Ticker Symbol or the Add New
Prophet.net Ticker Symbol button.

2. Enter the instrument’s ticker symbol into the Ticker box

3. Enter the instrument’s full name into the Name box

4. Select the instrument’s category using the Category drop dow n box.
5. Press the OK button to add the new instrument.

Notes:

. If you select multiple instruments, each one will be displayed on its own ‘chart page’. Once the chart is
displayed, you w ill be able to flip betw een ‘chart pages’.

o Any analysis technique (indicators, predictions, ...) you create will automatically be applied to all ‘chart
pages’.

. Once a chart is created, you can add/remove instruments by selecting Add/Remove Chart Pages under the Edit menu.
Analysis techniques already applied to the chart will be replicated on each new ‘chart page’.

. If you are using the data that came on the NeuroShell Trader Historical Data CD or the data installed in the NeuroShell
Trader Data subdirectory, you may see extra letters after the stock name (For example: Microsoft MSQ ZMF ZJZ). This is
an indication that the stock is an optionable stock and the letters are the actual root symbols for the stock’s option
contracts.

Tips:
e To select a group of instruments, hold the left mouse button dow n w hile you drag the mouse over the desired
instruments.

. If you are unable to find a ticker, you’ll w ant to make sure that your data is setup correctly. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.

Troubleshooting:

. If the instruments listed are not w hat you expect for the category you chose on the previous wizard screen or
instruments are missing that you think should be present for the previously selected category, then you will need to
change your data sources settings. To do this, press the Cancel button and select Data Sources from the Tools menu.



Opening an Existing Chart

Opening an existing chart allow s you to open a chart that you have previously saved. This will allow you to pick up w here you
left off or view charts with new data in them.

Follow ing the procedure below activates the file dialog box from w hich you can select a chart file.

]
1. Select g from the toolbar or Open ... from the File menu.

Bew ... ChEl+I
Chrl+0

Scan Ticker Symbols ...

Exit

Note:

e You may have multiple charts displayed at any one time by simply creating more than one chart or opening more than one
existing chart.



Opening an Existing Workspace

A w orkspace is a collection of all the currently loaded charts and their position on the screen. Opening an existing w orkspace
allow s you to open a w orkspace that you have previously saved. This wiill allow you to pick up w here you left off or quickly
view the charts in the w orkspace w ith new er data.

Follow ing the procedure below activates the file dialog box from w hich you can select a w orkspace file.

'
1. Select g from the toolbar or Open ... from the File menu.

Mew ... Chel+M
Chrl+0

Scan Ticker Symbals ..

Exit



Open Dialog

In the Look In drop-list, click the drive that contains the chart.

2. Inthe box beneath Look In that lists directories and files, double-click the name of the directory that contains the chart.
Continue double-clicking sub-directories until you open the sub-directory that contains the chart.

3. In the list of directories and files, click one or more chart or w orkspace names.
4. Press the Open button.

Notes:

e The file dialog displays both charts and w orkspace files at the same time, but can be changed to display only one or the
other using the Files of Type dropdow n box at the bottom of the dialog.



Opening Most Recent Charts

Opening an existing chart allow s you to open a chart that you have previously saved. This will allow you to pick up w here you
left off or view charts with new data in them.

1. Select the filename of the desired chart from the File menu.

Mew ... Chrl+M
Qpen ... Chrl+0

Scan Ticker Symbals ..

1 Examnple 4.cht

2 Exarple 3.cht
3 Exarple 2.cht
4 Example 1.cht

Ezxit



Saving a Chart

Saving a chart will allow you to save the w ork that you have done, and allow you to continue w ork on that chart or view that
chart with new data in it, by opening it later.

1. Select E from the toolbar or Save Chart from the File menu.

File
Bew ... ChEl+I
Qpen ... Chrl+0
Close
Close All

e Chart Chrl+5
Save Chart fs ..,
Save Chart s Template ...

Save Workspace ...

Scan Ticker Symbols ...

Prink Chart ... Chrl+P
Email a Chart ...

Exit

Notes:

e If more than one chart is being displayed, make sure the chart you wish to save has focus. To give a chart focus, position
the cursor over the chart window and press the mouse button.

. If the chart has not been saved previously, you will be prompted to enter a filename.



Saving a Chart as a Different File

Saving a chart as a different filename w ill allow you to save the w ork that you have done, and allow you to continue w ork on
that chart or view that chart with new data in it, by opening it later. Saving a chart as a different file allow s you to save
modifications from the original file to a different file name, thus preserving the original file.

1. Select Save Chart As from the File menu. This activates the file dialog box from w hich you can enter a file name for the
chart. This dialog also provides a checkbox option w hich allow s for saving the chart’s underlying data in the chart.

File
Mew ... Chel+M
QpEn .. Chrl+0
Close
Close all
Save Chart Chrl+5

Save Chart As ...

Save Chart As Template ...
Save Warkspace ...

Scan Ticker Symbals ..

Brint Chart ... Ckrl+P
Email a Chart ...

Exit

Note:

. If more than one chart is being displayed, make sure the chart you wish to save has focus. To give a chart focus, position
the cursor over the chart window and press the mouse button.



Save Chart As Dialog

In the Look In drop-list, click the drive w here you w ant to save the chart.

2. Inthe box beneath Look In that lists directories and files, double-click the name of the directory w here you w ant to save
the chart. Continue double-clicking sub-directories until you open the sub-directory in w hich you w ant to save the chart.

3. Type the name of the chart in the File name or if the file name already exists in the list of directories and files, click the
chart name.

4. Check the Save data in chart checkbox to save the current underlying data with in the chart. Use this feature w hen
sending charts to other people and you w ant to guarantee they are seeing exactly the same data w ithout differences in
files mapped, data feed provider, new data, etc. Note that w hen a chart with saved data is loaded, you have the option of
loading w ith the saved data or getting data from the normal sources (data feed, files, ...).

5. Press the Save button.



Saving a Chart as a Template

Saving a chart as a template wiill allow you to create other charts w ith exactly the same formatting, indicators, predictions,
trading strategies, etc. as the current chart. After saving a template, you w ill be able to choose this template w hen creating a
new chart. The new chart will look like the original chart, except all the formatting, indicators, predictions, trading strategies,
etc. will be applied to the ticker symbols in the new chart.

1. Select Save Chart As Template from the File menu. This activates the save template dialog from w hich you can enter
the template name and choose the template folder.

Eile
Mew ... Chrl+M
Qpen ... Chrl+0
Close
Close All
Save Chart Chrl+5

Save Chart s ..,

Chart fs Template ...

Save Workspace ...
Scan Ticker Symbals .,

Brint Chart ... Ckrl+P
Email a Chart ...

Exit

Note:

. If more than one chart is being displayed, make sure the chart you wish to save as a template has focus. To give a chart
focus, position the cursor over the chart window and press the mouse button.



Save Chart As Template Dialog

The Save Chart As Template dialog saves the current chart as a new chart template. Saving the chart as a template allow s
you to apply the same analysis/layout to a new chart w ithout having to recreate a chart from scratch.

To save a chart template:
1. Inthe Name text box, enter the name of the template w hich you wish to create from the current chart.

2. Inthe Create In box select the template folder in w hich you wish to save the chart template. To create a new folder,
press the New Folder button.

3. Press the OK button.

Once saved, the template will be show n on the first page of the new chart wizard w hen creating a new chart.



Saving a Works pace

A w orkspace is a collection of all the currently loaded charts and their position on the screen. Saving a w orkspace allow s you
to save the w ork that you have done, and to continue w ork on that w orkspace or view the charts in the w orkspace w ith new
data, by opening it at later time.

1. Select Save Workspace ... from the File menu. This activates the file dialog box from w hich you can enter a file name
for the w orkspace.

File
Mew ... Chel+M
QpEn .. Chrl+0
Close
Close all
Save Chart Chrl+5

Save Chart As ...
Save Chart As Template ...

Scan Ticker Symbals ..

Brint Chart ... Ckrl+P
Email a Chart ...

Exit

Notes:

. If one or more of the charts being displayed has not been saved previously, you will be prompted to enter a filename for
each of the unsaved charts.



Save Workspace Dialog

. Inthe Look In drop-list, click the drive w here you w ant to save the w orkspace.
2. Inthe box beneath Look In that lists directories and files, double-click the name of the directory w here you w ant to save
the w orkspace. Continue double-clicking sub-directories until you open the sub-directory in w hich you w ant to save the
w orkspace.
3. Type the name of the w orkspace in the File name or if the file name already exists in the list of directories and files, click
the w orkspace name.
4. Press the Save button.



Printing a Chart

Printing a chart allow s you to print the current chart page.
Follow ing the procedure below activates the print dialog box from w hich printing options are selected.

1. Select the chart page that you w ant to print.

2. Select @ from the toolbar or Print Chart from the File menu.

File
Mew ... Chrl+M
Qpen ... Chrl+0
Close
Close All
Save Chart Chrl+5

Save Chart fs ...
Save Chart As Template ...
Save Workspace ...

Scan Ticker Symbals .,

Erint Chart ... Ckrl+P
Email a Chart ...
Exit

Notes:

. If more than one chart is being displayed, make sure the chart you wish to print has focus. To give a chart focus, position
the cursor over the chart window and press the mouse button.

. If more than one chart page exists on a chart, make sure the chart page you wish to print is the selected chart page.
Refer to View ing a Different Chart Page for more information.



Print/Export - Setup

The Print/Export - Setup interface allow s you to select the type of print/export you w ant to perform. Using this interface you
may print to a printer (portrait or landscape), export to a file, or copy to the clipboard:

. To print to a printer (this option may not be available if you don’t have a printer defined in your window s environment):
1. Select the Printer option.
2. Select if you w ant to print in Landscape mode or Portrait mode.

e Towrite to afile:
1. Select the File option.
2. Enter the name of the file that you w ant to w rite to (you may use the Brow se button to help you).

e To copy to a clipboard:
1. Select the Clipboard option.

When you have completed selecting how you w ant to setup your print/export select the OK button to execute the print/export
or select the Selection tab to select w hat you w ant to print/export.



Print/Export - Selection (Chart)

The Print/Export - Selection interface allow s you to select w hat you w ant to print/export. Using this interface you may select
exactly w hat you w ant to print/export.

The Print/Export - Selection interface will list the items that you currently are view on the selected chart. The possibilities are
Chart View, Snapshot View, Historical View, and Portfolio View .

Any of the items that are checked wiill be printed/exported and any of the items that are not checked wiill not be
printed/exported.

When you have completed selecting w hat you w ant to print/export select the OK button to execute the print/export or select
the Setup tab to select the type of print/export you w ant to perform.



Emailing a Chart

Emailing a chart allow s you to email the current chart page. If you wish to email a chart to Ward Systems Group for technical
support purposes, use the email address:

support@w ardsystems.com

Follow ing the procedure below adds the chart to an email message using your default email client.
1. Select the chart page that you w ant to email.
2. Select Email Chart from the File menu.

3. You will be prompted w hether or not you wish to send the data w ith the chart. If you choose yes, a second copy of the
chart will be saved with (Data Saved) at the end of the name. This second copy wiill be the chart that is attached to your
email if you have chosen to save data w ith the chart. When the email recipient opens this chart, they w ill see the exact
same underlying data that w as in your chart w hen you selected Email Chart.

File
Bew ... ChEl+I
Qpen ... Chrl+0
Close
Close All
Save Chart Chrl+5

Save Chart fs ..,
Save Chart s Template ...
Save Workspace ...

Scan Ticker Symbols ...

Prink Chart ... Chrl+P

Exit

Troubleshooting:

e If you are using Internet based email (yahoo, hotmail, ...) instead of a window s based email client (outlook, outlook
express, ...) the Email Chart may not w ork properly. If this is the case, you may need to manually attach charts to your
emails w hen using internet email. How ever, note that you can still use the Email Chart menu item to save a chart w ith
your data included inside the chart and then attach this chart to your email.

Note:

. If more than one chart is being displayed, make sure the chart you w ish to email has focus. To give a chart focus, position
the cursor over the chart window and press the mouse button.



Chart View

View ing the Chart View enables you to graphically view your data. To select the Chart View follow the steps below :

1.  Select the chart on w hich you wish to see the Chart View
1. Select Chart View from the View menu.

v Chart ¥
Snapshat Yiew
Historical Wigw
PortFolio Wiew
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To hide the Chart View deselect the Chart View from the View menu.

This is an example of w hat a Chart View looks like. The annotated features are described at the bottom of the page.
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Legend - The graph legend provides a description of the charted data series. The Legend text may be clicked on to select the
desired series.

Value Axis - Axis that show s the numeric range of values for each subgraph.
Date Axis - Axis that show s the date range of graphed data series.

Horizontal Scroll - Scroll bar that allow s you to move to a different set of dates w hen zoomed in on a smaller area than the
entire data series in your data file. To make small moves use the arrow s at either end of the Scroll bar. To
make larger moves click area betw een gray box and arrow s at either end of the Scroll bar.



Snapshot View

The Snapshot View displays the data values for a specific date for the selected Chart Page. In order to see the Snapshot
View follow the steps below :

Select the chart on w hich you wish to see the Snapshot View .
2. Select Snapshot View from the View menu.

v Chark Wiew

Snapshot Yiew

Histarical Yigw
Portfolio View
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To hide the Snapshot View deselect the Snapshot View from the View menu.

In order to change the date that the Snapshot View is displaying select the Cross Hair Cursor. Once you are in Cross Hair
Cursor mode you may:

. Use the mouse to select the date by clicking on the chart.

. Use the left and right arrow s on your keyboard to move one bar.

. Use the page up and page dow n keys on keyboard to move 20 bars.
. Use the mouse to select the date by clicking on the Historical View

Also, clicking on a data series in the Snapshot view, w ill select/deselect that data series in the chart.

Notes:

e The Trading column only show s trades until they are filled. It does not indicate the current position. In order see the
current position you wiill need to insert a new "Position" indicator from the "Trading Strategy: Position Information"
category.

e The data that is displayed in red is most likely data that has not yet completed it’s time period. This means that if you have
a 5 minute chart that the red data show n in this view is for data that is within those 5 minutes, but the 5 minute period has
not completed. The only exception to this is if you have manually selected the color of a time series to be red.



Historical View

The Historical View displays all the data values for selected Chart Page. In order to see the Historical View follow the steps
below :

1. Select the chart on w hich you wish to see the Historical View .
2. Select Historical View from the View menu.

w Chart View
Snapshot Yiew

Histarical Yigw

Portfolio View
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To hide the Historical View deselect the Historical View from the View menu.

By clicking the mouse on the Historical View w hen the Cross Hair Cursor

has been selected the Cross Hair will move to that date on the chart. Additionally, if the Snapshot View is currently being used
the values displayed in the Snapshot View w ill be changed to reflect the date selected.

Notes:

e The Trading column only show s trades until they are filled. It does not indicate the current position. In order see the
current position you wiill need to insert a new "Position" indicator from the "Trading Strategy: Position Information"
category.

e The data that is displayed in red is most likely data that has not yet completed it’s time period. This means that if you have
a 5 minute chart that the red data show n in this view is for data that is w ithin those 5 minutes, but the 5 minute period has
not completed. The only exception to this is if you have manually selected the color of a time series to be red.



Portfolio View

The Portfolio View displays the data values for a specific date for all of the Chart Pages in the chart. In order to see the
Portfolio View follow the steps below :

1. Select the chart on w hich you wish to see the Portfolio View .
2. Select Portfolio View from the View menu.

Insert  Format Drawing T
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To hide the Portfolio View deselect the Portfolio View from the View menu.
If you click on a ticker or its data in the Portfolio view, the current Chart Page changes to the selected ticker.

Notes:

e The Trading column only show s trades until they are filled. It does not indicate the current position. In order see the
current position you wiill need to insert a new "Position" indicator from the "Trading Strategy: Position Information"
category.

e The data that is displayed in red is most likely data that has not yet completed it’s time period. This means that if you have
a 5 minute chart that the red data show n in this view is for data that is w ithin those 5 minutes, but the 5 minute period has
not completed. The only exception to this is if you have manually selected the color of a time series to be red.



Changing Line Style and Color

Changing the line style or color will allow you to view the data the way you w ant. In order to distinguish indicators and/or
predictions you may select different line styles and/or colors to your liking.

on
H
il

or

Select a data series on the chart by clicking on the corresponding line, legend text, or Snapshot View text.

Once the data series is selected (highlighted w ith black boxes), change the line style and color by using the style and
color dropdow n icons on the toolbar.

Press the style/color displayed on the toolbar if that is the desired style/color. The style or color displayed on the
toolbar is the last style or color set and provides a means of quickly changing a large number of data series to the
same style/color.

Press the small dow n arrow and click on the desired style or color. An indented box notates the current style or
color of the selected data series.

To deselect the data series, simply click on the selected data series again or click on a blank area of the chart.

HOEEEREECOOCOCN -
H O EEEENENEm-
H  EEEEEENTEN
HE EEEEEEEEEN

Select the data series you wish to format by right-clicking the mouse button on the corresponding line or legend text.
Select Format Selected Data ..., Format Selected Indicator ..., Format Selected Prediction ..., Format Selected
Trading Strategy ..., or Format Selected Alert ... from the pop-up menu, depending upon the type of data series you
are selecting.

Change the style and color using the Form at Data Series interface. Note that the Format Data Series interface provides
advanced formatting options, such as gradient coloring, that are not available on the tool bar.

To deselect the data series after using the Format Data Series interface, simply click on the selected data series again
or click on a blank area of the chart.

Format Chart ...

Eormat Selected Data ...

Add/Remove Chart Pages ...

Hide/Unhide Data ...

Troubleshooting:

You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection wiill not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line that connects tw o data points.



Renaming Chart Data

Renaming chart data may be desirable to change the name of the data to something that means more to you.

Select the data series you w ish to rename by clicking on the corresponding line, legend text, or Snapshot View text.
Select Format Selected Data ..., Format Selected Indicator ..., Format Selected Prediction ..., Format Selected
Trading Strategy ..., or Format Selected Alert ... from the Format menu, depending upon the type of data series you
are selecting.

Change the name using the Form at Data Series interface.

To deselect the data series after using the Form at Data Series interface, simply click on the selected data series again
or click on a blank area of the chart.

Format Chart ..,

Eormat Selected Data ...

or

Add/Remove Chart Pages ...

Hide/Unhide Data ...

Select the data series you wish to rename by right-clicking the mouse button on the corresponding line or legend text.

Select Format Selected Data ..., Format Selected Indicator ..., Format Selected Prediction ..., Format Selected
Trading Strategy ..., or Format Selected Alert ... from the pop-up menu, depending upon the type of data series you
are selecting.

Change the name using the Form at Data Series interface.

To deselect the data series after using the Form at Data Series interface, simply click on the selected data series again
or click on a blank area of the chart.

Cuk
Copy

Delete

Modify Selected Data Fileis) ...

Format Selected Data ..,

Troubleshooting:

You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection wiill not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.



Format Data Series

Formatting of a data series may be desirable to modify the appearance of the selected data, indicator, prediction, trading
stratetgy, or alert.

Select the data series you wish to format by clicking on the corresponding line, legend text, or Snapshot View text.
Select Format Selected Data ..., Format Selected Indicator ..., Format Selected Prediction ..., Format Selected
Trading Strategy ..., or Format Selected Alert ... from the Format menu, depending upon the type of data series you
are selecting.

Change the format using the Form at Data Series interface.

To deselect the data series after using the Form at Data Series interface, simply click on the selected data series again
or click on a blank area of the chart.

Eormat Chart ...

Eormat Selected Data ...

or

Add/Remove Chart Pages ...

Hide/Unhide Data ...

Select the data series you wish to format by right-clicking the mouse button on the corresponding line or legend text.

Select Format Selected Data ..., Format Selected Indicator ..., Format Selected Prediction ..., Format Selected
Trading Strategy ..., or Format Selected Alert ... from the pop-up menu, depending upon the type of data series you
are selecting.

Change the format using the Form at Data Series interface.

To deselect the data series after using the Form at Data Series interface, simply click on the selected data series again
or click on a blank area of the chart.
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Troubleshooting:

You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line that connects tw o data points.



Format Data Series - General

The General tab of the Format Data Series dialog is used to set the name, basic color, and style of the selected data.

To change the name of the data series:

1. Enter a name in Name of Data Series text box.

or

1. If the current name is not the original name, press the Default button to set the name to the original name.

To change the style and color of the data series:

1. Change the style by clicking the small dow n arrow on the Style drop dow n and click on the desired style. An indented
box notates the current style of the selected data series.

2. Change the color by clicking the small dow n arrow on the Color drop dow n and click on the desired color. An indented
box notates the current style of the selected data series.

When you are satisfied w ith the Format Data Series settings, select the OK button.



Format Data Series - Multi-Colored

The Multi-Colored tab of the Format Data Series dialog is used to color data series in a user defined color gradient based upon
the bars relative range, specific upper/low er ragnes, relative increase/decrease, or actual increase/decrease.

To set upper and low er range colors:

1. Select the Upper / Lower Range colors option to enable coloring based upon either a relative range or specific
upper/low er range.

2. Change the upper range color by clicking the small dow n arrow on the Upper Range Color drop dow n and click on the
desired color. An indented box notates the current upper range color of the selected data series.

3. Change the low er range color by clicking the small dow n arrow on the Lower Range Color drop dow n and click on the
desired color. An indented box notates the current upper range color of the selected data series.

To set gradient coloring of the data series based upon its relative range:

1. Select the Gradient coloring relative to last ___ bars option and enter the desired number of bars for the relative
range gradient coloring.

The gradient color shading is determined based upon the number of last bars chosen. So for instance if you choose 14 bars,

the current bar’s color will be chosen based upon its value relative to the min and max values over the last 14 bars. Ifitis at an

extreme max or min, then it will be colored in the Upper Range Color or Lower Range Color, otherw ise it will be colored in a

color shade betw een the tw o colors in proportion to its distance from the maximum and minimum value over the last 14 days.

To set the color of the data series w hen its values are in a specific upper or low er range:

1. Unselect the Gradient coloring relative to last X bars option to enable entry of upper and low er values. Enter the
desired upper range value in the Values >= text box and desired low er range value in the Values <= text box.

The data series will be colored in the Upper Range Color w henever the data series value is above the Values >= value.

Likew ise, the data series wiill be colored in the Lower Range Color w henever the data series value is below the Values >=

value. When the data series value is betw een the upper and low er range values, the data series wiill be colored in the default

color or the increasing/decreasing colors if that option is selected.

To set increasing and decreasing colors:

1. Select the Increasing / Decreasing colors option to enable coloring based upon either a relative increase/decrease or
the actual increase/decrease.

2. Change the increasing color by clicking the small dow n arrow on the Increase Color drop dow n and click on the desired
color. An indented box notates the current increasing color of the selected data series.

3. Change the decreasing color by clicking the small dow n arrow on the Decreasing Color drop dow n and click on the
desired color. An indented box notates the current decreasing color of the selected data series.

To set gradient coloring of the data series based upon its relative increase or decrease:

1. Select the Gradient coloring relative to last ___ bars option and enter the desired number of bars for the relative
increase/decrease gradient coloring.

The gradient color shading is determined based upon the number of last bars chosen. So for instance if you choose 14 bars,

the current bar’s color will be chosen based upon its current increase/decrease relative to the min and max increase/decrease

over the last 14 bars. If it is at an extreme increase or decrease relative to the last 14 days, then it will be colored in the

Increasing Color or Decreasing Color, otherwise it will be colored in a color shade betw een the tw o colors in proportion to

the distance of its increase/decrease from the maximum increase and minimum decrease over the last 14 days.

To set a solid color for the data series w hen its values are increasing or decreasing:

1. Unselect the Gradient coloring relative to last X bars option to enable solid coloring of increasing and decreasing
colors.

The data series will be colored in the Increasing Color w henever the data series is increasing. Likew ise, the data series will

be colored in the Decreasing Color w henever the data series value is decreasing. When the data series value does not

change, the data series will be colored in the default color.

When you are satisfied w ith the Format Data Series settings, select the OK button.

Note:

e The increase/decrease for each bar is measured as the 1 bar change in the data series, except w hen the data series has
both an Open and Close, in w hich case the increase/decrease is measured as the difference betw een the Closing and
Opening values.



e The upper/low er and increase/decrease coloring does not w ork w ith area charts. Area charts w ill be displayed as bar
charts w hen upper/low er and increase/decrease coloring is being utilized.



Format Chart

Formatting of a chart may be desirable to modify the appearance of the selected chart.

1.  Select the chart you wish to format.
2. Select Format Chart from the Format menu.

Eatmat Chart ...

Eormat Selected Cata ..,

Add/Remove Chart Pages ...

Hide/Unhide Data ...

or

Select the chart you wish to format by right-clicking the mouse button on the chart.
2. Select Format Chart from the pop-up menu.
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Format Chart - Dates

The Dates tab of the Format Chart dialog is used to set the range of dates that the chart graphs.

To limit the first date loaded into memory and show n on the graph:
1. Select the First date loaded from file(s) option.
2. Select the desired first date loaded from file(s).

To limit the last date loaded into memory and show n on the graph:
1. Select the Last date loaded from file(s) option.
2. Select the desired last date loaded from file(s).

When you are satisfied w ith the Chart Properties - Dates select the OK button.

Notes:
e The dates that you have selected here wiill be applied to any new chart that you create.

. (DayTrader Only) For intraday charts, the chart w hose properties you are modifying w ill remember the dates as you set
them; how ever, for any new chart of the same periodicity from this point on, NeuroShell Trader will default the dates to
select the same number of "days back" as you are using right now . For example, if you are using 5 days of data for your
current 5 minute chart, the start date for your current chart will alw ays be set to that start date, but any new 5 minute
chart will be defaulted to start 5 days prior to the date w hen the chart is created.

e Toincrease data loading and charting performance, make the First date loaded from file(s) as close to the current date
as possible w ithout taking aw ay too much historical data for training and backtesting purposes. As more data points are
displayed on the chart, you will notice the scrolling, zooming, and updating of the chart become exponentially slow er and
slow er. (DayTrader Only) This is particularly true of the NeuroShell DayTrader w here loading tw o0 months of data for a
1-minute chart will result in over 15,000 data points. If you find the data loading process taking too long your charts taking
too long to scroll, zoom, and update, then you should move the First date loaded from file(s) forw ard to improve data
loading performance.



Format Chart - Y-Axis

The Y-Axis tab of the Format Chart dialog is used to set the range of data and axis scale that is view ed in each subgraph.

To change the maximum value view ed in a specified subgraph:
1. Deselect the Auto option next to the Max Value for the desired subgraph axis.
2. Type a new maximum value in the Max Value box.

To change the minimum value view ed in a specified subgraph:
1. Deselect the Auto option next to the Min Value for the desired subgraph axis.

2. Type a new minimum value in the Min Value box.

To reset the maximum value view ed in a specified subgraph to auto:
1. Select the Auto option next to the Max Value for the desired subgraph axis.

To reset the minimum value view ed in a specified subgraph to auto:
1. Select the Auto option next to the Min Value for the desired subgraph axis.

To make the y-axis a log scale in a specified subgraph:
1. Select the Log Scale option for the desired subgraph axis

When you are satisfied w ith the Chart Properties - Y-Axis select the OK button.



Format Chart - Colors

The Colors tab of the Format Chart dialog is used to change the colors and grid style of your chart. The chart on the right w ill
give you an interactive view of w hat your chart w ill look like as you modify the chart colors.

To change the colors in your chart, select a color from each of the color pull dow n menus:

1.

2.
3.
4

Background — sets the chart background color.
Text — sets the legend and axis text colors.
Grid — sets the grid color

Price Default — sets the default color used w hen price data is added to the chart. Existing price data in the old color will
be changed to the new color.

Volume Default — sets the default color used w hen volume data is added to the chart. Existing volume data in the old
color w ill be change to the new color.

To change the grid style:

1.
2.

Select Display X-Axis Grid if you w ant vertical grid lines displayed on the chart.
Select Display Y-Axis Grid if you w ant horizontal grid lines displayed on the chart.

When you are satisfied w ith the Chart Properties - Colors select the OK button.

Note:

The colors and grid settings that you have selected w ill be used as the default settings and applied to any new chart that
you create.



Arranging Charts

Arranging Charts is accomplished by using one of three tools provided by NeuroShell Trader. These tools allow you to
Cascade, Horizontal Tile, or Vertical Tile your charts.

1.

Select the desired chart arrangement from the toolbar or from the Window menu.

i
Haorizantal Tile
Wertical Tile

v 1 Example 1.cht

Note:

. You may use the standard w indow s controls to minimize, maximize, resize, reposition, or close your chart.



Using the Cross Hair Cursor

Using the Cross Hair cursor w ill enable you to have a vertical and horizontal reference line, control the Snapshot View and
Portfolio View date, and control the highlighted date of the Historical View .

1
1. Select ;l from the toolbar or Cross Hair Cursor from the View menu. This activates the Cross Hair Cursor.
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SymbalfMameFrequency Bar

Tool Bar
Skatus Bar

To exit the Cross Hair Cursor mode:

1. Select il from the tool bar or deselect the Cross Hair Cursor from the View menu. This deactivates the Cross Hair
Cursor.



Zooming Chart

Zooming in on a chart allow s you to view a smaller time period of the data show n on your chart, this can be useful w hen
analyzing specific periods of data or predicting future events.

1. Select @ from the toolbar or Zoom In from the View menu.
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or

1.  Select the chart you wish to zoom in by right-clicking the mouse button on the chart.
2. Select Zoom In from the pop-up menu.
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Unzooming Chart

Unzooming a chart allow s you to view a larger time period of the data show n on your chart, this can be useful w hen analyzing
larger periods of data and overall trends.

1. Select the chart you wish to zoom out by clicking the mouse button on the chart.

2. Select el\ from the toolbar or Zoom Out from the View menu.
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or

1. Select the chart you wish to zoom out by right-clicking the mouse button on the chart.
2. Select Zoom Out from the pop-up menu.
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Notes:

« Note that each time you zoom out, the chart is only zoomed out to the previous zoom extents. If you have zoomed in
several times, you wiill have to press zoom out an equal number of times to fully zoom out the chart.

. If the current chart is already zoomed all the w ay out, you will not be able to zoom out any more.



Scrolling Chart

Once a chart is zoomed in on a smaller time period of data, you can scroll the chart data to the left or right to view earlier or
later data keeping the same zoom extents.

1. Scroll the chart left or right by either pressing the left or right arrow s, dragging the scroll box, or clicking in the scroll area
of the scroll bar located at the bottom of a zoomed in chart.

or

1. Scroll the chart left or right by dragging the chart in the desired direction w ith the left mouse button depressed. Note that
you must drag a blank portion of the chart, otherw ise the data series or annotation over w hich the mouse cursor is
positioned w ill get selected/dragged instead of the chart getting dragged.



Viewing a Different Chart Periodicity

3. Viewing a different chart periodicity can be very useful if you w ant to see the results of your analysis in different time
frames or time increments. Depending upon your original data files and sources, you can choose from periodicities of
either daily, w eekly, monthly, (DayTrader Only) hourly, minute, second, tick or volume bars. Note that Second, Tick, and
Voume bars may not be supported depending upon the data feed being used and therefore Second, Tick, and Volume may
not displayed.

You may view a different chart periodicity by:
. Selecting a new periodicity from the third drop dow n list at the top of the chart

Additionally, w hen using some data feeds (for example Quote.com), you can choose to display after hours or all market
sessions by:

e Selecting the AfterHours check box to the right of the periodicity drop dow n list at the top of the chart. If this check box
is not displayed, then you can not display after hours data w ith the current data source.

Be careful w hen using after hours data as the volume in afterhours is usually far less then during normal market hours and
therefore might mess up existing predictions and trading strategies.

Note:

. If you have any predictions or trading strategies on your chart, they wiill need to be retrained and rebacktested every time
you change to a new periodicity or sw itch betw een after hours data.



Deleting Data from a Chart

Deleting data from a chart can be very useful w hen you no longer wish to see the data on your chart.

1. Select a data series on the chart by clicking on the corresponding line, legend text, or Snapshot View text.
2. Once the data series is selected (highlighted w ith black boxes), press the Delete key or select Delete from the Edit

menu.
Cut Chrl+3%
Copy Chel+C

Modify Selected Data File(s) ...

or

1. Select a data series on the chart by right-clicking the mouse button on the corresponding line or legend text.
2. Select Delete from the pop-up menu.

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.



Dragging and Dropping

Dragging and dropping may be used to rearrange items on your chart. This can be very useful w hen trying to compare tw o
items in your chart.

1. Select a data series to drag and drop by clicking and holding the mouse button w hile the cursor is over the
corresponding line or legend text.

2. With the mouse button depressed, ‘drag’ the cursor to the desired ‘drop’ location and release the mouse button.

Notes:
e The drop location is indicated by a dotted rectangle.

o To move the data series into an existing subgraph, position the mouse so a large dotted rectangle is located over the
destination subgraph.

o To move the data series to a new subgraph, position the mouse so a small dotted rectangle is located at the insertion point
above or below an existing subgraph.

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.



Using Cut/Copy/Paste

The Cut/Copy/Paste functionality will allow you to manipulate your charts to facilitate testing of different ideas.

The Cut functionality removes the selected item from the chart, but stores it in memory so you can Paste it in a new subgraph
easily.

The Copy functionality stores a copy of the selected item in memory so that you can Paste it in a new subgraph easily.

The Paste functionality places a copy of w hat the Cut or Copy function placed into memory and places it on a new subgraph
on the chart. If you paste a copy of an indicator, prediction, or trading strategy, you will be able to modify either copy w ithout
the other copy being changing.

1. Select a data series on the chart by clicking on the corresponding line, legend text, or Snapshot View text.
2. Select the desired function (Cut or Copy).
3. Select the Paste function.

or
Copy Chrl+C
Delete Dl

Modify Selected Data Filels) ...

or

1. Select a datas series on the chart by right-clicking the mouse button on the corresponding line or legend text.

2. Select the desired function (Cut or Copy) from the pop-up menu.

3. Right-Click the mouse button on an empty section of the graph and select the Paste function from the pop-up menu

The Cut/Copy/Paste functionality is limited to a single chart. This means that if you copy an indicator from one chart you may
not paste it into a different chart, but you may paste it in the same chart that you copied it from.

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.



Changing Subgraph Size

To expand or collapse the vertical size of chart subgraphs:

1. Select the subgraph divider to size by clicking and holding the mouse button w hile the cursor is over the upper line
betw een tw o subgraphs.

2. With the mouse button depressed, ‘drag’ the cursor to the desired new line location and release the mouse button.

Troubleshooting:

. You must make sure the mouse cursor has changed to an up/dow n arrow before clicking on the upper divider line. If
the cursor is still an arrow or a cross hair, the selection will not occur.



Full Screen Chart

To view the entire screen as the current chart selected you can use the full screen chart method.

1. Select the chart you w ant to view .
2. Select Full Screen from the View menu to expand the current chart to the full size of the screen.

Wig
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Note:

e  When view ing a graph in Full Screen during market hours, the full screen chart view is not updated in real-time. You wiill
see no changes to the chart as new data is collected.



Recalculating Chart Data

Advanced NeuroShell Trader users can use the Recalculate Chart pop-up menu item to reread data files and recalculate all
the calculations in a chart.

1.  Select the chart you wish to recalculate by right-clicking the mouse button on the chart.
2. Select Recalculate Chart from the pop-up menu.

The Recalculate Chart pop-up menu item can be used w hen the chart is based on an external data file that is being updated
by an external program. Manually recalculating the chart will allow new data from the data file to be incorporated into the chart
w ithout having to load and unload the chart.

The Recalculate Chart pop-up menu item is especially useful w hen developing external DLL calls and the DLL has not been
updated since the chart w as loaded (Note that ‘UNLOADCUSTOMDLLS=" needs to be set to ‘True’ in the Nstparam.ini file in
order to copy over a dll being used by a chart)

The Recalculate Chart pop-up menu item can also be useed to refire a trading strategy or prediction that has inputs of the
form Lead(XXX,1) w here XXX is raw data like the Open, High, Low , Close or Volume. Use of Lead(XXX,1) allow s for a trading
strategy or prediction to ‘peek’ into the next bar to make decisions. This w orks w ell w hen backtesting, but not w hen used in
real time since the trading strategies and predictions are fired at the end of each bar w hen no data exists in upcoming bars.
Use of the ‘Recalculate Chart pop-up menu item essentially tells NeuroShell Trader w hen to ‘peek’ into the data of the red bar
at the end of the chart in order to revaluate any Lead(XXX,1)’s.



Hiding/Unhiding Data

Hiding/Unhiding data can be very useful in managing a chart because the chart is limited to six subgraphs. You may w ant to
hide/unhide data to view different items at different times.

Follow ing the procedure below activates the hide data dialog from w hich you can select the data series on the active chart that
you w ish to hide or unhide.

1. Select the chart you wish to hide/unhide data by clicking the mouse button on the chart.
2. Select Hide/Unhide Data from the Format menu.

Format Chart ...

Add/Remove Chart Pages ...

HidefUnhide Data ...

or

1. Select the chart you wish to hide/unhide data by right-clicking the mouse button on the chart.
2. Select Hide/Unhide Data from the pop-up menu.

Zoom In
Zoam 2k

HidefUnhide Data ...

Add/Remove Chart Pages ...
Faormat Chart ...

Recalculate Chart



Hide/Unhide Data Dialog

1. Check the subgraphs or data you w ish to display.
2. Uncheck the subgraphs or data you wish to hide.
3. Press the OK button.



Trend Line

A trend line is a type of chart annotation that is usually draw n betw een tw o price resistance points or tw o price support points.
Once draw n, the trend line wiill be draw n betw een the tw o points and also extend indefinitely to the right. When future prices
approach the trend line extension, it indicates a place of possible resistance or support for prices.

To draw a trend line on a chart:
1. Select Trend Line from the Draw ing menu.

2. Click and hold the mouse button on the left most point of the desired trend line, drag the mouse w ith the button still
depressed to the right most point of the trend line, and release the mouse button.

To move an existing trend line:
1. Select a trend line on the chart by clicking on a portion of the trend line.
2. Once the trend line is selected (highlighted w ith small squares):

« Click and drag, w ith the mouse button still depressed, a portion of the trend line that does not have a selection box to
move the entire trend line.

e Click and drag, w ith the mouse button still depressed, a selection square on the trend line to reposition only that point
of the trend line.

To delete an existing trend line:
3. Select a trend line on the chart by clicking on a portion of the trend line.

3. Once the trend line is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit
menu.

Troubleshooting:

e  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

e To continue draw ing Trend line annotations on the chart w ithout having to reselect the Trend Line menu item each time,
select Remain in Drawing Mode from the Drawing menu. Once you are done draw ing trend lines, simply select
another type of annotation or unselect Remain in Drawing Mode.



Trend Channel

A trend channel is a type of chart annotation that is usually draw n betw een tw o price resistance points and a price support
point or tw o price support points and a resistance point. Once draw n, a trend line w ill be draw n betw een the tw o
resistance/support points and a trend channel line w ill be draw n w ith the same slope from the single support/resistance point.
Both the trend line and trend channel lines wiill extend indefinitely to the right. When future prices approach the trend line or
trend channel extensions, it indicates a place of possible resistance or support for prices.

Todraw a trend channel on a chart:
1. Select Trend Channel from the Drawing menu.

2. Click and hold the mouse button on the left most point of the desired trend line, drag the mouse w ith the button still
depressed to the right most point of the trend line, and release the mouse button.

3. Click the mouse on the point through w hich the trend channel wiill be draw n using the same slope as the trend line draw n
in 2 above.

To move an existing trend line:
1. Select a trend channel on the chart by clicking on a portion of the trend channel.
2. Once the trend channel is selected (highlighted w ith small squares):

e Click and drag, w ith the mouse button still depressed, a portion of the trend channel that does not have a selection
box to move the entire trend channel.

e Click and drag, with the mouse button still depressed, a selection square on the trend channel to reposition only that
point of the trend channel.

To delete an existing trend channel:
1. Select a trend channel on the chart by clicking on a portion of the trend channel.

2. Once the trend channel is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit
menu.

Troubleshooting:

e  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection wiill not occur.

Note:

e To continue draw ing Trend channel annotations on the chart w ithout having to reselect the Trend Channel menu item
each time, select Remain in Drawing Mode from the Drawing menu. Once you are done draw ing trend channels,
simply select another type of annotation or unselect Remain in Drawing Mode.



Fibonacci Retracement Lines

A Fibonacci retracement line is a type of chart annotation that is usually draw n betw een a price peak and subsequent price
valley or price valley and subsequent price peak. Once draw n, a line w ill be draw n betw een the peak and valley and
horizontal lines at increasing Fibonacci retracement percentages will be draw n back tow ards the first peak or valley. When
future prices approach a Fibonacci retracement percentage, it indicates a place of possible price direction reversal.

To draw a Fibonacci retracement on a chart:
1. Select Fibonacci Retracement Lines from the Drawing menu.

2. Click and hold the mouse button on the left most peak or valley, drag the mouse w ith the button still depressed to the
right most valley or peak, and release the mouse button.

To move an existing Fibonacci retracement:
1. Select a Fibonacci retracement on the chart by clicking on a portion of the Fibonacci retracement.
2. Once the Fibonacci retracement is selected (highlighted w ith small squares):

e Click and drag, w ith the mouse button still depressed, a portion of the Fibonacci retracement that does not have a
selection box to move the entire Fibonacci retracement.

e Click and drag, w ith the mouse button still depressed, a selection square on the Fibonacci retracement to reposition
only that point of the Fibonacci retracement.

To delete an existing Fibonacci retracement:
1. Select a Fibonacci retracement on the chart by clicking on a portion of the Fibonacci retracement.

2. Once the Fibonacci retracement is selected (highlighted w ith small squares), press the Delete key or select Delete from
the Edit menu.

Troubleshooting:

e«  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

o To continue draw ing Fibonacci retracement line annotations on the chart w ithout having to reselect the Fibonacci
Retracement Lines menu item each time, select Remain in Drawing Mode from the Drawing menu. Once you are
done draw ing Fibonacci retracement lines, simply select another type of annotation or unselect Remain in Drawing
Mode.



Fibonacci Projection Lines

A Fibonacci projection line is a type of chart annotation that is usually draw n betw een a price peak, subsequent price valley
and subsequent price peak or price valley, subsequent price peak and subsequent price valley. Once draw n, a line will be
draw n betw een the peaks and valleys and horizontal lines at increasing Fibonacci projection percentages w ill be draw n back
tow ards the 2nd peak/valley. When future prices approach a Fibonacci projection percentage, it indicates a place of possible
price direction reversal.

To draw a Fibonacci projection on a chart:
1. Select Fibonacci Projection Lines from the Drawing menu.

2. Click and hold the mouse button on the left most peak or valley, drag the mouse w ith the button still depressed to the
middle valley or peak, and release the mouse button.

3. Click the mouse on the right most peak or valley to complete the Fibonacci projection.

To move an existing Fibonacci projection:
1. Select a Fibonacci projection on the chart by clicking on a portion of the Fibonacci projection.
2. Once the Fibonacci projection is selected (highlighted w ith small squares):

e Click and drag, w ith the mouse button still depressed, a portion of the Fibonacci projection that does not have a
selection box to move the entire Fibonacci projection.

e Click and drag, w ith the mouse button still depressed, a selection square on the Fibonacci projection to reposition
only that point of the Fibonacci projection.

To delete an existing Fibonacci projection:
1. Select a Fibonacci projection on the chart by clicking on a portion of the Fibonacci projection.

2. Once the Fibonacci projection is selected (highlighted w ith small squares), press the Delete key or select Delete from
the Edit menu.

Troubleshooting:

o  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

o To continue draw ing Fibonacci projection line annotations on the chart w ithout having to reselect the Fibonacci
Projection Lines menu item each time, select Remain in Drawing Mode from the Drawing menu. Once you are done
draw ing Fibonacci projection lines, simply select another type of annotation or unselect Remain in Drawing Mode.



Fibonacci Time Lines

A Fibonacci time line is a type of chart annotation that is usually draw n betw een price peaks and price valleys. Once drawn, a
vertical line w ill be draw n at the peak and valley and vertical lines at increasing Fibonacci time percentages w ill be draw n into
the future. When future prices approach a Fibonacci time percentage, it indicates a place for a possible price peak or valley.

To draw a Fibonacci time line on a chart:
1. Select Fibonacci Time Lines from the Draw ing menu.

2. Click and hold the mouse button on the left most peak or valley, drag the mouse w ith the button still depressed to the
right most valley or peak, and release the mouse button.

To move an existing Fibonacci time line:
1. Select a Fibonacci time line on the chart by clicking on a portion of the Fibonacci time line.
2. Once the Fibonacci time line is selected (highlighted w ith small squares):

« Click and drag, w ith the mouse button still depressed, a portion of the Fibonacci time line that does not have a
selection box to move the entire Fibonacci time line.

e Click and drag, w ith the mouse button still depressed, a selection square on the Fibonacci time line to reposition only
that point of the Fibonacci time line.

To delete an existing Fibonacci time line:
1. Select a Fibonacci time line on the chart by clicking on a portion of the Fibonacci time line.

2. Once the Fibonacci time line is selected (highlighted w ith small squares), press the Delete key or select Delete from the
Edit menu.

Troubleshooting:

e  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

e« To continue draw ing Fibonacci time line annotations on the chart w ithout having to reselect the Fibonacci Time Lines
menu item each time, select Remain in Drawing Mode from the Drawing menu. Once you are done draw ing Fibonacci
time lines, simply select another type of annotation or unselect Remain in Drawing Mode.



Line

A line annotation is simply a line draw n betw een tw o points on a chart.

To draw a line on a chart:
1. Select Line from the Drawing menu.

2. Click and hold the mouse button on the left most point, drag the mouse w ith the button still depressed to the right most
point, and release the mouse button.

To move an existing line:
1. Select a line on the chart by clicking on a portion of the line.
2. Once the line is selected (highlighted w ith small squares):

e Click and drag, w ith the mouse button still depressed, a portion of the line that does not have a selection box to move
the entire line.

e Click and drag, w ith the mouse button still depressed, a selection square on the line to reposition only that point of the
line.

To delete an existing line:
1. Select a line on the chart by clicking on a portion of the line.
2. Once the line is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit menu.

Troubleshooting:

e«  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

e« To continue draw ing line annotations on the chart w ithout having to reselect the Line menu item each time, select Remain
in Drawing Mode from the Drawing menu. Once you are done draw ing lines, simply select another type of annotation
or unselect Remain in Drawing Mode.



Horizontal Line

A horizontal line annotation is simply a horizontal line draw n across an entire chart.

To draw a horizontal line on a chart:
1. Select Horizontal Line from the Drawing menu.

2. Click and hold the mouse button on a point near w here the horizontal line should be, drag the mouse w ith the button still
depressed to the exact position desired, and release the mouse button.

To move an existing horitzontal line:
1. Select a horitzontal line on the chart by clicking on a portion of the horitzontal line.

2. Once the horitzontal line is selected (highlighted w ith small squares), click and drag, w ith the mouse button still
depressed, a portion of the horitzontal to move the entire line.

To delete an existing horizontal line:
1. Select a horizontal line on the chart by clicking on a portion of the line.

2. Once the horizontal line is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit
menu.

Troubleshooting:

o  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

e To continue draw ing horizontal line annotations on the chart w ithout having to reselect the Horizontal Line menu item
each time, select Remain in Drawing Mode from the Drawing menu. Once you are done draw ing horizontal lines,
simply select another type of annotation or unselect Remain in Drawing Mode.



Vertical Line

A vertical line annotation is simply a vertical line draw n across an entire chart.

To draw a vertical line on a chart:
1. Select Vertical Line from the Drawing menu.

2. Click and hold the mouse button on a point near w here the vertical line should be, drag the mouse w ith the button still
depressed to the exact position desired, and release the mouse button.

To move an existing horitzontal line:
1. Select a vertical line on the chart by clicking on a portion of the vertical line.

2. Once the vertical line is selected (highlighted w ith small squares), click and drag, w ith the mouse button still depressed, a
portion of the vertical to move the entire line.

To delete an existing vertical line:
1. Select a vertical line on the chart by clicking on a portion of the line.

2. Once the vertical line is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit
menu.

Troubleshooting:

o  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

e To continue draw ing vertical line annotations on the chart w ithout having to reselect the Vertical Line menu item each
time, select Remain in Drawing Mode from the Drawing menu. Once you are done draw ing vertical lines, simply select
another type of annotation or unselect Remain in Drawing Mode.



Rectangle

A rectangle annotation is simply a rectangle draw n betw een tw o points on a chart.

To draw a rectangle on a chart:
1. Select Rectangle from the Drawing menu.

2. Click and hold the mouse button on one of the desired corners of the rectangle, drag the mouse w ith the button still
depressed to the opposite corner, and release the mouse button.

To move an existing rectangle:
1. Select a rectangle on the chart by clicking on a portion of the rectangle.
2.  Once the rectangle is selected (highlighted w ith small squares):

e Click and drag, w ith the mouse button still depressed, a portion of the rectangle that does not have a selection box to
move the entire rectangle.

« Click and drag, w ith the mouse button still depressed, a selection square on the rectangle to reposition only that point
of the rectangle.

To delete an existing rectangle:
1. Select a rectangle on the chart by clicking on a portion of the rectangle.

2. Once the rectangle is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit
menu.

Troubleshooting:

o  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

e To continue draw ing rectangle annotations on the chart w ithout having to reselect the Rectangle menu item each time,
select Remain in Drawing Mode from the Drawing menu. Once you are done draw ing rectangles, simply select
another type of annotation or unselect Remain in Drawing Mode.



Ellipse

An ellipse annotation is simply an ellipse draw n betw een tw o points on a chart.

To draw an ellipse on a chart:
1. Select Ellipse from the Drawing menu.

2. Click and hold the mouse button on one of the desired corners of the ellipse, drag the mouse w ith the button still
depressed to the opposite corner, and release the mouse button.

To move an existing ellipse:
1. Select an ellipse on the chart by clicking on the upper, low er, right, or left most portion of the ellipse.
2. Once the ellipse is selected (highlighted w ith small squares):

e Click and drag, w ith the mouse button still depressed, a portion of the ellipse that does not have a selection box to
move the entire ellipse.

e Click and drag, w ith the mouse button still depressed, a selection square on the ellipse to reposition only that point of
the ellipse.

To delete an existing ellipse:
1. Select an ellipse on the chart by clicking on the upper, low er, right, or left most portion of the ellipse.
2. Once the ellipse is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit menu.

Troubleshooting:

e«  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

o To continue draw ing ellipses on the chart w ithout having to reselect the Ellipse menu item each time, select Remain in
Drawing Mode from the Drawing menu. Once you are done draw ing ellipses, simply select another type of annotation
or unselect Remain in Drawing Mode.



Text

Text annotation is simply user specified text draw n on a chart.

To draw text on a chart:
1. Select Text from the Drawing menu.
2. Click on the chart at the desired location of the text.

To change existing text to a different text string:
1. Double click text on the chart.
2. Enter the new text to replace the old text on the chart and press OK.

To move existing text:
1. Select text on the chart by clicking on a portion of the text.

2. Once the text is selected (highlighted w ith small squares), click and drag, w ith the mouse button still depressed, a portion
of the textl to reposition the text.

To delete existing text:
1. Select text on the chart by clicking on a portion of the text.
2. Once the text is selected (highlighted w ith small squares), press the Delete key or select Delete from the Edit menu.

Troubleshooting:

o  When moving or deleting an annotation, you must make sure the mouse cursor has changed to a hand before clicking on
the annotation. If the cursor is still an arrow or a cross hair, the selection will not occur.

Note:

o To continue draw ing text annotations on the chart w ithout having to reselect the Text menu item each time, select
Remain in Drawing Mode from the Drawing menu. Once you are done draw ing text, simply select another type of
annotation or unselect Remain in Drawing Mode.



Remain in Drawing Mode

To continue draw ing annotations on the chart w ithout having to reselect the annotation’s menu item each time, select Remain
in Drawing Mode from the Drawing menu. Once you are done draw ing the annotation, simply select another type of
annotation menuitem or unselect Remain in Drawing Mode.



Adding Existing Data/Calculations to a Chart

Adding existing data/calculations to a chart may be useful to view data that may be used as an input to an indicator or
prediction that isn’t currently show n on the chart.

1. Select Existing Data/Calculations from the Insert menu. This activates the data dialog box, w hich allow s you to select
data series you wish to add to the active chart.

ng Data | Calculations ...

Mew Indicator ...

Mew Predickion ...

Mew Trading Strakegy ...
Mew Alert ..

Other Inskrument Data ...



Insert Existing Data/Calculations Dialog

1. Select the item or items you w ish to add from the list.

2. To select indicator, prediction, and trading strategy inputs and outputs, click the mouse over the small + and — symbols to
the left of the root indicator, trading strategy, or prediction.

3. Press the OK button.

Tip:
e Various data streams may be available based upon how you’ve customized your environment.



Adding Data from Another Instrument

Adding data from another instrument allow s you to view other data that may be relevant to the instruments on your chart (i.e.
Dow Jones Industrial Average applies to many stocks).

1. Select Other Instrument Data from the Insert menu. This activates the instrument data w izard, w hich guides you
through the process of adding data from another instrument.

Insert

Existing Data | Calculations ...

Mew Indicator ...

Mew Predickion ...

Mew Trading Strakegy ...
Mew Alert ..

Other Inskrument Data ...




Instrument Wizard - Selecting a Category

Selecting the instrument category w ill select w hat type of data you w ant to view .

1.  Select the category of instrument or instruments you w ish to add.
2. Press the Next button to proceed to the next w izard screen.

Troubleshooting:

. If you think the categories listed are incorrect or some categories are missing, you w ill need to change your data sources
settings. To do this, press the Cancel button, select Data Sources from the Tools menu. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.



Instrument Wizard - Selecting an Instrument

Selecting the instrument that you w ant to view allow s you to select one or more instruments that you w ant to view on your
chart.

1.  Select the instrument or instruments you w ish to add.
2. Press the Next button to proceed to the next wizard screen.

To sort by ticker symbol:
2.  Select the Sort by Symbol option.

To sort by name/description:
1. Select the Sort by Name option.

To show only the items selected in your list:
1.  Select the Selected items only option.

To show all the items in the list (both selected and not selected):
1. Deselect the Selected items only option.

If you are using Quote.com, eSignal or Prophet.net as your data source, you have the option of adding instruments that are not

already listed. To add a new ticker symbol:

1. Press the Add New Quote.com Ticker Symbol, the Add New eSignal Ticker Symbol or the Add New
Prophet.net Ticker Symbol button.

2. Enter the instrument’s ticker symbol into the Ticker box

3. Enter the instrument’s full name into the Name box

4. Select the instrument’s category using the Category drop dow n box.

5. Press the OK button to add the new instrument.

Tip:

e To select a group of instruments, hold the left mouse button dow n w hile dragging the mouse over the desired

instruments.

Troubleshooting:

. If the instruments listed are not w hat you expect for the category you chose on the previous wizard screen or
instruments are missing that you think should be present for the previously selected category, then you will need to
change your data sources settings. To do this, press the Cancel button and select Data Sources from the Tools menu.

Notes:

. If you are using the data that came on the NeuroShell Trader Historical Data CD or the data installed in the NeuroShell
Trader Data subdirectory, you may see extra letters after the stock name (For example: Microsoft MSQ ZMF ZJZ). This is
an indication that the stock is an optionable stock and the letters are the actual root symbols for the stock’s option
contracts.

. If you are unable to find a ticker, you’ll w ant to make sure that your data is setup correctly. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.

e  NeuroShell Trader will handle all data conversion if you add an instrument w hose data file periodicity is different from the
data files upon w hich the chart is based.

Example #1: If you add a daily instrument to a monthly chart, NeuroShell Trader w ill set the instrument’s monthly open
equal to the first daily open, the monthly high equal to the highest daily high, the monthly low equal to the low est daily
low , and the monthly close equal to the last daily close. Additionally, the monthly volume & open interest equal to the
sum of all daily volumes & open interests, and all other monthly data values equal to the last daily data value.

Example #2: If you add a monthly instrument to a daily chart, the instruments data will be extended so that each day
displays the last monthly value.



Instrument Wizard - Selecting Data

Selecting data allow s you to choose w hich types of data you w ant to view for the instruments that you selected on the
previous w izard page.

1. Select the data item or items you wish to add.
2. Press the Finish button to end the wizard and add the instrument data items.



Viewing a Different Chart Page

View ing a different chart page can be very useful if you are applying your data to multiple instruments and w ant to see the
results of your analysis on the other instrument(s).

You may view a different chart page by:
e Selecting a new ticker symbol from the first drop dow n list at the top of the chart

Syrbaol

AAPL
CPQ
GATE
IEM

. Selecting a new instrument name from the second drop dow n list at the top of the chart

Marme

Gateway 2000 |nc
International Busines

. Selecting the instrument in the Portfolio View (if the Portfolio View is being view ed).

Tips:
e Toview anew chart page you may type the ticker symbol in the first drop dow n list at the top of the chart.
e Toview anew chart page you may type the instrument name in the second drop dow n list at the top of the chart.



Adding/Removing Chart Pages

Adding/Removing chart pages can be very useful if you w ant to apply the analysis that you have done on the current chart to
different instruments in the same instrument category.

Follow ing the procedures below activates the chart wizard, allow ing you to select and deselect instruments.

1. Select the chart you wish to Add/Remove Chart Pages by clicking the mouse button on the chart.
2. Select Add/Remove Chart Pages from the Format menu.

Eatmat Chart ...

Hide/Unhide Data ...

or

Select the chart you wish to Add/Remove Chart Pages by right-clicking the mouse button on the chart.
2. Select Add/Remove Chart Pages from the pop-up menu.

Paste

Zoarm In
Zoam 2k

Hide/Unhide Data ...

&dd/Remaove Chart Pages ...

Format Chart ..,

Recalculate Chart



Chart Wizard - Selecting Instruments

Selecting the instruments that you w ant to view allow s you to choose w hich instruments you w ant to view on your chart. You
can alw ays Add/Remove Chart Pages at a later time.

1. Select the instrument or instruments you wish to chart.
2. Press the Finish button to end the wizard and display the chart.

To sort by ticker symbol:
1.  Select the Sort by Symbol option.

To sort by name/description:
1. Select the Sort by Name option.

To show only the items selected in your list:
1.  Select the Selected items only option.

To show all the items in the list (both selected and not selected):
1. Deselect the Selected items only option.

If you are using Quote.com, eSignal or Prophet.net as your data source, you have the option of adding instruments that are not

already listed. To add a new ticker symbol:

1. Press the Add New Quote.com Ticker Symbol, the Add New eSignal Ticker Symbol or the Add New
Prophet.net Ticker Symbol button.

2. Enter the instrument’s ticker symbol into the Ticker box

3. Enter the instrument’s full name into the Name box

4. Select the instrument’s category using the Category drop dow n box.
5. Press the OK button to add the new instrument.

Notes:

. If you select multiple instruments, each one will be displayed on its own ‘chart page’. Once the chart is
displayed, you w ill be able to flip betw een ‘chart pages’.

o Any analysis technique (indicators, predictions, ...) you create will automatically be applied to all ‘chart
pages’.

. Once a chart is created, you can add/remove instruments by selecting Add/Remove Chart Pages under the Edit menu.
Analysis techniques already applied to the chart will be replicated on each new ‘chart page’.

. If you are using the data that came on the NeuroShell Trader Historical Data CD or the data installed in the NeuroShell
Trader Data subdirectory, you may see extra letters after the stock name (For example: Microsoft MSQ ZMF ZJZ). This is
an indication that the stock is an optionable stock and the letters are the actual root symbols for the stock’s option
contracts.

Tips:
e To select a group of instruments, hold the left mouse button dow n w hile you drag the mouse over the desired
instruments.

. If you are unable to find a ticker, you’ll w ant to make sure that your data is setup correctly. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.

Troubleshooting:

. If the instruments listed are not w hat you expect for the category you chose on the previous wizard screen or
instruments are missing that you think should be present for the previously selected category, then you will need to
change your data sources settings. To do this, press the Cancel button and select Data Sources from the Tools menu.



Modifying Data Files

Modifying data may be desirable, if you find that a specific value is incorrect.

1. Select a data series on the chart by clicking on the corresponding line, legend text, or Snapshot View text..
2. Select Modify Selected Data File(s) from the Edit menu.

Cut Chrl+3
Copy kel
Paste Chel+y
Delete Dl

IModify

or

Select a data series on the chart by right-clicking on the corresponding line or legend text.
2. Select Modify Selected Data File(s) from the pop-up menu.

uk
Copy
Paste
Delete

Maodif

Format Selected Data ..,

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.



Modify Data Dialog

The Modify Data dialog allow s you to correct data that is incorrect for any file that NeuroShell Trader is able to read. The folder
tab describes w hat kind of file the folder tab is representing, below that is the path and filename for the file on the selected
folder tab, and below that is the data that the selected file has in it.

In order to modify a specific data value:

Select the folder tab that represents the file that you w ant to modify.
Move the cell in the grid to date and column that you w ant to modify.
Type the corrected value in that cell.

P oN =

Select the OK button to save your corrections.

In order to restore a specific data value to its original value:
Select the folder tab that represents the file that you w ant to restore.

2. Move the cell in the grid to date and column that you w ant to restore. (It will be marked in yellow or red w ith the original
value placed in the Original Value box).

3. Select the Restore button.

Select the OK button to save your corrections.

NeuroShell Trader doesn’t modify the selected data file, but rather saves the corrections that you have made and replaces the
data you have corrected any time that the corrected file is loaded in the future. This means that if you attempt to use any other
program that the corrected data file will not have the corrected values in it.

Additionally, the Modify Data Dialog uses several colors to inform you of important information that is associated w ith the
colored grid cell. The follow ing describes the color scheme for the cell backgrounds:
. Red - you have just modified this cell and changes will be saved w hen you select the OK button. (Restore value is show n
in the Original Value box w hen cell selected).
- you have previously modified this cell. (Restore value is show n in the Original Value box w hen cell selected).
° Gray - NeuroShell Trader uses this data for possible split information only. The method that NeuroShell Trader uses to

combine files has chosen another file to get the data from. Any changes made to a gray cell will be saved, but it wiill not
be reflected on the current chart, unless it changes the split information that NeuroShell Trader needs to combine files.

Finally, NeuroShell Trader uses new er file information to decide w hether a split has occurred in the older file. If any
overlapping data doesn’t match, NeuroShell Trader applies a split to an older file (this is so that CD-ROM data is still usable). If a
file has a split applied to it you will see a note at the bottom of the selected folder tab that explains that there has been a split.



Combination Ticker Symbols

Neuroshell Trader allow s the use of combination ticker symbols w hich are simple combinations of other ticker symbol prices.
When used in a chart, the combination ticker symbol is the primary data series, predictions and trading strategy are based on
the ticker symbol combination and all trading statistics are calculated on the combination ticker symbol.

An example of a combination ticker symbol combination might be [5*YHOO-2.5*INTC+3*MSFT], w hich w ould result in a price
stream on the chart that is 5*YHOQ's price minus 2.5*INTC's price plus 3*MSFT's price. Examples of valid combination ticker
symbols are as follow s:

[YHOO - INTC]

[5* YHOO - 2.5 * INTC]

[5* YHOO - 2.5 * INTC + 3 * MSFT]

[5* YHOO - 2.5 * INTC + 3 * MSFT - 4 * DELL]
[YHOO / INTC]

[2* YHOO /3 * INTC]

Quotes may be used around ticker symbols to allow for ticker symbols that contain arithmetic operators like *, -, +, and /. An
example of a combination ticker combination ticker symbol w hich uses quotes is as follow s:

["bl u5-dt"-"gb u5-dt"]

It should be noted that combination ticker symbols are a useful method of creating hedging trading strategies. When using a
ticker symbol like [5*YHOO — 3*INTC], long positions w ould be equivalent to being long 5 shares of YHOO and short 3 shares of
INTC. Conversely, short positions w ould be equivalent to being short 5 shares of YHOO and long 3 shares of INTC.

To create a combination ticker, simply create a new ticker symbol like [5*YHOO-2.5* INTC+3*MSFT]. To add a new ticker symbol,
use the add ticker button found in the chart wizard w hen using Quote.com or eSignal.

Important Note:

Combination ticker symbols not in the formats listed above w ill not be recognized by NeuroShell Trader. Only combination
tickers of a quadratic form like [ aX + bY + ¢Z + ...] or the form [aX / bY] w ill be recognized. Combination tickers like
[1+2+3+IBM] or [IBM/2 + DELL/2] or [2*4*IBM / 4 + 3*DELL + (IBM + 3)/DELL] or any other complicated arithmetic forms are not
recognized.



What are Indicators?

An Indicator is a mathematical formula that is useful in detecting, recognizing, and/or predicting market trends. Indicators may
be plotted on your chart or just calculated for use as an input to another indicator, prediction, or trading strategy.

One common example of an indicator is a simple moving average. The five day simple moving average of the close (Annotated:
Avg(Close, 5)) calculates the average of the last five days closing price. When trying to evaluate trends of an instrument,
indicators like the simple moving average might be valuable because they incorporate more than one day’s prices.

For more information on any particular indicator: Select the Indicator Help button.

Topic of Interest:
What are Custom Indicators? (Professional Only)



Creating an Indicator

Creating an indicator wiill allow you to add indicators to your chart that are used in technical analysis of instruments on your
chart.

1. Select New Indicator from the Insert menu. This activates the indicator wizard, w hich guides you through the process
of creating an indicator.

Insert

Existing Data | Calculations ...

Mew Indicator ...

Mew Predickion ...
Mew Trading Strakegy ...
Mew Alert ..

Other Inskrument Data ...

Note:
e You may have multiple indicators displayed on one chart by simply creating more than one indicator.

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



Indicator Wizard - Selecting a Category

Selecting a category wiill allow you select the specific indicator that you w ant to use. This is necessary to select the indicator
you w ant to add. If you are unsure w hat category you w ant to add an indicator from you may select the all indicators
category.

1. Select a category by clicking on the desired category (i.e. Basic, Simple Moving Average, ...).
2. Press the Next button or double-click on the category to proceed to the next wizard screen.

All the available indicator categories and the category arranging buttons described below may not be visible depending upon
the currently selected Indicator Wizard Interface Options. Press the Options button if to change the Indicator Wizard Interface
Options. For more information see Indicator Wizard Interface Options.

To rearrange the order in w hich the categories are show n in the list, use the category arranging buttons at the bottom of the
list:

Move Up - moves the currently selected category up in the list.

Move Down — moves the currently selected category dow n in the list.

Reset — Resets all the categories to their original default positions.

Note:

. Not all indicators w ill be available if NeuroShell Trader has detected that a Boolean condition is required. This is true for
Trading Strategy Entry and Exit conditions, as w ell as inputs to indicators (i.e. If X then Y else Z — X must be a Boolean
condition).

Topics of Interest:

What are Indicators?

What are Custom Indicators? (Professional Only)



Indicator Wizard - Selecting an Indicator

Select an indicator or indicators that you w ant to add to your chart.

1. Select an indicator or indicators from the list by clicking on the desired indicator(s).
2. Press the Next button or double-click on the indicator to proceed to the next w izard screen.

Tip:
e To select a group of indicators, hold the left mouse button dow n w hile you drag the mouse over the desired indicators.

Notes:
. Press the Indicator Help button for information about the currently selected indicator.

e« To delete a custom indicator select the indicator to be deleted and select the delete button on your keyboard (this will
delete the custom indicator off your system permanently).

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



Indicator Wizard - Choosing Parameters

Choosing parameters allow s you set your indicator parameters as desired (i.e. to set the number of periods a moving average
is calculated over)

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters.
If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters.

To set or replace the currently selected parameter:
1. Select the Set Parameter button.
2. Press the Finish button to end the wizard and add the indicator.

To modify an indicator, data stream, or numeric parameter:

1. Select the indicator, data stream, or numeric parameter to be modified.
2. Select the Modify Parameter button.

3. Press the Finish button to end the wizard and add the indicator.

For information about an indicator:
1.  Select the indicator for w hich you w ant more information
2. Press the Indicator Help button

The Save Indicator and Modify buttons described below may not be visible depending upon the currently selected Indicator
Wizard Interface Options. Press the Options button to change the Indicator Wizard Interface Options. For more information
see Indicator Wizard Interface Options.

(Professional Only) To save an indicator as a custom indicator:
1. Select the indicator to be modified
2. Press the Save Indicator button (or the Modify Indicator button if you have previously saved the custom indicator).

(DayTrader Only) To eliminate large indicator fluctuations due to the gap betw een a days opening price and the previous days
closing price, select Don’t calculate indicator(s) across day boundaries. When this option is selected, none of the
previous days values are used w hen calculating the indicator(s). As a result, an indicator like MovAvg(Volume,5) wiill not
produce a value until the 5th bar of the day w hen this option is selected.

Notes:

. If you specify multiple parameters, more than one indicator wiill be created. To specify multiple parameters, separate each
value by a comma (or semi-colon if the w indow s regional settings are set such that a semi-colon is the standard w indow s
list separator). For example, specifying a moving average size of '5, 10, 20' will create three moving averages.

e To specify a range of parameters separate the start of the range from the end of the range w ith a colon. For example,
specifying a moving average size of ‘5:10” wiill create moving averages w ith sizes of 5,6,7,8,9, and 10. You may also
place an increment value after the end value, again separated by a colon. For example, specifying a moving average size
of ©10:20:2” wiill create moving averages w ith sizes of 10, 12, 14, 16, 18, and 20.

. (DayTrader Only) Be careful w hen using the Don’t calculate indicator(s) across day boundaries option for
indicators having a large lookback window relative to the number of bars per day. For example, if this option is applied to
the indicator MovAvg(Volume,40) on an hourly chart, no values will be produced as the lookback is larger than the number
of bars on any given day. When used in predictions and trading strategies, this problem may cause the prediction or
trading strategy to trade only a few bars per day or possibly not trade at all.

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



Parameter Dialog - Numeric

1.
2.

Enter a numeric value for the parameter w hose name is show n in the title bar.
Press the OK button.

Notes:

To determine the range of values that are valid for this parameter refer to the Indicator Help.

To list multiple values separate each value by a comma (i.e. 5,10,15,20). Note that if the w indow s regional settings are set
such that a semi-colon is the standard Window s list separator, then separate each value by a semi-colon (i.e. 5; 10; 15;
20).

To list a range of values separate the start of the range from the end of the range w ith a colon (i.e. 5:10 = 5,6,7,8,9,10).
You may also place an increment value after the end value, again separated by a colon (i.e. 5:25:10 = 5,15,25).
(Professional Only) When selecting numeric values for indicators w hen performing Full Optimization or Parameter Search
optimization from the Prediction Wizard or Trading Strategy Wizard you need to enter a range of values to perform the
optimization over (the larger the range the longer the optimization process w ill take).



Parameter Dialog - Numeric

1.
2.

Enter a numeric value for the parameter w hose name is show n in the title bar.
Press the OK button.

Notes:

To determine the range of values that are valid for this parameter refer to the Indicator Help.

To list multiple values separate each value by a comma (i.e. 5,10,15,20). Note that if the w indow s regional settings are set
such that a semi-colon is the standard Window s list separator, then separate each value by a semi-colon (i.e. 5; 10; 15;
20).

To list a range of values separate the start of the range from the end of the range w ith a colon (i.e. 5:10 = 5,6,7,8,9,10).
You may also place an increment value after the end value, again separated by a colon (i.e. 5:25:10 = 5,15,25).
(Professional Only) When selecting numeric values for indicators w hen performing Full Optimization or Parameter Search
optimization from the Prediction Wizard or Trading Strategy Wizard you need to enter a range of values to perform the
optimization over (the larger the range the longer the optimization process w ill take).



Parameter Dialog - Numeric

1.
2.

Enter a numeric value for the parameter w hose name is show n in the title bar.
Press the OK button.

Notes:

To determine the range of values that are valid for this parameter refer to the Indicator Help.

To list multiple values separate each value by a comma (i.e. 5,10,15,20). Note that if the w indow s regional settings are set
such that a semi-colon is the standard Window s list separator, then separate each value by a semi-colon (i.e. 5; 10; 15;
20).

To list a range of values separate the start of the range from the end of the range w ith a colon (i.e. 5:10 = 5,6,7,8,9,10).
You may also place an increment value after the end value, again separated by a colon (i.e. 5:25:10 = 5,15,25).
(Professional Only) When selecting numeric values for indicators w hen performing Full Optimization or Parameter Search
optimization from the Prediction Wizard or Trading Strategy Wizard you need to enter a range of values to perform the
optimization over (the larger the range the longer the optimization process w ill take).



Indicator Wizard - External DLL (Professional Only)

In order to make a call to an external DLL, follow the procedure below :

Select the Filename of the DLL by selecting the "..." button and selecting the DLL that you w ant to call.
Select the Procedure Name that you w ant to call from the drop dow n list.

3. Select the Indicator output is a Boolean value if the output of the indicator represents a zero or non-zero (off/on)
output (this is so it can be used as a Trading Strategy Condition if desired).

Select the Procedure Type of the selected procedure (return value of the procedure).

5. If the return value is not "Sub (void)" you can select Use the function return value as the indicator output (this
means that the value(s) that the function returns wiill be used as the output of the indicator).

Select the Number of Parameters that NeuroShell Trader should pass to the procedure.

7. Ifthe Number of Parameters is not zero you will need to define the Use, Declaration Type, and Value Type of each
parameter. To modify a parameter:

. Select the parameter to be modified
e Select the Modify Parameter button
8. Press the Next button to proceed to the next wizard screen.

Note:
. Refer to Indicator Help to distinguish betw een External DLL Call by Array versus External DLL Call by Value.

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



Indicator Wizard - NeuroShell 2 (Professional Only)

In order to make a call to a NeuroShell 2 neural netw ork follow the procedure below :

1. Select the Filename of the NeuroShell 2 DEF file by selecting the "..." button and selecting the NeuroShell 2 DEF file that
you w ant to call.

Select the NeuroShell 2 Output that you w ant to use (NeuroShell Trader is capable of using only one output at a time).
3. Press the Next button to proceed to the next wizard screen.

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



Indicator Wizard - NeuroShell Predictor/Classifier (Professional Only)

In order to make a call to a NeuroShell 2 neural netw ork follow the procedure below :

1. Select the Filename of the NeuroShell Predictor/Classifier net file by selecting the "..." button and selecting the NeuroShell
Predictor/Classifier net file that you w ant to call.

2. Select w hich NeuroShell Predictor/Classifier Output you w ant to use (NeuroShell Trader is capable of using only one
output at a time).

3. Press the Next button to proceed to the next wizard screen.

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



Modify DLL Parameter (Professional Only)

The Modify DLL Parameter dialog allow s you to define the properties of the DLL parameter so that NeuroShell Trader w ill know
how to send/receive data from your DLL procedure properly. For more information dow nload the Softw are Development Kit
(SDK) from the tech support and advanced user w eb site: http://w ww .w ard.net/

To define the DLL parameter:

1. Select the Declaration Type for the parameter (if the DLL Call is expecting a variable of size integer you need to tell
NeuroShell Trader how to pass the data).

2. Select "How should NeuroShell Trader utilize the parameter?"” This tells NeuroShell Trader if it should pass data to
the DLL parameter (As an Indicator Input), use data returned from the DLL parameter as the output (As the Indicator
Output), if it should pass the number of elements in the time series (As the number of values in Time Series
input(s)), if it should pass the Julian Date (As the Date), or if NeuroShell Trader should ignore the parameter (Ignore
the Parameter).

Notes:

. If you select the DLL parameter to be an Indicator Input you wiill need to select a name for the parameter as it will show up
on the Parameters screen of the Indicator Wizard. Additionally, you will need to select the type of values are acceptable
to be passed to the DLL parameter (Time Series and/or Numeric Value). Finally, if you have selected that it is
acceptable to pass a Numeric Value, then you wiill need to define w hat numeric values are acceptable (i.e., Real
Number, Real Number > 0, Integer >= 1, or etc.).

. Once you create a DLL Call you may save it as a custom indicator, so that you don’t need to redefine the call every time
you w ant to use the indicator.

. For more information on defining DLL Calls dow nload the Softw are Development Kit (SDK) from the tech support and
advanced user w eb site: http://w w w .w ard.net/.

e Julian Date is consider to be the number of days since December 31, 1899.

o  When using the DLLArray indicator all inputs, outputs, and date parameters must be passed by reference (byref or *). This
is so NeuroShell Trader can pass a pointer to the array of input, output, or date. Otherw ise only one value can be passed.


http://www.ward.net/
http://www.ward.net/

Modifying Indicators

Modifying indicators allow s you to modify the currently selected indicator. This may be useful if you w ant to change the
parameters of an indicator (i.e. moving average periods), or the type of indicator being used (i.e. MACD to MACD Signal).

1. Select an indicator displayed on the chart by clicking on the corresponding line, legend text, or Snapshot View text.
2. Once the indicator is selected (highlighted w ith black boxes), select Modify Selected Indicator from the Edit menu.

Cut kel
Copy Rl
Paste Chrl+Y
Delete Dl

Modify Selected Indicator ...

or

1. Select an indicator displayed on the chart by right-clicking on the corresponding line or legend text.
2. Select Modify Selected Indicator from the pop-up menu.

Cuk
Copy
Paste
Delete

Modify ed Indicator ...

Format Selected Indicator ...

or

1. Moadify an indicator displayed on the chart by double-clicking on the corresponding line or legend text.

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.

Topics of Interest:
What are Indicators?
What are Custom Indicators? (Professional Only)



What are Custom Indicators? (Professional Only)

Custom Indicators are a w ay of saving indicators in a w ay that may be easier to use, easier to understand, and/or easier to
distribute.

By creating a custom indicator you are able to create a complicated indicator w ith many levels of indicator nesting (i.e.
Avg(%Change(Close,5),10)) can be turned into a single level indicator (i.e. My Indicator(Close, 5, 10)). Also, you have the
ability to hide parameters that you feel you w on’t w ant to modify (i.e. My Indicator(Close)).

Additionally, by creating a custom indicator you are able to create an indicator that w ill be more understandable. You can take
a multilevel indicator (i.e. Avg(StdDev(Close, 10),10)) that is not that meaningful and give it a more meaningful name (i.e.
Smoothed Volatility(Close)).

Finally, by creating a custom indicator (even one that may need to call a DLL) you can create a method to distribute your
indicator(s) more easily. This will allow you to create an indicator on one chart and use it in all of your charts, as well as
distribute your custom indicator to customers.

To distribute your custom indicator, you must install the custom indicator template from your <C:\NeuroShell Trader>\Template\
directory that has the same name as your custom indicator (i.e. My Indicator.tpl) into your customers <C:\NeuroShell
Trader>\Template\ directory. Additionally, you must make sure to install (and register if necessary) all DLLs that are required (if
any). If you are distributing a corresponding help file, the help file must be installed into your customers <C:\NeuroShell
Trader>\Template\ directory.

If you w ant to distribute a custom indicator or a set of custom indicators, it is recommend that you inform Ward Systems Group
Sales Department of w hat you are distributing, so that it can maintain a list of Solution Providers for all of it’s customers.



Save Template Dialog (Professional Only)

The Save Template Dialog allow s you to name the custom indicator, select the category (new or already existing), and modify
advanced features of the custom indicator. To save a custom indicator:

Enter the Nam e of the custom indicator you wish to save.

2. Enter the Category of the custom indicator you wish to save (you may do this by selecting an existing category from the
drop dow n list or typing in a new Category name).

3. (Optional) Select the Advanced button to modify the parameter mapping, parameter defaults, indicator help file, and
passw ord protect the indicator.

4. Select the OK button to save your custom indicator.

To edit an indicator that has been previously saved as it w as show n originally:
1. Select the Reconstruct Original Indicator button.
Notes:
e This will not "unsave" the indicator previously saved.
e All changes made either in the Indicator Wizard or the Save Template dialogs will be lost.

. In order to replace an original indicator w ith minor changes you w ill w ant to reconstruct the indicator, save the
indicator under a new name, select the original indicator in the indicator list (make sure no others are selected) and
press the delete key on your keyboard, select the "new " indicator, modify saved indicator (from the parameter
selection screen), and save the indicator using the "original" name.

Note:

e After selecting OK the indicator will show in the category that you had previously selected, but the next time you enter the
Indicator Wizard it w ill be show n only in the Category that you entered on this screen.

Topic of Interest:
What are Custom Indicators? (Professional Only)



Save Template Advanced Dialog (Professional Only)

The Save Template Advance Dialog allow s you to modify the parameter mapping, parameter defaults, indicator help file, and
passw ord protection for the indicator.

To passw ord protect your indicator (this means in order to modify it you must provide the passw ord):
1. Select the Password check box
2. Enter a Password in the text box that you w ill remember.

To map a help file to the custom indicator (so that w hen you select Indicator Help from the Indicator Wizard it w ill load the select
Help File/Topic ID):

1. Select the Help File check box.

2. Enter a Help File name in the text box (either by typing or by selecting the brow se button "..."). Note that all custom
indicator help files must be located in the <C:\NeuroShell Trader>\Template\ directory.

3. Enter the Topic ID of the help topic to be loaded.

To modify the parameter name, mapping, and/or default value:
1. Select the parameter that you w ant to modify.
2. Select the Modify button.

When you have completed modifying the parameter mapping, parameter defaults, indicator help file, and passw ord protection
select the OK button.

Topic of Interest:
What are Custom Indicators? (Professional Only)



Modify Parameter's Display Properties (Professional Only)

The Modify Parameter’s Display Properties dialog allow s you to specify the order in w hich parameters are to be displayed (if at
all), the name of the parameter to be displayed in the Indicator Wizard (and other places), and the default values for the custom
indicator (if defaults are desired).

To hide a parameter from a user in the Indicator Wizard, and elsew here, select the Hidden from user option (this will not be
an option if the parameter is a Time Series). Note that if you hide a parameter, the parameter w ill essentially be unchangeable
from its current value. You w ill not be able to set this parameter to a different value or optimize this parameter.

To change the location of the parameter in the Parameter List of the Indicator Wizard and/or map tw o (or more) parameters to
the same parameter:

1. Select Display as Parameter Number option.
2. Select the desired parameter number.

To change the Parameter Name, enter a new name in the Parameter Name field.

To force the parameter value to be defaulted to nothing, deselect the Default Value check box. Otherw ise, to select the
default value:

1. Select the Default Value Check box.
2. Select the "..." button to select the default value.

To set the default optimization parameter range w hen the indicator is used in an optimization:
1. Enter a minimum and maximum value for Optimization Range.

Once you are satisfied w ith the parameter’s display order, the name of the parameter, and the default values for the custom
indicator select the OK button.

Topic of Interest:
What are Custom Indicators? (Professional Only)



Program Calls (DLLs)

The NeuroShell Trader Professional includes indicators that can call external DLLs created (usually) in C, C++, Ibasic Pro,

Pow er Basic, or Delphi. (If you don't already have a preference, w e recommend Ibasic Pro because it is easy to use and costs
only $49.99 at this w riting - see w w w .pyxia.com). This feature is located in the 'DLL calls' category in the Indicator Wizard.
This is a very pow erful feature, because it means that you can build custom indicators and other functions and use them in the
NeuroShell Trader. You can even build a business selling these to NeuroShell Trader users. How ever, you will need to have a
programmer available to help you set up the calls to the DLLs, and the programmer w ill have to know something about the DLL
he/she is trying to call.

There are tw o types of DLL calls:

1. Calling DLL by value. In this mode, the DLL is called once for each bar. The inputs to the DLL w ill usually be some current or
lagged values, and the output will be associated w ith that bar on the chart. This mode w ould be perfect for building a custom
indicator in C++.

2. Calling DLL by array. In this mode, the DLL is called only once for the entire chart. Each parameter is an array that is as large
as the number of bars loaded in the chart. The output is an array of the same size. This mode is for building some sort of
process that needs all the data at once.



Calls to NeuroShell2 and Predictor/Classifier Nets

You can call neural netw orks you created w ith NeuroShell 2, NeuroShell Predictor, or NeuroShell Classifier w ithin the Trader.
These net calls are special indicators in the 'DLL calls' category in the Indicator Wizard. You still have to train these nets w ithin
the respective programs, but they can be fired in the Trader, looking like an indicator. This indicator can then be used in a
trading strategy, another indicator, or even another net. It is easy to train nets in these programs using Trader data if you use
the Trader’s file export facility.

In order to call Predictor/Classifier netw orks, you must ow n the NeuroShell Run-Time Server. When you call the indicator to fire
NeuroShell 2 nets you must not only pass it the inputs to the net in the proper order, but the path to the .DEF file as w ell. For
Predictor and Classifier nets, you w ill need the path to the saved netw ork file as w ell as the inputs.



What are Neural Networks?

Neural netw ork technology mimics the brain's ow n problem solving process. Just as humans apply know ledge gained from
past experience to new problems or situations, a neural netw ork takes previously solved examples to build a system of
"neurons"” that makes new decisions, classifications, and forecasts.

Neural netw orks look for patterns in training sets of data, learn these patterns, and develop the ability to correctly classify new
patterns or to make forecasts and predictions. Neural netw orks excel at problem diagnosis, decision making, prediction,
classification, and other problems w here pattern recognition is important and precise computational answ ers are not required.

Topics of Interest:

What Type of Problems do Neural Netw orks Solve?
What is Training Data?

Netw ork Structure

How Does a Neural Netw ork Learn?

Advanced Users

Neural Netw ork - Output Discussion

Neural Netw ork - Input Discussion

Neural Netw ork - Netw ork Criteria Discussion
Neural Netw ork - Results Discussion

References



What Type of Problems Do Neural Networks Solve?

Neural netw orks solve three major classes of problems:

Prediction: The netw ork estimates a number from a set of input values using pattern recognition that the netw ork learned
from the training set of data. Examples of prediction problems include forecasting the next day’s closing price of a stock,
interest rate or currency rate, estimating the number of customers for a bank or restaurant, or predicting sales.

Simple Classification: The netw ork estimates an output value (w hich represents a simple classification) using pattern
recognition that the netw ork learned from the training set of data. Examples of simple classification problems include
identifying a buy, hold or sell signal, and identifying a bull or bear market. To identify a simple classification, create an
indicator that returns a simple numeric classification and allow the neural netw ork to predict this indicator. For the buy, hold,
or sell example create an indicator that returns 1,0, or -1 for a buy, hold, or sell. For the bull or bear market example, create
an indicator that returns 1 or 0 for a bull or bear market.

Complex Classification: A series of netw orks each estimate an output value (w hich represents a category) using pattern
recognition that the netw orks learned from the training set of data. An example of a complex classification problem is
identifying w hether to invest in the stock, bond, commodity, currency, or option market. To identify a complex classification,
create a series of indicators that return a simple numeric value for each category and allow a different neural netw ork to
predict each indicator. For the market example, create five indicators that return 1 or O for investing or not investing in the
respective market.



What is Training Data?

The training data includes many sets of input variables and a corresponding output variable. If you’re familiar w ith statistics,
the inputs are often called independent variables and the output (prediction) is called the dependent variable. Each set of
corresponding independent variables and dependent variable is called an observation, example, or case. In more general
terms, w hen the neural netw ork trains, it is using historical examples to "learn" the patterns of the input variables and how they
correlate to the output variable (prediction).

The range of historical examples ("training set") used to train the netw ork should include a representative set of problems likely
to be encountered in the real w orld. For example, if you w ant to predict the selling price of a stock, you need to make sure
your training set includes historical examples of w hen the price w ent up, w hen it w ent dow n, w hen it stayed the same.

You willw ant to provide historical examples that are relevant to predicting the current market and avoid historical examples that
do not represent current market behavior. The best w ay to do this is to limit the amount of past history upon w hich the neural
netw ork trains ("learns"). This means limiting the number of observations to betw een 300 and 2000 so that the neural netw ork
w ill learn data "relevant" to today’s market.

Additionally, it is important to understand that for each observation all the inputs must exist for the neural netw ork to use that
observation to "learn". If you are trying to predict a U.S. security and using an input that comes from a foreign market that has a
holiday on a day that you are expecting an observation, then the observation w ill be missing data. Thus the neural netw ork wiill
be unable to use this observation for "learning" or predicting its value.

Finally, because of inflation and an overall rise in most markets, normalizing inputs and outputs is extremely important. For more
information on normalizing data refer to Normalizing Variables topic in Neural Netw ork - Output Discussion

The results that you achieve wiill only be as good as the training data (inputs and outputs) that you select. For more information
on how to choose your training data refer to Neural Netw ork - Output Discussion and Neural Netw ork - Input Discussion.



How Does a Neural Network Learn?

The netw ork begins by finding linear relationships betw een the inputs and the output. Weight values are assigned to the links
betw een the input and output neurons. After those relationships are found, neurons are added to the hidden layer so that
nonlinear relationships can be found. Input values in the first layer are multiplied by the w eights and passed to the second
(hidden) layer. Neurons in the hidden layer "fire" or produce outputs that are based upon the sum of the w eighted values
passed to them. The hidden layer passes values to the output layer in the same fashion, and the output layer produces the
desired results (predictions).

The netw ork "learns" by adjusting the interconnection w eights betw een layers. The answ ers the netw ork is producing are
repeatedly compared w ith the correct answ ers, and each time the connecting w eights are adjusted slightly in the direction of
the correct answ ers. Additional hidden neurons are added as necessary to capture features in the data set.

Eventually, if the problem can be learned, a stable set of w eights evolves and w ill produce good answ ers for all of the sample
decisions or predictions. The real pow er of neural netw orks is evident w hen the trained netw ork is able to produce good
results for data that the netw ork has never "seen" before.



Network Structure

The basic building block of neural netw ork technology is the simulated neuron (depicted in Figure 1 as a circle). Independent
neurons are of little use, how ever, unless they are interconnected in a netw ork of neurons. The netw ork processes a number
of inputs from the outside w orld to produce an output, the netw ork's predictions. The neurons are connected by w eights,
(depicted as lines).

Inputs

Hidden
Cutput

Figure 1. Network Structure

Neurons are grouped into layers by their connection to the outside w orld. For example, if a neuron receives data from outside
of the netw ork, it is considered to be in the input layer. If a neuron contains the netw ork's predictions, it is in the output layer.
Neurons in betw een the input and output layers are in the hidden layer, w hich serves as a feature detector.
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Neural Network - Output Discussion

Once you’re familiar w ith neural netw orks, you realize they can help you solve many different problems. You also know from
experience there is more than one w ay to approach a problem. For example, if you’re creating a neural netw ork to predict
stocks, you can predict a number of things: stock price, change in a stock price, percent change in a stock price, stock
volatility, etc. You could also classify the market as to w hether it is going bull or bear, or you could get the netw ork to make a
buy, sell, or hold decision. In any of the above choices, you have a number of options about how far ahead you w ant to
predict. The variables you w ant to predict or classify will be the neural netw ork outputs.

Normalizing Variables (why you shouldn’t predict the Close)
Suppose you w anted to use a price indicator as a variable that has a graph over time that looks like the follow ing graph:

Price

Time
As you can see, a distinct pattern is evident even to our ow n neural netw orks, but this could look like three different patterns to

a neural netw ork because they occur at different price levels! Ideally, w e’d like to present the data to the netw ork as in the
follow ing graph:

Price

Time

The w ay to do this is to create an indicator that normalizes the data. There are many w ays this can be done, among them:

. Use price relative to some baseline, such as the last 100 days’ moving average (i.e. use the indicator X - avg(close,
100), w hich is found in the Simple Moving Average Category)

e  Use price relative to some index w hich could flatten the graph

. Use change in price

. Use percent change in price

. Use ratios of tw o variables to make one variable w henever possible

Of course, you can avoid normalization if you don’t go so far back in time for sample patterns that the price levels w ere
radically different.

Predict the Change (or Percent Change) of the Open vs. Close

If you are like most people, you dow nload your data at night, run your analysis, and place your order for tomorrow ’s open
based upon that analysis. In this case it makes the most sense to predict the Change (or Percent Change) of the Open, not the
Close. The reason for this is because the most interesting (and useful) prediction is one that predicts the difference betw een
your entry point and your exit point (w hich is the open).

When you use the Change in Open or Percent Change in Open for your output, the NeuroShell Trader predicts the movement
betw een the next bar’s open and the open <Trading Bars> ahead of the next bar.

Assume you could predict the Percent Change in Open for 1 trading day into the future from the next open 100% accurately. If
the prediction triggered a buy signal tonight, you w ould know that if you bought at the open tomorrow and sold at the open the
next day, your profit w ould be exactly w hat the neural net predicted.



Now assume you could predict the Percent Change in Close for 1 trading day into the future 100% accurately. If the prediction
triggered a buy signal tonight, you COULD ACTUALLY LOSE MONEY if you bought at the open tomorrow and sold at the open
the next day, even though your prediction is 100% accurate. You w ould lose money anytime the close tomorrow is higher than
the close today, but the market opened higher tomorrow than it opened the day after tomorrow .

Predict the Optimal Change (or Optimal Percent Change)

The optimal change outputs provide a more robust interpretation of the change in price. The optimal change outputs compute
the price movement from the current value to the next peak or valley found w ithin the specified number of bars into the future.
By doing so, they avoid the problem of premature exit signals that often occur w hen predicting the change.

Take as an example the case w here you are in a long position and the current price is at 100. The price rises to 125 over the
next 5 days and then drops dow n to 85 the follow ing 5 days. If you w ere predicting the 10 day change in price, the change
would be -15 and you w ould prematurely exit your position thinking the price w as heading dow nw ard. In this case, you don’t
w ant to exit the long position because there are still another 5 days and 25 points of upw ard price movement.

In contrast to simply predicting the change, the optimal change outputs only predict the price change to the next peak/valley
w ithin the specified number of bars into the future. The logic used to calculate the optimal peak/valley indicators is as follow s:

1. Choose the initial peak/valley by determining if the highest price value or the low est price value w ithin the specified
number of bars into the future w ill produce the largest absolute price change from the current price.

Continue calculating the change to the chosen peak/valley until the peak/valley is reached.
Once the peak or valley has been reached, start again at #1

In the example above, the optimal change indicators w ould initially choose the peak at 125 and continue calculating the change
to 125 until 125 w as reached. After that, they w ould then decide w hether the absolute change of 40 to the valley at 85 is the
next target or w hether a new peak has entered the future lookforw ard window w hich w ould have a larger absolute price
change than 40 (i.e. a peak at 165 or higher).

Predicting a Peak or Valley in Prices

If you only w ant to predict w hether you are approaching a price peak or a price valley and not the actual magnitude of change

to the upcoming price peak or price valley, then you may w ant to use the Optimal Buy/Sell and the optimal Buy/Sell/Hold outputs.
These outputs are calculated in the exact same manner as the optimal change outputs above, except that they provide a simple
buy/sell/hold value instead of a dynamic price change.

The Optimal Buy/Sell output is a buy(1) w hen prices are going upw ards tow ards a price peak and a sell(-1) w hen prices are
going dow nw ards tow ards a price valley.

The buy/sell/hold indicator is similar to the buy/sell except that it changes from a buy(1) to a hold(0) w hen the distance to the
next peak is less than the distance to the valley that follow s the peak. The buy/sell/hold indicator also changes from a sell(-1)
to a hold(0) w hen the distance to the next valley is less than the distance to the peak that follow s the valley.

Be Careful with Noisy Price Movement

Price indicators tend to have a lot of noisy movement in them. If you have trouble predicting price indicators, explore predicting
a moving average or other indicators. If you predict a moving average, make sure that the number of bars into the future that
you are predicting is at least as long as the bars you are averaging. This will insure that no component of the output is used as
an input to the neural net.
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Neural Network - Optimization Discussion (Professional Only)

Input Selection - In this mode the genetic algorithm selects w hich of the inputs you have chosen are most useful. Only the
ones it decides are best are used in the final training. Note that the usefulness of an input is evaluated in conjunction w ith all
other inputs. In other w ords, the GA is really finding an optimum SET of inputs, not inputs that are necessarily useful by their
self. These inputs do not have to be indicators built by the Trader. They can be any data stream you load. You can add quite a
few more indicators than you w ant to eventually use (w e w ouldn't suggest many more than 20 to 60 for best results).

Elsew here in the wizard you will specify the maximum number of inputs that you w ant the GA to keep (w e like betw een 3 and
12 to enhance chances of good generalization). The GA w ill search through combinations looking for the set of inputs w hich is
less than or equal to the maximum number of inputs that you specified and w hich, as a set during training, optimizes the training
criteria (e.g., maximize profit, minimize error, etc.). No parameters of any of the inputs that are indicators are modified or
optimized; they are used just as you have specified them.

Parameter Search - In this mode, the genetic algorithm wiill use all of the inputs you have chosen, but it w ill optimize the
parameters of all indicators you have used as inputs, even if they are embedded in other indicators. In other w ords, if one of
your inputs is the 10 period lag of the 5 period momentum of the close, the genetic algorithm may change the periods to 6 and 3
respectively if the resulting indicator w orks best. (You can even tell it to select among open, high, low, and close). Note that the
evaluation is in combination w ith the other optimized indicators and other inputs. In other w ords, it is possible that the
parameterization of an indicator does not produce an indicator that is useful by itself. It may only be useful in combination w ith
the entire set of optimized inputs. Note that optimization can only be accomplished on indicators w hich you have entered using
the NeuroShell Trader's Indicator Wizard (even if it w as entered from the Prediction Wizard). Other data streams used as inputs
w il still be used during optimization, but not optimized. Keep your number of inputs betw een 5 and 30 for best results.

Full Optimization - In this mode, both Input Selection and Parameter Optimization are accomplished at the same time.
This is a very advanced concept, and w e are not currently aw are of any other programs capable of this using a GA. Note
how ever, that the GA is doing more w ork (i.e., using more variables) than in doing either input selection or parameter
optimization separately. Therefore, for best results, keep your number of inputs below about 30 if they are all indicators.

No Optimization - In this mode, neither Input Selection nor Parameter Optimization is used. The inputs are used just as
you have selected them.

There is an additional form of optimization called threshold optimization that can take place (or not) in any of the modes above,
including the no optimization mode. Threshold optimization is discussed in Prediction Parameters - Positions and Neural Netw ork
— Netw ork Parameters Discussion (Objective).
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Neural Network - Input Discussion

Of course, as w ith all netw orks, the key to success is choosing the correct predictive variables. Current prices, moving
averages, lagged prices, price changes, and related indicators are good basic variables from w hich the netw ork can start, but
try to find indicators that precede a price change. Picking w hich variables to include in your neural netw ork is crucial to making
your neural netw ork w ork properly. These wiill be the netw ork’s inputs.

Note: You must choose data that is available at the time the prediction is made. This excludes indicators that incorporate future
data (i.e., use of the lead indicator) because this is providing future data that is not know at the time of prediction, and the
prediction w ill not extend into the future due the need for future data as an input.

Neuron Strength

A neural netw ork expects each input to be a continuous variable that represents the strength of the input neuron. Therefore, a
numeric input is really the strength of the input neuron. For example, suppose the input is annual rainfall ranging from 0 to 25
inches. You can see that the input is the "strength" of the rainfall.

But suppose you try to define an input that is a US state code from 1 to 50, w here 1 is Alabama, 2, is Alaska, and so on to 50
for Wyoming. Because the neural netw ork thinks the input is strength, it will assume that Alaska is very much like Alabama,
and a lot different from Wyoming, w hich probably doesn’t make any sense.

Suppose you are attempting to predict the yields of municipal bonds, a useful input might be in w hich state the municipal bond
resides. There are several w ays you could handle the input:

. Order the states by some meaningful ranking criteria, like average income of the inhabitants, gross tax income per
person, etc. Then you can use a code from 1 to 50 w here 1 is the highest income, 50 is the low est income, or 1 is
the least taxed, 50 is the most taxed, etc.

e Make 50 inputs, one for each state. One State variable will be on (coded as 1) and the others wiill be off (coded as
0). This is a valid method of representing up to about 10 categories, how ever for the States example this method
w ould produce too many variables for the net to learn.

e Make 50 predictive nets, one for each state.

Market Variables

Users doing financial applications or other time series problems may use fundamental indicators in addition to raw price data,
such as interest rates, price of gold, etc. They may also find it helpful to create additional input variables derived from the raw
input data they already have, such as lagged versions or averages of the raw data.

When deciding on variables, it’s usually better to include more variables than not enough variables (up to a point). Include all of
the inputs that seem reasonable because neural netw orks can find subtle differences in data patterns that even our brains can
’t discern. Too many inputs w ill cause the net to over-train, meaning the net w ill learn the training data very w ell, but do poorly
on out of sample examples (your evaluation set). A good number of inputs to use is betw een 6 and 30 for financial problems.
You should also use at least 10 times as many training patterns as inputs. How ever, even if you have thousands of training
samples (data in the training set), you should try to limit your number of inputs to few er than 30.

Indicators

Users doing financial applications or other time series problems may find it helpful to create additional input variables derived
from the raw input data they already have. Some examples of these additional inputs are:

. Lagged versions of the raw data. For example, if your raw data is today’s price and you are trying to predict
tomorrow ’s price, then it may be helpful to include yesterday’s price, and the price the day before as well.

e Averages of previous raw data (i.e., rolling averages)

. Changes (deltas) in the raw data. For example, you might w ant the difference in today’s price and yesterday’s
price. You can also lag or average changes in the raw data.

These are just a few examples and certainly are not the best indicators that can be used. For more information on Indicators
see What are Indicators?

Using Predictions as inputs to Predictions

Some users have found that it is useful to use the results of one prediction as an input to another prediction. This may be
considered by some as one expert using another expert’s analysis to make their ow n analysis. If you decide that you w ant to
use this method be sure to review Using Predictions.
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Neural Network - Network Parameters Discussion

Training Set

The training set is used to "teach" the neural netw ork the patterns that it should recognize. NeuroShell Trader creates the
training set by calculating and retrieving the inputs that you have selected in the prediction input list.

For more information: What is Training Data?

Paper Trading (calibrating your model so that it has the best chance of w orking in the future)

(Professional Only) Paper trading has a special meaning in the NeuroShell Trader Professional and DayTrader Professional.
Paper trading is activated w hen you choose the option called "Save optimization w hich performs best on later paper trading”,
either in the Prediction Wizard or theTrading Strategy Wizard.

Before w e explain w hat it is, a little background is necessary about a modeling problem common to all model building w ith past
data.

Any time you optimize there is a possibility that you may "over-fit", w hich means that you build a model that w orked so w ell in
the past that it fit the past noise too, so that it probably w ill not w ork w ell into the future. (Editors note: some people use the

w ord "curve fitting to describe the over-fitting phenomenon, but that is a misnomer because all modeling from past data is curve
fitting - it is over curve fitting, i.e. or over-fitting, that is the problem).

Over-fitting can occur even if you do not optimize, because in fact w hen you backtest different strategies to see w hich w orks
the best, you are in fact optimizing manually! How ever, machine optimizing increases the odds of over-fitting because it is so
much more efficient. The possibility of over-fitting is reduced by not optimizing, optimizing over plenty of historical data, and/or
optimizing as few parameters as possible.

One w ay that has been traditionally used to test if over-fitting has occurred is simply to see how the model holds up on new
data. There are a couple of w ays that can be done:

a. Of course you could simply w atch your model for several w eeks or months and "paper trade" it in the traditional sense to
see if you would have made money. Few of us w ant to take the time to do that, how ever.

b. Another w ay to do this in NeuroShell is to use the check box called "Start trading before last chart date" in the Dates tab.
That will allow you to select how much time to "hold out" of the optimization for evaluation of the model after it is optimized.
Optimization w ill take place on an earlier period of the chart, and the final backtesting (evaluation) using the model w ill take
place immediately after that. The disadvantage of this "hold out" approach is that even if you are satisfied the model held up
during evaluation, you essentially have an old model, one that w as not built on the latest data (although it w as evaluated on the
latest data). In order to use "Start trading before last chart date", you must turn on the option that enables it from the menu
Tools->Options-> Advanced.

Consider the approach b. (above) further. Using the evaluation of new data (called out-of-sample data by statisticians), w hat
you w ill wind up doing is repeatedly optimizing models until you find the one that w orks the best on the new data, i.e. the one
that show s up best during the evaluation (out-of-sample period). This is sometimes called "data snooping" because your
evaluation data is not really out-of-sample anymore. Nevertheless it is still the most effective method to arrive at a model w hich
has the best likelihood of holding up as you trade with it in the future.

Therefore, w e have automated this process of building models, then evaluating them, keeping the one that w orks best during
evaluation. The automated method is invoked w hen you check the box called "Save optimization w hich performs best on later
paper trading" in the Dates tab. (Editor’s note: Ward Systems Group invented the method for use w ith neural nets years ago.
We included it in all of our old softw are, and the technique, there called "calibration", has been copied and adopted by other
vendors and academia.)

Of course if you data snoop, statisticians will say that you still haven’t properly evaluated your model w ith real out of sample
data. Of course statisticians usually assume normal distributions, and a number of other factors not present in market trading.
How ever, if you w ant to build your model w ith paper trading and still satisfy the statistician in you, you can select both of the
boxes:

(Professional Only) "Save optimization w hich performs best on later paper trading"
"Start trading before last chart date"



That w ill enable saving the model w hich w orks best on paper trading, w hile still giving you a real out-of-sample period as
described in b. above. The disadvantage is that you have an old model, at least as old as the out-of-sample trading period.
Given that the market is frequently changing, and w e suspect the number of statisticians w ho got rich in the market is quite
small, w e suggest that you consider using the paper trading feature w ithout the added out-of-sample period.

Objective

The objective is the method used to train the net. NeuroShell Trader allow s you to train the net using a variety of objective
functions. The objective is the method that the prediction determines w hat the "best" neural net is during training (Professional
Only) and optimization. Please refer to Error Objective Functions and Trading Objective Functions for more information.

Minimizing Prediction Error is the default method of training a neural netw ork and has historically been the method chosen to
train neural netw orks. How ever, NeuroShell Trader offers a new and pow erful set of w ays to train neural netw orks, including
a variety of ‘Training on Profit” methods.

If you choose to train by Minimizing Prediction Error, or any of the other ‘non-Train on Profit’ objectives, you may specify
Trading Rules to view how w ell the Neural Netw ork w ould have traded. This can often be helpful in determining the usefulness
of a prediction, because a prediction may have very little error, but may not be good enough to trade with. Contrarily, a
prediction may have a large error, but may trade very well.

When selecting any of the ‘Training on Profit” objectives you must specify the associated trading rules (Both Long and Short,
Long Positions Only, or Short Positions Only, as well as the trading rule thresholds). These rules can be as important to
making a profitable netw ork as selecting the proper inputs (obviously rules that are too strict, might result in a trading strategy
that never makes any trades and thus never makes any money).

(Professional Only) Additionally, you may select Find the optimal trading rules, w hich w ill automatically find an optimal set
of trading thresholds for you. This method is recommended because you may find a set of inputs that predict very w ell, but
have the incorrect thresholds, and therefore the prediction performs poorly.

Note that if you are trading Both Long and Short positions and your thresholds overlap (e.g., Long Exit < 0 and Short Entry <
1), you wiill not enter into the opposite position until after you have exited the first position (e.g., you won’t go short until you
exit your long position first).

(Professional Only) Advanced

The advanced tab can play a very important role in how optimization is accomplished. Since these are professional features,
you have some flexibility in determining how the program w orks w ith these features. You also have a responsibility to
experiment and find out w hat is right for you; w e cannot do more than provide general guidelines.

Realize that during optimization, the genetic algorithm is choosing inputs, parameters, and thresholds (depending upon your
selections) and then training and applying a netw ork w ith each such choice. Hundreds or even thousands of netw orks might
be trained.

Understand too that the Turboprop 2 netw ork paradigm trains by adding hidden neurons one by one, up to a maximum of 80.
Zero hidden neurons produce a linear model, and the model becomes more and more non-linear the more hidden neurons are
added. Generally speaking, the more hidden neurons added, the "tighter" the fit becomes and the longer the training takes.
Previous practitioners of older types of neural nets like the primitive "backpropagation" nets are cautioned not to try to equate
Turboprop 2 performance w ith a certain number of hidden nodes w ith backpropagation performance using the same number.
These are very different algorithms.

The sliding bar used to adjust the number of hidden neurons is labeled Number of hidden nodes during training.

Next, w e will discuss the small check box marked Adjust training set for trending markets by evenly distributing
training bars. Understand that neural netw orks are pattern recognition devices: they make predictions based upon w hat
happened during training w hen they encountered similar patterns. If your training set covered a period of a strong and
sustained bull or bear market, the majority of the patterns are likely to be all in one direction. Neural nets aren't likely to predict
the other direction w ell at all in such a case. Ideally, you'd like to have about half of your training patterns show ing up trends,
and the other half show ing dow n trends, to varying degrees.

Turning on this option w ill cause your training sets to be automatically balanced in this w ay. If you are predicting some output
that show s both positive and negative numbers (like percent change), the algorithm wiill produce a training set having roughly
the same number of both signs. If your output is an indicator that alw ays has the same sign (like an indicator that is alw ays

betw een 0 and 100) then the algorithm w ill select even numbers above and below the mean based on the data’s distribution.

Selecting the Shortest Average Trade Span option forces the optimization to choose a neural netw ork that guarantees an



average trade span greater than or equal to the Shortest Average Trade Span over the optimization period. The optimization
period is set by the Number of optimal walk-forwards on the General Tab. Use this option is to decrease the number of
trades if you find that optimization produces too many trades over the optimization period. It is recommended that you choose
this option only if you are unable to achieve your goals using other methods.

Selecting the Longest Average Trade Span option forces the optimization to choose a neural netw ork that guarantees an
average trade span less than or equal to the Longest Average Trade Span over the optimization period. The optimization period
is set by the Number of optimal w alk-forw ards on the General Tab. Use this option to increase the number of trades if you find
that optimization produces too few trades over the optimization period. It is recommended that you choose this option only if
you are unable to achieve your goals using other methods.

The average trade span is the average number of bars that all of the trades are in over the optimization period. An acceptable
average trade span may produce undesirable trades by having one very long trade and several short trades. Selection of the
Shortest and Longest Average Trade Spans are not necessarily the answ er to your problems.

Finally, if you have selected the Input Selection or Full Optimization mode of optimization, you may select the Maximum
number of inputs that the GA is allow ed to use. The GA may determine that less is better. Remember that the more inputs in
a netw ork, the greater the chances of "over-fitting".
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Neural Network - Output Discussion

Once you’re familiar w ith neural netw orks, you realize they can help you solve many different problems. You also know from
experience there is more than one w ay to approach a problem. For example, if you’re creating a neural netw ork to predict
stocks, you can predict a number of things: stock price, change in a stock price, percent change in a stock price, stock
volatility, etc. You could also classify the market as to w hether it is going bull or bear, or you could get the netw ork to make a
buy, sell, or hold decision. In any of the above choices, you have a number of options about how far ahead you w ant to
predict. The variables you w ant to predict or classify will be the neural netw ork outputs.

Normalizing Variables (why you shouldn’t predict the Close)
Suppose you w anted to use a price indicator as a variable that has a graph over time that looks like the follow ing graph:

Price

Time
As you can see, a distinct pattern is evident even to our ow n neural netw orks, but this could look like three different patterns to

a neural netw ork because they occur at different price levels! Ideally, w e’d like to present the data to the netw ork as in the
follow ing graph:

Price

Time

The w ay to do this is to create an indicator that normalizes the data. There are many w ays this can be done, among them:

. Use price relative to some baseline, such as the last 100 days’ moving average (i.e. use the indicator X - avg(close,
100), w hich is found in the Simple Moving Average Category)

e  Use price relative to some index w hich could flatten the graph

. Use change in price

. Use percent change in price

. Use ratios of tw o variables to make one variable w henever possible

Of course, you can avoid normalization if you don’t go so far back in time for sample patterns that the price levels w ere
radically different.

Predict the Change (or Percent Change) of the Open vs. Close

If you are like most people, you dow nload your data at night, run your analysis, and place your order for tomorrow ’s open
based upon that analysis. In this case it makes the most sense to predict the Change (or Percent Change) of the Open, not the
Close. The reason for this is because the most interesting (and useful) prediction is one that predicts the difference betw een
your entry point and your exit point (w hich is the open).

When you use the Change in Open or Percent Change in Open for your output, the NeuroShell Trader predicts the movement
betw een the next bar’s open and the open <Trading Bars> ahead of the next bar.

Assume you could predict the Percent Change in Open for 1 trading day into the future from the next open 100% accurately. If
the prediction triggered a buy signal tonight, you w ould know that if you bought at the open tomorrow and sold at the open the
next day, your profit w ould be exactly w hat the neural net predicted.



Now assume you could predict the Percent Change in Close for 1 trading day into the future 100% accurately. If the prediction
triggered a buy signal tonight, you COULD ACTUALLY LOSE MONEY if you bought at the open tomorrow and sold at the open
the next day, even though your prediction is 100% accurate. You w ould lose money anytime the close tomorrow is higher than
the close today, but the market opened higher tomorrow than it opened the day after tomorrow .

Predict the Optimal Change (or Optimal Percent Change)

The optimal change outputs provide a more robust interpretation of the change in price. The optimal change outputs compute
the price movement from the current value to the next peak or valley found w ithin the specified number of bars into the future.
By doing so, they avoid the problem of premature exit signals that often occur w hen predicting the change.

Take as an example the case w here you are in a long position and the current price is at 100. The price rises to 125 over the
next 5 days and then drops dow n to 85 the follow ing 5 days. If you w ere predicting the 10 day change in price, the change
would be -15 and you w ould prematurely exit your position thinking the price w as heading dow nw ard. In this case, you don’t
w ant to exit the long position because there are still another 5 days and 25 points of upw ard price movement.

In contrast to simply predicting the change, the optimal change outputs only predict the price change to the next peak/valley
w ithin the specified number of bars into the future. The logic used to calculate the optimal peak/valley indicators is as follow s:

1. Choose the initial peak/valley by determining if the highest price value or the low est price value w ithin the specified
number of bars into the future w ill produce the largest absolute price change from the current price.

Continue calculating the change to the chosen peak/valley until the peak/valley is reached.
Once the peak or valley has been reached, start again at #1

In the example above, the optimal change indicators w ould initially choose the peak at 125 and continue calculating the change
to 125 until 125 w as reached. After that, they w ould then decide w hether the absolute change of 40 to the valley at 85 is the
next target or w hether a new peak has entered the future lookforw ard window w hich w ould have a larger absolute price
change than 40 (i.e. a peak at 165 or higher).

Predicting a Peak or Valley in Prices

If you only w ant to predict w hether you are approaching a price peak or a price valley and not the actual magnitude of change

to the upcoming price peak or price valley, then you may w ant to use the Optimal Buy/Sell and the optimal Buy/Sell/Hold outputs.
These outputs are calculated in the exact same manner as the optimal change outputs above, except that they provide a simple
buy/sell/hold value instead of a dynamic price change.

The Optimal Buy/Sell output is a buy(1) w hen prices are going upw ards tow ards a price peak and a sell(-1) w hen prices are
going dow nw ards tow ards a price valley.

The buy/sell/hold indicator is similar to the buy/sell except that it changes from a buy(1) to a hold(0) w hen the distance to the
next peak is less than the distance to the valley that follow s the peak. The buy/sell/hold indicator also changes from a sell(-1)
to a hold(0) w hen the distance to the next valley is less than the distance to the peak that follow s the valley.

Be Careful with Noisy Price Movement

Price indicators tend to have a lot of noisy movement in them. If you have trouble predicting price indicators, explore predicting
a moving average or other indicators. If you predict a moving average, make sure that the number of bars into the future that
you are predicting is at least as long as the bars you are averaging. This will insure that no component of the output is used as
an input to the neural net.

Topic of Interest:
What are Neural Netw orks?



Advanced Users

The follow ing information is for those users w ho have previously used another neural netw ork program, such as our own
NeuroShell 2 Professional System. The neural net included in the NeuroShell Trader is unlike any other type of netw ork you
may have used. Unlike other backpropagation netw orks, for example, it learns quickly and a test set is not required to improve
the net’s ability to generalize (give reasonable answ ers on data it has never seen before). Because the net is designed to
generalize w ell rather than to memorize training data, it may or may not do as w ell on the training set as it does on other data.

If you have w orked w ith NeuroShell 2, you most likely used Calibration. Calibration requires the extraction of a test set from
your original data in order for the netw ork to generalize w ell on new data. The remainder of the original data w as called the
training set.

The training procedures in NeuroShell 2 actually used both the training and test sets in order to create a model. Therefore, if
you w ant to compare the results of a NeuroShell 2 net w ith those in the NeuroShell Trader, you must use all of your original
data (both the training and test sets) w hen you train your model w ith the NeuroShell Trader. It has a built-in method for making
the model generalize w ithout extracting a test set.

The nets in the NeuroShell Trader do not require you to set parameters such as learning rate and momentum, so they are easier
to use than backpropagation nets. Additionally, the nets can only have one output, so if you w ant to predict more than one
output, you need to create separate models for each output using the same set of inputs. Finally, the neural net w orks better
w ith continuous value inputs than it does w ith binary inputs (1’s and 0’s).



What are Genetic Algorithms? (Professional Only)

Genetic algorithms (GAs) seek to solve optimization problems using the methods of evolution, specifically survival of the fittest.
In a typical optimization problem, there are a number of variables that control the process, and a formula or algorithm that
combines the variables to fully model the process. The problem is then to find the values of the variables that optimize the
model in some w ay. If the model is a formula, then w e w ill usually be seeking the maximum or minimum value of the formula.

For example, if your company has $100,000 to spend on different types of advertising such as TV, radio, and print, w hat is the
best mix of the different types that w ill maximize sales? The dollars spent on each type of ad are the variables that control the
process. A formula would be used to calculate sales dollars. The genetic algorithm w ould try different combinations of dollar
values for each type of advertising until it found a combination that maximizes sales (as computed by the formula). A genetic
algorithm, how ever, does not use an exhaustive search technique; it is much faster and more efficient than that.

There are many mathematical methods w hich can optimize problems of this nature (and very quickly) for fairly "w ell behaved"
problems. These traditional methods tend to break dow n w hen the problem is not so w ell behaved. Examples of these types
of problems include combinatorial problems, or problems w here the fitness function is not a smooth, continuous mathematical
formula.

Evolution and Genetic Algorithms

Before describing how a genetic algorithm can be applied to an optimization problem, let us draw the evolutionary parallel. The
theory is that a population of a certain species will, after many generations, adapt to live better in its environment. For example,
if the species is an animal that lives mainly in a sw ampy area, it may eventually evolve w ith w ebbed feet. The reason is that
the members of this population, w hich w e w ill call individuals, wiill tend to die if they are poor swimmers that cannot easily get
food, and tend to live and reproduce if they are good swimmers. The offspring of tw o good sw immers w ill probably be good
swimmers as w ell because they will usually carry genetic traits of their parents, such as slight w ebbing betw een the toes.
These genetic traits are carried in chromosomes in the individuals.

Plant or animal breeders often use selective breeding techniques w herein they choose parents for breeding based upon the
intensity of desirable traits with w hich the prospective parents are endow ed. These breeders are using the same evolutionary
techniques.

Topics of Interest:

How Does a Genetic Algorithm Work? (Professional Only)

Why is a Genetic Algorithm Better Than Other Optimizers? (Professional Only)

What Types of Problems Do Genetic Algorithms Solve? (Professional Only)

How are Genetic Algorithms Used in the NeuroShell Trader Professional? (Professional Only)



How Does a Genetic Algorithm Work? (Professional Only)

A genetic algorithm solves optimization problems by creating a population or group of possible solutions to the problem. The
individuals in this population will carry chromosomes that are the values of variables of the problem.

The genetic algorithm actually solves your problem by allow ing the less fit individuals in the population to die (peacefully) and
selectively breeding the most fit individuals (the ones that solve the problem best). This process is called selection, as in
selection of the fittest. The genetic algorithm w ill take tw o fit individuals and mate them (a process called crossover). The
offspring of the mated pair will receive some of the characteristics of the mother, and some of the father.

In nature, offspring often have some slight abnormalities, called mutations. Usually these mutations are disabling and inhibit the
ability of the children to survive, but once in a w hile they improve the fitness of the individual (like toes stuck together in a

w eb-like fashion). The genetic algorithm similarly occasionally causes mutations in its populations by randomly changing the
value of a variable.

After the genetic algorithm mates fit individuals and mutates some, the population undergoes a generation change. The
population will then consist of offspring plus a few of the older individuals, w hich the genetic algorithm allow s to survive to the
next generation because they are the most fit in the population, and w e will w ant to keep them breeding. These most fit
individuals are called elite individuals.

After dozens or even hundreds of "generations", a population eventually emerges w herein the individuals w ill solve the
problem very w ell. In fact, the most fit (elite) individual w ill be an optimum or close to optimum solution.

The processes of selection, crossover, and mutation are called genetic operators.
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Why is a Genetic Algorithm Better Than Other Optimizers? (Professional Only)

There are many opportunities for optimization in technical analysis. Prior to the NeuroShell Trader Professional, some trading
systems had optimizers, but the optimization technique used w as simple "exhaustive search", meaning that every possible
combination w as tried to see w hat w as the best one. This is a very accurate approach, since you are bound to find the best
combination of variables - eventually. How ever, it is a very inefficient approach, because w henever there are more than a few
thousand combinations, it takes too long to try them all. That is w hy users of exhaustive search optimizers tend to limit the
number of variables they use, or tend to limit the number of values these variables can take.

The genetic algorithm, by contrast, does not try every possible combination. It attempts instead to intelligently get closer and
closer to the best solution. Therefore, far more variables can be utilized, and you can allow all values of a variable. Optimization
can still take a good deal of time if you give a GA a fair number of variables, but it will be doing much more w ork in that amount
of time.

More efficient optimizers than exhaustive search optimizers are in use. If they are not genetic algorithms, how ever, they are
most likely only searching one section of the search space at a time. Genetic algorithms are searching dozens or hundreds of
parts of the search space simultaneously. This means they are impervious to becoming stuck in "local minima" as the others
quite often do. (Local minima are decent solutions that the optimizer can never get out of in order to find better solutions.)
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What Types of Problems Do Genetic Algorithms Solve? (Professional Only)

A genetic algorithm is a computational method modeled on biological evolutionary processes that can be used to find the
optimum solution to a problem that may have many solutions. For example, you can use genetic algorithms to find the maximum
and the minimum of a function, to find an optimal route on a map, or to minimize the cost of manufacturing your products. They
can be used to find an optimal set of parameters (such as the optimal number of shares of each type of stock in a portfolio), or
to select an optimal sequence of events (such as the shortest route to cover a sales territory). In other w ords, genetic
algorithms can be pow erful tools for finding the best of millions of possible solutions for different real life problems.

These algorithms have been found to be very pow erful in solving optimization problems that appear to be difficult or even
unsolvable by traditional methods. Genetic algorithms use a minimum of information about the problem and they only require a
quantitative estimation of the quality of a possible solution. This makes them easy to use and applicable to most optimization
problems.

Genetic Algorithm Applications

The follow ing is a list of some of the applications developed by Ward Systems Group customers. Business applications for
genetic algorithms include:

Business

Optimizing process control operations

Scheduling salesman or delivery routes

Minimizing manufacturing time

Optimizing budget allocations to different departments to maximize profit
Optimizing retail site locations

Group packages w ith different dimensions into delivery lots

Finance

Generating rules to predict a rise in stock indexes

Optimally group stocks w ith different values into balanced portfolios

Minimize financial risk managing a fund w hile simultaneously trying to maximize return
Optimize technical indicators

Finding optimal trading strategies

Medicine

Optimize treatment programs

Schedule use of medical treatment practitioners and/or facilities
Classify patients into groups for experimental studies

Schedule medical students through training and clinical rotations

Science

Maximize polymer qualities based upon different composition materials

Optimize chemical reactions based on different chemicals or processing times

Maximize forest yield by varying types of trees planted, fertilization, and cutting practices

And many more!
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How are Genetic Algorithms Used in the NeuroShell Trader Professional? (Professional Only)

In the Prediction Wizard, genetic algorithms are used to find:

1. The best inputs to a neural netw ork
2. The best parameters for indicators used as inputs to a neural netw ork
3. The best buy/sell thresholds for neural nets

In the Trading Strategy Wizard, genetic algorithms are used to find:

1. The best trading rules to use
2. The best parameters for indicators used in trading rules
3. The best parameters for indicators used in limit orders, stop orders, and stop limit orders

In order for a genetic algorithm to optimize, it has to have an idea of w hat fit individuals in the population look like (the fitness
function). The fitness function is the Training Objective in the Prediction Wizard, and the Objective in the Trading Strategy
Wizard. You wiill find that these are objectives like "minimize error", "maximize correlation”, "minimize draw dow n", "maximize net
profit", etc. To a very great extent, your choice of the objective (fithess) function can have a great bearing on how w ell the
optimization goes, and how w ell the optimized model w orks later on out of sample data. Unfortunately, there are no universal

guidelines.
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Creating a Prediction

Creating a prediction wiill allow you to add a prediction of a value to your chart. The prediction is made using neural netw orks.

1. Select New Prediction from the Insert menu. This activates the prediction w izard, w hich guides you through the
process of creating a prediction.

Existing Data | Calculations ...

Mew Indicator ..,

Mew Trading Strakegw ...
Mew Alert ...

Qther Instrument Data ...

Note:
e You can have multiple predictions displayed on a chart by simply creating more than one prediction.

Topics of Interest:
What are Neural Netw orks?
Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful



Prediction Wizard - Templates

This screen show s the prediction templates available for use. Prediction templates are preconfigured predictions that allow
you to create a prediction quickly w ithout having to know or w orry about all the details of creating one from scratch.

To select an existing template:
1. Select the desired template from the list.

To create a prediction from scratch
1. Select (No Template) located at the top of the list.

When you are satisfied w ith the template the prediction will use press the Next button to proceed to the next wizard screen.

Topics of Interest:
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Prediction Wizard - Listing Inputs

Listing inputs allow s you to select inputs that you w ant the neural netw ork to use as inputs for your prediction. For more
information see Neural Netw ork - Input Discussion.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters.
(Professional Only) Clicking on the + sign wiill show the indicator’s parameters if you have selected Input Selection or No
Optimization. The parameter ranges to be searched during optimization w ill be show n if you have selected Parameter
Optimization of Full Optimization.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or hide the indicator’s parameter range to be searched during optimization.

Make a list of the inputs you w ish to use for your prediction.

. To add data items to the list:
1. Press the Add Input(s) button.

e To modify an input, input’s parameter, or (Professional Only) input’s parameter range:
1. Select the item in the list you w ish to modify.
2. Press the Modify Input button or Modify Param eter button (depending on w hat item you have selected).
Or
1. By double-clicking on the item in the list you w ish to modify.

. To remove items from the list:
1. Select the item or items in the list you w ish to remove.
2. Press the Remove Input(s) button or press the delete button on you keyboard.

When you are finished making a list of inputs you w ish to use for your prediction press the Next button to proceed to the next
wizard screen.

Note:

e (Professional Only) If you have selected Parameter Optimization or Full Optimization and you do not w ant a particular
parameter to be optimized, then set both its beginning and ending parameter range to the same value.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Input Discussion

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful
Using Predictions



Prediction Wizard - Parameters

This screen show s the parameters the prediction will use w hen training. Among other things, parameters are used to
determine the number and type of w alk-forw ard tests, as w ell as the training set size and the training objective (training by
profit or error). The defaults set are very useful for a broad variety of problems and should be used unless you consider
yourself an advanced user. For more information on training sets, w alk-forw ard tests, and objectives see Neural Netw ork -
Netw ork Criteria Discussion

This screen may or may not be displayed depending upon the currently selected Prediction Wizard Interface Options. If
displayed, the list will show only the parameters w hose interface options have been selected. All other parameters are set to
their default values and do not appear in the list w hen the corresponding interface option has not been selected. Press the
Options button to change the Prediction Wizard Interface Options. For more information see Prediction Wizard Interface
Options.

If you wish to change any of these parameters:
1. Press the Change Prediction Parameters button.

When you are satisfied w ith the parameters the prediction w ill use w hen training press the Next button to proceed to the next
wizard screen.
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Prediction Wizard - Training Results

This screen show s the results of your prediction during training and after the neural netw orks are finished training. For more
information see Neural Netw ork - Results Discussion

If at any time during training, you w ant to abort training, press the Abort Training button. After training has been aborted, you
may do any of the follow ing:

. Press the Retrain button to restart training of the neural netw orks.
. Press the Back button to modify the neural netw ork output, input list, or training criteria.
e Press the Cancel button to exit the prediction wizard w ithout saving any results.

. Press the minimize icon at the top right corner of the w izard to minimize the entire NeuroShell Trader application. Doing so
will allow you to w ork w ith other programs during training. Note that using the Show Desktop Window s task bar icon,
typically located next to the Window s Start button, will also minimize the NeuroShell Trader application.

(DayTrader Only) During market hours, optimization and training may be much slow er if processor time is being utilized to update
charts with real-time data. Use the "Don’t update chart w hile optimizing/training" check box to turn off the real-time updating
chart during optimization/training.

After training of all w alk-forw ards and current netw orks has finished, you may do any of the follow ing:

. Sort the results list by clicking on the column header by w hich the list should be sorted. Clicking once wiill sort the list in
ascending order based upon the values in that column. Clicking a column header a second time wiill sort the list in
descending order based upon the values in that column.

. Press the Retrain button to restart training of the neural netw orks.

If you have new data since you last trained your prediction you w ill be given the option to Carry Forw ard your prediction
or retrain/optimize w ith the most recent data.

(Professional Only) If you are optimizing, you will be given the choice to optimize starting at the last optimal settings,
reoptimize starting from scratch, or simply retrain with the last optimal settings (no optimization occurs).

. Press the Finished button to end the wizard and add the prediction to your chart

. Press the Back button to modify the neural netw ork output, input list, or training criteria.

. Press the Cancel button to exit the prediction wizard w ithout saving any results.

. Press the Prediction Analysis button to view detailed analysis of the selected prediction.

. Press the Save as Tem plate button to save the prediction as a new prediction template. Saving the prediction as a
template allow s you to apply the same prediction to different charts w ithout having to recreate the prediction from scratch.

. Press the Print button to print a copy of the prediction.

The columns and statistics that are displayed can be customized in the Results Screen Columns section of the Prediction
Wizard Interface Options. Press the Options button to change the Prediction Wizard Interface Options. For more information
see Prediction Wizard Interface Options.

Notes:

. When the prediction is added to the chart and either long and/or short positions are allow ed for calculating trading
statistics, a price line will be displayed w ith annotated trades for the prediction. The price line will be split into gray,
orange, and/or green sections to correspond to the data sets used to evaluate the prediction as configured on the date tab
of the prediction parameters.

. When the prediction is added to the chart and no trading positions has been selected, tw o lines w ill be displayed. The blue
line is the actual value of the output. The other line is the actual predicted value for the prediction and is split into gray,
orange, and/or green sections to correspond to the data sets used to evaluate the prediction as configured on the date tab
of the prediction parameters.

. If missing data prevents the prediction from being made (i.e. you are using the Japanese Nikki Index as an input, but it’s a
Japanese Holiday, so there is no prediction made) the prediction w ill not generate any trading signals. Therefore, a trading
system based upon the prediction w ill remain in the same position it w as prior to the missing data. Hence, the prediction’s
profit statistics are based on not trading on days w ith missing data.

e (Professional Only) During optimization the objective function is calculated at exactly the Number of hidden nodes
during optimization. During training the objective function is calculated for 0 hidden nodes to the Maximum number
of hidden nodes during training, and the number of hidden nodes w ith the best results is used. This means that even
if the Number of hidden nodes during optimization is exactly the same as the Maximum number of hidden
nodes during training, the training results may be better than the optimization results on the same training set.

. NeuroShell Trader defaults to displaying an annualized percent return in the results summary (unless you changed the
optimization objective function). If you are using a small evaluation period, keep in mind that the percentage show n is an
annualized return. For instance, if the NeuroShell Trader displays an annualized return of 1000% across a one w eek



evaluation, the actual return w as approximately 20% for the w eek. (DayTrader Only) In the NeuroShell DayTrader, the
difference becomes even greater. For example, a 1000% annualized return across a one day evaluation is approximately
a 4% return for the day.

. If you have selected to insert the prediction data series instead of the prediction signal data series (Customizing Your
Environment), the start and end dates show n on the graph for the training and evaluation periods w ill be offset by the
number of bars into the future you are predicting. This is because the data for your inputs start on the date show n in the
w izard but the predicted value that you are charting starts the number of bars into the future beyond that start date.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.
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Print/Export - Setup

The Print/Export - Setup interface allow s you to select the type of print/export you w ant to perform. Using this interface you
may print to a printer (portrait or landscape), export to a file, or copy to the clipboard:

. To print to a printer (this option may not be available if you don’t have a printer defined in your window s environment):
1. Select the Printer option.
2. Select if you w ant to print in Landscape mode or Portrait mode.

e Towrite to afile:
1. Select the File option.
2. Enter the name of the file that you w ant to w rite to (you may use the Brow se button to help you).

e To copy to a clipboard:
1. Select the Clipboard option.

When you have completed selecting how you w ant to setup your print/export select the OK button to execute the print/export
or select the Selection tab to select w hat you w ant to print/export.



Print/Export - Selection (Prediction)

The Print/Export - Selection interface allow s you to select w hat you w ant to print/export. Using this interface you may select
exactly w hat you w ant to print/export.

The Print/Export - Selection interface will list the items that are in your prediction, w hich are Prediction, (Professional Only)
Optimization, Inputs, Training Criteria, and Training Results.

Any of the items that are checked wiill be printed/exported and any of the items that are not checked wiill not be
printed/exported.

When you have completed selecting w hat you w ant to print/export select the OK button to execute the print/export or select
the Setup tab to select the type of print/export you w ant to perform.



Prediction Parameters - Output

The prediction parameters output tab is used to specify the output you w ant the prediction to predict and how far into the future
you w ant to predict. For more information see Neural Netw ork - Output Discussion.

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Select the Indicator whose future value is to be predicted in the drop-dow n list. If the item that you w ish to predict
is not show n select (Other Datal/Indicators...).

2. Type a number representing How far into the future the output should be predicted.

When you are satisfied w ith the prediction parameters to be used w hen training (Professional Only) and optimizing press the
OK button to return to the Prediction Wizard.
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Prediction Parameters - Inputs (Professional Only)

The prediction parameters inputs tab is used to select the type of input optimization. The four possibilities, Full Optimization,
Parameter Search, Rule Selection, and No Optimization, are outlined below and discussed in detail in Neural Netw ork -
Optimization Discussion (Professional Only).

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Select the Optimization method used to determine the best input for the prediction.

Full Optimization - Performs both Parameter Search and Input Selection at the same time.

Parameter Search - All of the inputs are used, but the GA evolves optimum parameters for you. These parameters
do not produce inputs that are individually optimum, but optimal as a complete set.

Input Selection - Chooses among all the inputs you have specified, leaving only the ones that w ork best together.

No Optimization - Trades using the user specified rules. Performs no modifications to any rules or rule parameters.

When you are satisfied w ith the prediction parameters to be used w hen training and optimizing press the OK button to return to
the Prediction Wizard.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Optimization Discussion (Professional Only)

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful

Using Predictions

What are Genetic Algorithms? (Professional Only)

How Does a Genetic Algorithm Work? (Professional Only)

Why is a Genetic Algorithm Better Than Other Optimizers? (Professional Only)

What Types of Problems Do Genetic Algorithms Solve? (Professional Only)

How are Genetic Algorithms Used in the NeuroShell Trader Professional? (Professional Only)



Prediction Parameters - Dates

Use the prediction parameters dates tab to set up the data ranges for the prediction paper trading (Professional Only) and
optimization.

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Specify the Data used to evaluate prediction.
You can specify that the data range(s) match the chart, be a specified size, or start and stop on specified dates.
2. (Professional Only) Specify w hether or not to Save optimization which performs best on later paper trading.

If you choose Save optimization which performs best on later paper trading, the model’s parameters are still
optimized on the optimization set, but each new optimal solution that is found by the GA is applied to the paper trading
set. If that optimal solution is found to get better results on the paper trading set than previous optimal solutions, then it
is saved as the ‘best model’. Optimal solutions that underperformed on the paper trading are still used in the GA
optimization process to find an optimal solution on the optimal data set, but they are not used as the ‘best model’. The
final model selected by the optimization is the last saved ‘best model’.

3.  (Professional Only) Specify w hether or not to Start trading before last chart date.

This option may or may not be visible depending upon the currently selected NeuroShell Trader program options. To
enable this option, from the main NeuroShell Trader menu, select Tools, choose Options, navigate to the Advanced
option tab and check Allow real trading to begin before last chart date under the Date interface settings.

The Start trading before last chart date option allow s a ‘trading’ statistics data set to be calculated after the
optimization and paper trading data sets. This ‘trading’ data set will be a true "out-of-sample" data set. It can be used if
you do not wish to keep the model that did best on paper trading, but yet you still w ant to see how a model did on data
other than the optimization data set. This data set can also be used in conjunction w ith saving the model that did best
on subsequent paper trading to evaluate the model and yet another independent data set.

When you are satisfied w ith the prediction parameters, press the OK button to return to the Prediction Wizard.

(Professional Only) Note that the optimization range of data is important because it determines w hich trading strategy is the
"best" (as specified by your Optimization objective on the Optimization tab). The default is to optimize across the same data as
the paper trading data, as this seems to be the standard among our competitors. This is a little risky, because w e are really
looking at in sample results. On the other hand, the NeuroShell Trader Professional is, w e believe, the first softw are to optimize
trading strategies that actually offers an alternative. In other w ords, w e are the first to provide a paper trading data set that is
out of sample from the optimization data set. Therefore, you might w ant to take some risk here since it has been standard
practice for some time. If you do not w ant to take that risk, simply do not choose the Save optimization which performs
best on later paper trading option.

Notes:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Netw ork Criteria Discussion (General)

Neural Netw ork - Netw ork Criteria Discussion (Objective)

Neural Netw ork - Netw ork Criteria Discussion (Advanced)

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful



Prediction Parameters - Output

The prediction parameters output tab is used to specify the output you w ant the prediction to predict and how far into the future
you w ant to predict. For more information see Neural Netw ork - Output Discussion.

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Select the Indicator whose future value is to be predicted in the drop-dow n list. If the item that you w ish to predict
is not show n select (Other Datal/Indicators...).

2. Type a number representing How far into the future the output should be predicted.

When you are satisfied w ith the prediction parameters to be used w hen training (Professional Only) and optimizing press the
OK button to return to the Prediction Wizard.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Output Discussion

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful



Prediction Parameters - Costs

Use the prediction parameters costs tab to set up the costs associated w ith trades. The costs will be used w hen calculating
prediction profits.

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Select and enter the Entry commission(s) and Exit commission(s) to use during training:
Per Trade $ - Specifies a fixed dollar commission per trade.
Per Trade % - Specifies a commission based upon a fixed percentage of the total value of each trade.
Per Share/Contract $ - Specifies a commission based upon a fixed dollar charge per share/contract traded.

2. Select and enter the Other costs to use during training:

Margin % per share/contract - Specifies the percentage of the share/contract cost that you must deposit w hen
leveraging your trades. This type of margin is generally used to backtest stock trades on margin.

Margin $ per share/contract - Specifies the number of dollars per share/contract that you must deposit w hen
leveraging your trades. This type of margin is typically used to backtest future trades on margin.

Slippage per share/contract - Specifies the expected difference betw een the desired execution price for an order
and the price at w hich the order is actually filled. Slippage should be used in a prediction if you wish to take into
account real w orld conditions w hich often cause a difference in price betw een w hen you place a trade w ith your
broker and w hen the trade gets filled on the floor.

When simulating a market order, a prediction only uses the next bars opening price and does not take into consideration
w hether the opening price w as at the bid or ask. By setting slippage to the expected average bid ask spread, the
entry and exit prices will be adjusted as if the opening price w as at the opposite side of the bid ask spread as the entry
or exit w ould occur.

Note that slippage is entered as the number of points you expect the market to move before the order is filled. If you
have not selected ‘Point value for futures contracts’, then a one point move is equivalent to a one dollar change in
price.

Point value for futures contracts - Specifies the amount by w hich the future price is multiplied to determine the
dollar value of a contract. Point value should be used in a prediction if you w ant the profit/loss results to reflect the
actual dollars you gained/lost instead of the points gained/lost.

When you are satisfied w ith the prediction parameters to be used w hen training (Professional Only) and optimizing press the
OK button to return to the Prediction Wizard.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Netw ork Criteria Discussion (General)

Neural Netw ork - Netw ork Criteria Discussion (Objective)

Neural Netw ork - Netw ork Criteria Discussion (Advanced)

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful



Prediction Parameters - Positions

The prediction parameters positions tab is used to set up the type of trading that w ill occur. For more information on positions
see Neural Netw ork - Netw ork Criteria Discussion (Objective)

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Select the Trading positions used to calculate trading statistics.

If you have chosen to train on a training objective (Training tab) that must calculate trading points then you must select
Both Long and Short, Long Positions Only, or Short Positions Only.

2. (Professional Only) Select the Trading rules used to calculate trading statistics.

If you have selected a Trading position that requires trades, you must select w hether you w ant the optimization
process to Find the optimal trading rules or to Use the trading rules specified below. If you are using a
training objective (Training Tab) that does not require trades you must select Use the trading rules specified
below (because the GA doesn’t have a trading objective to optimize).

If you have selected a training objective (Training tab) that requires trades (Professional Only) and you haven’t
selected the optimization to Find the optimal trading rules, you must fill in the appropriate Trading rules used to
calculate profit.

When you are satisfied w ith the prediction parameters to be used w hen training (Professional Only) and optimizing press the
OK button to return to the Prediction Wizard.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Netw ork Criteria Discussion (General)

Neural Netw ork - Netw ork Criteria Discussion (Objective)

Neural Netw ork - Netw ork Criteria Discussion (Advanced)

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful



Prediction Parameters - Training

The prediction parameters training tab is used to set up parameters for the neural netw ork training. For more information on
training parameters see Neural Netw ork - Netw ork Criteria Discussion (Advanced).

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

1. Select the Training objective used to select optimal network structure and optimal inputs/parameters.

If you select the minimize error objective (Professional Only) or another non-trading objective, trading statistics for the
net can still be calculated based on trading rules. You can still choose w hether you w ant trading simulated w ith long
positions, short positions, or both on the Positions tab.

2. (Professional Only) Setup the Advanced training parameters.

Number of hidden nodes during training - This will determine how many hidden nodes to use w hen training and
optimizing.

Adjust training set for trending markets by evenly distributing training bars — This w ill make the neural net
train on an equal amount of positively trending data points and negatively trending data points. Warning: This randomly
removes training cases that trend in the more populated direction, and thus the neural netw ork will have few er cases
from w hich to learn. The training w ill occur on few er points, but the statistics will be calculated over all of the data
points.

When you are satisfied w ith the prediction parameters to be used w hen training (Professional Only) and optimizing press the
OK button to return to the Prediction Wizard.

Notes:

. Not all objectives may result in the type of trading you like to accomplish, and how they perform could depend upon many
factors, like the issue you are trading, the inputs you have chosen, the time periods chosen, and many other things. If
some objective functions don't perform for you, try some others.

. (Professional Only) During optimization the objective function is calculated at exactly the Number of hidden nodes
during training. During training the objective function is calculated for 0 hidden nodes to the Number of hidden
nodes during training, and the number of hidden nodes w ith the best results is used. This means that even though the
number of hidden nodes during optimization is exactly the same as the number of hidden nodes during training, the training
results may be better than the optimization results on the same training set.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Netw ork Criteria Discussion (General)

Neural Netw ork - Netw ork Criteria Discussion (Objective)

Neural Netw ork - Netw ork Criteria Discussion (Advanced)

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful
Using Predictions



Prediction Parameters - Optimization (Professional Only)

The prediction parameters optimization tab is used to set up the criteria for the neural netw ork optimization. For more
information on optimization parameters see Neural Netw ork - Netw ork Criteria Discussion (Advanced).

The parameters on this tab may or may not be visible depending upon the currently selected Prediction Wizard Interface
Options. Press the Options button to change the Prediction Wizard Interface Options. For more information see Prediction
Wizard Interface Options.

Setup the Optimization parameters.

Maximum number of inputs (Input Selection and Full Optimization Only) — Limits the number of inputs considered by the
optimization at any one time. The more inputs that you allow the netw ork to optimize over the more combinations the
optimization process will need to try, and thus the length of the optimization process w ill extend exponentially. In general,
the neural netw ork needs less than 10 good inputs to successfully model a problem.

Optimize for exactly - Forces the optimization to take a specified amount of time. Because of the nature of genetic
optimization, it is impossible to determine the exact optimization time or even w hen the best neural netw ork has been
found. Without this parameter selected, optimization w ill automatically stop after it has decided that a better neural netw ork
is unlikely to be found in the future. Set this parameter to a longer time to make absolutely sure that the best neural

netw ork has been found. Set this parameter to a shorter time to stop optimization before the best neural netw ork has
been found.

Optimize across all chart pages - Forces the optimization to choose the same inputs and parameters for each chart
page. The optimization will find the inputs and parameters that perform best across all chart pages by using the average
result across all chart pages instead of trying to optimize the individual results for each chart page. Use of this parameter
w ill result in w orse results than optimizing each chart page individually, but will provide more consistent and generalized
inputs and parameters across the chart pages.

Shortest Average Trade Span — Forces the optimization to choose a neural netw ork that guarantees an average trade
span greater than or equal to the Shortest Average Trade Span over the optimization period. Use this option is to
decrease the number of trades if you find that optimization produces too many trades over the optimization period. It is
recommended that you choose this option only if you are unable to achieve your goals using other methods.

Longest Average Trade Span - Forces the optimization to choose a neural netw ork that guarantees an average trade
span less than or equal to the Longest Average Trade Span over the optimization period. Use this option to increase the
number of trades if you find that optimization produces too few trades over the optimization period. It is recommended that
you choose this option only if you are unable to achieve your goals using other methods.

When you are satisfied w ith the prediction parameters to be used w hen training and optimizing press the OK button to return to
the Prediction Wizard.

Note:

During optimization the objective function is calculated at exactly the Number of hidden nodes during training. During
training the objective function is calculated for O hidden nodes to the Number of hidden nodes during training, and
the number of hidden nodes w ith the best results is used. This means that even though the number of hidden nodes
during optimization is exactly the same as the number of hidden nodes during training, the training results may be better
than the optimization results on the same training set.

Topics of Interest:

What are Neural Netw orks?

Neural Netw ork - Netw ork Criteria Discussion (General)

Neural Netw ork - Netw ork Criteria Discussion (Objective)

Neural Netw ork - Netw ork Criteria Discussion (Advanced)

Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful

Using Predictions



Prediction Analysis - General

This screen show s the general prediction results of training for the selected w alk-forw ard, the current netw ork, or the
average of the w alk-forw ard netw orks. Using this information, you can evaluate how w ell you have setup your prediction.

The most effective w ay to evaluate your prediction is to look at the average error or 1yr return. When using average error,
remember that the units of this value are the same units as the variable you are predicting. This means that if you are predicting
the change in close of IBM and Exxon you must take into consideration the predicted change vs. the price to evaluate w hich
prediction did better. One w ay to easily take care of this is to predict the percent change in price. Additionally, w hen
evaluating using 1yr return, you w ant to make sure that the percent return is based (at least in part) on the performance of the
neural netw ork and not solely upon a bull market.

The follow ing is a list of results that you wiill receive w ith each training set:
Input Start Date - Date of the first bar in the training or evaluation set to be used as inputs.
Input End Date - Date of the last bar in the training or evaluation set to be used as inputs.

Output Start Date - Date of the first bar in the training or evaluation set that is output from the prediction. Note that because
the prediction is made into the future that the Output Start Date follow s the Input Start Date by the number of bars into the future
that the prediction is being made.

Output End Date - Date of the last bar in the training or evaluation set that is output from the prediction. Note that because the
prediction is made into the future that the Output End Date follow s the Input End Date by the number of bars into the future that
the prediction is being made.

Number of Bars - Number of bars in the training or evaluation set.

Average Error - The average error across the training or evaluation set. Note that average error is defined as the average of
the absolute value of the differences betw een the prediction and the actual value, expressed in the same unit as the actual
value (if you prediction is in dollars, then your error is in dollars).

Correlation - The correlation is a measure of linear correlation betw een the prediction and the actual. The closer the
correlation is to one, the stronger the positive correlation. The closer the correlation is to negative one the stronger the negative
correlation. A value of zero represents no correlation betw een the prediction and the actual.

R-Squared - The R-Squared value is a statistical measure usually applied to multiple regression analysis. It compares the
accuracy of the prediction to the accuracy of the mean of all of the samples (a trivial benchmark model). A perfect fit w ould
result in an R squared value of 1, a very good fit near 1, and a very poor fit near 0. If you neural model predictions are w orse
than you could predict by just using the mean of your sample case outputs, the R squared value w ill be negative.

Do not confuse R squared w ith r squared, w here r is the correlation coefficient. They are tw o different measures w ith
different formulas. Although the result is the same value w ith linear regression analysis, they are not the same in non-linear
neural netw orks.

Mean Squared Error - The Mean Squared Error is the average of the squared value of the error betw een the prediction and
the actual. This more heavily penalizes any error that is larger than the average.

% Correct Sign - The percentage of times the prediction correctly predicts the sign of the actual value. This is useful w hen
predicting values that oscillate around zero (i.e. Percent Change or Change). This function presumes that if you can predict the
direction of the actual value you will be able to make money because the trade is going to be profitable, even though you might
not predict the size of the movement accurately.

Number of Trades (available only w hen training by profit) - The number of trades made during the training or evaluation
period.

Return on Trades (available only w hen training by profit) - The total percent return of the neural netw ork and trading rules
based upon the performance over the training or evaluation period. Return on Trades = the cumulative sum of the Returns for
each trade. For long trades, Return = 100 * ((exit price - entry price) * shares) - exit commission) / (entry price * shares + entry
commission). For short trades, Return = 100 * ((entry price - exit price) * shares) - exit commission) / (entry price * shares +
entry commission).

Annualized Return (available only w hen training by profit) - The average 1 year percent return of the neural netw ork and
trading rules based upon the performance over the training or evaluation period. Annualized Return = 365 * (Return on
Trades) / (Number of Calendar days betw een Start Date and End Date)

Long Entry Threshold - If the prediction is greater than this threshold the trading strategy associated w ith the prediction
enters a long position, if the trading strategy is currently not long or short.

Long Exit Threshold - If the prediction is less than this threshold the trading strategy associated w ith the prediction exits a
long position, if the trading strategy is currently in a long position.

Short Entry Threshold - If the prediction is less than this threshold the trading strategy associated w ith the prediction enters
a short position, if the trading strategy is currently not long or short.

Short Exit Threshold - If the prediction is greater than this threshold the trading strategy associated w ith the prediction exits
a short position, if the trading strategy is currently in a short position.

Actual Hidden Nodes — The actual number of hidden nodes used during training. Note that the training process may
determine that training to less hidden nodes results in better results.

Max Possible Hidden Nodes — The max number of hidden to be used during training as set in the Number of Hidden Nodes



setting of the Advanced Training Parameters.

Note:

. (DayTrader Only) The start times correspond to the time of the first training bar and first evaluation bar. It should be noted
that a bar’s time is w hen the bar is complete and not w hen the bar started.

For example, on a 30 minute chart, the 10:00am bar contains all the price action from 9:30am to 10:00am. If the Train Start
w as at 10:00am, then the 10:00am bar w as the first bar used for training and therefore the training set includes price
action starting at 9:30am.

Topic of Interest:
What are Neural Netw orks?



Prediction Analysis - Input Contributions

The importance of input values is a relative measure of how significant each of the inputs is in the predictive model. Values
range from 0 to 100. Higher values are associated w ith more important variables (inputs). If the importance of an input value is
ever set to zero, then that input is useless and might as w ell be omitted. You can omit that variable in the future if you desire.
In fact, if you are seeking to eliminate inputs from you model, it is probably a good bet that some of the low est contributing
variables can be safely not used in the future.

How ever, do not assume that if the importance value of input 1 is 10 and the importance value of input 2 is 5, that input 1 is
twice as good as input 2. All w e can really say w ith confidence is that input 1 is more important than input 2.

In fact, contribution factors are only a guide or estimation of the value of the input variables. They should never be considered
highly accurate. Additionally, if you use too many inputs (more that 10), the accuracy of the contribution factors will decrease.
If you are using contribution factors to decide amongst a large group of potential inputs, it is best to test them in groups of 10,
taking a few of the best ones from each group of 10.

You may receive any of the follow ing messages due to errors in your prediction, w hich w ill be explained as follow s:

Insufficient Data - No data available for training set - No data is available for the specified input, you may w ant to verify
that the data you specified exists over the period of time specified for the training set.

Constant Data - The input is constant across the training set - The specified input remains constant across all points in
the training set. This provides no information that the neural netw ork can use and thus the input is skipped.

Insufficient Data - Less than x days of data (Minimum Training Set Size) available for training set - Data exists for
the specified input; how ever, the amount of data that exists is less than the Minimum Training Set Size that is specified in the
Training Criteria. You may w ant to change the Minimum Training Set Size by modifying the Training Criteria or provide more data
so that the neural netw ork can use this input.

Topic of Interest:
What are Neural Netw orks?



Prediction Analysis - Trading Statistics

This screen show s the trading statistics for the selected optimal net, w alk-forw ard net, current net, average of the
w alk-forw ards and current net, or the out of sample results. Using this information, you can evaluate how w ell you have setup
your prediction.

If you have selected to display the detailed analysis of a w alk-forw ard or an average you w ill be given a choice of displaying
the training statistics or the evaluation statistics for the trades that occurred over the selected periods. To do this, select the
Show Training Statistics option or the Show Evaluation Statistics option.

The follow ing is a list of results that you wiill receive for the selected w alk-forw ard evaluated by All trades, Long only, and
Short only:

Start Date - The first date included in the backtest. (DayTrader Only) See note below regarding start date.
End Date - The last date included in the backtest

Beginning Price - The closing price on the start date

Ending Price - The closing price on the end date

Change in Price - The difference betw een the beginning and ending price

Percent Change in Price - The percent difference betw een the beginning and ending price.

Annual Percent Change in Price - The annualized percent change in price. Annual Percent Change in Price = 365 *
(Percent Change in Price) / (Number of Calendar days betw een Start Date and End Date)

Return on Trades - The cumulative sum of all returns for each trade (including any open profit/loss on the last day of the
backtest). For long trades, Return = 100 * (exit price - entry price - commissions) / (entry price + commissions). For short
trades, Return = 100 * (entry price - exit price - commissions) / (entry price + commissions). Note that the entry and exit price
incorporate any specified slippage and/or point value. For more explanation refer to Return on Account vs. Return on Trades.

Annual Return on Trades - The annualized return on trades. Annual Return on Trades = 365 * (Return on Trades) /
(Number of Calendar days betw een Start Date and End Date)

Return on Account - The net profit relative to the account size required to trade over the backtest (including any open
profit/loss on the last day of the backtest). Return on Account = 100 * (Net Profit) / (Account Size Required). For more
explanation refer to Return on Account vs. Return on Trades.

Annual Return on Account - The annualized return on account. Annual Return on Account = 365 * (Return on Account) /
(Number of Calendar days betw een Start Date and End Date)

Net Profit - The total dollar profit/loss for the trading strategy during the backtest (including any open profit/loss on the last day
of the backtest). Net Profit = (Gross Profit) - (Gross Loss)

Gross Profit - The total profit for all profitable trades over the backtest (including any open profit/loss on the last day of the
backtest). For long trades with an entry price < exit price, Trade Profit = exit price - entry price - commissions. For short
trades w ith an exit price < entry price, Trade Profit = entry price - exit price - commissions. Note that the entry and exit price
incorporate any specified slippage and/or point value.

Gross Loss - The total loss for all losing trades over the backtest (including any open profit/loss on the last day of the
backtest). For long trades w ith an entry price > exit price, Trade Loss = entry price - exit price - commissions. For short trades
w ith an exit price > entry price, Trade Loss = exit price - entry price - commissions. Note that the entry and exit price
incorporate any specified slippage and/or point value.

Ratio Gross Profit/Loss - The gross profit relative to the gross loss. Ratio Gross Profit/Loss = (Gross Profit) / (Gross
Loss)

Percent Profitable Trades - The percent of the trades over the backtest that w ere profitable. Percent Profitable Trades =
100 * (Number Winning Trades) / (Number of Trades)

Number Trades - The number of trades over the backtest.

Number Winning Trades - The number of trades over the backtest that w ere profitable.
Number Losing Trades - The number of trades over the backtest that w ere not profitable.
Largest Winning Trade Profit - The most profit made by a trade during the backtest.
Largest Losing Trade Loss - The largest loss caused by a trade during the backtest.

Average Trade Profit - The average gain (or loss) across all trades in the backtest. Average Trade Profit = Net Profit /
Number Trades

Average Winning Trade Profit -The average gain across all profitable trades in the backtest. Average Winning Trade Profit
= (Gross Profit) / (Number Winning Trades)

Average Losing Trade Loss - The average loss across all losing trades in the backtest.

Ratio Avg Win/Avg Loss - The average w inning trade profit relative to the average losing trade profit. Ratio Avg Win/Avg
Loss = (Average Winning Trade Profit) / (Average Losing Trade Loss)

Maximum Consecutive Winners - The maximum number of consecutive profitable trades during the backtest.
Maximum Consecutive Losers - The maximum number of consecutive losing trades during the backtest.

Average Trade Span - The average number of bars betw een the entry order signal and the exit order execution for each
trade in the backtest.



Average Winning Trade Span - The average number of bars betw een the entry order signal and the exit order execution for
each profitable trade in the backtest.

Average Losing Trade Span - The average number of bars betw een the entry order signal and the exit order execution for
each losing trade in the backtest.

Longest Trade Span - The largest number of bars betw een the entry order signal and the exit order execution for any single
trade during the backtest.

Longest Winning Trade Span - The largest number of bars betw een the entry order signal and the exit order execution for
any single profitable trade during the backtest.

Longest Losing Trade Span - The largest number of bars betw een the entry order signal and the exit order execution for
any single losing trade during the backtest.

Largest Shares Traded - The largest number of shares traded during any single trade during the backtest.

Largest Winning Shares Traded - The largest number of shares traded during any single profitable trade during the
backtest.

Largest Losing Shares Traded - The largest number of shares traded during any single losing trade during the backtest.
Average Shares Traded - The average number of shares traded for each trade in the backtest.

Average Winning Shares Traded - The average number of shares traded for each profitable trade in the backtest.
Average Losing Shares Traded - The average number of shares traded for each losing trade in the backtest.
Commissions Paid - The total amount of commissions paid during the backtest.

Maximum Drawdow n - The maximum value of draw dow n, w here the draw dow n at each bar is the difference betw een the
highest prior closed net profit and the current open net profit. Draw dow n = (Largest Net Profit prior to trade entry) - (Net
Profit prior to trade entry) + (Open Trade Draw dow n)

Maximum Open Trade Drawdow n - The maximum open trade draw dow n for any trade during the backtest. Open Trade
Draw dow n = (shares traded) * [(entry price) - (w orst price during the trade)]. Note that the entry price incorporates any
specified slippage and/or point value.

Required Account Size - If a margin per contract has been selected on the trading parameters screen, then the Required
Account Size = (Maximum Draw dow n) + (Margin Per Contract) * (Largest Contracts Traded). If no margin per contract has
been selected, then the Required Account Size is the largest entry cost w here Entry Cost = (number of shares traded) * (entry
price) - (Net Profit prior to trade entry). Note that the entry price incorporates any specified slippage and/or point value.

Notes:

. If missing data prevents the prediction from being made (i.e. you’re using the Japanese Nikki Index as an input, but it’s a
Japanese Holiday, so there is no prediction made) the prediction w ill not generate any trading signals. Therefore, a trading
system based upon the prediction will remain in the same position it w as prior to the missing data. Hence, the prediction’s
profit statistics are based on not trading on days w ith missing data.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

. (DayTrader Only) The Start Date corresponds to the date/time of the first bar in the backtest. It should be noted that a bar’
s time is w hen the bar is complete and not w hen the bar started.

For example, on a 30 minute chart, the 10:00am bar contains all the price action from 9:30am to 10:00am. If the Start Date
w as at 10:00am, then the 10:00am bar w as the first bar used for backtesting and therefore the backtest includes price
action starting at 9:30am.

Topic of Interest:
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Prediction Analysis - Trade by Trade

This screen show s the trading statistics for the selected optimal net, w alk-forw ard net, current net, average of the
w alk-forw ards and current net, or the out of sample results. Using this information, you can evaluate how w ell you have setup
your prediction.

If you have chosen to display the detailed analysis of a w alk-forw ard or an average you wiill be given a choice of displaying a
list of the training or evaluation trade by trade results for the trades that occurred over the selected periods. To do this, select
the Show Training Statistics option or the Show Evaluation Statistics option.

The follow ing is a list of items that you w ill receive for each entry and exit signal in the backtest:
Date - Date on w hich the entry or exit w as signaled.

Signal - The type of order (Long Entry, Long Exit, Short Entry, or Short Exit). On the graph, a Long Entry is annotated with a
solid blue upw ard triangle, a Long Exit is annotated w ith a blue outlined dow nw ard triangle, a Short Entry is annotated w ith a
solid red dow nw ard triangle, and a Short Exit is annotated w ith a red outlined upw ard triangle.

Shares - The number of shares (or contracts) bought or sold w ith the order.

Fill Date - Date on w hich the entry or exit w as actually filled. For the simple case of a market order, the date w ill be the next
trading day after the signal.

Price - The price at w hich the order w as filled. On the graph, this price is annotated w ith an X on the Fill Date. For the simple
case of a market order w ith no slippage the price is the open on the Fill Date. If no open is included in your data, then the
previous days close is used and adjusted for gaps if a high and low is included in your data (i.e. if today’s low is higher than
yesterday’s close then the low w ill be used as today’s open).

Commission - The commission paid for the order. If you have not specified any entry or exit commissions in the trading
parameters, this value will be zero.

%Return (exit only) - % return for the position that w as exited.
%Return is calculated as follow s:

Long Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) / (entry
price*shares — entry commissions).

Short Percent Return = 100 * ((exit price - entry price)*shares - entry commission - exit commission) / (entry
price*shares — entry commissions).

If using margin $ per share/contract, then % return is calculated as follow s:

Long Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) /
(margin*contracts — entry commissions)

Short Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) /
(margin* contracts — entry commissions)

Note that the entry and exit price incorporate any specified slippage and/or point value.
Profit/Loss (exit only) - The dollar amount made (or lost) by the position that w as exited.
Cum %Ret (exit only) - The cumulative percent return for all positions up to and including the position just exited.
Cum Profit/Loss (exit only) - The cumulative profit (or loss) for all positions up to and including the position just exited.

Notes:

. If missing data prevents the prediction from being made (i.e. you’re using the Japanese Nikki Index as an input, but it’s a
Japanese Holiday, so there is no prediction made) the prediction w ill not generate any trading signals. Therefore, a trading
system based upon the prediction will remain in the same position it w as prior to the missing data. Hence, the prediction’s
profit statistics are based on not trading on days w ith missing data.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.
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Print/Export - Setup

The Print/Export - Setup interface allow s you to select the type of print/export you w ant to perform. Using this interface you
may print to a printer (portrait or landscape), export to a file, or copy to the clipboard:

. To print to a printer (this option may not be available if you don’t have a printer defined in your window s environment):
1. Select the Printer option.
2. Select if you w ant to print in Landscape mode or Portrait mode.

e Towrite to afile:
1. Select the File option.
2. Enter the name of the file that you w ant to w rite to (you may use the Brow se button to help you).

e To copy to a clipboard:
1. Select the Clipboard option.

When you have completed selecting how you w ant to setup your print/export select the OK button to execute the print/export
or select the Selection tab to select w hat you w ant to print/export.



Print/Export - Selection (Prediction Analysis)

The Print/Export - Selection interface allow s you to select w hat you w ant to print/export. Using this interface you may select
exactly w hat you w ant to print/export.

The Print/Export - Selection interface will list the items that are in your prediction analysis, w hich are General Analysis, Trading
Statistics, Trade By Trade Analysis, and Input Contribution Analysis.

Any of the items that are checked wiill be printed/exported and any of the items that are not checked wiill not be
printed/exported.

When you have completed selecting w hat you w ant to print/export select the OK button to execute the print/export or select
the Setup tab to select the type of print/export you w ant to perform.



Modifying Predictions

Modifying predictions allow s you to modify the currently selected prediction. This may be useful if you w ant to retrain the
prediction, change the criteria of a prediction (i.e. number of w alk-forw ards), the inputs being used, or the value the prediction
is predicting.

1. Select a prediction displayed on the chart by clicking on the corresponding line, legend text, or Shapshot View text.
2. Once the prediction is selected (highlighted w ith black boxes), select Modify Selected Prediction from the Edit menu.

Cut Chrl+3
Copy Chrl+C
Paste Chel+y
Delete Dl

Modify Selected Prediction ...

or

1. Select a prediction displayed on the chart by right-clicking on the corresponding line or legend text.
2. Select Modify Selected Prediction from the pop-up menu.

Cuk
Copy
Paste
Delete

Modify Selected Prediction ...

Format Selected Prediction ...

or

1. Modify a prediction displayed on the chart by double-clicking on the corresponding line or legend text.

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.

Topic of Interest:
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What are Trading Strategies?

Trading Strategies are a w ay of implementing a set of mechanical rules to determine w hen to buy and sell an instrument or a
set of instruments. Trading Strategies enable you to develop a systematic approach to trading, test how a system does in the
past, and use signals from the system to place trades into the future.

The NeuroShell Trader Trading Strategy Wizard makes it easy to test and implement Trading Strategies. You w ill be able to
create strategies that do any of the follow ing:

e Trade Long and/or short positions

. Limit losses w ith Trailing stops

. Trade w ith market, limit, stop, stop limit, and market on close orders
. Test strategies w ith commissions, margin, slippage and point value

o Trade a fixed number of shares/contracts, a fixed dollar amount, or a grow ing number of shares/contracts as profits are
made.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.



What are Genetic Algorithms? (Professional Only)

Genetic algorithms (GAs) seek to solve optimization problems using the methods of evolution, specifically survival of the fittest.
In a typical optimization problem, there are a number of variables that control the process, and a formula or algorithm that
combines the variables to fully model the process. The problem is then to find the values of the variables that optimize the
model in some w ay. If the model is a formula, then w e w ill usually be seeking the maximum or minimum value of the formula.

For example, if your company has $100,000 to spend on different types of advertising such as TV, radio, and print, w hat is the
best mix of the different types that w ill maximize sales? The dollars spent on each type of ad are the variables that control the
process. A formula would be used to calculate sales dollars. The genetic algorithm w ould try different combinations of dollar
values for each type of advertising until it found a combination that maximizes sales (as computed by the formula). A genetic
algorithm, how ever, does not use an exhaustive search technique; it is much faster and more efficient than that.

There are many mathematical methods w hich can optimize problems of this nature (and very quickly) for fairly "w ell behaved"
problems. These traditional methods tend to break dow n w hen the problem is not so w ell behaved. Examples of these types
of problems include combinatorial problems, or problems w here the fitness function is not a smooth, continuous mathematical
formula.

Evolution and Genetic Algorithms

Before describing how a genetic algorithm can be applied to an optimization problem, let us draw the evolutionary parallel. The
theory is that a population of a certain species will, after many generations, adapt to live better in its environment. For example,
if the species is an animal that lives mainly in a sw ampy area, it may eventually evolve w ith w ebbed feet. The reason is that
the members of this population, w hich w e w ill call individuals, wiill tend to die if they are poor swimmers that cannot easily get
food, and tend to live and reproduce if they are good swimmers. The offspring of tw o good sw immers w ill probably be good
swimmers as w ell because they will usually carry genetic traits of their parents, such as slight w ebbing betw een the toes.
These genetic traits are carried in chromosomes in the individuals.

Plant or animal breeders often use selective breeding techniques w herein they choose parents for breeding based upon the
intensity of desirable traits with w hich the prospective parents are endow ed. These breeders are using the same evolutionary
techniques.
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How Does a Genetic Algorithm Work? (Professional Only)

A genetic algorithm solves optimization problems by creating a population or group of possible solutions to the problem. The
individuals in this population will carry chromosomes that are the values of variables of the problem.

The genetic algorithm actually solves your problem by allow ing the less fit individuals in the population to die (peacefully) and
selectively breeding the most fit individuals (the ones that solve the problem best). This process is called selection, as in
selection of the fittest. The genetic algorithm w ill take tw o fit individuals and mate them (a process called crossover). The
offspring of the mated pair will receive some of the characteristics of the mother, and some of the father.

In nature, offspring often have some slight abnormalities, called mutations. Usually these mutations are disabling and inhibit the
ability of the children to survive, but once in a w hile they improve the fitness of the individual (like toes stuck together in a

w eb-like fashion). The genetic algorithm similarly occasionally causes mutations in its populations by randomly changing the
value of a variable.

After the genetic algorithm mates fit individuals and mutates some, the population undergoes a generation change. The
population will then consist of offspring plus a few of the older individuals, w hich the genetic algorithm allow s to survive to the
next generation because they are the most fit in the population, and w e will w ant to keep them breeding. These most fit
individuals are called elite individuals.

After dozens or even hundreds of "generations", a population eventually emerges w herein the individuals w ill solve the
problem very w ell. In fact, the most fit (elite) individual w ill be an optimum or close to optimum solution.

The processes of selection, crossover, and mutation are called genetic operators.
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Why is a Genetic Algorithm Better Than Other Optimizers? (Professional Only)

There are many opportunities for optimization in technical analysis. Prior to the NeuroShell Trader Professional, some trading
systems had optimizers, but the optimization technique used w as simple "exhaustive search", meaning that every possible
combination w as tried to see w hat w as the best one. This is a very accurate approach, since you are bound to find the best
combination of variables - eventually. How ever, it is a very inefficient approach, because w henever there are more than a few
thousand combinations, it takes too long to try them all. That is w hy users of exhaustive search optimizers tend to limit the
number of variables they use, or tend to limit the number of values these variables can take.

The genetic algorithm, by contrast, does not try every possible combination. It attempts instead to intelligently get closer and
closer to the best solution. Therefore, far more variables can be utilized, and you can allow all values of a variable. Optimization
can still take a good deal of time if you give a GA a fair number of variables, but it will be doing much more w ork in that amount
of time.

More efficient optimizers than exhaustive search optimizers are in use. If they are not genetic algorithms, how ever, they are
most likely only searching one section of the search space at a time. Genetic algorithms are searching dozens or hundreds of
parts of the search space simultaneously. This means they are impervious to becoming stuck in "local minima" as the others
quite often do. (Local minima are decent solutions that the optimizer can never get out of in order to find better solutions.)
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What Types of Problems Do Genetic Algorithms Solve? (Professional Only)

A genetic algorithm is a computational method modeled on biological evolutionary processes that can be used to find the
optimum solution to a problem that may have many solutions. For example, you can use genetic algorithms to find the maximum
and the minimum of a function, to find an optimal route on a map, or to minimize the cost of manufacturing your products. They
can be used to find an optimal set of parameters (such as the optimal number of shares of each type of stock in a portfolio), or
to select an optimal sequence of events (such as the shortest route to cover a sales territory). In other w ords, genetic
algorithms can be pow erful tools for finding the best of millions of possible solutions for different real life problems.

These algorithms have been found to be very pow erful in solving optimization problems that appear to be difficult or even
unsolvable by traditional methods. Genetic algorithms use a minimum of information about the problem and they only require a
quantitative estimation of the quality of a possible solution. This makes them easy to use and applicable to most optimization
problems.

Genetic Algorithm Applications

The follow ing is a list of some of the applications developed by Ward Systems Group customers. Business applications for
genetic algorithms include:

Business

Optimizing process control operations

Scheduling salesman or delivery routes

Minimizing manufacturing time

Optimizing budget allocations to different departments to maximize profit
Optimizing retail site locations

Group packages w ith different dimensions into delivery lots

Finance

Generating rules to predict a rise in stock indexes

Optimally group stocks w ith different values into balanced portfolios

Minimize financial risk managing a fund w hile simultaneously trying to maximize return
Optimize technical indicators

Finding optimal trading strategies

Medicine

Optimize treatment programs

Schedule use of medical treatment practitioners and/or facilities
Classify patients into groups for experimental studies

Schedule medical students through training and clinical rotations

Science

Maximize polymer qualities based upon different composition materials

Optimize chemical reactions based on different chemicals or processing times

Maximize forest yield by varying types of trees planted, fertilization, and cutting practices

And many more!
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How are Genetic Algorithms Used in the NeuroShell Trader Professional? (Professional Only)

In the Prediction Wizard, genetic algorithms are used to find:

1. The best inputs to a neural netw ork
2. The best parameters for indicators used as inputs to a neural netw ork
3. The best buy/sell thresholds for neural nets

In the Trading Strategy Wizard, genetic algorithms are used to find:

1. The best trading rules to use
2. The best parameters for indicators used in trading rules
3. The best parameters for indicators used in limit orders, stop orders, and stop limit orders

In order for a genetic algorithm to optimize, it has to have an idea of w hat fit individuals in the population look like (the fitness
function). The fitness function is the Training Objective in the Prediction Wizard, and the Objective in the Trading Strategy
Wizard. You wiill find that these are objectives like "minimize error", "maximize correlation”, "minimize draw dow n", "maximize net
profit", etc. To a very great extent, your choice of the objective (fithess) function can have a great bearing on how w ell the
optimization goes, and how w ell the optimized model w orks later on out of sample data. Unfortunately, there are no universal

guidelines.
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Creating a Trading Strategy

Creating a trading strategy wiill allow you to add buy/sell signals to your chart that are based upon rules that you define.

1. Select New Trading Strategy from the Insert menu. This activates the trading strategy w izard, w hich guides you
through the process of creating a trading strategy.

Existing Data | Calculations ...

Mew Indicator ..,
Mew Prediction ...

Mew Trading Strakegw ...

Mew Alert ...

Qther Instrument Data ...

Notes:

e You can have multiple trading strategies displayed on a chart by simply creating more than one trading strategy.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.
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Trading Strategy Wizard - Templates

This screen show s the trading strategy templates available for use. Trading strategy templates are preconfigured trading
strategies that allow you to create a trading strategy quickly w ithout having to know or w orry about all the details of creating
one from scratch.

To select an existing trading strategy template:
1. Select the desired template from the list.

To create a trading strategy from scratch
1. Select (No Template) located at the top of the list.

When you are satisfied w ith the template the trading strategy w ill use press the Next button to proceed to the next wizard
screen.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

Topic of Interest:
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Trading Strategy Wizard - Long Entry

The Long Entry tab allow s you to specify your entry conditions to a long position.

If you don’t w ant to trade long in this trading strategy, then deselect "Generate a buy long order ...". This wiill allow you to
continue w ithout entering any entry conditions, trailing stops, or exit conditions for a long position.

For more information about the different types of trading strategies see Trading Strategy Types.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters
(Professional Only) or the indicator’s parameter ranges.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or the indicator’s parameter ranges.

o Toinsert long entry conditions:
1. Press the Add Condition(s) button.

o To modify a long entry condition, long entry condition’s parameter, (Professional Only) or long entry condition’s parameter
range:
1. Select the item in the list you w ish to modify.
2. Press the Modify Condition button or Modify Parameter button (depending on w hat item you have selected).
Or
1. By double-clicking on the item in the list you w ish to modify.

e Toremove a long entry condition:
1.  Select the entry condition(s) in the list you w ish to remove.
2. Press the Remove Condition(s) button or press the delete button on you keyboard.

The Order Type, Number of Conditions, Short Trading, and Trailing Stop interfaces described below may or may not be visible
depending upon the currently selected Trading Strategy Wizard Interface Options. Press the Options button to change the
Trading Strategy Wizard Interface Options. For more information see Trading Strategy Wizard Interface Options.

Select the <Order Type> that you w ant to use w hen entering a long position:
Market Order - Enters at the opening of the next bar. The entry price is the opening price plus slippage.

Stop Order - Enters if the next bar trades at or above the stop price. The entry price is the stop price (or open price if the
bar opens above the stop price) plus slippage.

Limit Order - Enters if the next bar trades at or below the limit price. The entry price is the limit price (or open price if the bar
opens below the stop price).

Stop Limit Order - Enters the market if the next bar trades above the stop price and then subsequently trades at or below
the limit price. The final entry price is the limit price.

Market Close Order - Enters at the closing of the next bar. The entry price is the closing price plus slippage.

If you select a stop order, limit order or stop limit order be sure to enter the corresponding stop price and/or limit price. Note
that the stop, limit, and stop limit orders are day orders and are therefore canceled if not filled by the end of the next bar. If
you w ant to trade from the open to the close of a single bar, use a market order to enter at the open of the next bar and a
market close order w ith the same conditions to exit at the close.

Select the <Number of Conditions> that you w ant to be true for a long entry signal to be generated. As an example, if you have
three items listed and you have selected the <Number of Conditions> to be 2, then w hen any 2 of the three entry conditions are
true a long entry signal will be generated.

When displayed on a chart, a Long Entry is annotated w ith a solid blue upw ard triangle below the bar on w hich the long entry
signal w as generated. The entry price is annotated on the next bar with a blue X. When using stop, limit and stop limit orders,
no entry price annotation w ill appear on the next bar if the order is not filled and you will likely see a series of entry signal
annotations for subsequent bars until an order is filled.

If you are using a stop price, then the stop price is displayed on the chart as a horizontal blue line placed at the stop price level
and extending from just after the bar on w hich it w as calculated to the next bar for w hich it is active. If you are using a limit
price, then the limit price is displayed on the chart as a horizontal dashed blue line placed at the limit price level and extending
from just after the bar on w hich it w as calculated to the next bar for w hich it is active.



After setting your long entry conditions, <Order Type>, and <Number of Conditions> you can select the Long Trailing Stop
tab, Long Exit tab, Short Entry tab, Short Trailing Stop tab, Short Exit tab or the Next button.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

. (Professional Only) When using Full Optimization or Rule Selection, the trading strategy allow s reduction in the number of
conditions below the number specified that must be true w hen a better solution if found w ith few er rules. When the
number of conditions selected by the optimizer is less than the specified number that must be true, all the optimally
selected rules must be true for the entry to occur.
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Trading Strategy Wizard - Long Trailing Stop

The Long Trailing Stop tab allow s you to specify trailing stop price levels for a long position. Note that a trailing stop liquidates a
position w ith a stop order placed prior to and executed during the bar in w hich the stop price w as penetrated. In contrast, exit
conditions liquidate a position w ith an exit order placed and executed after the bar on w hich the exit condition(s) became true.

If you don’t w ant to use a long trailing stop in this trading strategy, then deselect "Generate a trailing stop order for every bar
that is after an entry order has been filled and before an exit order has been generated". This will allow you to continue

w ithout entering any trailing stop price levels for a long position. Note that if you deselect both long trailing stop and long exit
conditions, then a long position wiill end (w ith a market order to exit long) w henever a short entry signal occurs.

For more information about the different types of trading strategies see Trading Strategy Types.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters
(Professional Only) or the indicator’s parameter ranges.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or the indicator’s parameter ranges.

o Toinsert long trailing stop price levels:
1. Press the Add price level(s) button.

o To modify a long trailing stop price level, long trailing stop price level’s parameter, (Professional Only) or long trailing stop
price level’s parameter range:

1. Select the item in the list you w ish to modify.

2. Press the Modify price level button or Modify Parameter button (depending on w hat item you have selected).
Or

1. By double-clicking on the item in the list you w ish to modify.

e Toremove a long trailing stop price level:
1.  Select the price level(s) in the list you wish to remove.
2. Press the Remove price level(s) button or press the delete button on you keyboard.

When displayed on a chart, a long trailing stop is displayed as a horizontal blue line placed at the most recent trailing stop price
level and extending from just after the bar on w hich it w as calculated to the next bar for w hich it is active. If the trailing stop
price level is reached during the next bar, the exit price is annotated on the next bar with a blue X. The exit price is the trailing
stop price (or open price if the bar opens below the trailing stop price) minus slippage.

The Short Trading interfaces described below may or may not be visible depending upon the currently selected Trading
Strategy Wizard Interface Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For
more information see Trading Strategy Wizard Interface Options.

After setting your long trailing stop price levels you can select the Long Entry tab, Long Exit tab, Short Entry tab, Short
Trailing Stop tab, Short Exit tab or the Next button.

Notes:

e If you are using both trailing stops and exit conditions, the trailing stop wiill not be placed on days w here the exit condition
is true and the exit order type is a Market Order.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.
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Trading Strategy Wizard - Long Exit

The Long Exit tab allow s you to specify exit conditions for a long position. Note that exit conditions liquidate a position w ith an
exit order placed and executed after the bar on w hich the exit condition(s) became true. In contrast, a trailing stop liquidates a
position w ith a stop order placed prior to and executed during the bar in w hich the stop price w as penetrated.

If you don’t w ant to use long exit conditions in this trading strategy, then deselect the "Generate a sell long order ...". This wiill
allow you to continue w ithout entering any exit conditions for a long position. Note that if you deselect both long trailing stop and
long exit conditions, then a long position wiill end (w ith a market order to exit long) w henever a short entry signal occurs.

For more information about the different types of trading strategies see Trading Strategy Types.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters
(Professional Only) or the indicator’s parameter ranges.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or the indicator’s parameter ranges.

e Toinsert long exit conditions:
1. Press the Add Condition(s) button.

« To modify a long exit condition, long exit condition’s parameter, (Professional Only) or long exit condition’s parameter
range:

1. Select the item in the list you w ish to modify.

2. Press the Modify Condition button or Modify Parameter button (depending on w hat item you have selected).
Or

1. By double-clicking on the item in the list you w ish to modify.

e Toremove a long exit condition:
1.  Select the exit condition(s) in the list you wish to remove.
2. Press the Remove Condition(s) button or press the delete button on you keyboard.

The Order Type, Number of Conditions, Short Trading, and Trailing Stop interfaces described below may or may not be visible
depending upon the currently selected Trading Strategy Wizard Interface Options. Press the Options button to change the
Trading Strategy Wizard Interface Options. For more information see Trading Strategy Wizard Interface Options.

Select the <Order Type> that you w ant to use w hen exiting a long position:
Market Order - Exits at the opening of the next bar. The exit price is the opening price minus slippage.

Stop Order - Exits if the next bar trades at or below the stop price. The exit price is the stop price (or open price if the bar
opens below the stop price) minus slippage.

Limit Order - Exits if the next bar trades at or above the limit price. The exit price is the limit price (or open price if the bar
opens above the stop price).

Stop Limit Order - Exits if the next bar trades below the stop price and then subsequently trades at or above the limit price.
The final exit price is the limit price.

Market Close Order - Exits at the closing of the next bar. The exit price is the closing price minus slippage.

If you select a stop order, limit order or stop limit order be sure to enter the corresponding stop price and/or limit price. Note
that the stop, limit, and stop limit orders are day orders and are therefore canceled if not filled by the end of the next bar. If
you w ant to trade from the open to the close of a single bar, use a market order to enter at the open of the next bar and a
market close order w ith the same conditions to exit at the close.

Select the <Number of Conditions> that you w ant to be true for a long exit signal to be generated. As an example, if you have
three conditions listed and you have selected the <Number of Conditions> to be 2, then w hen any 2 of the three exit conditions
are true a long exit signal w ill be generated.

When displayed on a chart, Long Exit is annotated w ith a blue outlined dow nw ard triangle above the bar on w hich the long exit
signal w as generated. The exit price is annotated on the next bar w ith a blue X. When using stop, limit and stop limit orders, no
exit price annotation w ill appear on the next bar if the order is not filled and you wiill likely see a series of exit signal annotations
for subsequent bars until an order is filled.

If you are using a stop price, then the stop price is displayed on the chart as a horizontal blue line placed at the stop price level



and extending from just after the bar on w hich it w as calculated to the next bar for w hich it is active. If you are using a limit
price, then the limit price is displayed on the chart as a horizontal dashed blue line placed at the limit price level and extending
from just after the bar on w hich it w as calculated to the next bar for w hich it is active.

After setting your long exit conditions, <Order Type>, and <Number of Conditions> you can select the Long Entry tab, Long
Trailing Stop tab, Short Entry tab, Short Trailing Stop tab, Short Exit tab or the Next button.

Notes:

. If you are using both trailing stops and exit conditions, the trailing stop w ill not be placed on days w here the exit condition
is true and the exit order type is a Market Order.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

. (Professional Only) When using Full Optimization or Rule Selection, the trading strategy allow s reduction in the number of
conditions below the number specified that must be true w hen a better solution if found w ith few er rules. When the
number of conditions selected by the optimizer is less than the specified number that must be true, all the optimally
selected rules must be true for the exit to occur.

Topics of Interest:

What are Trading Strategies?
Using Predictions

Trading Strategy Types



Trading Strategy Wizard - Short Entry

The Short Entry tab allow s you to specify your entry conditions to a short position.

If you don’t w ant to trade short in this trading strategy, then deselect "Generate a sell short order ...". This will allow you to
continue w ithout entering any entry conditions, trailing stops, or exit conditions for a short position.

For more information about the different types of trading strategies see Trading Strategy Types.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters
(Professional Only) or the indicator’s parameter ranges.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or the indicator’s parameter ranges.

e« Toinsert short entry conditions:
1. Press the Add Condition(s) button.

o To modify a short entry condition, short entry condition’s parameter, (Professional Only) or short entry condition’s
parameter range:

1. Select the item in the list you w ish to modify.

2. Press the Modify Condition button or Modify Parameter button (depending on w hat item you have selected).
Or

1. By double-clicking on the item in the list you w ish to modify.

e Toremove a short entry condition:
1.  Select the entry condition(s) in the list you w ish to remove.
2. Press the Remove Condition(s) button or press the delete button on you keyboard.

The Order Type, Number of Conditions and Trailing Stop interfaces described below may or may not be visible depending upon
the currently selected Trading Strategy Wizard Interface Options. Press the Options button to change the Trading Strategy
Wizard Interface Options. For more information see Trading Strategy Wizard Interface Options.

Select the <Order Type> that you w ant to use w hen entering a short position:
Market Order - Enters at the opening of the next bar. The entry price is the opening price minus slippage.

Stop Order - Enters if the next bar trades at or below the stop price. The entry price is the stop price (or open price if the
bar opens below the stop price) minus slippage.

Limit Order - Enters if the next bar trades at or above the limit price. The entry price is the limit price (or open price if the bar
opens above the stop price).

Stop Limit Order - Enters if the next bar trades below the stop price and then subsequently trades at or above the limit price.
The final entry price is the limit price.

Market Close Order - Enters at the closing of the next bar. The entry price is the closing price minus slippage.

If you select a stop order, limit order or stop limit order be sure to enter the corresponding stop price and/or limit price. Note
that the stop, limit, and stop limit orders are day orders and are therefore canceled if not filled by the end of the next bar. If
you w ant to trade from the open to the close of a single bar, use a market order to enter at the open of the next bar and a
market close order w ith the same conditions to exit at the close.

Select the <Number of Conditions> that you w ant to be true for a short entry signal to be generated. As an example, if you
have three conditions listed and you have selected the <Number of Conditions> to be 2, then w hen any 2 of the three entry
conditions are true a short entry signal will be generated.

When displayed on a chart, a Short Entry is annotated w ith a solid red dow nw ard triangle above the bar on w hich the short
entry signal w as generated. The entry price is annotated on the next bar with a red X. When using stop, limit and stop limit
orders, no entry price annotation will appear on the next bar if the order is not filled and you wiill likely see a series of entry

signal annotations for subsequent bars until an order is filled.

If you are using a stop price, then the stop price is displayed on the chart as a horizontal red line placed at the stop price level
and extending from just after the bar on w hich it w as calculated to the next bar for w hich it is active. If you are using a limit
price, then the limit price is displayed on the chart as a horizontal dashed red line placed at the limit price level and extending
from just after the bar on w hich it w as calculated to the next bar for w hich it is active.



After setting your short entry conditions, <Order Type>, and <Number of Conditions> you can select the Long Entry tab, Long
Trailing Stop tab, Long Exit tab, Short Trailing Stop tab, Short Exit tab, or the Next button.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

. (Professional Only) When using Full Optimization or Rule Selection, the trading strategy allow s reduction in the number of
conditions below the number specified that must be true w hen a better solution if found w ith few er rules. When the
number of conditions selected by the optimizer is less than the specified number that must be true, all the optimally
selected rules must be true for the entry to occur.

Topics of Interest:

What are Trading Strategies?
Using Predictions

Trading Strategy Types



Trading Strategy Wizard - Short Trailing Stop

The Short Trailing Stop tab allow s you to specify trailing stop price levels for a short position. Note that a trailing stop liquidates
a position w ith a stop order placed prior to and executed during the bar in w hich the stop price w as penetrated. In contrast,
exit conditions liquidate a position w ith an exit order placed and executed after the bar on w hich the exit condition(s) became
true.

If you don’t w ant use a short trailing stop in this trading strategy, then deselect "Generate a trailing stop order for every bar
that is after an entry order has been filled and before an exit order has been generated". This wiill allow you to continue

w ithout entering any trailing stop price levels for a short position. Note that if you deselect both short trailing stop and short exit
conditions, then a short position will end (w ith a market order to exit short) w henever a long entry signal occurs.

For more information about the different types of trading strategies see Trading Strategy Types.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters
(Professional Only) or the indicator’s parameter ranges.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or the indicator’s parameter ranges.

e Toinsert short trailing stop price levels:
1. Press the Add price level(s) button.

e« To modify a short trailing stop price level, short trailing stop price level’s parameter, (Professional Only) or short trailing
stop price level’s parameter range:

1. Select the item in the list you w ish to modify.

2. Press the Modify price level button or Modify Parameter button (depending on w hat item you have selected).
Or

1. By double-clicking on the item in the list you w ish to modify.

e Toremove a short trailing stop price level:
1. Select the price level(s) in the list you wish to remove.
2. Press the Remove price level(s) button or press the delete button on you keyboard.

When displayed on a chart, a short trailing stop is displayed as a horizontal red line placed at the most recent trailing stop price
level and extending from just after the bar on w hich it w as calculated to the next bar for w hich it is active. If the trailing stop
price level is reached during the next bar, the exit price is annotated on the next bar with a red X. The exit price is the trailing
stop price (or open price if the bar opens above the trailing stop price) plus slippage.

After setting your short trailing stop price levels you can select the Long Entry tab, Long Trailing Stop tab, Long Exit tab,
Short Entry tab, Short Exit tab, or the Ne xt button.

Notes:

e If you are using both trailing stops and exit conditions, the trailing stop wiill not be placed on days w here the exit condition
is true and the exit order type is a Market Order.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

Topics of Interest:

What are Trading Strategies?
Using Predictions

Trading Strategy Types



Trading Strategy Wizard - Short Exit

The Short Exit tab allow s you to specify exit conditions for a short position. Note exit conditions liquidate a position w ith an exit
order placed and executed after the bar on w hich the exit condition(s) became true. In contrast, a trailing stop liquidates a
position w ith a stop order placed prior to and executed during the bar in w hich the stop price w as penetrated.

If you don’t w ant to use short exit conditions in this trading strategy, then deselect "Generate a cover short order ...". This will
allow you to continue w ithout entering any exit conditions for a short position. Note that if you deselect both short trailing stop
and short exit conditions, then a short position will end (w ith a market order to exit short) w henever a long entry signal occurs.

For more information about the different types of trading strategies see Trading Strategy Types.

If an indicator has a + sign to the left of the indicator you may click on the + sign to show the indicator’s parameters
(Professional Only) or the indicator’s parameter ranges.

If an indicator has a — sign to the left of the indicator you may click on the — sign to hide the indicator’s parameters (Professional
Only) or the indicator’s parameter ranges.

. To insert short exit conditions:
1. Press the Add Condition(s) button.

« To modify a short exit condition, short exit condition’s parameter, (Professional Only) or short exit condition’s parameter
range:

1. Select the item in the list you w ish to modify.

2. Press the Modify Condition button or Modify Parameter button (depending on w hat item you have selected).
Or

1. By double-clicking on the item in the list you w ish to modify.

e Toremove a short exit condition:
1.  Select the exit condition(s) in the list you wish to remove.
2. Press the Remove Condition(s) button or press the delete button on you keyboard.

The Order Type, Number of Conditions and Trailing Stop interfaces described below may or may not be visible depending upon
the currently selected Trading Strategy Wizard Interface Options. Press the Options button to change the Trading Strategy
Wizard Interface Options. For more information see Trading Strategy Wizard Interface Options.

Select the <Order Type> that you w ant to use w hen exiting a short position:
Market Order - Exits at the opening of the next bar. The exit price is the opening price plus slippage.
Stop Order - Exits if the next bar trades at or above the stop price. The exit price is the stop price (or open price if the bar
opens above the stop price) plus slippage.
Limit Order - Exits if the next bar trades at or below the limit price. The exit price is the limit price (or open price if the bar
opens below the stop price).

Stop Limit Order - Exits the market if the next bar trades above the stop price and then subsequently trades at or below the
limit price. The final exit price is the limit price.

Market Close Order - Exits at the closing of the next bar. The exit price is the closing price plus slippage.

If you select a stop order, limit order or stop limit order be sure to enter the corresponding stop price and/or limit price. Note
that the stop, limit, and stop limit orders are day orders and are therefore canceled if not filled by the end of the next bar. If
you w ant to trade from the open to the close of a single bar, use a market order to enter at the open of the next bar and a
market close order w ith the same conditions to exit at the close.

Select the <Number of Conditions> that you w ant to be true for a short exit signal to be generated. As an example, if you have
three conditions listed and you have selected the <Number of Conditions> to be 2, then w hen any 2 of the three exit conditions
are true a short exit signal w ill be generated.

When displayed on a chart, a Short Exit is annotated w ith a red outlined upw ard triangle below the bar on w hich the short exit

signal w as generated. The exit price is annotated on the next bar with a red X. When using stop, limit and stop limit orders, no
exit price annotation w ill appear on the next bar if the order is not filled and you wiill likely see a series of exit signal annotations
for subsequent bars until an order is filled.

If you are using a stop price, then the stop price is displayed on the chart as a horizontal red line placed at the stop price level



and extending from just after the bar on w hich it w as calculated to the next bar for w hich it is active. If you are using a limit
price, then the limit price is displayed on the chart as a horizontal dashed red line placed at the limit price level and extending
from just after the bar on w hich it w as calculated to the next bar for w hich it is active.

After setting your short exit conditions, <Order Type>, and <Number of Conditions> you can select the Long Entry tab, Long
Trailing Stop tab, Long Exit tab, Short Entry tab, Short Trailing Stop tab, or the Next button.

Notes:

. If you are using both trailing stops and exit conditions, the trailing stop w ill not be placed on days w here the exit condition
is true and the exit order type is a Market Order.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

. (Professional Only) When using Full Optimization or Rule Selection, the trading strategy allow s reduction in the number of
conditions below the number specified that must be true w hen a better solution if found w ith few er rules. When the
number of conditions selected by the optimizer is less than the specified number that must be true, all the optimally
selected rules must be true for the exit to occur.

Topics of Interest:

What are Trading Strategies?
Using Predictions

Trading Strategy Types



Trading Strategy Wizard - Parameters

This screen show s the parameters the trading strategy will use w hen calculating trading strategy performance. Among other
things, the trading strategy parameters are used to determine the start of trading strategy and evaluation of trading strategy
performance, the size of trades, entry commission(s), exit commission(s), and other costs associated w ith each trade.

This screen may or may not be displayed depending upon the currently selected Trading Strategy Wizard Interface Options. If
displayed, the list will show only the parameters w hose interface options have been selected. All other parameters are set to
their default values and do not appear in the list w hen the corresponding interface option has not been selected. Press the
Options button to change the Trading Strategy Wizard Interface Options. For more information see Trading Strategy Wizard
Interface Options.

If you wish to change any of these parameters:
1. Press the Modify Training Strategy Parameters button.

When you are satisfied w ith the trading strategy parameters press the Next button to proceed to the next wizard screen.

Notes:

. If you are trying to match the trading points of a prediction use the Match date ranges to the out of sample date
ranges of prediction(s) used in the trading strategy option on the Trading tab after you select to Modify Trading
Strategy Parameters. This option w ill automatically match up the dates to your out of sample prediction(s) so that all of
the trading strategy results will be based on data that the prediction(s) w asn’t trained on.

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

Topic of Interest:
What are Trading Strategies?



Trading Strategy Wizard - Results Summary

This screen show s the results of your trading strategy after the calculations are finished computing.

If at any time during backtest calculations, you w ant to abort, press the Abort button. After backtesting has been aborted, you
may do any of the follow ing:

e« Press the Rebacktest button to restart the backtesting.

e Press the Back button to modify the trading strategy.

. Press the Cancel button to exit the trading strategy w izard w ithout saving any results.

. Press the minimize icon at the top right corner of the w izard to minimize the entire NeuroShell Trader application. Doing so

will allow you to w ork w ith other programs during backtesting. Note that using the Show Desktop Window s task bar
icon, typically located next to the Window s Start button, w ill also minimize the NeuroShell Trader application.

(DayTrader Only) During market hours, optimization and backtesting may be much slow er if processor time is being utilized to
update charts w ith real-time data. Use the "Don’t update chart w hile optimizing/backtesting" check box to turn off the real-time
updating chart during optimization/backtesting.

After all backtest calculations have finished, you may do any of the follow ing:

. Sort the results list by clicking on the column header by w hich the list should be sorted. Clicking once wiill sort the list in
ascending order based upon the values in that column. Clicking a column header a second time w ill sort the list in
descending order based upon the values in that column.

. Press the Rebacktest button to restart the backtesting.

(Professional Only) If you are optimizing, you w ill be given the choice to optimize starting at the last optimal settings,
reoptimize starting from scratch, or simply rebacktest w ith the last optimal settings (no optimization occurs).

. Press the Finished button to end the wizard and add the trading strategy to your chart

. Press the Back button to modify the trading strategy.

. Press the Cancel button to exit the trading strategy wizard w ithout saving any results.

e Press the Detailed Analysis button to view detailed analysis of the selected trading strategy.

. Press the Save as Tem plate button to save the trading strategy as a new trading strategy template. Saving the trading
strategy as a template allow s you to apply the same trading strategy to different charts w ithout having to recreate the
analysis from scratch.

. Press the Print button to print a copy of the trading strategy.

The columns and statistics that are displayed can be customized in the Results Screen Columns section of the Trading
Strategy Wizard Interface Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For
more information see Trading Strategy Wizard Interface Options.

Notes:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

. NeuroShell Trader defaults to displaying an annualized percent return in the results summary (unless you changed the
optimization objective function). If you are using a small backtest period, keep in mind that the percentage show n is an
annualized return. For instance, if the NeuroShell Trader displays an annualized return of 1000% across a one w eek
backtest, the actual return w as approximately 20% for the w eek. (DayTrader Only) In the NeuroShell DayTrader, the
difference becomes even greater. For example, a 1000% annualized return across a one day backtest is approximately a
4% return for the day.

. (DayTrader Only) The Start Date corresponds to the date/time of the first bar in the backtest. It should be noted that a bar’
s time is w hen the bar is complete and not w hen the bar started.

For example, on a 30 minute chart, the 10:00am bar contains all the price action from 9:30am to 10:00am. If the Start Date
w as at 10:00am, then the 10:00am bar w as the first bar used for backtesting and therefore the backtest includes price
action starting at 9:30am.

o Trading Strategies play sound files or show pop-up order messages (for example: Buy 100 Shares of Dell) w hen a new
order is generated. Only active trading strategies wiill play sound files or show pop-up order messages.
When a new Trading Strategy is added to a chart, it is automatically activated. To deactivate or reactivate a trading
strategy, select the Alerts and Orders Window menu item from the View menu.
To change the sound and pop-up message options, select the Options menu item from the Tools Menu. If the Play
Sound File option is selected, then the selected sound wiill play w henever an active trading strategy generates a trading
order. If the Popup Order Message option is selected, a pop-up order notification message w ill appear w henever an
active trading strategy generates a trading order.

Topic of Interest:



What are Trading Strategies?
Trading Objective Functions



Print/Export - Setup

The Print/Export - Setup interface allow s you to select the type of print/export you w ant to perform. Using this interface you
may print to a printer (portrait or landscape), export to a file, or copy to the clipboard:

. To print to a printer (this option may not be available if you don’t have a printer defined in your window s environment):
1. Select the Printer option.
2. Select if you w ant to print in Landscape mode or Portrait mode.

e Towrite to afile:
1. Select the File option.
2. Enter the name of the file that you w ant to w rite to (you may use the Brow se button to help you).

e To copy to a clipboard:
1. Select the Clipboard option.

When you have completed selecting how you w ant to setup your print/export select the OK button to execute the print/export
or select the Selection tab to select w hat you w ant to print/export.



Print/Export - Selection (Trading Strategy)

The Print/Export - Selection interface allow s you to select w hat you w ant to print/export. Using this interface you may select
exactly w hat you w ant to print/export.

The Print/Export - Selection interface will list the items that are in your trading strategy. The possible items in this list are
(Professional Only) Optimization, Long Entry, Long Trailing Stop, Long Exit, Short Entry, Short Trailing Stop, Short Exit, Trading
Strategy Parameters, and Trading Strategy Results Summary.

Any of the items that are checked wiill be printed/exported and any of the items that are not checked wiill not be
printed/exported.

When you have completed selecting w hat you w ant to print/export select the OK button to execute the print/export or select
the Setup tab to select the type of print/export you w ant to perform.



Trading Strategy Parameters - Rules (Professional Only)

Use the trading strategy parameters rules tab to select the type of optimization you w ant to perform.

The parameters on this tab may or may not be visible depending upon the currently selected Trading Strategy Wizard Interface
Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For more information see Trading
Strategy Wizard Interface Options.

1. Select the optimization method used to determine the best entry, stop, and exit rules for the trading
strategy.

Full Optimization - Performs both Parameter Search and Rule Selection at the same time.

Parameter Search - All of your conditions (rules) are used, but the GA evolves optimum parameters for you. These
parameters do not produce rules that are individually optimum, but optimal as a complete set.

Rule Selection - Chooses among all the rules you have specified, leaving you w ith only the ones that w ork best
together.

No Optimization - Trades using the user specified rules. Performs no modifications to any rules or rule parameters.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

Topics of Interest:

What are Trading Strategies?

What are Genetic Algorithms? (Professional Only)

How Does a Genetic Algorithm Work? (Professional Only)

Why is a Genetic Algorithm Better Than Other Optimizers? (Professional Only)

What Types of Problems Do Genetic Algorithms Solve? (Professional Only)

How are Genetic Algorithms Used in the NeuroShell Trader Professional? (Professional Only)



Trading Strategy Parameters - Trading

Use the trading strategy parameters general tab to set up size of trades and other trading parameters used to evaluate the
trading strategy.

The parameters on this tab may or may not be visible depending upon the currently selected Trading Strategy Wizard Interface
Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For more information see Trading
Strategy Wizard Interface Options.

1. Specify the Size of trades used to evaluate trading strategy. The size of trades is important because it is the basis
for profit and commission calculations during the backtest. For the profit and commission statistics to be realistic, you
should specify a trading size that is closest to your actual trading style.

Buy a fixed number of shares - Backtests trading the specified number of shares

Buy a fixed dollar amount of shares - Backtests trading a varying number of shares based upon the specified
dollar amount and the closing price w hen the entry signal occurs. Shares Traded = (Dollars Specified / Entry Price)
rounded dow n to the nearest w hole number of shares.

Buy as many shares as possible with current account balance - Backtests trading a varying number of shares
based upon the current account balance and the closing price w hen the entry signal occurs. The current account
balance is increased/decreased by the realized profit/loss of each trade. Shares Traded = (Current Account Balance /
Entry Price) rounded dow n to the nearest w hole number of shares.

2. Specify the Other Trading Parameters used to evaluate trading strategy.

Buy shares in round lot of — Rounds dow n the number of shares traded to a multiple of the specified number of
shares. As an example, if the round lot shares is set to 100 and the number of shares to be traded is 299, then the
actual number of shares traded w ill be 200.

Long/Short entries exit existing short/long positions — Forces an entry signal to automatically exit existing
positions. Long positions will be exited w hen the short entry condition(s) become true. Likew ise, short positions will
be exited w hen the long entry condition(s) become true. If you do not select this parameter and you have specified
trailing stops and/or exit conditions, then a position w ill be exited only w hen the trailing stops are hit or the exit
conditions become true.

Match date ranges to the out of sample date ranges of prediction(s) used in the trading strategy (this
option is only available if you are using a prediction in your trading strategy) - This option matches up the dates of the
out of sample period of the prediction(s) to the period that you are evaluating your trading strategy over. (Professional
Only) Additionally, this option matches up the periods that the prediction(s) has been optimized over to the period that
the trading strategy will be optimized over.

When you are satisfied w ith the Trading Strategy Parameters press the OK button to return to the Trading Strategy Wizard.

Topic of Interest:
What are Trading Strategies?



Trading Strategy Parameters - Dates

Use the trading strategy parameters dates tab to set up the data ranges for the trading strategy paper trading (Professional
Only) and optimization.

The parameters on this tab may or may not be visible depending upon the currently selected Trading Strategy Wizard Interface
Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For more information see Trading
Strategy Wizard Interface Options.

1. Specify the Data used to evaluate trading strategy.

You can specify that the data range(s) match the chart, be a specified size, or start and stop on specified dates.

2. (Professional Only) Specify w hether or not to Save optimization which performs best on later paper trading.

If you choose Save optimization which performs best on later paper trading, the model’s parameters are still
optimized on the optimization set, but each new optimal solution that is found by the GA is applied to the paper trading
set. If that optimal solution is found to get better results on the paper trading set than previous optimal solutions, then it
is saved as the ‘best model’. Optimal solutions that underperformed on the paper trading are still used in the GA
optimization process to find an optimal solution on the optimal data set, but they are not used as the ‘best model’. The
final model selected by the optimization is the last saved ‘best model’.

3. Specify w hether or not to Start trading before last chart date.

This option may or may not be visible depending upon the currently selected NeuroShell Trader program options. To
enable this option, from the main NeuroShell Trader menu, select Tools, choose Options, navigate to the Advanced
option tab and check Allow real trading to begin before last chart date under the Date interface settings.

The Start trading before last chart date option allow s a ‘trading’ statistics data set to be calculated after the
optimization and paper trading data sets. This ‘trading’ data set will be a true "out-of-sample" data set. It can be used if
you do not wish to keep the model that did best on paper trading, but yet you still w ant to see how a model did on data
other than the optimization data set. This data set can also be used in conjunction w ith saving the model that did best
on subsequent paper trading to evaluate the model and yet another independent data set.

When you are satisfied w ith the Trading Strategy Parameters press the OK button to return to the Trading Strategy Wizard.

(Professional Only) Note that the optimization range of data is important because it determines w hich trading strategy is the
"best" (as specified by your Optimization objective on the Optimization tab). The default is to optimize across the same data as
the paper trading data, as this seems to be the standard among our competitors. This is a little risky, because w e are really
looking at in sample results. On the other hand, the NeuroShell Trader Professional is, w e believe, the first softw are to optimize
trading strategies that actually offers an alternative. In other w ords, w e are the first to provide a paper trading data set that is
out of sample from the optimization data set. Therefore, you might w ant to take some risk here since it has been standard
practice for some time. If you do not w ant to take that risk, simply do not choose the Save optimization which performs
best on later paper trading option.

Notes:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

e The start date for the trading strategy is important because it defines the start date for the backtest. The start date is also
important if you are currently in the market and you w ould like to setup the trading strategy to signal w hen you should exit
your position. By setting the start date closer to the current date, it will be easier to setup a trading strategy that is in a
matching long or short position on the last bar of the chart.

Topic of Interest:
What are Trading Strategies?



Trading Strategy Parameters - Costs

Use the trading strategy parameters costs tab to set up the costs associated with each trade. The costs wiill be used w hen
calculating your profit during the backtest.

The parameters on this tab may or may not be visible depending upon the currently selected Trading Strategy Wizard Interface
Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For more information see Trading
Strategy Wizard Interface Options.

1. Select and enter the Entry commission(s) and Exit commission(s) to use during backtesting:

Per Trade $ - Specifies a fixed dollar commission per trade.

Per Trade % - Specifies a commission based upon a fixed percentage of the total value of each trade.

Per Share/Contract $ - Specifies a commission based upon a fixed dollar charge per share/contract traded.

2. Select and enter the Other costs to use during backtesting:

Margin % per share/contract - Specifies the percentage of the share/contract cost that you must deposit w hen
leveraging your trades. This type of margin is generally used to backtest stock trades on margin.

Margin $ per share/contract - Specifies the number of dollars per share/contract that you must deposit w hen
leveraging your trades. This type of margin is typically used to backtest future trades on margin.

Slippage per share/contract - Specifies the expected difference betw een the desired execution price for an order
and the price at w hich the order is actually filled. Slippage should be used in a trading strategy if you wish to take into
account real w orld conditions w hich often cause a difference in price betw een w hen you place a trade w ith your
broker and w hen the trade gets filled on the floor.

When simulating a market order, a trading strategy only uses the next bars opening price and does not take into
consideration w hether the opening price w as at the bid or ask. By setting slippage to the expected average bid ask
spread, the entry and exit prices will be adjusted as if the opening price w as at the opposite side of the bid ask spread
as the entry or exit w ould occur.

Note that slippage is entered as the number of points you expect the market to move before the order is filled. If you
have not selected ‘Point value for futures contracts’, then a one point move is equivalent to a one dollar change in
price.

Point value for futures contracts - Specifies the amount by w hich the future price is multiplied to determine the
dollar value of a contract. Point value should be used in a trading strategy if you w ant the profit/loss results to reflect
the actual dollars you gained/lost instead of the points gained/lost.

When you are satisfied w ith the Trading Strategy Parameters press the OK button to return to the Trading Strategy Wizard.
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Trading Strategy Parameters - Optimization (Professional Only)

Use the trading strategy parameters optimization tab to set up the optimization objective and other optimization parameters.

The parameters on this tab may or may not be visible depending upon the currently selected Trading Strategy Wizard Interface
Options. Press the Options button to change the Trading Strategy Wizard Interface Options. For more information see Trading
Strategy Wizard Interface Options.

1. Select the Objective to determine the best entry, stop, and exit conditions during optimization of the trading
strategy

This is the objective that the trading strategy uses to determine w hat the "best" trading strategy is during optimization.
For more information see Trading Objective Functions.

2. Setup the Optimization parameters.

Shortest Average Trade Span - forces the optimization to choose a trading strategy that guarantees an average
trade span greater than or equal to the Shortest Average Trade Span over the optimization period (specified on the
Dates tab). Use this option is to decrease the number of trades if you find that optimization produces too many trades
over the optimization period. It is recommended that you choose this option only if you are unable to achieve your goals
using other methods.

Longest Average Trade Span - forces the optimization to choose a trading strategy that guarantees an average
trade span less than or equal to the Longest Average Trade Span over the optimization period (specified on the Dates
tab). Use this option to increase the number of trades if you find that optimization produces too few trades over the
optimization period. It is recommended that you choose this option only if you are unable to achieve your goals using
other methods.

Optimize for exactly - Forces the optimization to take a specified amount of time. Because of the nature of genetic
optimization, it is impossible to determine the exact optimization time or even w hen the best trading strategy has been
found. Without this parameter selected, optimization w ill automatically stop after it has decided that a better trading
strategy is unlikely to be found in the future. Set this parameter to a longer to make absolutely sure that the best trading
strategy has been found. Set this parameter to a shorter time to stop optimization before the best trading strategy has
been found.

Optimize across all chart pages - Forces the optimization to choose the same rules and parameters for each chart
page. The optimization will find the rules and parameters that perform best across all chart pages by using the
average result across all chart pages instead of trying to optimize the individual results for each chart page. Use of
this parameter w ill result in w orse results than optimizing each chart page individually, but will provide more consistent
and generalized rules and parameters across the chart pages.

When you are satisfied w ith the Trading Strategy Parameters press the OK button to return to the Trading Strategy Wizard.
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Trading Strategy Detailed Analysis - Statistics

This screen show s the general statistics for the selected backtest or the selected average of the backtests. Using this
information, you can evaluate how w ell you have setup your trading strategy.

The follow ing is a list of results that you will receive for the selected backtest evaluated by All trades, Long only, and Short
only:

Start Date - The first date included in the backtest. (DayTrader Only) See note below regarding start date.

End Date - The last date included in the backtest

Beginning Price - The closing price on the start date

Ending Price - The closing price on the end date

Change in Price - The difference betw een the beginning and ending price

Percent Change in Price - The percent difference betw een the beginning and ending price.

Annual Percent Change in Price - The annualized percent change in price. Annual Percent Change in Price = 365 *
(Percent Change in Price) / (Number of Calendar days betw een Start Date and End Date)

Return on Trades - The cumulative sum of all returns for each trade (including any open profit/loss on the last day of the
backtest). For long trades, Return = 100 * ((exit price - entry price) * shares) - exit commission) / (entry price * shares + entry
commission). For short trades, Return = 100 * ((entry price - exit price) * shares) - exit commission) / (entry price * shares +
entry commission). Note that the entry and exit price incorporate any specified slippage and/or point value. For more
explanation refer to Return on Account vs. Return on Trades.

Annual Return on Trades - The annualized return on trades. Annual Return on Trades = 365 * (Return on Trades) /
(Number of Calendar days betw een Start Date and End Date). For more explanation refer to Return on Account vs. Return on
Trades.

Return on Account - The net profit relative to the account size required to trade over the backtest (including any open
profit/loss on the last day of the backtest). Return on Account = 100 * (Net Profit) / (Account Size Required). For more
explanation refer to Return on Account vs. Return on Trades.

Annual Return on Account - The annualized return on account. Annual Return on Account = 365 * (Return on Account) /
(Number of Calendar days betw een Start Date and End Date). For more explanation refer to Return on Account vs. Return on
Trades.

Net Profit - The total dollar profit/loss for the trading strategy during the backtest (including any open profit/loss on the last day
of the backtest). Net Profit = (Gross Profit) - (Gross Loss)

Gross Profit - The total profit for all profitable trades over the backtest (including any open profit/loss on the last day of the
backtest). For long trades w ith an entry price < exit price, Trade Profit = exit price - entry price - commissions. For short
trades w ith an exit price < entry price, Trade Profit = entry price - exit price - commissions. Note that the entry and exit price
incorporate any specified slippage and/or point value.

Gross Loss - The total loss for all losing trades over the backtest (including any open profit/loss on the last day of the
backtest). For long trades with an entry price > exit price, Trade Loss = entry price - exit price - commissions. For short trades
w ith an exit price > entry price, Trade Loss = exit price - entry price - commissions. Note that the entry and exit price
incorporate any specified slippage and/or point value.

Ratio Gross Profit/Loss - The gross profit relative to the gross loss. Ratio Gross Profit/Loss = (Gross Profit) / (Gross
Loss)

Percent Profitable Trades - The percent of the trades over the backtest that w ere profitable. Percent Profitable Trades =
100 * (Number Winning Trades) / (Number of Trades)

Number Trades - The number of trades over the backtest.

Number Winning Trades - The number of trades over the backtest that w ere profitable.
Number Losing Trades - The number of trades over the backtest that w ere not profitable.
Largest Winning Trade Profit - The most profit made by a trade during the backtest.
Largest Losing Trade Loss - The largest loss caused by a trade during the backtest.

Average Trade Profit - The average gain (or loss) across all trades in the backtest. Average Trade Profit = Net Profit /
Number Trades

Average Winning Trade Profit -The average gain across all profitable trades in the backtest. Average Winning Trade Profit
= (Gross Profit) / (Number Winning Trades)

Average Losing Trade Loss - The average loss across all losing trades in the backtest.

Ratio Avg Win/Avg Loss - The average w inning trade profit relative to the average losing trade profit. Ratio Avg Win/Avg
Loss = (Average Winning Trade Profit) / (Average Losing Trade Loss)

Maximum Consecutive Winners - The maximum number of consecutive profitable trades during the backtest.
Maximum Consecutive Losers - The maximum number of consecutive losing trades during the backtest.

Average Trade Span - The average number of bars betw een the entry order signal and the exit order execution for each
trade in the backtest.

Average Winning Trade Span - The average number of bars betw een the entry order signal and the exit order execution for
each profitable trade in the backtest.



Average Losing Trade Span - The average number of bars betw een the entry order signal and the exit order execution for
each losing trade in the backtest.

Longest Trade Span - The largest number of bars betw een the entry order signal and the exit order execution for any single
trade during the backtest.

Longest Winning Trade Span - The largest number of bars betw een the entry order signal and the exit order execution for
any single profitable trade during the backtest.

Longest Losing Trade Span - The largest number of bars betw een the entry order signal and the exit order execution for
any single losing trade during the backtest.

Largest Shares Traded - The largest number of shares traded during any single trade during the backtest.

Largest Winning Shares Traded - The largest number of shares traded during any single profitable trade during the
backtest.

Largest Losing Shares Traded - The largest number of shares traded during any single losing trade during the backtest.
Average Shares Traded - The average number of shares traded for each trade in the backtest.

Average Winning Shares Traded - The average number of shares traded for each profitable trade in the backtest.
Average Losing Shares Traded - The average number of shares traded for each losing trade in the backtest.
Commissions Paid - The total amount of commissions paid during the backtest.

Maximum Drawdow n - The maximum value of draw dow n, w here the draw dow n at each bar is the difference betw een the
highest prior closed net profit and the current open net profit. Draw dow n = (Largest Net Profit prior to trade entry) - (Net
Profit prior to trade entry) + (Open Trade Draw dow n)

Maximum Open Trade Draw dow n - The maximum open trade draw dow n for any trade during the backtest. Open Trade
Draw dow n = (shares traded) * [(entry price) - (w orst price during the trade)]. Note that the entry price incorporates any
specified slippage and/or point value.

Required Account Size - If a margin per contract has been selected on the trading parameters screen, then the Required
Account Size = (Maximum Draw dow n) + (Margin Per Contract) * (Largest Contracts Traded). If no margin per contract has
been selected, then the Required Account Size is the largest entry cost w here Entry Cost = (number of shares traded) * (entry
price) - (Net Profit prior to trade entry). Note that the entry price incorporates any specified slippage and/or point value.

Notes:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.

e (DayTrader Only) The Start Date corresponds to the date/time of the first bar in the backtest. It should be noted that a bar’
s time is w hen the bar is complete and not w hen the bar started.

For example, on a 30 minute chart, the 10:00am bar contains all the price action from 9:30am to 10:00am. If the Start Date
w as at 10:00am, then the 10:00am bar w as the first bar used for backtesting and therefore the backtest includes price
action starting at 9:30am.
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Trading Strategy Detailed Analysis - Trade by Trade

This screen show s the trade by trade results for the selected backtest. Using this information, you can evaluate how w ell you
have setup your trading strategy.

The follow ing is a list of items that you w ill receive for each entry and exit signal in the backtest:
Date - Date on w hich the entry or exit w as signaled.

Signal - The type of order (Long Entry, Long Exit, Short Entry, or Short Exit). On the graph, a Long Entry is annotated with a
solid blue upw ard triangle, a Long Exit is annotated w ith a blue outlined dow nw ard triangle, a Short Entry is annotated w ith a
solid red dow nw ard triangle, and a Short Exit is annotated w ith a red outlined upw ard triangle.

Shares - The number of shares (or contracts) bought or sold w ith the order.

Fill Date - Date on w hich the entry or exit w as actually filled. For the simple case of a market order, the date will be the next
trading day after the signal.

Price - The price at w hich the order w as filled. On the graph, this price is annotated w ith an X on the Fill Date. For the simple
case of a market order w ith no slippage the price is the open on the Fill Date. If no open is included in your data, then the
previous days close is used and adjusted for gaps if a high and low is included in your data (i.e. if today’s low is higher than
yesterday’s close then the low will be used as today’s open).

Commission - The commission paid for the order. If you have not specified any entry or exit commissions in the trading
parameters, this value will be zero.

%Return (exit only) - % return for the position that w as exited.
%Return is calculated as follow s:

Long Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) / (entry
price*shares — entry commissions).

Short Percent Return = 100 * ((exit price - entry price)*shares - entry commission - exit commission) / (entry
price*shares — entry commissions).

If using margin $ per share/contract, then % return is calculated as follow s:

Long Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) /
(margin*contracts — entry commissions)

Short Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) /
(margin* contracts — entry commissions)

Note that the entry and exit price incorporate any specified slippage and/or point value.
Profit/Loss (exit only) - The dollar amount made (or lost) by the position that w as exited.
Cum %Ret (exit only) - The cumulative percent return for all positions up to and including the position just exited.
Cum Profit/Loss (exit only) - The cumulative profit (or loss) for all positions up to and including the position just exited.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.
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Trading Strategy Detailed Analysis - Trading Rules

This screen show s the consolidated trading rules that w ere used to calculate the backtest that you selected. (Professional
Only) This is particularly important during optimization because you w on’t have any other w ay to determine w hat the rules are
for each instrument. Remember that the rules for each instrument w ill probably be different because they have been optimized
individually.

Note:

. It should be understood that trading can result in losses, and that past performance of a trading system is no guarantee of
future performance.
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Print/Export - Setup

The Print/Export - Setup interface allow s you to select the type of print/export you w ant to perform. Using this interface you
may print to a printer (portrait or landscape), export to a file, or copy to the clipboard:

. To print to a printer (this option may not be available if you don’t have a printer defined in your window s environment):
1. Select the Printer option.
2. Select if you w ant to print in Landscape mode or Portrait mode.

e Towrite to afile:
1. Select the File option.
2. Enter the name of the file that you w ant to w rite to (you may use the Brow se button to help you).

e To copy to a clipboard:
1. Select the Clipboard option.

When you have completed selecting how you w ant to setup your print/export select the OK button to execute the print/export
or select the Selection tab to select w hat you w ant to print/export.



Print/Export - Selection (Trading Strategy Detailed Analysis)

The Print/Export - Selection interface allow s you to select w hat you w ant to print/export. Using this interface you may select
exactly w hat you w ant to print/export.

The Print/Export - Selection interface w il list the items that are in your trading strategy detailed analysis, w hich are Statistics,
Trade By Trade, and Trading Rules.

Any of the items that are checked wiill be printed/exported and any of the items that are not checked wiill not be
printed/exported.

When you have completed selecting w hat you w ant to print/export select the OK button to execute the print/export or select
the Setup tab to select the type of print/export you w ant to perform.



Modifying Trading Strategies

Modifying trading strategies allow s you to modify the currently selected trading strategy. This may be useful if you w ant to
recalculate the backtest results, change the trading strategy parameters (i.e. Size of backtest used to evaluate trading
strategy), or the long and short signals.

1. Select a trading strategy displayed on the chart by clicking on the corresponding line, legend text, or Snapshot View
text.

2. Once the prediction is selected (highlighted w ith black boxes), select Modify Selected Trading Strategy from the Edit

menu.
Cuk Chrl43
Copy Chrl4C
Paske Chrl4Y
Delete Dl

Madify

or

1. Select a trading strategy displayed on the chart by right-clicking on the corresponding line or legend text.
2. Select Modify Selected Trading Strategy from the pop-up menu.

uk
Copy
Paste
Delete

Maodify Selected Trading Strateqgy ...

Format Selected Trading Strategy ...

or

1. Modify a trading strategy displayed on the chart by double-clicking on the corresponding line or legend text.

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection wiill not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.

. In order to recalculate a backtest you must select the Rebacktest button (from the Trading Strategy Wizard - Results
Summary).
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What are Alerts? (Professional Only)

Alerts are a set of conditions that, w hen all are true at the same time, give a notification to you. When this set of conditions
activates an alert, it will be show n in the Alert Window automatically, pop up the Alert Window (if desired), play a sound (if
desired), and show the change in alert status on your screen (if not hidden from view ).



Creating an Alert (Professional Only)

Creating an alert will allow you to add alerts to your chart that are used to inform you of events that you define.

1. Select New Alert from the Insert menu. This activates the alert wizard, w hich guides you through the process of
creating an alert.

Insert

Existing Data | Calculations ...

Mew Indicator ...
Mew Prediction ...
Mew Trading Strakegw ...

Mew alert ...

Qther Inskrument Data ...

Note:
e You may have multiple alerts displayed on one chart by simply creating more than one alert.
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Alert Wizard - List Conditions (Professional Only)

Listing conditions allow s you to select the conditions that you w ant to be true for the alert to be raised. Note that all of the
conditions must be true for the alert to be activated.

Make a list of the conditions you w ish to use for your alert.

e To add data items to the list:
1. Press the Add Condition(s) button.

e  To modify or replace an item in the list:
1. Select the item in the list you w ish to modify.
2. Press the Modify Condition button.
Or
1. Double-Click the condition.

e Toremove items from the list:
1.  Select the item or items in the list you w ish to remove.
2. Press the Remove Condition(s) button or press the delete key on your keyboard.

When you are finished making a list of conditions that you w ish to use for your alert press the Next button to proceed to the
next wizard screen.
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Alert Wizard - Properties (Professional Only)

Setting the properties of the alert will allow you to control how the Alert will be displayed and heard (if desired).

To set the properties of the Alert:
1. Select the Name of Alert, this is w hat wiill be displayed on the chart and in the Alert Window w hen the alert occurs.
2. Enter a Description (if desired) of the Alert, this will be displayed in the Alert Window w hen the alert occurs.

3. Select Popup Alert Window if you w ant this alert to automatically popup the Alert Window w hen the alert occurs.
Otherw ise (if you don’t w ant the Alert Window popping up), deselect this option.

Select Play sound file if you w ant this alert to play a sound w hen the alert occurs. Additionally you must select w hich
sound that you w ant the alert to play. If you don’t w ant the alert to play a sound deselect this option.

5. Press the Finish button to end the wizard and display the alert.

»

Tip:

e The list of available sounds is compiled from all the .WAV sound files located in the Sounds subdirectory (C:\NeuroShell
Trader\Sounds). If you would like to use a custom sound not provided w ith NeuroShell Trader, simply copy the desired
.WAYV sound file into the Sounds subdirectory prior to running NeuroShell Trader.
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Modifying Alerts (Professional Only)

Modifying alerts allow s you to modify the currently selected alert. This may be useful if you w ant to change the conditions of
an alert (i.e. moving average crossover periods), or the properties of the alert (i.e. sound played or name).

1. Select an alert displayed on the chart by clicking on the corresponding line, legend text, or Snapshot View text.
2. Once the indicator is selected (highlighted w ith black boxes), select Modify Selected Indicator from the Edit menu.

Cut Chrl+3
Copy Chel+C
Paste Chrl+y
Delete Dl

Modify Selected Alert ...

or

1. Select an indicator displayed on the chart by right-clicking on the corresponding line or legend text.
2. Select Modify Selected Alert from the pop-up menu.

Zuk
Copy
Paste
Delete

Modify

Format Selected Alert ..,

Troubleshooting:

e You must make sure the mouse cursor has changed to a hand before clicking on the line or legend text. If the cursor is
still an arrow or a cross hair, the selection will not occur. If you are selecting a line on the chart, it is best to position the
cursor over a data point instead of the portion of the line connecting tw o data points.



Alerts and Orders Window (Professional Only)

The Alerts and Orders Window displays the alerts, active trading strategies, current market positions and trading orders for all
charts. It show s lists of the alerts, active trading strategies, current market positions, all trading orders, open trading orders,
filled trading orders, and canceled trading orders.

To view the Alerts & Orders Window :
1. Select Alerts and Orders Window menu item from the View menu.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.
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Alerts and Orders Window - Active Trading (Professional Only)

The Active Trading view of the Alerts and Orders Window displays all the trading strategies across all open charts, with a
check next to strategies that are currently active. Only active trading strategies w ill show their position and orders in the other
tabs of the Alerts and Orders Window .

Additionally, only active trading strategies w ill give sound accompanied pop-up order notification w hen the sound and pop-up
order options are active (the sound and pop-up order notification options are accessed using the Options menu item in the
Tools Menu).

If you have selected Send Orders to Brokerage option (accessed using the Options menu item in the Tools Menu), then
active trading strategies wiill send orders directly to the selected brokerage.

To activate or deactivate a trading strategy, select or unselect the trading strategy using the check box to the left of the ticker
symbol.

The follow ing is a description of each column in the Active Trading view :
Position — The current position of the ticker symbol. Possible positions include none, long, and short.
Shares — The number of shares/contracts being bought or sold.
Symbol — The ticker symbol for the trading strategy. There wiill be one ticker symbol for each chart page in the chart.
Strategy — The name of the trading strategy.
Chart — The chart name on w hich the trading strategy resides.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.

Note:

. Only trading strategies can be activated. To get position status, order status, and order notification for a prediction, create
a trading strategy based upon the prediction and then activate that strategy.



Alerts and Orders Window - Alerts (Professional Only)

The Alerts view of the Alerts and Orders Window displays all the alerts that have occurred on all open charts.

The follow ing is a description of each column in the Alerts view :
Date — The time and date w hen the alert occurred.
Chart — The chart name on w hich the alert resides.
Symbol — The ticker symbol on w hich the alert occurred.
Alert — The name of the alert.
Description — The alert description.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.



Alerts and Orders Window - All Orders (Professional Only)

The All Orders view of the Alerts and Orders Window displays the status of all trading orders that have been placed for
active trading strategies. Only those orders that have occurred since a trading strategy w as activated w ill be show n in this
view .

The follow ing is a description of each column in the All Orders view :
Status — The current status of the order. Possible statuses include Open, Filled, and Canceled.
Action — The action of the order. Possible actions include Buy Long, Sell Long, Sell Short, or Cover Short.
Shares — The number of shares/contracts being bought or sold.
Symbol — The ticker symbol being traded.

Order — The order type. Possible order types include Market, Stop XX, Limit XX, Stop XX Limit XX, and Market Close (w here
XX represents the stop or limit price).

Last Price — The last price of the symbol.
Fill Price — The price at w hich the order w as filled in the market (if status is Filled)

Time Filled/Canceled — The time that the order w as filled in the market (if status is Filled) or the time that the order w as
cancelled by the trading strategy (if status is Canceled)

Time Placed — The time the order w as generated by the trading strategy.
Strategy — The name of the trading strategy that generated the order.
Chart — The chart name on w hich the trading strategy resides.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.



Alerts and Orders Window - Canceled Orders (Professional Only)

The Canceled Orders view of the Alerts and Orders Window displays all the trading orders for active trading strategies that
w ere cancelled before they ever got filled.

In general, market orders w ill be filled almost immediately during market hours. Order types like stops and limits w ill remain open
until their target price is reached or the trading strategy cancels them.

The follow ing is a description of each column in the Open Orders view :
Action — The action of the order. Possible actions include Buy Long, Sell Long, Sell Short, or Cover Short.
Shares — The number of shares/contracts being bought or sold.
Symbol — The ticker symbol being traded.

Order — The order type. Possible order types include Market, Stop XX, Limit XX, Stop XX Limit XX, and Market Close (w here
XX represents the stop or limit price).

Last Price — The last price of the symbol.

Time Canceled — The time that the order w as filled in the market (if status is Filled) or the time that the order w as cancelled
by the trading strategy (if status is Canceled)

Time Placed — The time the order w as generated by the trading strategy.
Strategy — The name of the trading strategy that generated the order.
Chart — The chart name on w hich the trading strategy resides.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.



Alerts and Orders Window - Filled Orders (Professional Orders)

The Filled Orders view of the Alerts and Orders Window displays all the trading orders for active trading strategies that have
been executed in the market.

In general, Market orders will be filled almost immediately during market hours. Order types like Stops and Limits w ill remain
open until their target price is reached or the trading strategy cancels them.

The follow ing is a description of each column in the Open Orders view :
Action — The action of the order. Possible actions include Buy Long, Sell Long, Sell Short, or Cover Short.
Shares — The number of shares/contracts being bought or sold.
Symbol — The ticker symbol being traded.

Order — The order type. Possible order types include Market, Stop XX, Limit XX, Stop XX Limit XX, and Market Close (w here
XX represents the stop or limit price).

Last Price — The last price of the symbol.

Fill Price — The price at w hich the order w as filled in the market.

Time Filled — The time that the order w as filled in the market.

Time Placed — The time the order w as generated by the trading strategy.
Strategy — The name of the trading strategy that generated the order.
Chart — The chart name on w hich the trading strategy resides.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.



Alerts and Orders Window - Open Orders (Professional Only)

The Open Orders view of the Alerts and Orders Window displays all the currently unfilled trading orders that have been
placed for active trading strategies. Once an order is filled or canceled, it will be removed from this view and moved to the
appropriate Filled or Canceled orders view .

In general, Market orders w ill be filled almost immediately during market hours. Order types like Stops and Limits w ill remain
open until their target price is reached or the trading strategy cancels them.

The follow ing is a description of each column in the Open Orders view :
Action — The action of the order. Possible actions include Buy Long, Sell Long, Sell Short, or Cover Short.
Shares — The number of shares/contracts being bought or sold.
Symbol — The ticker symbol being traded.

Order — The order type. Possible order types include Market, Stop XX, Limit XX, Stop XX Limit XX, and Market Close (w here
XX represents the stop or limit price).

Last Price — The last price of the symbol.

Time Placed — The time the order w as generated by the trading strategy.
Strategy — The name of the trading strategy that generated the order.
Chart — The chart name on w hich the trading strategy resides.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.



Alerts and Orders Window - Positions (Professional Only)

The Positions view of the Alerts and Orders Window displays the current market position for all active trading strategies.
Long positions wiill be colored blue, short positions wiill be colored red, and no position w ill be colored gray.

The follow ing is a description of each column in the Positions view :
Position — The current position of the ticker symbol. Possible positions include none, long, and short.
Shares — The number of shares/contracts being bought or sold.
Symbol — The ticker symbol being traded.
Fill Price — The price at w hich the entry order w as filled in the market.
Last Price — The last price of the symbol.
Profit — The current open profit of the position if it w as closed at the last price.
Time Placed — The time the order w as generated by the trading strategy.
Entry Time — The time that the entry order w as filled in the market
Strategy — The name of the trading strategy that generated the order.
Chart — The chart name on w hich the trading strategy resides.

To hide the Alerts and Orders Window deselect the Alerts and Orders Window menu item from the View menu.



What is Ticker Symbol Scanning

Ticker Symbol Scanning is a w ay of searching a large number of ticker symbols for user defined criteria or indicator values.
Ticker scanning enables you to develop a systematic approach to selecting ticker symbosl to trade and test how systems do on
ticker symbols that match a given criteria.

The NeuroShell Trader Ticker Scanning Wizard makes it easy to implement scanning of ticker symbols for any number of user
created criteria or values. Once scanning is complete, you wiill be able to sort the ticker symbols on the criteria or values and
create a chart with those criteria and values for the ticker symbols of your choice.



Creating a Ticker Symbol Scan

Creating a trading strategy wiill allow you to add buy/sell signals to your chart that are based upon rules that you define.

1. Select Scan Ticker Symbols ... from the File menu. This activates the ticker symbol scanning w izard, w hich guides
you through the process of creating a scan.

File
Mew ... Chrl+M
Qpen ... Chel+0
Close
Close All
Save Chart Chrl+5

Save Chart fs .,
Save Chart As Template ...
Save Workspace ..,

Scan Ticker Symbols ...

Brint Chart .., CLrl+P
Email 3 Chart ...

Exit

Topic of Interest:
What is Ticker Symbol Scanning



Scanning Wizard - Choosing a Tem plate

This screen show s the scanning templates available for use. Scanning templates are preconfigured scans that allow you to
create a ticker symbol scan quickly w ithout having to w orry about all the details of creating one from scratch.

To select an existing template:
1. Select the desired template from the list.

To create a scan from scratch
1. Select (No Template) located at the top of the list.

When you are satisfied w ith the template the scan wiill use press the Next button to proceed to the next wizard screen.

Notes:

e Any scan that is saved by selecting Save as Tem plate button on the last scanning w izard page wiill be available as a
scan template in template list. Therefore, if you w ant to create your ow n custom scanning templates, you need only
create a scan from scratch and then save it as a template on the last wizard page.



Scanning Wizard - Choosing a Periodicity and First Date

Selecting the scan periodicity and first date enables you to choose the frequency and amount of data used in the scan.

The periodicities available are as follow s:

Monthly Each bar represents one month of trading activity
Weekly Each bar represents one w eek of trading activity
Daily Each bar represents one day of trading activity

(Day Trader Only)

Hour Each bar represents trading activity for the user-specified number of hours.

Minute Each bar represents trading activity for the user-specified number of minutes.

Second Each bar represents trading activity for the user-specified number of seconds.

Tick Each bar represents trading activity for the user-specified number of trades.

Volume Each bar represents trading activity for the user-specified minimum volume. The volume of each bar w ill equal
the specified volume. Each bar is created by accumulating trades until the specified volume is reached. Since
trades are not split across bars, a bar’s volume may exceed the specified volume if the volume of the last
trade is greater than needed to exactly reach the specified volume.

Range Each bar represents trading activity for the user-specified minimum price range. The high-low range of each
bar will equal the specified range. Each bar is created by accumulating trades until the high-low range is
reached. The first trade to break outside that range starts a new bar. Since price gaps are not filled w ith
phantom bars, the high-low range of a bar can exceed the specified range w hen prices gap outside the range
before a bar’s price range criteria w as met.

To choose a chart periodicity and first date:

1. Select a periodicity for the scan by clicking on the desired periodicity of either daily, w eekly, monthly, (DayTrader
Only) or intraday. If you chose intraday, you should also enter the desired intraday bar size (i.e. 1, 2, 3, ...) in the text box
and select the desicred bar type (i.e. Hour Bars, Minute Bars, Second Bars, Tick Bars, or Volume Bars). Note that
Second, Tick, and Voume bars may not be supported depending upon the data feed being used and therefore Second,
Tick, and Volume may not displayed.

2. Choose how far back to initially load data by entering a date, using the up/dow n buttons to change the
day/month/year, or selecting the dropdow n arrow to select a date from the calendar.

3. Press the Next button to proceed to the next wizard screen.

Notes:

(DayTrader Only) Note that Second, Tick, Volume and Range bars are created from tick by tick data streams and therefore
historical data may be limited and take longer to load.

(DayTrader Only) Second, Tick, Volume and Range bars can only be created using Quote.com or eSignal and w il
therefore not be visible w hen using other data feeds.

NeuroShell Trader wiill handle all data conversion if you choose a chart periodicity different from the data files upon w hich
the scan is based.

Example #1: If you create a monthly scan based upon daily data files, NeuroShell Trader w ill set the monthly open equal
to the first daily open, the monthly high equal to the highest daily high, the monthly low equal to the low est daily low,
and the monthly close equal to the last daily close. Additionally, the monthly volume & open interest equal to the sum of
all daily volumes & open interests, and all other monthly data values equal to the last daily data value.

Example #2: If you create a daily scan based upon monthly data files, data points will only occur once a month.

How ever, if you insert other instrument data that comes from a daily data file, the new instrument wiill have data every
day and the original data w ill be extended so that each day has the last monthly value.



Scanning Wizard - Selecting an Instrument Category

Selecting the instrument category w ill select w hat type of scan you w ant to view. From this point on everything in your scan
w ill be based on this type of instrument data (you w ill alw ays be able add other instrument data to the scan, but the tickers
actually scanned wiill be based upon this type of instrument data).

1.  Select the type of instruments you w ish to scan.
2. Press the Next button to proceed to the next wizard screen.

Troubleshooting:

. If you think the categories listed are incorrect or some categories are missing, you w ill need to change your data sources
settings. To do this, press the Cancel button and select Data Sources from the Tools menu. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.



Scanning Wizard - Selecting Instruments

Selecting the instruments that you w ant to scan allow s you to choose the instruments for w hich you w ant to view criteria and
values.

1.
3.

Select the instrument or instruments you wish to scan.
Press the Next button to proceed to the next wizard screen.

To sort by ticker symbol:

1.

Select the Sort by Symbol option.

To sort by name/description:

1.

Select the Sort by Nam e option.

To show only the items selected in your list:

1.

Select the Selected items only option.

To show all the items in the list (both selected and not selected):

1.

Deselect the Selected items only option.

If you are using Quote.com, eSignal or Prophet.net as your data source, you have the option of adding instruments that are not
already listed. To add a new ticker symbol:

1.

Press the Add New Quote.com Ticker Symbol, the Add New eSignal Ticker Symbol or the Add New
Prophet.net Ticker Symbol button.

2. Enter the instrument’s ticker symbol into the Ticker box

3. Enter the instrument’s full name into the Name box

4. Select the instrument’s category using the Category drop dow n box.

5. Press the OK button to add the new instrument.

Notes:

e If you are using the data that came on the NeuroShell Trader Historical Data CD or the data installed in the NeuroShell
Trader Data subdirectory, you may see extra letters after the stock name (For example: Microsoft MSQ ZMF ZJZ). This is
an indication that the stock is an optionable stock and the letters are the actual root symbols for the stock’s option
contracts.

Tips:

To select a group of instruments, hold the left mouse button dow n w hile you drag the mouse over the desired
instruments.

If you are unable to find a ticker, you’ll w ant to make sure that your data is setup correctly. For information on how to
setup your data review : Setting Up Data Directories and/or Setting Up Data Server.



Scanning Wizard - Adding Values to Scan

This list contains the values that w ill be scanned for each ticker. You may add one or more data series, indicators, or other
instrument data values. For each added value, the scan results screen will dispaly the calculated value for each of the
scanned ticker symbols.

Make a list of the values for w hich you wish to scan.

e To add data items to the list:
1. Press the Add Value(s) button.

e To madify an input, input’s parameter, or (Professional Only) input’s parameter range:
1.  Select the item in the list you w ish to modify.
2. Press the Modify Value ... button.
Or
1. By double-clicking on the item in the list you w ish to modify.

. To remove items from the list:
1. Select the item or items in the list you w ish to remove.
2. Press the Remove Value(s) button or press the delete button on you keyboard.

When you are finished making a list of values for w hich you wish to scan, press the Next button to proceed to the next wizard
screen.



Scanning Wizard - Scan Results

This screen show s the results of scan after all the ticker symbols have been scanned and the calculations are finished
computing.

If at any time during scan, you w ant to abort, press the Stop Scanning button.

After the scanning has finished, you may do any of the follow ing:

Sort the results list by clicking on the column header by w hich the list should be sorted. Clicking once will sort the list in
ascending order based upon the values in that column. Clicking a column header a second time w ill sort the list in
descending order based upon the values in that column.

Select the ticker symbols for w hich you wish to create a chart by clicking the mouse button in the square to the left of
each ticker symbol in the results list.

Press the Finished button to end the wizard and create a chart that has the scan values/indicators already created for
the ticker symbols that are checked in the results list.

Press the Back button to modify the scan.
Press the Cancel button to exit the scanning w izard w ithout saving any results.

Press the Save as Tem plate button to save the scan as a new scanning template. Saving the scan as a template allow s
you to redo the scan at a later time w ithout having to recreate the scan from scratch.

Topic of Interest:

What is Ticker Symbol Scanning



What is Integrated Brokerage Trading

Integrated Brokerage Trading allow s trades from a Trading Strategy to be sent directly to a brokerage.

To setup integrated trading w ithin NeuroShell Trader
1. Select Options from the Tools menu to activate the Options Dialog.

2. Select Send orders to brokerage from the Trading Orders tab.
3. Select the desired brokerage server from the Brokerage drop-dow n list

The follow ing are the brokerage servers distributed w ith NeuroShell Trader that can be selected in the Brokerage drop dow n
list:
Interative Brokers — Sends trades to Interactive Brokers. For more detailed information see: Interactive Brokers
Order Emailer — Emails trades to a list of email addresses. For more detailed information see: Order Emailer

Notes:
« Additional brokerage servers may be available from third party developers or developed using the NeuroShell Trader
Brokerage API. Once installed, additional brokerage servers will be listed in the Brokerage drop dow n list.
e While integrated trading is occurring, the price bars of the trading strategy w ill be colored yellow . If you save and reload a
chart that w as being actively trading, the old fill prices and yellow areas of active trading will also be saved and
redisplayed.



Interactive Brokers

Interactive Brokers (w w w .interactivebrokers.com) is the default brokerage supported by NeuroShell Trader’s integrated
trading interface.

To setup integrated trading so that NeuroShell Trader sends sends trades to an Interactive Brokers account, Interactive Brokers
paper trading account, or Interactive Brokers demo account:

Select Options on the Tools menu.
Select the Send orders to brokerage option located on the Trading Orders tab.
Select Interactive Brokers from the Brokerage drop-dow n list.

Note: If Popup order prom pt/confirmation is checked, then NeuroShell Trader w ill ask you if you w ant to send
orders before sending them, otherw ise it will simply send orders w ithout user interaction.

At this point, any chart you load that has a trading strategy w ill NOT automatically start sending orders to a brokerage.
Only charts that have active trading already setup will send trades to the brokerage. To setup active trading on a chart,
select Alerts/Orders Window from the View menu and select the Trading Strategies on that you w ish to actively trade
from the list on the Active Trading tab of the Alerts/Orders w indow .

When you first select a trading strategy to actively trade, you get a message box saying "About to establish a connection
w ith Interactive Brokers". If you do not follow the instructions (show n below ), NeuroShell Trader w ill NOT be able to
communicate w ith Interactive Brokers due to restrictions in the interface provided by Interactive Brokers.

a. Make sure the IB Trader Workstation is loaded and running before pressing OK.

Ward Systems Group highly recommends using Interative Broker’s demo w orkstation or a paper trading account
before making live trades.

The demo w orkstation is for evaluation purposes and doesn’t actually make trades in the market. Using the demo
w orkstation first allow s you to be confident that your system is w orking as desired and that the communications
betw een NeuroShell Trader and Interactive Brokers is w orking properly on your computer. To load a demo version
of the IB Trader Workstation, goto w w w .interactivebrokers.com, choose ‘Softw are’ on the upper menu bar, and
select "Trader Workstation" and then "Demo". Follow the instructions to run the Individual Demo.

If you have an account w ith Interactive Brokers, you can also request a paper trading account from Interactive
Brokers. A paper trading account w orks just like a real Interactive Broker’s account, except you are issued a
different logon id/passw ord and the trades are not actually placed w ith the market. A paper trading account is
another excellent w ay to test that your system is w orking as desired and that the communications betw een
NeuroShell Trader and Interactive Brokers is w orking properly on your computer before you start live trading.

If you have an account w ith Interactive Brokers and you w ish to make live trades, then simply load up the
Interactive Brokers Trader’s Workstation as you w ould normally to place trades w ith Interactive Brokers.

b. Verify client support is configured in the IB Trader Workstation

To make sure client support is configured in the IB Trader Workstation (TWS), goto the ‘Configure’ Menu on the
TWS menu screen, select the ‘AP’ menu item and make sure the ‘Enable ActiveX and Socket Clients’ is checked.

c. Choose Yes on the ‘Accept Incoming Attempt prompt in the IB Trader Workstation

Once you hit OK, NeuroShell Trader tries to establish a connection. The IB Trader Workstation (TWS) puts up a
message box to verify that you w ant to make the connection. If you do not go back to the IB TWS and press Yes,
then trades sent from NeuroShell Trader will not reach the IB TWS.

If you haven’t already specified a ticker and exchange mapping for the underlying data feed ticker symbol using the
Ticker/Exchange Mapping button on the Options dialog, you will be prompted to enter an appropriate ticker and
exchange mapping w hen you first activate a trading strategy. You must enter the Ticker Symbol, Exchange, and
Security Type exactly as expected by Interactive Brokers before NeuroShell Trader wiill allow you to activate integrated
trading. Note that futures ticker symbols are entered in the symbol mode format (for example ESH6) and not the
underlying mode format (for example ES).



Now w henever a new trade occurs in an activated Trading Strategy, if you have selected "Popup Order Prompt/Confirmation",
a pop-up order confirmation w ill be displayed w hich allow s modification of the order and confirmation that you w ant to send the
order, otherw ise the order w ill simply be sent with only a brief flash of the order on the screen. Trades sent to Interactiver
Brokers should show up in the IB TWS trade screen under ‘API’ and/or ‘Pending’ tab.

Notes:

o Integrated trading will start with the first new entry order. If the trading strategy is already in a position w hen you activate
it, the exit order for the existing position w ill not be sent to the brokerage.

o Fill prices from Interactive Brokers w ill be communicated back to NeuroShell Trader for use in the Trading Strategy. Even if
price action on the chart makes it appear as if a fill should have occurred, NeuroShell Trader w ill only actually fill an order
and proceed w ith subsequent trading strategy orders after Interactive Brokers has returned a fill price. If Interactive
Brokers does not fill the order, neither will the NeuroShell Trading Strategy. This guarantees that the Trading Strategy wiill
not get out of step with the orders/fills occurring w ith Interactive Brokers and also allow s you to view the actual fill prices
and related statistics w ithin NeuroShell Trader.

« While integrated trading is occurring, the price bars of the trading strategy w ill be colored yellow . If you save and reload a
chart that w as being actively trading, the old fill prices and yellow areas of active trading w ill also be saved and
redisplayed.



Order Emailer

The Order Emailer is one of the integrated trading servers distributed w ith NeuroShell Trader and supported by NeuroShell
Trader’s integrated trading interface. The Order emailer simply emails trades to a list of email addresses.

To setup integrated trading so that NeuroShell Trader sends sends trades to a list of email addresses:

1) Select Options on the Tools menu.
2) Select the Send orders to brokerage option located on the Trading Orders tab.
3) Select Order Emailer from the Brokerage drop-dow n list.

Note: If Popup Order prom pt/confirmation is checked, then NeuroShell Trader w ill ask you if you w ant to send
orders before sending them, otherw ise it will simply send orders w ithout user interaction.

4) At this point, any chart you load that has a trading strategy will NOT automatically start sending orders to a brokerage.
Only charts that have active trading already setup wiill send trades to the brokerage. To setup active trading on a chart,
select Alerts/Orders Window from the View menu and select the Trading Strategies on that you w ish to actively trade
from the list on the Active Trading tab of the Alerts/Orders w indow .

Now w henever a new trade occurs in an activated Trading Strategy, if you have selected "Popup Order Prompt/Confirmation”,
you w ill be asked if you w ant to send the order, otherw ise the order will simply be sent w ith only a brief flash of the order on
the screen.

The Order Emailer is a separate program from NeuroShell Trader and can be accessed by clicking on the Order Emailer icon at
the bottom of the screen. The Order Emailer displays detailed order instructions (order date/time/id, symbol, quantity, chart
name, strategy name, etc.) in the Order instructions list box for user information.

WARNING: The Order Emailer requires a valid POP3 mail account preset in either Outlook Express or Outlook. If you use
AOL or remote mail boxes such as Yahoo, Google, etc, you most probably do not have a POP3 account and therefore
the order emailer program w ill not w ork for you.

You must setup emailing capabilities before the Order Emailer w ill actually email trades: To activate email capabilities:

1) Select the Order Emailer icon at the bottom of the screen to display the Order Emailer interface. Note that the Order Emailer
w ill only load and its icon w ill only appear after you have selected a trading strategy to be actively traded from the Active
Trading tab of the Alerts/Orders Window.

2) Check the Email order instructions to the following addresses box and add at least one valid email address to the
list.

3) To add an email address, simply press the Add button and type in the desired address. After you’re done, press OK, and
the email address will be added to the list.

4) The Delete button allow s deleting undesired entries from the email address list.

The order emailer program itself does not actually send emails. Instead, it relies on your main email program (Outlook Express or
Outlook) to do that. The order emailer puts messages in the main email program’s outgoing mail box, then the main email program
should actually send the message. So, in order for the w hole thing to w ork, you must have a valid email account preset and
capable of sending emails in either Outlook Express or Outlook.

After the order emailer receives order instructions from NeuroShell Trader, it composes an order message and puts it in the
Outbox folder of your Outlook Express or Outlook. These programs may not send messages found in the Outbox folder
immediately. To enable automatic sending, you w ill need to instruct your main email program to do so using the follow ing steps:

Outlook Express - go to the Tool -> Options menu and select the Send tab. Make sure that the "Send messages
immediately" box is checked. Now , go to the General tab and set the "Check for new messages" box to 1 min. The reason
for doing so is that the Outlook Express checks for any outgoing messages only w hen it checks for incoming ones.

Outlook - go to the Tools -> Options menu and select the Mail Setup tab. Make sure that the "Send immediately w hen
connected" box is checked.

Notes:
o Integrated trading will start w ith the first new entry order. If the trading strategy is already in a position w hen you activate
it, the exit order for the existing position w ill not be sent to the brokerage.



« While integrated trading is occurring, the price bars of the trading strategy wiill be colored yellow . If you save and reload a
chart that w as being actively trading, the old fill prices and yellow areas of active trading will also be saved and
redisplayed.



Exporting Chart Data/lmages

Exporting chart data/images allow s you to export data to import into other programs, or images to put into presentations.

Follow ing the procedure below activates the export wizard, w hich guides you through the process of exporting data or images
to either a file or the clipboard.

1. Select Export Chart/Data from the Tools menu.

To als

Export Chart/Data ...

Data Sources ...
Opkions ...



Chart Export Wizard - Defining Export

1. Select the type of export:
e Chart Data Values - values for all of the dates show n on the selected chart for items on the chart
e Chart Image - an image of the selected chart
. Snapshot Values - values that are currently in the Snapshot view (this may be disabled if you are not currently
view ing the Snapshot view )
. Historical Values - values that are currently in the Historical view (this may be disabled if you are not currently
view ing the Historical view )
. Portfolio Values - values that are currently in the Portfolio view (this may be disabled if you are not currently
view ing the Portfolio view )
2. Select the export destination:
e File - afile that you will select later in the wizard
. Clipboard - a device used to paste data or images to other programs

3. Press the Next button to proceed to the next wizard screen or the Finis h button if you are copying Snapshot, Historical,
or Portfolio values to the clipboard.



Chart Export Wizard - Data Items

Make a list of the Data ltems you w ish to export.

To add data items to the list:
1. Press the Add Data Item (s) button.

To remove items from the list:
1. Select the item or items in the list you w ish to remove.
2. Press the Remove Selected Data Item(s) button

When you are finished making a list of the Data Items you w ish to export press the Next button to proceed to the next wizard
screen.



Exporting Chart Data/lmages

Exporting chart data/images allow s you to export data to import into other programs, or images to put into presentations.

Follow ing the procedure below activates the export wizard, w hich guides you through the process of exporting data or images
to either a file or the clipboard.

1. Select Export Chart/Data from the Tools menu.

To als

Export Chart/Data ...

Data Sources ...
Opkions ...



Chart Export Wizard - Defining Export

1. Select the type of export:
e Chart Data Values - values for all of the dates show n on the selected chart for items on the chart
e Chart Image - an image of the selected chart
. Snapshot Values - values that are currently in the Snapshot view (this may be disabled if you are not currently
view ing the Snapshot view )
. Historical Values - values that are currently in the Historical view (this may be disabled if you are not currently
view ing the Historical view )
. Portfolio Values - values that are currently in the Portfolio view (this may be disabled if you are not currently
view ing the Portfolio view )
2. Select the export destination:
e File - afile that you will select later in the wizard
. Clipboard - a device used to paste data or images to other programs

3. Press the Next button to proceed to the next wizard screen or the Finis h button if you are copying Snapshot, Historical,
or Portfolio values to the clipboard.



Chart Export Wizard - Data Items

Make a list of the Data ltems you w ish to export.

To add data items to the list:
1. Press the Add Data Item (s) button.

To remove items from the list:
1. Select the item or items in the list you w ish to remove.
2. Press the Remove Selected Data Item(s) button

When you are finished making a list of the Data Items you w ish to export press the Next button to proceed to the next wizard
screen.



Chart Export Wizard - Data File

1. Select the format of the data file to be exported:
. Comma separated ASCII file
e Tab separated ASCII file
. Space separated ASCII file
2. Enter the name of the data file to be exported (you may choose to brow se your files by selecting the Brow se button).
3. Select how many data files should be exported:
. Export a file for the current chart page only — This option w ill export only a single file containing data for the
currently selected chart page.
. Export a data file for each chart page in the chart - This option will export as many files as there are chart
pages.
. Export one data file containing data for all chart pages in the chart — This option will export a single file that
contains data for all the chart pages in the chart.
4. Press the Finished button to end the wizard and export the listed data items to the file in the appropriate format.

Notes:

o When using the Export a data file for each chart page in the chart option, the exported file names wiill be different for
each file written. If the name of the data file to be exported includes a ticker symbol of one of the chart pages, then each
data file will be named the same except w ith the ticker symbol replaced by the ticker symbol for the particular chart page
being exported. As an example, if the file name is "Exported IBM.csv" and there are three chart pages IBM, INTC, and
MSFT, then the files w ritten w ould be "Exported IBM.csv", "Exported INTC.csv", and "Exported MSFT.csv". How ever, if the
name of the data file to be exported does not contain a ticker symbol of one of the chart pages, then the files will simply be
named the same as the chart page ticker symbol. For example if the file name is "junk.csv", then the files w ritten w ould be
"IBM.csv", "MSFT.csv", and "INTC.csv".

o  When using the Export one data file containing data for all chart pages in the chart option, a Ticker data field, containing the
chart pages ticker symbol, w ill be added to the file to distinguish data from different chart pages. The data for each
additional chart page w ill be appended to the bottom of the previous chart page’s data (i.e. more row s of data will be
added for each chart page).



Exporting Chart Data/lmages

Exporting chart data/images allow s you to export data to import into other programs, or images to put into presentations.

Follow ing the procedure below activates the export wizard, w hich guides you through the process of exporting data or images
to either a file or the clipboard.

1. Select Export Chart/Data from the Tools menu.

To als

Export Chart/Data ...

Data Sources ...
Opkions ...



Chart Export Wizard - Defining Export

1. Select the type of export:
e Chart Data Values - values for all of the dates show n on the selected chart for items on the chart
e Chart Image - an image of the selected chart
. Snapshot Values - values that are currently in the Snapshot view (this may be disabled if you are not currently
view ing the Snapshot view )
. Historical Values - values that are currently in the Historical view (this may be disabled if you are not currently
view ing the Historical view )
. Portfolio Values - values that are currently in the Portfolio view (this may be disabled if you are not currently
view ing the Portfolio view )
2. Select the export destination:
e File - afile that you will select later in the wizard
. Clipboard - a device used to paste data or images to other programs

3. Press the Next button to proceed to the next wizard screen or the Finis h button if you are copying Snapshot, Historical,
or Portfolio values to the clipboard.



Chart Export Wizard - Defining Image

1. Select the format of the image to be exported:
. Metafile
. Bitmap
Enter the dimensions of the image to be exported (both the Height and Width in inches).
3.  Enter the name of the data file to be exported (you may choose to brow se your files by selecting the Brow se button).
Press the Finished button to end the wizard and export the image to the file selected in the appropriate format.



Exporting Chart Data/lmages

Exporting chart data/images allow s you to export data to import into other programs, or images to put into presentations.
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Chart Export Wizard - Defining Export

1. Select the type of export:
e Chart Data Values - values for all of the dates show n on the selected chart for items on the chart
e Chart Image - an image of the selected chart
. Snapshot Values - values that are currently in the Snapshot view (this may be disabled if you are not currently
view ing the Snapshot view )
. Historical Values - values that are currently in the Historical view (this may be disabled if you are not currently
view ing the Historical view )
. Portfolio Values - values that are currently in the Portfolio view (this may be disabled if you are not currently
view ing the Portfolio view )
2. Select the export destination:
e File - afile that you will select later in the wizard
. Clipboard - a device used to paste data or images to other programs

3. Press the Next button to proceed to the next wizard screen or the Finis h button if you are copying Snapshot, Historical,
or Portfolio values to the clipboard.



Chart Export Wizard - Defining Image

1. Select the format of the image to be exported:
. Metafile
. Bitmap
Enter the dimensions of the image to be exported (both the Height and Width in inches).
3.  Enter the name of the data file to be exported (you may choose to brow se your files by selecting the Brow se button).
Press the Finished button to end the wizard and export the image to the file selected in the appropriate format.



Installing indicators and functions into Trade Station®

NOTE: This interface is included in NeuroShell Trader, but is UNSUPPORTED by Ward Systems Group since the
method of obtaining data from TradeStation is not officially sanctioned by Trade Station and it may be unreliable
in some situations. If you are using daily bars, the most reliable method of obtaining data from Trade Station is
to export text files (see the Tradestation data window) from TradeStation and load then map and load them into
NeuroShell

NeuroShell Trader has the ability to incorporate data and functions from TradeStation®. Additionally, indicators and predictions
displayed in a NeuroShell Trader chart can be incorporated into TradeStation® (Unsupported Feature). Use the follow ing
procedures to install the necessary indicators and functions into TradeStation®.

Note: NSTrdExport is not a viable substitute for a data feed if you regularly trade more than a few dozen issues (ticker
symbols) because the export indicator must be inserted in the chart for each issue. Furthermore, because TradeStation® does
not allow us access to their feed directly, there wiill be timing issues as w e transfer data from a TradeStation® chart to a
NeuroShell chart. This means that as new bars are transferred, bars may occasionally be a tick or so off betw een the tw o
systems.

To install ‘NSTrdExport’ and ‘NSTrdimport’ indicators into Trade Station®

Select Im port/Export EasyLanguage® from the File menu.
Select Import EasyLanguage file (ELD, ELS or ELA) and press the Next button.

3. Click on the Brow se button and look in your NeuroShell Trader 4 Directory for the file named NST-TS6.ELD or
NST-TS7.ELD (w hichever is appropriate) and then press the Next button.

Make sure both the Function and Indicator options are selected and press the Next button.

5. Make sure all of the listed items are checked (you can just click on Select All button) and press the Finish button. You
should receive a message that you have successfully imported your analysis techniques.

TradeStation®, EasyLanguage®, and Pow erEditor® are registered Trademarks of TradeStation Technologies, Inc. Neither
TradeStation Technologies nor any of its affiliates has reviewed, certified, endorsed, approved, disapproved or
recommended, and neither does or will review, certify, endorse, approve, disapprove or recommend, any
trading software tool that is designed to be com patible with Trade Station Open Platform.

Topics of Interest:
Importing TradeStation Data and Indicators
Exporting Data and Indicators to TradeStation



Exporting Data and Indicators to Trade Station®

The TradeStation Import indicator is a feature which is unsupported in NeuroShell. Although the feature
worked reasonably well when we introduced it, changes made to TradeStation have rendered the feature
unreliable. We continue to include it for the benefit of any user who may find it reliable, but new users should
not attempt to use it, and our technical support personnel cannot assist with any problems it causes.

Indicators and predictions displayed in a NeuroShell Trader chart can be incorporated into a TradeStation® chart using the
procedures below :

In NeuroShell Trader:

1. Create a chart in the NeuroShell Trader and save it with an 8 character or less name (w ith no spaces) so it may be
imported into TradeStation®.

Tips:

. If you are importing predictions made by NeuroShell Trader into TradeStation®, you may w ant to use the Signal version
(i.e. Out of sample Signal) of the prediction or apply the "Lead" indicator to the prediction in NeuroShell Trader so that all of
the predicted values will be imported by TradeStation®. This is necessary because NeuroShell Trader predicts future
values and TradeStation® is unable to import future values. Therefore, w e need to shift the predicted value to the day on
w hich the prediction is made. Example: Lead(Close as predicted 10 days ago, 10).

e  Use the rename functionality in NeuroShell Trader to rename chart data series to names that are less than 18 characters
because TradeStation® limits the length of names to 18 characters.

NeuroShell Trader has provided the NSTrdIlmport function in the NST-TS7.ELD, but not the indicator. This is because w e have
seen TradeStation® not properly plot the results of the indicator (even though they have been received by TradeStation®). We
recommend using this w ith caution. In order to build the indicator you must use the follow ing three lines in EasyLanguage®:

Input: Chart("Import Chart"), Ticker("Import Ticker"), Name("Import Name");
Value1 = NSTrdlmport(Chart, Ticker,Name);
Plot1( Value1, "NSTrdImport" );

In TradeStation®:

Select Indicator from the Insert menu.

Select the NSTrdimport Indicator.

Check the Prom pt for Form at option if it is not already selected.
Press the OK button.

Select the CHART line and enter the name of the chart you w ish to import inside the quotation marks. Include the path w ith
the name of the chart if the chart is not in the default charts directory (i.e. C:\NeuroShell Trader\charts\ directory or
equivalent if you didn’t install NeuroShell Trader into the default directory).

o H> b=

6. Select the TICKER line and enter the name of ticker that you w ish to import inside the quotation marks.
7.  Select the NAME line and enter the name of the line that you w ish to import inside the quotation marks.
Press the OK button.



Format Indicator: M5 Trdlmport |

Inputs TS tyle TS caling TF"ru:uperties | 0K I
Input Hame Expression Lance! |
CHART "Examplel"

TICKER "<¢RSF" Help |

"Close"

Notes:

e Additionally, you may use the NSTrdImport function in any fashion you desire (another Indicator, Show Me study, PaintBar
study, or Trading System). The NSTrdlmport function has exactly the same parameters as the indicator (show n above).

e You do not need to export from TradeStation® to NeuroShell Trader in order to import from NeuroShell Trader into
TradeStation®. For example, you could simply import data from one of the NeuroShell Trader examples even though they
w ere not created using data exported from TradeStation®.

e You do not need to have NeuroShell Trader running w hen you export data from TradeStation® or w hen you import data
into TradeStation®.

o  When you receive new data in TradeStation® the NSTrdExport and NSTrdImport indicators are automatically recalculated
every time you load the chart in TradeStation®, so you don’t need to import or export data every time you receive new
data.

. Only the most recent 5000 points (approximately 20 years, depending on your data) w ill be imported into TradeStation®.
The remainder w ill not be show n or able to be used in TradeStation®.

TradeStation®, EasyLanguage®, and Pow erEditor® are registered Trademarks of TradeStation Technologies, Inc. Neither
TradeStation Technologies nor any of its affiliates has reviewed, certified, endorsed, approved, disapproved or
recommended, and neither does or will review, certify, endorse, approve, disapprove or recommend, any
trading software tool that is designed to be com patible with Trade Station Open Platform.

Topics of Interest:
Installing indicators and functions into TradeStation®
Importing TradeStation® Data and Indicators



Troubleshooting Your Model - What to Do if You Feel You Haven’t Been Successful

Understand What it Takes to Succeed

The first thing you must appreciate is that successful financial models (i.e., those that consistently make money) are not easy; if
they w ere, there w ould be an aw ful lot of rich people. If you have been at it less than tw o months, then you may just be
scratching the surface so far. Most of our users w ho have become successful have taken much more time than that, some as
much as a year before they are happy w ith the returns they can produce. Frankly, some of our users never get there, but we
can say w ith certainty that the unsuccessful ones are usually those w ho feel one should be able to be very rich w ith little
effort, and they do not persist.

Understand Success

Remember that neural nets are not magic; they are excellent modeling tools. Furthermore, financial markets are driven by a
myriad of complex variables that are frequently changing. It is therefore quite unreasonable to expect that any model you build
w ill be 100% right 100% of the time, or anything even approaching that goal. You wiill be successful if you can build some
models that make money most of the time. At various times you w ill have w inning trades on some issues, and losing trades on
others, but you should try to find a strategy that plays the odds w ith several models or at least several issues you are trading.
The idea is to build a system that makes more money on average than it loses, that doesn’t take any large losses, and that does
better than you can do trading w ith your ow n brain’s neural netw orks. More on this later.

Understand the Background

You should view and review our Tutorial. If you are like most of us, you just skimmed over it and the videos because you w ere
excited to get started w ith the program. Now it’s time to study them carefully, because there are some good tips in the dialog.
The financial models that w e built on the videos are very typical of the types of models you can build for yourself.

Have you carefully gone over our examples? The models that w e built w ere successful w hen w e built them and w ere very
typical of how successful models are built. There are also good suggestions in the text. Perhaps you dow nloaded additional
data and discovered that these models are no longer profitable, and you’ve therefore dismissed them? You shouldn’t have!
Very few people have built technical models of any type that continue to be profitable throughout the life of an issue, or in
different market conditions. If a model w orks for you for six months, you are very lucky. Even neural nets need to be retrained,
and even new indicators may need to be found as market forces change. Expect that.

Have you visited our tech support and advanced user w eb site yet? We aren’t talking about our sales site. We’re talking about
www .w ard.net/. You’ll need your serial number to log in. (Your serial number is on the back of the folder your installation CD
arrived in.) There are a number of valuable tips and techniques there that wiill help you w ith you trading and profiting w ith the
NeuroShell Trader. We modify it frequently, and it also contains new s about new releases as soon as w e make that information
available anyw here.

In our training videos, examples, and on our technical support w eb site w e have been repeating a common theme: not all stock

or other issues are easy to predict. Some are much harder than others. The biggest mistake you can make is "beating an issue

to death." If you are not able to predict your favorite issue after a w hile, let it go. It’s a big market, and there are a lot of w ays to
make money. Find something else that’s easier to predict. Often that something else is less glamorous, but do you really care if

you make money?

If you are using neural nets, there are thousands of possible indicators and other functions you could use as inputs to your
netw orks, as you no doubt now realize. The w inners at this game are those persistent enough to find good input variables.
One of the more successful users of our neural nets is able to predict the S&P by using only ratios! No complicated indicators at
all! Of course, if you have a good deal of market savvy to begin with, you may not have to rely on persistence as much. Use
your ow n intuition and feeling about w hat must be driving the issues you are trying to predict.

On the other hand, there are some standard technical indicators that have w orked very w ell for us at Ward Systems Group
and many of our customers. We talk about them in our videos, in our examples, and on our tech support and advanced user
w eb site w ww .w ard.net/. Start w ith these; don’t beat your favorite indicators to death either.

While w e’re on the subject of inputs to a neural net, let’s don’t forget over fitting: making a model that w orks w ell w hen it is
being built w ith know n answ ers, but w hich becomes unprofitable w ith new "out of sample" data, or in trading. The biggest
mistake made by users of both neural nets and other modeling techniques is to use too many inputs. That is the easiest w ay
w e know of to promote over fitting, even w ith our ow n Turboprop 2. You’ll notice that most of our models only use about 5
inputs. Have you used dozens of inputs to your neural nets?



If you have the NeuroShell Trader Professional, you can use the genetic algorithm to help you find a few good inputs. You can
also make good use of the Input Contributions screen that you can select after pressing the Prediction Analysis button that
appears after training. The neural netw ork is able to estimate how important it found each of the input variables to be during
training of the model. Use this as a guide to help you decide amongst many possible input variables. The NeuroShell
Professional Trader w ill expand this capability w ith genetic algorithms and other automatic optimization techniques.

Prediction Analysis
General | Input Contributions |
i | Contribution | |nput |
1 T.E0% Open
2 5326% High
3 467 % Low
4 A6 %  Cloze
4] 000% ‘olume
B 0.00%  Acceleration|Cloze,10]
¥ 000% WelocitCloge,10]
Qg Erirt ... Help

In the figure above, the input analysis shows that only the high and close were used by the neural net to any significant
degree. The inputs with contributions of 0% above can definitely be removed, and possibly even the low with a percentage
under 5%.

More on Pattern Recognition; The Key to Success

Neural netw orks are pattern recognition devices. They associate output predictions w ith patterns that they find in the inputs. In
other w ords, they make predictions about the future based on w hat happened in the past w hen similar input patterns occurred.
This simple, but fundamental, fact is all you w ill ever have to know about neural netw orks to make them w ork for you. If there is
any one key to success, know ing this is the key. Even neural netw ork experts forget this fact quickly w hen they attempt to
predict financial markets. In fact, neural netw ork experts rarely succeed at this game! The real success stories are made by
users w ho know something about the market, because these people can concentrate on w hat the market has done before
instead of dw elling on red herring neural netw ork internals.

So what does pattern recognition mean to you?

The Holy Grail: You must give neural networks input patterns during training that will repeat in the future. Furthermore, when
these patterns repeat in the future, the price movement that follows (i.e., the output) should be like the price movements that
followed these same patterns when they occurred in the past.

If you can do this, you w ill make good models. If not, you w ill not make good models. It is a fundamentally simple concept, but
one that is difficult to achieve in practice. But it is literally all you need to do to be a success, because that is the w ay neural
netw orks and pattern recognition algorithms operate.

Of course, neural nets can still do a good job even it the patterns in the past are similar; they don’t have to be identical. The
same is true about follow ing price movements — they need not be identical. That is because neural nets are good fuzzy pattern
recognizers.

Practical Suggestions

So w hat can you do to take advantage of the Holy Grail, now that you have found out w hat it is? There’s the obvious, of
course: find variables that affect the price movements. This is daunting, so fortunately, there are some things you can do to
increase your chances of success:

Try picking issues to model that are somew hat volatile or cyclic. If the price movements don’t repeat, there is no chance that
your repeating patterns will result in repeating price movements. This can be a little difficult in a sustained bull market.

Don’t pick issues that are driven primarily by fundamental variables if you are using technical variables. As an example, look at
IBM stock from the period September 1987 to January 1997. During that period Big Blue stock tumbled from over $170 dow n to



the low $40 range as doubts about its ability to compete w ere rampant. Later in the same period the price climbed back up as
IBM restructured, reorganized, dow nsized, and started to show the w orld it w as still going to be a major force in computing.
The big bull market didn’t hurt the rise, either.

Don’t go back too far in time if doing so is likely to mean the input patterns found during training will be substantially different
from those show ing up today. Even if you have great inputs that are normalized over time, it is likely that as markets change,
so does the effectiveness of your input variables.
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IBM stock was probably driven strongly by fundamental factors during the period shown above. Predicting the stock except
for very short term may require more than technical factors.

A related issue is expecting your neural net, or other model, to backtest (or w alk-forw ard) profitably a long period of time. We
think that is very unrealistic. If it w ould have w orked profitably over the last year, w e think that’s probably enough. It may not
be perfect, but it’s probably good enough to trade. Don’t insist on the perfect w ave before you surf, or you may never get w et!
Sure you’ll w ipe out sometimes, but at least you’ll be learning to ride the w aves.

More on the Odds — Don’t Put all of Your Eggs in One Basket

We mentioned earlier that it is effective to use multiple issues or multiple models. Below are some w ays that can be
accomplished. Your trading strategy (how you trade w ith your models) may be as important as the models themselves.

We know that no model wiill be perfect in the financial arena. For some issues it will w ork, and for some it will not. It may even
be the case that the issues it w orks w ell w ith wiill not be consistently the same. Fortunately, the NeuroShell Trader has a
feature w herein you only need to build your indicators and predictions once to apply them to a w hole series of your favorite
issues. You just place these issues in different pages of the same chart. Then on a given day, adopt a trading strategy like
purchasing the top 10% as predicted by the model, and selling the bottom 10%.

Design a trading strategy that does not depend on one model, even for a given issue. The NeuroShell Trader is the best vehicle
ever invented for pursuing strategies w ith multiple models. The pow er is there, use it! You use it by building indicators that
query multiple predictions built differently, and using those indicators in your trading strategies. These strategies could be as
simple as buying only w hen tw o out of three predictions indicate a price rise.



Trading Strategy Wizard

Chooze how the trading strategy should trade long positions and
usze the following tabs to specify the entry. stop. and exit methods.

Long Entry | Long Trailing Stop | Long Exit I

¥ Generate a buy long Imarket j order if |2 j of the following are brue

AxB[10 day Percent Change in Close predicted 10 days into the future, 0]
AxB10 day Percent Change in Cloge predicted 10 days into the future #2.10]
AxB[10 day Percent Change in Close predicted 10 days into the future #3.0]

I adifr EonditianE].. I Eemaye Earditiem ] I

Help < Hack MHewt » | Cancel

In the strategy above, we execute a long order when two of three models (predictions) are predicting a rise.

When using multiple models, as in 2 above, remember that all models need not be neural. If you have some w inning buy/sell
indicators you have previously constructed by traditional means, include them in your trading strategy as w ell. Remember also
that your indicator that evaluates several models CAN be neural. You can build a neural netw ork that makes an overall decision
based on inputs that are the predictions of several other models!

Select the input[z] you wizh to add ok

Cancel

Help

.-'-‘-.u:tual 1EI u:Ia F'eru:ent Ehane in Else #3
10 day Percent Change in C redicted 10 into the future #3

Indizatar .. Other Ingtrument Data .

In this prediction, the inputs will be three previous predictions.

Perhaps now you may have seen that your model may not be all that bad, and may be an effective part of a multiple model total
solution.

Using the NeuroShell Trader Professional Successfully

The NeuroShell Trader Professional is highly recommended, but it is not a silver bullet! It has be a lot of fantastic features w ith
w hich you can experiment. How ever, you shouldn’t just throw "everything but the kitchen sink" at it and expect immediate
gratification in the form of fantastic out of sample predictions. Although that w orks sometimes, it often does not.

As a pow erful optimizer, the NeuroShell Trader Professional can, w ith very little effort, build highly over-fit models much easier



than you can do it yourself! They wiill look great in sample, but fall apart out of sample and during later trading. Also, even
genetic algorithms can take a great deal of time optimizing w ith too many variables. For these reasons, you must be
professional enough to recognize that pow erful optimizers can do this, and professional enough to experiment and take steps
to avoid over-fitting.

Among the suggestions w e have relative to the above are:

o  Start with pretty good models and use optimization to make modest improvements to them. Search only a little on either side
of the indicator parameters that are presently being used.

e Make sure you stick to a very few inputs to neural nets (usually about 5). When finding an optimum set of inputs, tell the
optimizer to use at most 5 inputs.

. Make sure that you do out of sample testing w hen you optimize trading strategies.

. Experiment w ith stopping optimization not long after it has begun to avoid over optimizing.

« When optimizing neural nets, consider optimizing on out of sample evaluation sets instead of the oldest w alk-forw ard
training set. (But don’t go back too far in time w hen the market w as different.)

. Consider and experiment w ith optimizing neural nets or trading strategies, but not both in the same trading system.

. When optimizing neural nets, use very few hidden neurons. This wiill not only help prevent over-fitting, but w ill keep it from
taking forever to optimize.

. Use different objective (fitness) functions w hen optimizing. These can make all the difference in the w orld. We are
providing plenty and considering offering more in the future. Unfortunately, there are no rules on w hen to use w hich ones.

The NeuroShell Trader Professional is a pow er tool, and like most pow er tools, it can help you but only if used properly and
carefully.

You’ll Never be Finished

We’re sorry to tell you this. Once you start making money w ith neural netw orks and the NeuroShell Trader, you w ill w ant to
keep on improving your models and trading strategies, especially since the market is changing all the time. If you are not doing it
full time now , you probably w ill be some day. We know this because w e know traders w ho make $millions w ith neural nets,
and they are just as active as they ever w ere in trying new theories and models, if not more so. Fortunately, most of us look
forw ard to the day w hen w e can spend full time trading. So let’s get started!

Note to Writers and Would-be Writers

The material above, like all advice and documentation in the NeuroShell Trader, is copyrighted information for the use of
NeuroShell Trader ow ners only. No part of this material may be published or distributed in any form w ithout the w ritten consent
of Ward Systems Group, Inc.

Copyright © 1997-2006 Ward Systems Group, Inc. All rights reserved.



Frequently Asked Questions

Q. The data that | downloaded from Quote.com, eSignal, or Prophet.net is incorrect, missing or corrupt data.
How do I fix this problem?

A. In order to correct these problems you w ill need to manually delete files that the NeuroShell Trader dow nloads and stores in
the \Servers\Data directory. To do this unload any charts that you believe have incorrect, missing or corrupt data, use the
Window s Explorer to delete the ticker file associated w ith the bad data (for Yahoo — 1 minute data the filename is YHOO.1
min.w sg), then reload the chart (this will redow nload the data from Quote.com).

Q. Why can’t NeuroShell Trader find my AlQ data?

A. In order for NeuroShell Trader to map AlIQ data you must use the Data Sources Dialog to add the directory that contains the
master.ndx and master.adf files. If you are having difficulty mapping or using your AlQ data you may consider using the
"Rebuild Master List" functionality in your AIQ product. Please note that NeuroShell Trader is unable to read data from AlQ’s
data CD.

Q. How dolimport my data files?

A. First, you must make sure that your data files are in the proper format. The NeuroShell Trader reads text files w ith the
follow ing extensions: *.txt, *.csv, *.prn, and *.asc. It also reads MetaStock, and AlQ. Once you have verified that your data
is in the proper format, open the NeuroShell Trader, select Data Sources from the Tools menu, and select the
Directories/Files tab. Then click on the Add Directory button. Brow se to locate the correct directory and hit OK. Note that the
NeuroShell Trader automatically assigns a category but you can change this category if you w ish by clicking on the Change
Category button after highlighting the directory name you wish to change.

Q. Does the NeuroShell Trader perform optimization of inputs?

A. No, it does not. How ever, the NeuroShell Trader Professional and NeuroShell DayTrader Professional have a genetic
optimizer that assists in the selection of inputs and indicator parameters. On the other hand, after you have trained a net,
you can see how important each input w as to the net. Just select Detailed Analysis on the final Training Wizard screen
(before you hit the Finish button). Then choose the Input Contributions tab.

Q. Can |l build my own custom indicators in the NeuroShell Trader?

A. Yes. The NeuroShell Trader comes w ith built-in functions that you can use to create your ow n custom indicator. These
functions are found in the Indicator Wizard under the follow ing categories: Arithmetic, Boolean, Rules, Trigonometric, and
Relational. You can create your ow n custom indicator by combining any of these functions together. You can even combine
them w ith the other standard indicators that are already included.

Q. Why can't | add a stock page to my index chart using Edit, Add/Remove Chart Pages?

A. You cannot create stock pages in an index chart or vice versa. This w as designed like this because someone might try to
add an index page to a stock chart that has indicators on it that are only applicable to stocks. All of the pages in your
NeuroShell Trader chart must be constructed from data streams in the same category.

Q. How is the profit calculated in the Train by Profit mode of training?

A. The profit is calculated in the form of a percent return for each trade. For the long side (sell side w orks the same w ay), the
NeuroShell Trader wiill buy w hen the prediction is greater than your buy long threshold and hold the position until the
prediction drops below your exit long threshold. Percent return for that trade is then calculated by dividing the point total
made in the trade by the security's value at trade entry. For example, if you bought IBM at 120, stayed long for 10 days, and
then exited at 130 your profit w ould be:

10 ( points made) / 120 (initial security value) = 8.33%

When Training by Profit, the NeuroShell Trader w ill try to maximize the sum of the percent returns for each trade. The profit
figures that are listed on the Training Results screen are annualized figures.

Q. Canlchange the periodicity of my chart (from daily to weekly or monthly or (DayTrader Only) from 5 minute
bars to 10 minute bars)?



Yes, you can do this w hen you first create the chart or after the chart is displayed. The Chart Wizard w ill ask you if you

w ant the chart to be in daily, w eekly, monthly (DayTrader Only) or intraday format. Once you have created a chart, you can
change it to a different periodicity by using the frequency drop dow n box located at the top of the chart. Note that any
predictions and trading strategies on the chart will need to be retrained and rebacktested every time you change the charts
periodicity.

How do | actually view the predictions?

You can get the predicted value by view ing the data. To do this please see Displaying Data.

Is there a way to evaluate the influence each indicator has on the prediction?

Yes, after you have trained a net, you can see how important each input w as to the net. Just select Detailed Analysis on
the final Prediction Wizard screen (before you hit the Finish button). Then choose the Input Contributions tab. Each input wiill
have a number: the higher the number the more important the net found that input to be.

Can the prediction results be printed or recalled to compare with other predictions?

Yes, the prediction results can be view ed by selecting the prediction and choosing Modify Selected Prediction from the
Edit menu (or from the right-click). At this point you can print the predictions results from final Prediction Wizard screen by
selecting the print button.

After | train a prediction and plot it on my chart, how can | view the training results again?

You can access the Training Results screen again by selecting the prediction on your chart (using the right mouse button)
and selecting the Modify Selected Prediction option.

How can | delete indicators from the chart or from memory?

You can delete indicators from your chart by highlighting them and pressing the delete key. Remember that the NeuroShell
Trader stores indicators that are being used in predictions and these can be deleted from your chart (w hich w ill clear some
memory), but w ill not be completely deleted from memory until the prediction has been removed. Also, an indicator that is
based on other indicators does not require those indicators to be displayed on the chart (in fact it takes up more memory to
have them displayed on the chart). Additionally, if any unnecessary indicators hidden from view (check the Hide/Unhide
Data screen), you may unhide them and delete them as w ell.

| cannot see the entire indicator stream because it goes out of the edit window. How can I fix this?

You can expand any window to see more of the indicator stream. You do this by placing your mouse in the low er right hand
corner of the form screen and w ait for the double arrow to appear, then resize the window .

Why do | get 'System Out of Memory' when | try to open a chart of a data file | have on my hard drive?

You are probably trying to open the chart by using the Open Chart menu command from the File menu. The Open Chart
command lets you brow se through folders to find previously saved NeuroShell Trader charts. You cannot directly open a
MetaStock, CSlI, AlQ, ASCII, or any other type file using the Open Chart command. You first need to add the data directory
under Tools - Data Sources and then create a new chart w ith the Chart Wizard.

Does the NeuroShell Trader autom atically splice the NeuroShell Trader CD-ROM with the newly downloaded
data from Dial Data?

Yes, it does. In fact, NeuroShell Trader will splice together any tw o data files together as long as they are mapped to the
same category and have the same ticker name. You can even splice together price data files and files containing other data
such as fundamentals.

What is the difference between the neural nets in NeuroShell 2 and those used in the NeuroShell Trader?

TurboProp 2, w hich is the neural net algorithm used in the NeuroShell Trader, is uniquely different than any of the algorithms
in NeuroShell 2. First of all, TurboProp 2 prevents over fitting w ithout using a test set. This means that you can train on all of
your historical data w ithout having to hold any out. Second, TurboProp 2 is the result of several years of research and is,



therefore, new er technology than the older neural nets in NeuroShell 2. Third, TurboProp 2 trains much, much faster than
many of the neural nets in NeuroShell 2. This means the time it takes you to develop a profitable model will be that much
shorter. Finally, Turboprop 2 is much more accurate than any net that has ever built to date (that w e know of).

What is an acceptable range for the Training and Evaluation Average Error figures?

There is no particular range. This number w ill vary depending on w hat you are trying to predict. The real question is, can
you make money on the predictions? As our profit based training will illustrate, you don't have to get good predictions at all
as long is the direction is mostly right.

When a normalization technique is used in the prediction, such as the percent change in price, is this
technique applied to all the instruments and indicators in the study?

No, this is only applied to the value you are trying to predict. This normalization technique does not apply to indicators or
inputs that w ill be used to make that prediction. If you w ant to use inter-market analysis and w ould like to include the price of
another market as an input to your prediction, then it is a good idea to add it's percent change rather than its raw data value.
The algorithm does scale all of your inputs and does some normalizing for you, but you w ill probably have a better model if
you use technical indicators to pre-process your raw data.

When a network has been trained, can the resulting analysis be applied to new data without re-training?
How is this done?

Yes, after you have trained a net, it will automatically be applied to any new data that is added to your chart. For example, if
you dow nload your data every day in MetaStock format and train a net on one of those files, then new predictions wiill be
made w henever the data for that chart is updated.

Is the NeuroShell Trader capable of using a prediction to generate buy/sell signals on new data?

Yes, you can create buy/sell signals by applying an indicator to your prediction. For example, your indictor could be
something like 'If prediction > .5 then 1 else 0'. This w ould result in a binary 1 or 0 buy/sell indicator being plotted. Or you
could decide to train the net to producea1ora0 (or 1, -1).

Why is it that when | compared the predictions from the NeuroShell Trader with an older back propagation
neural net and found that accuracy of the nets was about the same?

Neural nets are the best modeling tools available, and the new Turboprop2 is far superior for most problems than
backpropagation. How ever, no modeling tool can perform any better if it is given poor inputs. The old saying, "Garbage In,
Garbage Out" rings true. Predicting the stock market w ith technical indicators is a very difficult process (if it w eren't, there
w ould be thousands of rich neural net users). The reason the stock market is so difficult is that there are literally millions of
possible variables that can be used for each of the millions of combinations of output types. We have one customer w ho
earned a 300 percent return last year in actual daily trading by predicting things like the S&P, but he didn't get there by just
feeding open, high, low, close, and volume into his nets. He did a lot of w ork experimenting and using his ow n savvy to
arrive at appropriate things (LEADING indicators) to feed his models. Neural nets are not magic; they are simply great
modeling tools. You have to feed them things that are predictive. To see that this is true, just feed one of your nets the
output as an input and you w ill suddenly see it nail the answ er. If you have the right inputs, you will get good outputs. If you
don't, no modeling tool can make it happen. It takes time.

How do | create a network that will learn to generate trading signals under specific conditions?

You can do this by first creating an indicator that outputs a 1 for a buy or a -1 for a sell and choose it as the value you are
trying to predict. Using IF THEN rules, you can build the indicator to sense the specific conditions in w hich you are
interested.

When simulating a market order, does the trading strategy take into account whether the opening price is at
the bid or the ask price?

When simulating a market order, a trading strategy only uses the next bars opening price and does not take into
consideration w hether the opening price w as at the bid or ask. If you set slippage to the expected average bid/ask spread,
the entry and exit prices w ill be adjusted as if the opening price w as at the opposite side of the bid ask spread as the entry
or exit w ould occur.

When | export data to a file, only the date and the actual price values are showing up. What am | doing wrong?



When you go to export data items to a file, it will ask you to add the items you w ant to export. Make sure you select 'Out of
sample: Predicted ... ' or w hatever value you w ould like to export to file.

How do | use the neural net prediction once | have developed it?

The nets are automatically applied to your chart w hen you add more data. All you have to do is add data to the files (new
dates). Then w hen you load the chart, you just scroll over to the right side and view the new predictions. You can view the
data by Displaying Data. Additionally, you can build a trading strategy based upon your prediction by selecting Trading
Strategy from the Insert menu. This will allow you to place trading points on your graph using rules similar to the follow ing:

If prediction > x then buy long
If prediction < -x then sell long

When | add new data to my chart, do | have to re-train the neural net?

No. Once you have trained a neural net prediction and applied it to your chart, it will generate new predictions every time
your chart is updated w ith new data. The prediction becomes just like another indicator, only a leading one rather than a
lagging one. At some point, you may w ant to re-train your neural net. We have some users that re-train every six months,
other retrain every tw o w eeks. It all depends on the robustness of your model and the market you are trying to predict.

When | load a text file that | created, why does the NeuroShell Trader only plot one of my data streams?

You can insert other variables from your data file by choosing Existing Data/Calculations from the Insert Menu. This wiill
allow you to insert other variables from your data file. It is important to remember that every column in your data file must
have a label row, w hich wiill enable you to plot the right value.

How can | use logarithms to normalize data?

You can do this by applying the Log indicator to your data before you add it as an input to your prediction. The Log indicator
is found in the Arithmetic category.

Why do | get an error when | try to open MetaStock, CSI, AlQ or ASCII files?

You are probably trying to open the file by using the Open Chart command from the File menu. The Open Chart command lets
you brow se through folders to fine previously saved NeuroShell Trader charts. You cannot directly open a MetaStock, CSI,
AlQ, or ASCII, or any other type file using the Open Chart command. You first need to add the data directory under Tools,
Data Sources and then create a new chart with the Chart Wizard.

When | Auto Scan for data files the program either stops responding or crashes. What do | do?

The Auto Scan feature is not alw ays able to locate all of your data files. If you have older or corrupted data files then this
could be w hat is causing the program to stall. To w ork around the problem, if you know w hich directories contain your data
files, then skip the Auto Scan feature and just add the directories one at a time. If one of those directories is still causing the
program to crash, then look in the directory to verify that all of the files are data files and everything looks normal. If you still
are having difficulties, then email some or all of the files in that directory to Ward Systems Group Technical Support so the
problem can be corrected. Your directory may contain a file that w e never ran across in our product testing, so by emailing
it to us w e can correct the bug that is causing the program to crash.

How can | use the NeuroShell Trader to make predictions on a daily chart several months into the future?

You can make predictions 6 w eeks, 3 months, and even 6 months in advance on a daily chart. You w ould just change your
Days Ahead parameter to be the appropriate number of days. For example, a 6-w eek prediction on a daily chart is the
same as a 30-day prediction (assuming 5 days in a w eek). A 3-month prediction is a 60-day prediction (assuming 20 days in
a month), etc.

I would like to create a prediction and then plug the results in a database. How do | do this?

After training, you can export the prediction values for use by another program or database. You can export your trained
predictions, indicators, and closing prices to a text file by choosing Export Chart/Data from the Tools menu.



Since | track stocks by groups, is there a way to separate batches into groups for stocks, currencies, and
indexes?

Yes, you can create a chart for stocks, one for currencies, and one for indexes. Remember that you can add another
instrument to a chart by selecting Add/Remove Chart Pages from the Edit menu.

It looks like the program is retraining each time | open the chart or switch to a different page in the chart.
Why is this?

The softw are does not retrain the neural net each time you load the chart page. It is just loading the price data into memory
and calculating the values for all of the indicators and predictions that are currently on your chart.

How would I build a portfolio of health care stocks and generate new predictions for them each day?

You can create a new chart called health care stocks and add multiple stocks to the chart by highlighting them in the
selection box. If you already have a chart to w hich you w ould like to add additional stocks, then you could just choose
Add/Remove Chart Pages from the Edit Menu. Once you have a chart w ith different pages in it for each health care stock,
you w ould just build a prediction for the one stock and it w ould automatically be applied to all of the other stocks in the chart.
All you wiill have to do now is open the chart each day after your data has been updated and new predictions w ill be made
for each of the stocks. You can also add buy/sell indicators to make it easier to determine w hich stocks are predicted to rise
or fall.

What is the difference between the ‘Prediction’ and the ‘Prediction Signal’?

The ‘Prediction’ values are displayed on the chart for the bar that they are predicted, w here as the ‘Prediction Signal’ is
displayed on the chart for the bar that the prediction w as made on. This means that the ‘Prediction” will lag the ‘Prediction
Signal’ by the number of periods into the future that you are predicting. Be sure that all inputs to a different Prediction or
Trading Strategy are created using the ‘Signal’ version of the prediction, other wise your prediction or trading strategy wiill
use values that w ere predict for today, not for the future.

Why does my prediction just seem to mirror the target price, only it is offset by the number of days in the
prediction?

Neural nets are great modeling tools, but no model is any better than the inputs you are using to build the model. It sounds
like you are trying to predict something like the close and are using the open, high, low, and close as inputs to your
prediction. The neural net is unable to find any patterns in the inputs you are giving it, so it is forced to just go with w hatever
w ill get it the closest to the prediction. In this case, it is probably the most recent close. If you changed your prediction to
include things like fundamental indicators, sentiment indicators, or technical indicators like velocity, acceleration, or Bollinger
Band % b you w ould probably start to get better predictions.

How can | prevent all of the data directories | add from being put in the Miscellaneous Category?

When you add a directory into the NeuroShell Trader it is automatically added into the Miscellaneous Category. You can
change the category for any directory by choosing Data Sources from the Tools menu, selecting the Directories/Files tab,
highlighting the category, and selecting the Change Category button. This brings up a list of all the possible category names
that you can use.

Why are there gaps in my prediction or custom indicator where nothing is plotted?

Gaps or blank spaces in your prediction or indicator are caused by the NeuroShell Trader not getting all of the inputs it
needs to calculate the prediction or indicator. For example, if you have a neural net that makes a prediction on the S&P and
uses the Treasury Bonds as an input, a prediction w ill not be generated on a day w hen there is no value for the Treasury
Bonds. The same is true for an indicator - if your indicator formula uses an input that either returns a null value or is blank
for that day, the NeuroShell Trader wiill plot a blank space on your chart.

What are continuous futures (also called continuous contracts)?

Continuous futures are data series that consist of individual futures contracts that are "glued" together. The method that
they are glued together by depends on the data source that you are using. The data supplied on the CD-ROM uses the
current contract (next contract to expire) until it expires, then starts using data from the next contract to expire, etc. All of
the data that is represented this w ay has a ticker symbol that ends with “1600°. If you w ere to dow nload a ticker that
ended w ith <1605 from DialData, the continuous contract w ould vary from the one described above in the follow ing w ay:



The current contract w ould be used until 5 days prior to the contract expiring, then starts using data from the next contract
to expire until 5 days prior to it expiring, etc. DialData offers a range of values that you can dow nload from 1600’ to <1630’

(DayTrader Only)
Q. Canlaccess intra-day data from Trade Station®'s real-time server?

A.

Yes, how ever this must been done using the NSTrdExport indicators from inside TradeStation®. For more information on
how to use these functions refer to TradeStation NSTExport Server.

TradeStation® is a registered Trademark of TradeStation Technologies, Inc. Neither TradeStation Technologies nor
any of its affiliates has reviewed, certified, endorsed, approved, disapproved or recommended, and neither
does or will review, certify, endorse, approve, disapprove or recommend, any trading software tool that is
designed to be compatible with Trade Station Open Platform.

What is the difference between "Return on Account” and "Return on Trades"? Which one should be used
when comparing to "buy and hold", since they are sometimes so very different?

Return on Account is the percentage return over a period of time on your money invested. Another w ay of saying this is
that it is (net profit)/(account size required). Return on Account is very simple and straightforw ard w hen considering only
one trade, but it can get more complicated if there are several trades at different price levels, as w e will see in some
examples that follow .

Return on Trades is the cumulative sum of the percentage returns of individual trades. If you make three trades, during
w hich you made 5%, 7%, and 10%, then your Return on Trades is just 5% + 7% + 10% = 22%.

It can be noted here that the percentages 5%, 7%, and 10% above are actually the percentages you'd get if you computed
Return on Account separately for each individual trade. How ever, the Return on Account for the w hole series of trades wiill
not be 22% as you w ll see.

Return on Account is best for comparison w ith "buy and hold", w hich is just the percent change in price. If you compare
w ith Return on Trades you may erroneously conclude that you aren't beating buy and hold w hen you may be. That is
because return on Trades looks much w orse on a trending stock.

Some examples w ill make the differences betw een these figures more clear. For purposes of clarity, w e will assume no
commissions and no slippage in these examples.

Example 1: You buy 100 shares of a stock at 50 and sell them at 60.

Return on Account:

The required account size is 100 shares * $50 = $5000.
The net profitis =100 * (60 - 50) = $1000.

Therefore Return on Account = 1000/5000 = .2 or 20%

Return on Trades:
The sum of the trade percentages = 20%
Therefore Return on Trades = 20%

Example 2: You buy 100 shares of a stock at 50, sell them at 80, repurchase them at 80, and then sell them again at 90.

Return on Account:

The required account size is 100 shares * $50 = $5000

The net profitis = 100 * (80 - 50) + 100 * (90 - 80) = 3000 + 1000 = $4000.
Therefore Return on Account = 4000/5000 = .8 or 80%

Return on Trades:
We compute the percentages individually:
Trade 1 percentage is 100 * (80 - 50)/(100*50) = 3000/5000 = .6 or 60%.



Trade 2 percentage is 100 * (90 - 80)/(100*80) = 1000/8000 = .125 or 12.5%. Note that the required account size is
larger for trade 2, since it cost more to get into the trade.

Therefore Return on Trades = 60% + 12.5% = 72.5%

Example 3: You buy 100 shares of a stock at 50, sell them at 80, repurchase them at 85, and then sell them again at 90.

Note that this is the same as case 2, except that w e repurchased at $85 instead of the $80 at w hich w e last sold the
shares. This means that w e had to come up w ith an additional 100*5 = $500 to make the second trade. Therefore, the
required account size is now $5000 + $500 = $5500.

Return on Account:

The required account size is $5500

The net profitis = 100 * (80 - 50) + 100 * (90 - 85) = 3000 + 500 = $3500.
Therefore Return on Account = 3500/5500 = .636 or 63.6%

Return on Trades:

We again compute the percentages individually:

Trade 1 percentage is 100 * (80 - 50)/(100*50) = 3000/5000 = .6 or 60% as before.

Trade 2 percentage is 100 * (90 - 85)/(100*85) = 500/8500 = .059 or 5.9%. Note that the required account size is larger
for trade 2, since it cost more to get into the trade.

Therefore Return on Trades = 60% + 5.9% = 65.9%

Example 4: You buy 100 shares of a stock at 50, sell them for a loss at 45, repurchase them again after they have risen to
80, and then sell them again at 90.

Note that this is similar to case 3 because w e had to come up w ith an additional $80 - $45 = $35 per share for a total of
$3500 to make the second trade. Therefore, the required account size is now $5000 + $3500 = $8500.

Return on Account:

The required account size is $8500

The net profitis = 100 * (45 - 50) + 100 * (90 - 80) = -500 + 1000 = $500.
Therefore Return on Account = 500/8500 = .0588 or 5.88%

Return on Trades:

We again compute the percentages individually:

Trade 1 percentage is 100 * (45 - 50)/(100*50) = -500/5000 = -.1 or -10%.
Trade 2 percentage is 100 * (90 - 80)/(100*80) = 1000/8000 = .125 or 12.5%.
Therefore Return on Trades = -10% + 12.5% = 2.5%



Performance Tips

Below is a list of items that may improve the performance of NeuroShell Trader:

If you find that everything you do causes your hard disk drive to be accessed, then your system may require more
memory to minimize use of the sw ap file used by the operating system. We recommend that NeuroShell Trader be used
w ith @ minimum of 128 megabytes of memory; how ever, if you are creating complex charts you may require more. For
more information on this issue refer to your operating system manual or help file.

Try to avoid hidden information on your chart. The more information that you have on your chart (hidden or visible)
requires more memory, slow s NeuroShell Trader dow n, and produces larger size chart files w hich in turn causes charts
to load slow ly. By removing unused hidden data from your chart, you w ill most likely find that NeuroShell Trader loads and
manipulates the chart faster. Note that indicators in your chart used to create other indicators or used as input predictions
may no longer be needed and can be deleted w ithout affecting the indicators or predictions that use the indicators.

Use the Format Chart to limit your chart to dates that are relevant. The more data bars that are displayed on the chart, the
slow er the operation of the chart.

Map only the data files / data directories that you use, mapping unnecessary files w ill require more memory, and slow

dow n NeuroShell Trader. To remove unnecessary files refer to Setting Up Data Directories.

Purge data that you don’t use. Limiting the size of your data files will allow NeuroShell Trader to read the files faster. If
you have already limited the dates using Format Chart, then this wiill only improve performance during loading of files.
Remove unnecessary programs that run in the background from your startup folder. These files are running in the
background w hen other programs are run and thus NeuroShell Trader must share system resources w ith these
programs. In particular, the FINDFAST program installed by Microsoft Office 97 (w hich can be run from w ithin Office 97)
consumes a lot of system resources at all times and if removed may improve NeuroShell Trader performance.

Defrag your hard disk. This allow s your file system to access your files more quickly.



Tips for Using the DayTrader Successfully (DayTrader Only)

10.

1.

12.

13.

14.

In our opinion, some data providers can sometimes be very slow for purposes of loading historical data during market
hours. That is w hy the DayTrader saves historical data once you close a chart. If you later load that chart during market
hours, the saved data wiill be loaded and not dow nloaded from your data provider. Any data bars since the chart w as
closed will be added by dow nloading from your data provider. If you are loading historical data for the first time and you
find it slow, try again after market hours (also see tip 11 below ).

In tip 1, w e mentioned that data is reloaded from the disk source w hen you reload a chart. Here are some additional
aspects of this process:

a. If you load another chart w ith the same ticker and same bar size (1 minute, 5 minute, etc.), the data wiill still be loaded
from disk if possible. The data is not saved in the chart.

b. Data is saved in the Data folder of the Servers Folder of the NeuroShell Trader folder. Release 3.0 does not erase old
data files. If you are no longer interested in a particular ticker, you may w ant to delete the data file yourself using the
Window s Explorer.

c. Ifanew chart requests data older than that saved, the data will have to be entirely dow nloaded again from your data
provider. If not, only the data bars that w ere created after the data w as saved need to be dow nloaded. All of this is
done automatically for you by the DayTrader.

Don't load too much intraday data. You obviously don't need as many bars of intraday data as you do daily bars to build
good models. Usually 2000 to 4000 bars is plenty. If you use too much data, loading w ill take a long time, as w ill many other
processes in the DayTrader. Remember, the farther back in time you go, the more you risk building models w ith ancient
history that are not relevant today.

When optimizing, turn on the check mark entitled "Don't update chart w hile optimizing/training" if you are connected to the
Internet. If the DayTrader keeps talking to the server, it will consume processing cycles that could be utilized by the
optimizer.

Note that disconnecting from the server in the DayTrader does NOT disconnect your Internet connection. You must do that
yourself in Window s, or else you may stay connected to your Internet Service Provider. If you have a line that costs by
the minute, remaining connected could cost you money. Methods of disconnecting vary w ith the type of line, type of
service, etc. Contact your Internet Service Provider if you don't know how to do this.

Tip 5 above is especially true if you are optimizing; you don't w ant to remain connected w hile optimizing. After optimizing
starts, you may w ant to disconnect your Internet connection. After a few seconds, the DayTrader wiill tell you that you
have been disconnected and ask if you w ant to reconnect. Say no.

Some data providers may not alw ays correct for stock splits or correct for them immediately (contact your data provider
for more info on this). Therefore, if you know there has been a stock split, your models may no longer be as accurate.
You may have to w ait some number of days to obtain more data at the new price level in order to build another good
model.

There are new options under the Tools menu w here you can set the sensitivity of the message that tells you if data has
changed and suggests retraining. For example, Quote.com data does change from server to server and day to day
slightly, in our opinion.

Some indicators (e.g. PCA, or indicators you program in a DLL) may take so long to compute that they may not be
appropriate for intraday charts.

If you do load data during market hours, and the server or the Internet stops sending data, you can cancel loading of that
ticker and w hatever data w as already loaded may still be used.

If you w ant to see if sluggish performance of the server during market hours is due to your data provider or your Internet
Service Provider, bring up the Internet Explorer and see if you can access w eb pages never before accessed. If that

w orks quickly, the problem is probably not the Internet Service Provider. Please contact your data provider customer
support if you feel their servers are not providing historical data fast enough.

Don't load too many tickers into the DayTrader at one time, especially if your models take a long time to process and you
are using the portfolio view or alerts. If the portfolio view is displayed or alerts are active, then all the models are
"recalculated" w ith the completion of every new bar, otherw ise only the current model is "recalculated" w ith the
completion of every new bar. If you have 1 minute bars, and 20 tickers loaded, then 20 models could be recalculated
every minute.

If you are using Quote.com, eSignal, or Prophet.Net as your Data Server and the ticker that you are looking for is not
available please look at Adding New Data Server Ticker Symbols.

Occasionally, data that is dow nloaded from a data provider is incorrect, missing or corrupt data. In order to correct these
problems you w ill need to manually delete files that the NeuroShell Trader dow nloads and stores in the \Servers\Data
directory. To do this unload any charts that you believe have incorrect, missing or corrupt data, use the Window s
Explorer to delete the ticker file associated w ith the bad data (for Yahoo - 1 minute data the filename is YHOO.1 min.w sg),
then reload the chart (this will redow nload the data from the data provider).



Troubleshooting

If you experiencing a General Protection Fault, you may have a conflict with a program that is running in the background. In
particular, w e have had some users report that First Aid 95 and First Aid 97 report erroneous General Protection Faults. By
turning off First Aid, the NeuroShell Trader runs w ith no problems.

If you are experiencing other errors or problems, then you should run the troubleshooting utility program provided by Ward
Systems Group. To run the troubleshooting program, follow the procedure below :

1.  Click the Start button and choose the Run command.

2. Inthe Open box, type: "<NeuroShell Trader Path>\uti\debug", w here <NeuroShell Trader Path> is replaced by the letter of
the drive the NeuroShell Trader is installed on follow ed by the path that NeuroShell Trader is installed in (i.e., "c:\NeuroShell
Trader\util\debug").

3. Press the OK button to start the Debug Utility.
Follow the instructions.
5. If you are still unable to solve your problem, please contact Ward Systems Group Technical Support.



Ward Systems Group Technical Support

We are dedicated to providing quality technical support. In fact, our technical support staff has acquired such an outstanding
reputation that w e frequently get help requests from people w ho are not entitled to this service. To keep these people from
getting in the w ay of providing quality service to legitimate users of our products, we will always ask for your name and
serial number. Please assist us by understanding that this helps you get the fastest support. The serial number is on the
back of your CD case.

@) Here are the steps you should take to get help:

You

Check the help file. It is quite extensive, and w e have found that it covers 90% of all questions w e are asked about this
product.

If you are receiving an error message or experiencing other problems w hen running NeuroShell Trader, refer to the
Troubleshooting help topic.

Check our tech support and advanced user w eb site (for users only). On this page w e will be posting reports of bugs,
w orkarounds, fixes, frequently asked questions, tips, notice of new releases, and new examples. You will need your
serial number to log into the product area for this product. The w eb page address is http://ww w .w ard.net/ (This w eb
page w ill alw ays be changing, so check it frequently). If you have more than one Internet brow ser or have Internet
access but do not have a brow ser, click on Internet Access for information on how to reach our Web site.

E-mail or fax us your questions. Be sure to include your name and serial number. We try to answ er all questions w ithin 24
hours (Monday through Friday except US holidays and days of certain company events). However, you must
carefully describe the problem you are having. In particular, copy the exact text of any error message, and exactly
w hat you w ere doing w hen you received it. Most people assume w e are familiar w ith the error, but many of them come
from Window s. Our e-mail address is support@w ardsystems.com. Our fax number is 301-663-9920. New or alternate
addresses may be posted from time to time on our tech support w eb page (see 2. above).

Call us on the phone. We wiill ask for your name and serial number. Please have it ready! Our phone tech support
service is open from 9:00 am to 12 noon, and from 1:00 PM to 5:00 PM Eastern Standard time Monday through Friday
except US holidays and days of certain company events. The phone number is 301-662-7950. The most busy times to
call are betw een 11:00 am and 3:00 PM Eastern standard time. The most busy days are Monday and Friday. In the event
you call us at a busy time w hen all of our tech support personnel are assisting others, you may hold or call back at a less
busy time.

You may pay for personal consulting in our office. This service is by appointment only and costs $200 per hour in quarter
hour increments.

You may pay for consulting or classes in your office. This service is arranged on a case by case basis.

will get a faster answer to your question if you do the following:

Know the exact w ording of any error message that appeared on the screen.

Know the NeuroShell Trader release number, w hich is displayed by selecting About NeuroShell Trader from the Help
Menu.

Have available the follow ing information about your system:

a. Hardw are type and model number and amount of memory (RAM) installed.
The release number of Microsoft Window s™ or NT™ that you are using.
Monitor type (VGA, super VGA, etc.)

Netw ork configuration, if any.

® a0 o

Printer manufacturer, type, and model.


http://www.ward.net/

Ward Systems Group Sales Department

Ward Systems Group Inc. sales hours are: 8:30 a.m. to 5:30 p.m. Eastern time.

Telephone: (301) 662 7950

Fax: (301) 663 9920

E-mail: Sales@wardsystems.com

World Wide Web: http://www.wardsystems.com/

Click here to visit our Web site! If your computer has a modem and an Internet brow ser, you can go directly to the Ward
Systems Group home page on the World Wide Web.

If you have more than one Internet brow ser or have Internet access but do not have a brow ser, click on Internet Access for
information on how to reach our Web site.


http://www.wardsystems.com/

Ward Systems Group Corporate Headquarters

Ward Systems Group, Inc.
Executive Park West

5 Hillcrest Drive
Frederick, MD 21703

USA

Phone: (301) 662 7950

Fax: (301) 663 9920

E-mail: Sales@wardsystems.com

World Wide Web: http://www.wardsystems.com/

Click here to visit our Web site! If your computer has a modem and an Internet brow ser, you can go directly to the Ward
Systems Group home page on the World Wide Web.

If you have more than one Internet brow ser or have Internet access but do not have a brow ser, click on Internet Access for
information on how to reach our Web site.


http://www.wardsystems.com/

Changes from 1.3 to 1.4

The follow ing are the primary new features in the 1.4 release of the Trader:

A.

New chart formatting features have been added. Now you can turn off our automatic Y-Axis (price) scaling, and set your
ow n fixed scale, if you prefer that. You can also make your ow n custom foreground and background color scheme. To
access these new features, go to the Edit menu, then select Format Chart. You can also right-click, then choose Format
Chart.
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Dialog box sizes are now remembered. Once you open one of our dialog boxes to a larger size on your screen, it will stay
that size until you change it again. This eliminates the constant resizing of some of these dialog boxes.

A new out of sample net or "data stream" has been added w hen you train a netw ork w ith w alk-forw ard tests. This is a
very pow erful and useful feature. The out of sample data stream, w hich appears in green, essentially "glues together" all
of the evaluation periods for all of the w alk-forw ard tests. This means you can see, in one continuous prediction line, how
the w hole period w ould be predicted by alw ays using the latest net that did not include the data in the training set.
Furthermore, w hen going forw ard in time past the current net’s training period, this net’s prediction uses the current net.
This unique net can be used in trading strategies, or in indicators just like either the current net or a w alk-forw ard net. In
fact, this is the recommendation so that you w ill alw ays be seeing out of sample results. In the past, it uses the

w alk-forw ard nets, and in the future it uses the current net. In both cases, it is alw ays show ing out of sample results.

Since this is so important, w e’ll try to explain it a different w ay. Think of this "out of sample net" as a combo net that looks
at the date of the inputs. It then uses an appropriate net to make the prediction. The appropriate net is not a net that w as
trained on this date, because that net has "seen" the answ ers. The appropriate net is the most recent w alk-forw ard net
trained prior to the date of the inputs. For all bars in the future, the current net is the appropriate net. The picture below
may help illustrate this.



The green out of sample net w ill automatically show up on the chart if you train a completely new net. It is available on old
nets you made w ith release 1.3, but you wiill have to insert it on the chart yourself (Insert existing data/calculations).
We have added pop-up labels to give the full name of a line on the chart. All you have to do is put the mouse over the chart

line or the legend label and the pop-up window w ill appear to make the title clear and readable in case the legend is too
small.

Itis now possible to edit data files, even the ones on a CD-ROM. To do this, you simply modify a raw data stream (like the
close) w ith the right mouse button, just like you w ould modify an indicator, prediction, or trading strategy. (You can also
left click and use the edit menu.) A spreadsheet w indow allow s you to make changes to the data. These changes can
later be unmodified even, because the changes are stored internally in an override file. It is that feature that makes it
possible to modify a CD-ROM file.



F.

Modify PZZA Data

COROM |  DialData |
. | CAMEURGERELL TRARER downlpad'data\FEZA ; a% I,
Open High Low Clc ~ — = 1
272798
273798 |34 34.75 33687  33.6¢ Lancel
274798 |33.5 35 33.375 345
[T 2/5/98 S5 dNES Sy e [T
2/6/98 |35.625 37.875 35625 375 Help
279798 |37.5 38125  36.25 36.31
2710798 | 36.25 37 35.75 36.37
2411298 |36.5 37125 36375 3675 |l _
2712798 | 36.75 37625 36375 | 37.2F
2713798 |36.875 38.375 36875  38.37
2/17/98 |38.375 38625  36.25 36.4°
2718798 | 36.25 375 36.25 375
2719798 (37125 38879 37 - 583%
2/20/98 |38.937 39.25 37.625  38.2 Original ¥ alue:
2/23/98 |37.75 38.25 37.25 38.2 |
38.25 38375 37625 38
E.E:‘:gg 17 R 7R, IR’ W T HESe |
1] | - i} |'|'

v

In the Data Window Mode, the vertical line now has an added horizontal line to make a cross hair. In this mode, you can
now do many menu functions that w ere not possible in this mode.
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On all charts, the current mouse chart coordinates are now displayed on the low er right side of the screen. You can point
to any point on the chart and see the date and price level w here the mouse is positioned. Refer to the low er right hand
corner of the chart above.

Almost a hundred new indicators have been added in these categories:
Basic - (4) - Sum, Multiply, Cumulative Sum, Cumulative Multiply
Statistics - (1) - Standard Normal: Data Point

Arithmetic - (3) - Average2, Average3, Average4

Trading Strategy: Position Information - (13)

Trading Strategy: System Information - (66)

Selective Calculation - (9)

The Dial/Data Dow nloader now automatically detects if ticker symbols are in your chart but not your dow nload list, and it
w ill automatically add them to the dow nload list if you desire. You can also sort by ticker or name w hen adding a new
ticker.

We have shortened the nomenclature used for naming predictions. For example, instead of "5 day percent change in close



M.

as predicted 5 days ago" we willnow simply use "% change as predicted 5 days ago."

The Trader now detects that predictions need retraining or trading strategies need recalculating and so informs the user.
The user is told the reason (e.g., the training data has changed) and allow s the user the opportunity to do so or ignore the
w arning. This is done on a page by page basis w hen a chart page is loaded.

There is new sort functionality so that you can sort dialog box column entries just by clicking the column name. This is in
the Prediction Wizard, Trading Strategy Wizard (Trade by Trade Analysis and Results screens), and Data Sources Dialog.

In the Trading Strategy Wizard, you can now set up to backtest through a certain date instead of selecting a period of time.
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The NeuroShell Trader now reads CSI data files (dow nloaded from Commodity Systems, Inc.)

The new selective calculation indicator category contains pow erful indicators that allow you to include data values in a
calculation only if certain conditions are met. For example, suppose you w ant a moving average, but you only w ant to
include Mondays in the moving average. You w ould choose the selective moving average and give it as a condition the
Monday flag. Or suppose you w ant to take the minimum low only on up days (w hen the close is higher than the last day’s
close). You w ould choose the selective minimum value of the low, and give it the condition that the close is > the one day
lag of the close.

On w eekly and monthly charts created from daily data, there is now an average volume data series in addition to a volume
data series. This is because the volume data series w ill look much smaller in w eeks that have less than 5 days. The
average volume may be a better normalized input for a neural net.

On w eekly and monthly charts created from daily data, the open interest has been changed so that it now only returns the
last open interest value instead of the sum of the open interest across the w hole bar. We believe this is a more proper
w ay to calculate open interest on w eekly and monthly charts.

You can now buy and sell on market close. If you choose market close instead of market, the fill price w ill be the close of
the next day instead of the open for the next day. This is useful for certain types of mutual funds that fill at the next day’s
close. It also means that it is now possible to buy on market, sell on market close, and have both transactions take place
the same day, assuming the buy/sell conditions w ere met on the same day.

With limit, stop, and stop limit orders the price levels are now good for a day. Each day that the entry/exit conditions are
met, the limit, stop, or stop limit order is good again for a day. In previous releases, they w ere essentially good until
canceled w ith no w ay to cancel them.

The Trader now allow s a short entry to occur on the same bar as a long exit market order. If the condition for a short entry
is true on the same bar that the condition for the long exit market order is true, then the trader w ill both exit the long
position and enter the short position in the next bar. On the graph, the long entry exit triangle (empty dow nw ard blue
triangle) w ill not be show n. Only the short entry signal (solid dow nw ard red triangle) w ill be show n for the bar on w hich
the long exit and short entry condition is true.

There is now a "Rebacktest" button at the end of the Trading Strategy Wizard. This button now makes modification of a
trading strategy w ork the same w ay modification of a prediction w orks. You need to use this button to backtest again if
you have made no changes to the trading strategy. (Before you had to modify the strategy, go backw ards in the w izard,
then go forw ard again.) If you do make changes, the backtest wiill run again automatically w hen you go forw ard w ithout
using the button.

The examples have been changed. Examples 1, 2, and 3 are now much more tutorial in nature. Most of the examples on



our ww w .neuroshell.com/ w eb page have been updated and added as examples 4 through 9 in release 1.4.1.

The buy/sell triangles w ill now be show n on the trading strategy chart in the space betw een the day of the signal and the
next day (the day the order is filled). Previously they w ere on top of the day of the signal.

The Dial/Data dow nloader supplied in this release wiill use Userids that you previously obtained for another program. You
are nevertheless asked not to dow nload the same data tw ice, once from the Trader and once from the other program,
since it doubles the w orkload for Dial/Data.

We have slightly modified some indicators to increase the precision of the calculations internally. The values produced wiill
be slightly different, usually in the 3rd or 4th significant digit, but more accurate. If you retrain any nets using any of these
indicators as inputs, there will be slight differences in the results.

In a trading strategy, there is a possibility that small differences in a netw ork’s output can make larger differences in profit
if those small differences cause a trade to be missed, for example. It is very likely that any charts containing nets using
these indicators may now give different results, especially if you retrain the nets..

Below is a list of indicators affected.

SIMPLE MOVING AVERAGE CATEGORY
(All Indicators)

EXPONENTIAL MOVING AVERAGE CATEGORY
(All Indicators)

LINERALY WEIGHTED MOVING AVERAGE CATEGORY
(All Indicators)

VOLUME WEIGHTED MOVING AVERAGE CATEGORY
(All Indicators)

CHANGE CATEGORY

Average Negative Momentum
Average Positive Momentum
Minimum Momentum

Maximum Momentum
Cumulative Negative Momentum
Cumulative Positive Momentum
Cumulative Absolute Momentum

TIME SERIES CATEGORY

Bollinger Band: Low

Bollinger Band: High

Bollinger Band: %B

Bollinger Band: Band Width Percent

PRICE MOMENTUM & PRICE MOMENTUM SMOOTHED CATEGORIES
Commodity Channel Index
Accumulation/Distribution

VOLUME & VOLUME SMOOTHED CATEGORIES
Arms Ease of Movement

Negative Volume Index

On Balance Volume

Positive Volume Index

Volume Accumulation #1

Volume Accumulation #2

Volume Accumulation #3

Volume Life Force

Volume Price Trend



Changes from 1.4 to 2.0

The follow ing are the primary new features in the 2.0 release of the Trader:

A. New Data Views - There are new data view window s that you can select under the View menu. You can turn on one or
several view s at a time.
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The chart above show s all view s at once. These are the new view s available:

1. Snapshot view, w hich replaces the old data view window . If you click on a data series in the Snapshot view , the
chart w ill select/deselect that data series.

2. Historical view, w hich allow s view ing a historical list of buy/sell signals, predictions, indicators, etc., across the
current chart page. If you click on a date in the Historical view w hile in cursor mode, the chart cursor wiill jump to that
date.

3. Portfolio view , w hich allow s view ing buy/sell signals, predictions, indicators, etc., across multiple chart pages. If you
click on a ticker or its data in the Portfolio view, the chart changes to that chart page.

B. Using Custom Indicators - You can use custom indicators that wiill be saved in the Professional product. This allow s
NeuroShell Trader "Solution Providers" to create custom indicators and sell or distribute them to ALL NeuroShell Trader
users, even if those users don't have the Professional product.

C. Several New Indicators and Categories
1. 16 Adaptive Moving Average variations added ('Kaufman Adaptive Moving Average' category)

2. 4 new Time Series category indicators: Efficiency, Simple Stochastic %K, Simple Stochastic %D, Simple Stochastic
Slow %D

3. 1 new Statistical indicator: Random
5 new Volume category indicators: Money Flow Index, Positive Money Flow , Negative Money Flow, Resistance to
Advances, Resistance to Declines

5. 9 new moving average indicators added to appropriate categories: MovAvg Ratio, ExpAvg Ratio, LinWgtAvg Ratio,
VolWgtAvg Ratio, VolWgtAvg Offset, VolWgtAvg/Lag(VolWgtAvg) Ratio, VolWgtAvg - Lab(VolWgtAvg),
Avg(VolWgtAvg-Lag(VolWgtAvg)), Avg(VolWgtAvg/Lag(VolWsgAvg) Ratio)

6. Volume Accumulation #3 renamed to William's Variable Accumulation in the Volume Category. Accordingly, all former
Volume Accumulation #3 indicators in the Volume:Smoothed Category have been renamed.

7. 2new Crossover indicators: Stochastic %K/%D Crossover Above, Stochastic %K/%D Crossover Below
Stochastic Crossover Above and Stochastic Crossover Below renamed to Stochastic %K Crossover Above and
Stochastic %K Below, respectively



Note that if you used one of the renamed indicators in an old chart, the old chart will still w ork properly in the new release.

New Charting of Predictions by the Prediction Wizard - The Prediction Wizard has been significantly changed regarding the

manner in w hich predictions are displayed. Primarily, since the netw ork can simulate trading during the net training

process (even if you train on error minimization), w e have modified the program to display the resulting trading information

w ithout the necessity of building a trading strategy. You can still build more complicated trading strategies w ith the Trading

Strategy Wizard as usual. As soon as the net is trained, the follow ing are displayed automatically w ith regard to the period

that is the concatenation of all the evaluation periods for all w alk-forw ards:

1. Full trading statistics and trade-by-trade statistics are displayed in the detailed analysis for predictions.

2. Buy/sell points resulting from the trained out of sample net are now displayed on the graph. These are shown on a
separate subgraph w ith green coloring for the price stream.

3. Prediction results now show a line for the combined out of sample error/profit.

Also, the red current net prediction is no longer show n w ith the green out of sample prediction line. You can still insert the
current net's prediction, or any w alk-forw ard net's prediction, if you w ant to.
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In the chart above, w e have just inserted a prediction. The green Trades subgraph w as produced by the Prediction

Wizard, not the Trading Strategy Wizard (w e moved that subgraph to the top so it w ould be larger).

In case you do w ant to build a trading strategy that matches the Prediction Wizard's results, the follow ing assistance is

now available:

1. When you select entry and exit conditions, the conditions the net used during training are already set up and
displayed for you to choose (i.e., the relational indicator A>B has already been completed for you).
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2. You will have an option to match up trading strategy dates to the out of sample dates for the prediction(s) that w ere
used for the prediction buy/sell signals. This builds a trading strategy that is redundant because you already have
buy/sell signals from the net; how ever, building it may be useful if you w ant to add more sophistication to the trading
strategy.
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Expandable Parameter Listing for Prediction and Trading Strategy w izards - When you insert an indicator w ithin either the
Prediction Wizard or the Trading Strategy Wizard (as opposed to inserting w ithin the Indicator Wizard), you can now
modify the parameters of those indicators easier, even if they are deep w ithin embedded indicators. Each such indicator is
preceded by a plus (+) sign you can click on. When you click it, the parameters are listed below . Double-clicking on a
parameter allow s it to quickly be changed. The plus sign w ill change to a minus sign, w hich w hen clicked, hides the
parameters previously listed. See below for example.
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G. Multiple Selection of Indicators - Now you can go to an indicator category and select several indicators at the same time,
and all will be entered at once.

Indicator Wizard
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‘Indicator Help® button
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H. TradeStation® 2000i Support - The new Trader automatically recognizes w hether it is talking to TradeStation® 4.0 or




2000i, and communicates accordingly.

Carry Forw ard Retraining - This is a new feature w e don't think anyone else is doing yet (although w e are usually copied!)
It is also a feature some of our users have asked for. Previously, you trained a net, used it for aw hile in trading, and then
retrained at some time in the future. When you retrained, the current net and all w alk-forw ards moved ahead to the
present date, and their back-tested history to the present date w iped out the history that you had w ith your older net(s).
Furthermore, you had to be careful w hen to switch to the new net, because if you w ere long in the old net, for example,
the new net didn't know that. You had to w ait until the old net sold, or adjust the back-test until the new net w as long, or
something similar, so you could sw itch to the new net.

Now our Carry Forw ard Retraining feature makes sw itching to the new net painless. When you retrain an old net after

using it for a w hile, you w ill get a dialog box asking you if you w ant to carry forw ard, keeping the old net's results. If you

say yes, it won't switch you to the new net until you dow nload tomorrow . Furthermore, it remembers w hether you w ere
in the market or not and w hether you w ere long or short, and keeps you in that same status on the new net. The old
buy/sell points don't change since they're based on the old net still. The next buy or sell signal you get will be from the new
net.

Nomenclature Changes and the New Options Menu - In previous releases, predictions w ere charted on the day the

prediction w ould come true, not on the day the prediction w as made. This w as so that actual and predicted values could

both be charted on the day of the actual. Nevertheless, data streams in the Trader used for trading strategies needed the
prediction on the day it w as made. We used terms like "% Change as predicted 1 day ago" and "% change predicted 1 day
into the future" to differentiate these data streams. Some of our users w ere not comfortable w ith the predictions plotted

w hen they w ould come true because they (correctly) think of a prediction as an indicator w hose value today is the

prediction for x days into the future. Others w ere perfectly comfortable w ith our displays, even if they previously used

systems that did not "know " about the future. We have therefore given the user control in this release of how these
predictions should show up on a chart. We have at the same time renamed predictions to (hopefully) make the concepts
clearer and more succinct.

1. Inthis release there are now "predictions" and "prediction signals". The prediction is w hat w as plotted before, i.e., "%
Change as predicted 1 day ago." It is plotted on the day it comes true. Prediction signals are indicators giving you the
value today that is predicted for the future, previously "% change predicted 1 day into the future." You get your
choice of w hich one to plot (see 2 below ), but the prediction signal is the default. Both can be made available as data
streams in the Existing Data/Calculations menu. Only the prediction signal can be used in a trading strategy.

There are three types of predictions, three types of prediction signals, and similar nomenclature for actuals:

Out of sample: 1 day % change
Walk-forw ard: 1 day % change
Current net: 1 day % change

Actual: 1 day % change

Out of sample signal: 1 day % change
Walk-forw ard signal: 1 day % change
Current net signal: 1 day % change
Actual signal: 1 day % change

2. We have added an options dialog that is accessible from the ‘Tools” menu. This dialog currently allow s you to
change how a prediction is inserted on the chart. The prediction may be inserted as a prediction signal on the bar the
net w as fired or as the prediction that extends out into the future. In addition this dialog gives the user control over
w hether Current nets and Walk-forw ard nets are displayed in the data lists and w hether or not to display the
predictions in the data lists (since normally only signals will be needed there for trading strategies.)
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Existing data/calculation settings
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Cancel Help




K.  Other Minor Prediction Wizard Changes

1. Change in open and %Change in open have replaced Change in close and %Change in close in the list of default
prediction outputs. These new outputs compute the change from tomorrow ’s open to the open x bars beyond
tomorrow ’s open. The prediction enters and exits at the next bar's open, just as actual daily trading w ould do.
Therefore, this will allow for a more realistic prediction. How ever, Change in Close and %Change in close are still
available by selecting Other Data/Indicators.

2. When predicting a custom indicator output, the prediction wizard displays a ‘...” button that can be used to modify the
parameters of the custom indicator output.

3. The prediction profit will be slightly (depending on the trades) different from release 1.4x because that version did not
allow a long exit and short entry (or a short exit and a long entry) on the same bar, as release 2.0 does.

L. New Trading Strategy Order Features - Some new trading features have been added. They are somew hat complicated
for the beginner and should only be considered by more experienced users.

1. A market on close exit order can exit on the same bar as entry for market, limit, stop, and stop-limit entry orders.
Previously, only a market order could exit on the same bar as a close exit order. For example, this allow s for very
limited day trading: predict the low and use a limit order to enter on the predicted low , w hile exiting at the close on the
same day.

2. The trading strategies now allow a trailing stop reversal trading strategy. If you specify only a long trailing stop and a
short trailing stop, the strategy will reverse betw een long and short positions using trailing stops to enter/exit each
position.

3. When using a long/short entry reversal system (i.e. only long and short entry conditions) and stop/limit/stop limit
orders, the system now exits w ith the same type of order as it enters. Previously if the system w as long and the
short entry condition became true, the system w ould exit the long position w ith a market order and place the short
entry order w ith the desired order type (stop/limit/stop limit). Now the system w ill exit the long position w ith the same
type of order as wiill be used for the short entry. This eliminates the problem in w hich there's an exit on the next bar's
open, but the entry is some time later that bar or perhaps even an indefinite number of bars later depending upon the
limit/stop prices involved.

M. The follow ing trading strategy position indicators have been changed to more accurately reflect their meaning:

1. Bars Since Entry Activated:

. Parameter has changed from Positions ago to Activations ago (0 Positions ago should now be 1 Activation ago).
e« Values now reflect activations that may not have been filled (i.e., the limit price w as never reached), as well as
activations that w ere filled.

2. Bars Since Entry Filled:

. Parameter has changed from Positions ago to Fills ago (0 positions ago should now be 1 Fill ago).

3. Bars Since Exit Activated:

. Parameter has changed from Positions ago to Activations ago (0 Positions ago should now be 1 Activation ago).
¢ Values now reflect activations that may not have been filled (i.e., the limit price w as never reached), as well as
activations that w ere filled.

4. Bars Since Exit Filled:

. Parameter has changed from Positions ago to Fills ago (0 Positions ago should now be 1 Fill ago).

5. Bars Active:

. Properly handles reversals - still represents the number of bars active in the current position or any previous

position.
6. Bars Filled:
. Properly handles reversals - still represents the number of bars filled in the current position or any previous
position.

7. Value w hen Entry Activated:
e Parameter has changed from Positions ago to Activations ago (0 Positions ago should now be 1 Activation ago).

e Values now reflect activations that may not have been filled (i.e., the limit price w as never reached), as well as
activations that w ere filled.

8. Value w hen Entry Filled:
. Parameter has changed from Positions ago to Fills ago (0 Positions ago should now be 1 Fill ago).
9. Value w hen Exit Activated:
. Parameter has changed from Positions ago to Activations ago (0 Positions ago should now be 1 Activation ago).
e« Values now reflect activations that may not have been filled (i.e., the limit price w as never reached), as well as
activations that w ere filled.
10. Value w hen Exit Filed:
. Parameter has changed from Positions ago to Fills ago (0 Positions ago should now be 1 Fill ago).

TradeStation® is a registered Trademark of TradeStation Technologies, Inc. Neither TradeStation Technologies nor any
of its affiliates has reviewed, certified, endorsed, approved, disapproved or recommended, and neither does
or will review, certify, endorse, approve, disapprove or recommend, any trading software tool that is designed



to be compatible with Trade Station Open Platform.



Changes from 2.0 to 3.0

The follow ing are the primary new features in the 3.0 release of the Trader:

A. NeuroShell Trader now has the ability to be upgraded to the NeuroShell DayTrader. This upgrade w ill allow users to use
real-time intraday data. For upgrade price and information please contact the Ward Systems Group Sales Department.

B. The dialog for setting up your data directories & files has been combined w ith the dialog to dow nload data. Additionally,
w e have added a servers tab to allow you to connect to your real-time data source. This new dialog can be accessed by
selecting Data Sources from the Tools menu.

C. Forthe new millennium, a new dow nloader from Dial Data has been included. Also, version 3.0 has the ability to read new
MetaStock and CSI file formats that some dow nloading services may be using. Furthermore, version 3.0 reads the new
data format Omega uses in its files that our TradeStation® interface reads.

D. The daily historical data for Mutual Funds and Market Funds has been moved from the Historical Data CD to the Installation
CD. If you w ant to use this data, you can either use it directly from the installation CD or you can copy the needed files to
a directory on your hard drive. We suggest that you copy the needed files to your hard drive because if you use this data
directly from the installation CD, you will be unable to access the Historical Data CD at the same time (unless you have
more than one cdrom drive).

TradeStation® is a registered Trademark of TradeStation Technologies, Inc. Neither TradeStation Technologies nor any
of its affiliates has reviewed, certified, endorsed, approved, disapproved or recommended, and neither does
or will review, certify, endorse, approve, disapprove or recommend, any trading software tool that is designed
to be compatible with TradeStation Open Platform.



Changes from 3.0 to 3.2

The follow ing are the primary new features in the 3.2 release of the Trader:

A.

The capability to change the periodicity of a chart has been added. All charts now have a drop dow n list of periodicities at
the top right of the chart. By selecting a different periodicity, all of a chart’s data, calculations, predictions, and trading
strategies w ill change to the new periodicity. Note that the parameters of indicators, predictions and trading strategies do
not change, so if you had MovAvg(Close,5) on a daily chart, the indicator w ill remain as MovAvg(Close,5) if you change to
a w eekly chart. The difference w ill be that 5 data points now represent 5 w eeks instead of 5 days. Any predictions and
trading strategies on a chart will need to be retrained and rebacktested w henever you change the chart periodicity.

Analysis templates have been added to NeuroShell Trader. Analysis Templates allow a presaved analysis/chart layout to
be applied to a new chart. When creating a new chart, you have the option of selecting an Analysis Template from the
Analysis Template drop dow n list. If an analysis template is selected, the chart will be created w ith the selected analysis
already applied to the chart. For instance, one analysis template you can select is called the Moving Average Crossover
Strategy. If selected, a chart will be created w ith a moving average crossover based trading strategy on the chart. Any
chart file that is saved to the template subdirectory will be available as an analysis template in the New Chart Wizard.
Therefore, if you w ant to create your ow n custom analysis templates, you need only save or copy a representative chart
into the template directory. Custom Analysis Templates are an alternative to multiple chart pages in that they allow you to
easily apply the same analysis/chart format to a variety of ticker symbols.

(Professional Only) The ability to reconstruct the original indicator from a custom indicator has been added. If you select
the Modify Indicator button on the last page of the indicator wizard w hen a custom indicator is selected, you will see
the Reconstruct Original Indicator button at the bottom of the Save Template dialog. Pressing this button wiill
reconstruct the original indicator that w as used to create the custom indicator. Note that if you have created custom
indicators and do not w ant other people to have the ability to view or reconstruct the original indicator, you should make
sure that you have passw ord protected all your custom indicators.

The prediction w izard has eight new standard outputs. The eight new outputs are the Optimal Change in Close, Optimal
Percent Change in Close, Optimal Buy/Sell/Hold based on Close, Optimal Buy/Sell based on Close, Optimal Change in Open,
Optimal Percent Change in Open, Optimal Buy/Sell/Hold based on Open, and Optimal Buy/Sell based on Open. The optimal
change and optimal percent change outputs are the change from the current price value to the next peak/valley in prices.
The buy/sell output is a buy(1) w hen prices are going upw ards tow ards a peak and a sell(-1) w hen prices are going

dow nw ards tow ards a peak. The buy/sell/hold indicator is similar to the buy/sell except that it changes from a buy to a
hold(0) w hen the distance to the next peak is less than the distance to the valley that follow s the peak. The buy/sell/hold
indicator also changes from a sell to a hold w hen the distance to the next valley is less than the distance to the peak that
follow s the valley. For more information about these outputs see Neural Netw ork - Output Discussion

A new indicator category Neural Outputs has been created and contains the new indicators Optimal Change, Optimal
Percent Change, Optimal Buy/Sell/Hold, and Optimal Buy/Sell. These indicators allow users to use the optimal outputs
described above as the output for the neural indicators add-on packages.

The indicators Time of Day, Hour of Day, and Minute of Hour have been added to the Time Flags category.

The indicator Days until Third Friday has been added to the Day and Date Flags category. This will aid in determining the
number of days until the next options expiration.

The indicators Crossover Above and Crossover Below have been added to the Crossover & Breakout Identification
category.

Double clicking on the legend text or a line on the chart will cause an edit of the indicator, prediction, or trading strategy
being double clicked. If you prefer, you can still access the modify menu items by right clicking or selecting modify from
the edit menu.

Exporting has been improved to include the ability to export a data file for each chart page in the chart w ith only one
export. The export wizard now contains an Export a data file for each chart page in the chart option. This option
allow s for a data file to be w ritten for each chart page using the export wizard only once instead of having to use the
export wizard once for each chart page for w hich a file is desired.

(Professional Only) Four new trading objective functions have been added to both Prediction and Trading Strategy
optimization. The new objective functions are Maximize ReturnOnAccount * EquityCurveCorrelation, Maximize Sharpe
Ratio by Trade, Maximize Ratio Net Profit / StndDev Profit, and Maximize Ratio Net * Avg Profit / StndDev Profit. For more
details on these objective functions see Trading Objective Functions.

A quote.com setup dialog has been added to the data sources form. Once you select quote.com as your data server, you
can select the Setup button to access the setup dialog. The setup dialog contains options for controlling w hether or not
NeuroShell Trader tries to automatically reconnect to quote.com if the connection is lost and the option of how to handle
situations w here the data on the quote.com server does not match the old quote.com data that NeuroShell trader
previously dow nloaded to your hard drive.

An option to show Selected items only has been added to the Chart Wizard so that selecting and deselecting
instruments may be made a little easier w hen creating a new chart or adding/removing chart pages.

End of day Omega Global Server data is now mapped as a data server instead of as a data file. The Omega Global Server
is mapped as a data server by selecting Data Sources from the Tools menu, selecting the Servers tab, and selecting
Omega Global Server (2000i) in the drop dow n list. If you previously had end of day Omega Global Server data mapped,
NeuroShell Trader w ill automatically make the Omega Global Server the data server and remove any Omega Global Server



file mappings that you had in prior versions the first time you run NeuroShell Trader version 3.2.

NeuroShell Trader now w orks on Asian versions of Window s. How ever, to w ork w ith Asian window s it w as necessary
to change the file format for charts and custom indicators. All charts will automatically be saved to the new file format

w hen they are saved in version 3.2. When you first run version 3.2, all of your template files (.TPL) located in the
NeuroShell Trader Template subdirectory w ill be automatically changed to the new file format. NeuroShell Trader w ill also
save the old template file to the extension .V30. In the event that you need to sw itch back to the old template format, you
can erase the new .TPL file and then rename the old .V30 file to .TPL.

Indicators w ill now extend data of other frequencies properly. In old versions, if you added w eekly raw data to a daily
chart, the w eekly raw data values w ould be extended out to fill each daily bar. How ever, if you had created an indicator
based solely upon the w eekly data, the resulting indicator w ould not extend itself out to every daily bar. In the new
version, if you create an indicator based solely upon w eekly data, the indicator will properly extend itself out to fill every
daily bar.

In the Prediction Wizard, the default number of hidden nodes for the training set w as reduced to 10 to match to number of
hidden nodes for the optimization set.

Additional Market lists for Quote.com have been added — NASDAQ 100, S&P 500, S&P 100, and Breadthalizer (Quote.com’
s exclusive market breadth statistics).



Changes from 3.2 to 3.3

Release 3.3 is primarily a maintenance release, how ever the follow ing new features have been added in the 3.3 release of the
Trader:

A.

Trading Strategies now display a dashed line for all entry and exit limit orders. The dashed line is draw n from just right of
the current bar to just left of the future bar for w hich the limit order is active. The line is draw n at the price level for

w hich the limit order should be placed. NOTE: To get an old trading strategy w hich uses limit orders to display a dashed
line, you wiill need to follow the follow ing steps:

a. Add "Trading Strategy Long Entry Order" data to your chart using Insert Existing Data/Calculations from
the Insert Menu.

Delete all "Trading Strategy" data from your chart (i.e. all the price/trade annotations for the trading strategy).

Read "Trading Strategy" data from your chart by using Insert Existing Data/Calculations from the Insert
Menu.

d. Delete the "Trading Strategy Long Entry Order" data you inserted in the first step.

Trading Strategies now display a solid line for all entry and exit stop orders. The solid line is draw n from just right of the
current bar to just left of the future bar for w hich the stop order is active. The line is draw n at the price level for w hich

the stop order should be placed. NOTE: To get an old trading strategy w hich uses stop orders to display a dashed line,

you w ill need to follow the same steps as outlined for limit orders above.

Quote.com’s latest Continuumclient.DLL is now installed. NOTE: Quote.com’s latest DLL will disconnect your
connection if another user tries to logon to a Quote.com server using the same Name and Password.

Please verify that no one else is using your Quote.com account if you are experiencing substantially more disconnects
than you had with previous releases.



Changes from 3.3 to 4.0

The follow ing are the major new features added in the 4.0 release of NeuroShell Trader:

Data Source Changes:

A.

Quote.com Afterhours — The ability to receive after hours data has been added to the quote.com data feed. An
afterhours check box is displayed to the right of the frequency selection drop dow n list on the chart. Selecting the after
hours check box w ill cause after hours or all markets data to be dow nloaded and added to the chart. Be careful w hen
using after hours data as the volume in afterhours is usually far less then during normal market hours and therefore might
mess up existing predictions and trading strategies.

eSignal Data Feed — The ability to receive data from eSignal by selecting the e Signal Data Server from the Server tab in
the Data Sources dialog (select Data Sources from the Tools menu). For more information on the eSignal server refer
to eSignal.

eSignal European Market .Ist Files — Using the eSignal Data Feed you now have the ability to access European Markets via
the eSignal European Market .Ist files. These can be selected once you’ve choosen eSignal Data Feed as your Server.
Once that is done you can select the European Markets from the list of markets on the Server tab of the Data Sources
dialog.

Data Pump Interface — The ability to program custom data interfaces to be used inside the NeuroShell Trader. This
interface is quite complicated, but can provide a great deal of pow er. This feature provides you w ith a method to "pump"
data into the NeuroShell Trader. This allow s you to feed any type of data you w ant from any vendor, with any
transformation that you w ant to perform on the data before NeuroShell Trader looks at the data. This is quite complicated,
but it can be done w ith a decent programmer and information provided in the DataPumpExample.zip available on

http://w w w .w ard.net/.

DDE Interface — The ability to link to any data stream that uses DDE as a method of providing data. This can be done by
using the DDE Archive program provided in the Servers directory. For more information on the DDE Interface visit the
Dynamic Data Exchange help file.

TradeStation® Intraday Chart Data Transfer — The ability to use TradeStation intraday data realtime. This feature allow s
users to "export" data and functions from indicators to NeuroShell Trader from TradeStation®. For more information refer
to TradeStation NSTExport Server.

Adding Ticker Symbols - If you are using Quote.com or eSignal as your data source, you have the option of adding
instruments that are not already show n in the New Chart Wizard or the Add Other Instruments Data Wizard. When
choosing instruments in each of these wizards, the Add New Quote.com Ticker Symbol and the Add New eSignal
Quote.com Ticker Symbol button will allow you to add new ticker symbols. Use of these buttons allow s users to add
new ticker symbols dynamically instead of having to manually edit the server .LST files.

Combination Ticker Symbols - Ability to create ticker symbols that are simple combinations of ticker prices and use the
combination symbol as the primary data series. The optimizations and trading strategies wiill be based on the ticker
symbol combination and results determined on the calculation, not a single ticker symbol. For instance a ticker symbol
combination might be [5*YHOO-2.5* INTC+3*MSFT], w hich w ould result in a price stream on the chart that is 5*YHOO's
price minus 2.5*INTC's price plus 3*MSFT's price. To use this feature, simply create a new ticker symbol like
[5*YHOO-2.5*INTC+3*MSFT]. To add a new ticker symbol, use the add ticker button found in the chart wizard w hen using
Quote.com or eSignal. For more information, see Combination Ticker Symbols.

DialData Cleanup - The End of Day Dow nload tab in the Data Sources dialog now has the button DialData Dow nload
Reinitialization and Cleanup. This button can be used if the DialData master file is corrupted and causes errors w hen
adding new tickers to be dow nloaded or w hen dow nloading. Please note that all your previously dow nloaded data will
be removed and the data w ill be redow nloaded next time you dow nload from DialData.

Major Functionality Changes:

A.
B.

Adding Ticker Symbols - If you are using Quote.com or eSignal as your data.

Wizard Interface Options — Options have been added the Indicator, Prediction and Trading Strategy Wizards to control the
complexity of the trading strategy, prediction and indicator w izard interfaces. By selectively turning on only desired
interface options, you can customize the interface to show only those trading strategy, prediction, and indicator
parameters and options that you will use. With the majority of the interface options turned off, you have a simple and
easy to understand interface for creating basic trading strategies, predictions, and indicators. With the majority of the
options turned on, you have an extensive interface for creating complex trading strategies, predictions, and indicators.
For detailed information on each of the w izard interface option see Trading Strategy Wizard Interface Options, Prediction
Wizard Interface Options, and Indicator Wizard Interface Options.

Softw are Copy Protection — The NeuroShell Trader now uses softw are protection instead of the old security block
hardw are protection. The softw are protection is linked to a w ebsite w hich allow s for quick enabling and disabling of the
softw are. In the past, to switch computers, you had to move the security block from home to office and back, or to a
notebook, etc. Now you can sw itch computers by simply disabling the NeuroShell Trader on the first computer and then
enabling the NeuroShell Trader on the second computer. All of the disabling/enabling is done via the internet. In addition,
if you have purchased tw o copies of NeuroShell, you w ill be given tw o activations so that it can be run on tw o different
computers at the same time. For more information see NeuroShell Trader Activation

Trading Position and Orders - The alert window has been expanded to include active trading strategies, current market


http://www.ward.net/

positions and trading orders for all charts. It now show s lists of the alerts, active trading strategies, current market
positions, all trading orders, open trading orders, filled trading orders, and canceled trading orders.

Trade Prompting - Trading Strategies now play sound files or show pop-up order messages (for example: Buy 100
Shares of Dell) w hen a new order is generated. Only active trading strategies w ill play sound files or show pop-up order
messages.

a. When a new Trading Strategy is added to a chart, it is automatically activated. To deactivate or reactivate a
trading strategy, select the Alerts and Orders Window menu item from the View menu.

b. To change the sound and pop-up message options, select the Options menu item from the Tools Menu. If
the Play Sound File option is selected, then the selected sound w ill play w henever an active trading
strategy generates a trading order. If the Popup Order Message option is selected, a pop-up order
notification message w ill appear w henever an active trading strategy generates a trading order.

Chart Related Changes:

A.
B.

C.

Adjustable Subgraphs — Subgraph sizes can now be adjusted by dragging the bar separating subgraphs up or dow n.
Improved Legend — The names of data series are now placed at the top of each subgraph instead of all being placed at
the top of the graph.

Color and Style Dropdow ns — The color and style selections have been moved from the vertical toolbar on the left to the
drop dow n menus in the upper toolbar.

More colors — A total of 48 color choices are now available for chart s.

Grid Lines — You can now show vertical or horizontal grid lines on charts. To setup grid lines, select the Format Chart
menu item from the Form at menu and then go to the Colors tab of the Format Chart dialog.

Log scaling — Individual subgraphs of a chart can be scaled logarithmically. To add log scaling, select the Format Chart
menu item from the Form at menu and then go to the Y-Axis tab of the Format Chart dialog.

Expanded window space — For added w indow /charting space, you can now toggle the display of the status bar, tool

bar, and a charts symbol/name/frequency bar using the Symbol/Name/Frequency Bar, Tool Bar, and Status Bar
menu items located in the View menu.

Subgraphs can have more than 2 line styles — The subgraphs can now have more than 2 different lines styles displayed
at once. Additionally, more than 1 Candlestick, OHLC, or HLC can be displayed on a single subgraph.

First/Last Date Displayed — The first and last date displayed options have been removed from the Format Chart dialog.

Prediction and Trading Strategy related changes:

A.
B.

First/Last Date Displayed — The first and last date displayed options have been removed from the Format Chart dialog.

Prediction and Trading Strategy Templates — The prediction and trading strategy w izards now allow selection of
templates. Templates are preconfigured predictions/strategies that allow you to create a prediction/strategy quickly
w ithout having to know or w orry about all the details or w ork of creating one from scratch.

Saving Custom Templates — Custom prediction and trading strategy templates can be saved using the Save as Tem plate
button on the last page of the prediction and trading strategy w izard. Saving custom templates allow s you to apply the
same prediction or trading strategy analysis to different charts w ithout having to recreate the prediction or trading
strategy from scratch.

Optimization Parameter Linking (Professional Only) - Parameters can be associated w ith an optimization link and all
parameters associated w ith the same link w ill optimize to the same value.

Optimization Timeout (Professional Only) - The parameter ‘Optimize for exactly’ has been added to predictions and
trading strategies. This option forces the optimization to take a specified amount of time. Because of the nature of
genetic optimization, it is impossible to determine the exact optimization time or even w hen the best neural netw ork has
been found. Without this parameter selected, optimization w ill automatically stop after it has decided that a better neural
netw ork is unlikely to be found in the future. Set this parameter to a longer to make absolutely sure that the best neural
netw ork has been found. Set this parameter to a shorter time to stop optimization before the best neural netw ork has
been found.

Option to Save Optimal Results that did best on Out of Sample Data (Professional Only) - The parameter ‘Generalize on
Optimal walk-forwards’ has been added to predictions. This option essentially saves the input and parameter
combination that did best on ‘out of sample’ data. It makes the selection of the optimal neural netw ork based upon
performance on the optimal w alk-forw ard out-of-sample data instead of the optimal w alk-forw ard training data. During
optimization, the neural netw ork is still trained on the training set, but it is then applied to the optimal w alk-forw ard
out-of-sample data. The out-of-sample result is then used to determine the optimal neural netw ork. Note that by using
this option, the optimal w alk-forw ard out-of-sample results can no longer be considered truly out-of-sample as the data is
being used to determine the best inputs and parameters during optimization.

Optimization Across Chart Pages (Professional Only) - The parameter ‘Optimize across all chart pages’ has been
added to predictions and trading strategies. This option forces the optimization to choose the same inputs and
parameters for each chart page. The optimization w ill find the inputs and parameters that perform best across all chart
pages by using the average result across all chart pages instead of trying to optimize the individual results for each chart
page. Use of this parameter will result in w orse results than optimizing each chart page individually, but w ill provide more
consistent and generalized inputs and parameters across the chart pages.

Round Lot Trading — The parameter ‘Buy shares in round lot of’ has been added to predictions and trading strategies.
When selected, this parameter Rounds dow n the number of shares traded to a multiple of the specified number of



shares. As an example, if the round lot shares is set to 100 and the number of shares to be traded is 299, then the actual
number of shares traded will be 200.

Option for Entries to Exit Positions — The option Long/Short entries exit existing short/long positions has been
added to the Trading Strategy Parameters dialog. This option forces an entry signal to automatically exit existing
positions. Long positions w ill be exited w hen the short entry condition(s) become true. Likew ise, short positions will be
exited w hen the long entry condition(s) become true. If you do not select this parameter and you have specified trailing
stops and/or exit conditions, then a position wiill be exited only w hen the trailing stops are hit or the exit conditions
become true (i.e. the w ay old NeuroShell Trader versions w orked).

Predictions Default to In-Sample Optimization (Professional Only) — The prediction wizard now defaults to insample
optimization. Out of sample optimization is still available, but must be set in the Prediction Parameters dialog.

Minimize w hile processing — A minimize button has been added to the Prediction Wizard and the Trading Strategy Wizard.
The button is visible during the training, backtesting, and optimization process. The button w ill minimize the entire
NeuroShell Trader window so that you can w ork on other programs w hile long processing is taking place. Note that
using the Show Desktop Window s task bar icon w hich is typically located next to the Window s Start button w ill also
minimize the Trader during processing.

Column Widths Remembered - The columns w idths in the results screen of the Prediction Wizard and the Trading Strategy
Wizard are now remembered and restored every time the wizards are run.

Indicator Related Changes:

A.

Ability to reorganize Indicator Categories — Move Up, Move Down, and Reset buttons have been added to the category
page of the indicator wizard. These buttons allow you to change the order in w hich indicator categories are listed. For
more information see Indicator Wizard - Selecting a Category.

Custom Indicator Optimization Ranges (Professional Only) — When creating custom indicators, you can now specify the

default optimization range that should be used for each parameter w hen the custom indicator is optimized. For more
information see Modify Parameter's Display Properties (Professional Only)

General Changes:

A.

Autosaving of charts — An option has been added that allow s charts to be saved after every major change and before
training/backtesting. If the Trader is unexpectedly terminated (pow er outage, system crash, etc), the Trader w ill ask you
if you would like to load the autosaved chart(s) w hen the first time you rerun the Trader. For more information see
Options - Chart.

Emailing Charts - An Email Chart menu item has been added to the File menu. This menu item allow s users to
automatically attach their charts to a new email message using their default email client. The option also exists to save
the current underlying data in the chart that gets emailed so that email recipients have the same data as w hen the Email
Chart menu item w as selected. For more information, see Emailing a Chart.

Direct Link to ww w .w ard.net. A Connect to Advanced User’s Tips & Techniques Website menu item has been

added to the Help menu. This menu item w ill bring up your internet brow ser and load w w w .w ard.net. For more
information, see Advanced User's Tips & Techniques Website




Changes from 4.0 to 4.3

The TradeStation Import function is no longer a supported feature, although it is still included in the release. It is unsupported
because changes made to TradeStation have rendered the feature unreliable.



Changes from 4.3 to 4.4

The follow ing are the major new features added in the 4.4 release of NeuroShell Trader:

1. Ability to select time zone information for server data:

a.

b
C.
d

Select Tools — Data Sources.

Select the Servers tab.

Select the Setup button for your selected server.
Select the Time Zone tab.

2. Ability to view and delete historical data server files from inside NeuroShell Trader:

a.
b.
(3

Select Tools — Data Sources.
Select the Servers tab.
Select the Manage Realtime Files button.

3. The %return calculation w as changed to add the entry commission into the numerator of the %return calculation:

%Return is calculated as follow s:

Long Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) / (entry
price*shares — entry commissions).

Short Percent Return = 100 * ((exit price - entry price)*shares - entry commission - exit commission) / (entry
price*shares — entry commissions).

If using margin $ per share/contract, then % return is calculated as follow s:

Long Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) /
(margin*contracts — entry commissions)

Short Percent Return = 100 * ((entry price - exit price)*shares - entry commission - exit commission) /
(margin* contracts — entry commissions)

Note that the entry and exit price incorporate any specified slippage and/or point value



Changes from 4.4 to 4.5

The follow ing are the major new features added in the 4.5 release of NeuroShell Trader:

1. eSignal recently made 60 days of data available for dow nload (as opposed to 30 days previously). Version 4.5 adds the
ability to dow nload 60 days of data from eSignal. and the new 4.5 version of the Trader will now dow nload the full 60
days of data.



Changes from 4.6 to 4.7

The follow ing are the major new features added in the 4.7 release of NeuroShell Trader:

1. Added ability to read ASCII files that are ordered from most recent date at top to least recent date at bottom.



Changes from 4.7 to 4.8

The follow ing are the major new features added in the 4.8 release of NeuroShell Trader:

1. Composite Symbols (i.e. [2*IBM-3*DELL]), now allow quotes around ticker symbols to allow for ticker symbols that contain
arithmetic operators like *, -, +, and /. This allow s composite symbols on foreign exchanges of the form ["bl u5-dt"-"gb
u5-dt"]



Changes from 4.8 to 5.0

The follow ing are the primary new features in NeuroShell Trader 5.0:

Integrated Trading — Ability to send trades directly to the brokerage firm Interactive Brokers or email orders to a list of
email addresses. To setup integrated trading w ithin NeuroShell Trader:

1. Select Options from the Tools menu to activate the Options Dialog
2. Select Send orders to brokerage from the Trading Orders tab
3. Select the desired brokerage server from the Brokerage drop-dow n list.
For more detailed information about the brokerage servers available in 5.0, see: Interactive Brokers and Order Emailer

Integrated Trading API — Integrated trading programmer’s interface w hich will allow programmers to create NeuroShell
Trader integrated trading connections to brokerages other than Interactive Brokers. Additional details are available in the
Trading API package available from Ward Systems Group.

Range Bar Charts — Constant range bars can be created w here each bar represents trading activity for the user-specified
minimum price range. The high-low range of each bar will equal the specified range. Each bar is created by accumulating
trades until the high-low range is reached. The first trade to break outside that range starts a new bar. Since price gaps are
not filled w ith phantom bars, the high-low range of a bar can exceed the specified range w hen prices gap outside the range
before a bar’s price range criteria w as met.

To create a constant range bar chart, in the New Chart wizard, simply choose ‘Range Bars’ and then enter the desired
amount of price range that w ill make up each bar (for example price range of 2.5 per bar). Note that range bars are created
from tick by tick data streams and therefore historical data may be limited and take longer to load. Additionally, range bars can
only be created using Quote.com or eSignal in the 5.0 release.

Volume Bar Charts — Constant volume bar charts can be created w here each bar represents trading activity for the
user-specified minimum volume. The volume of each bar w ill equal the specified volume. Each bar is created by accumulating
trades until the specified volume is reached.

To create a volume bar chart, in the New Chart w izard, simply choose ‘Volume Bars’ and then enter the desired amount of
volume that w ill make up each bar (for example volume of 10000 shares per bar). Note that volume bars are created from tick
by tick data streams and therefore historical data may be limited and take longer to load. Additionally, volume bars can only be
created using Quote.com or eSignal in the 5.0 release.

Tick Bar Charts - Tick bar charts can be created w here each bar represents trading activity for the user-specified number
of trades. In the New Chart wizard, simply choose ‘Tick Bars’ and then enter the desired number of ticks that w ill make up
each bar (for example 25 ticks per bar). Note that tick bars are created from tick by tick data streams and therefore historical
data may be limited and take a longer to load. Additionally, tick bars can only be created using Quote.com or eSignal in the 5.0
release.

Second Bar Charts —Second bars can be created. In the New Chart wizard, simply choose ‘Second Bars’ and then enter
the desired number seconds that w ill make up each bar (10 seconds per bar). ). Note that second bars are created from tick
by tick data streams and therefore historical data may be limited and take a longer to load. Additionally, second bars can only
be created using Quote.com or eSignal in the 5.0 release.

Expanded Minute and Hour Bar Charts — Minute and Hour bars can now be created w ith any number of minutes or hours
per bar. In the New Chart wizard, simply choose either ‘Minute Bars’ or ‘Hour Bars’ and then enter the desired number of
minutes or hours that w ill make up each bar (for example 13 minute bars or 5 hour bars).

Bid and Ask Statistics — When using any tick by tick data stream based charting method (Second Bars, Tick Bars, Volume
Bars and Range Bars), the follow ing bid and ask data streams are created in addition to the standard Open, High, Low, Close
and Volume:

Bid The current bid price at the close of the bar.

Ask The current ask price at the close of the bar.

Bid Size The number of shares offered for purchase at the current bid price at the close of the bar.
Ask Size The number of shares offered for sale at the current ask price at the close of the bar.

# Bid Trades The number of trades that occurred at the bid price during the last bar.

# Ask Trades The number of trades that occurred at the ask price during the last bar.

Bid Trade Volume The total volume of trades that occurred at the bid price during the last bar.

Ask Trade Volume The total volume of trades that occurred at the ask price during the last bar.
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Avg Bid Trade Volume The average trade volume for trades that occurred at the bid price during the last bar.
Avg Ask Trade Volume The average trade volume for trades that occurred at the ask price during the last bar.

Note that bid ask statistics may not be available for every ticker symbol. Availability is dependent upon w hether the data
provider includes current bid/ask ticks in the tick by tick data stream for a given ticker symbol.

Ticker Scanning — Large numbers of ticker symbols can be scanned for user definable criteria or values. To start ticker
symbol scanning w izard, select ‘Scan Ticker Symbols’ from the ‘Tools Menu’ and then follow the instructions below :
1. On the first page of the Ticker Symbol Scanning Wizard, select either a pre-saved scan template or select No
Template.
2. Onthe second wizard page, select the scanning periodicity (minute bars, hour bars, etc.) and how far back data is
loaded for each scan’s calculations.
3. Use the third wizard page to select the category of ticker symbols to be scanned
On the fourth w izard pages, select the actual ticker symbols to be scanned.
5.  On the fifth wizard page, enter all the indicators values that you w ish to view for the scanned ticker symbols. The
sixth wizard page lists the latest indicator values for each of the selected ticker symbols. You can sort the columns
to group indicators w ith certain indicator values. Any of the ticker symbols that you select/check will be added to a
new chart w hen you press the Finish button. The new chart will also contain all the indicators that w ere included
in the scan.

»

Workspaces — Saving and loading of w orkspaces, w hich are collections of charts you w ant to load at the same time. To
save a w orkspace, select the ‘Save Workspace’ menuitem from the ‘File’ menu. To load a pre-saved w orkspace, select ¢
Open’ from the file menu and select a w orkspace (file name ending in .w rk). Note that the ‘Open’ dialog displays both charts
and w orkspace files at the same time, but can be changed to display only one or the other using the ‘Files of Type’ dropdow n
box at the bottom of the dialog.

Trend, Fibonnaci, Line, Shape and Text Annotations - Trend lines, trend channels, Fibonacci retracements, Fibonacci
projections, Fibonacci time lines, lines, vertical lines, horizontal lines, squares, ellipses, and text can now be draw n on charts.

To draw annotations on a chart, select the appropriate annotation type from the ‘Draw ing’ menu and then press the left
mouse button on the chart w here you w ish the annotation to start and then drag the mouse w ith the button still depressed
to the ending location of the annotation.

To edit annotations already on a chart, simply select the annotation w ith the mouse and left mouse button and either drag the
annotation to a new position, resize the annotation using the resize squares at the edges of the annotation, or simply delete

the annotation using the delete key or the delete menu item. To change text annotations to different text strings, double click
on the text annotation.

Increasing/Decreasing Bar Colors — Ability to color data series in user selected colors based upon w hether the data
series is increasing or decreasing. To turn on this feature, select a data series on a chart, choose the "Format Selected ..."
menu item from the ‘Format’ menu and make the appropriate changes in the ‘Mult-Colored’ tab.

Maximum/Minimum Range Bar Colors — Ability to color data series in user selected colors based upon w hether the data
has reached a user defined upper range or low er range. To turn on this feature, select a data series on a chart, choose the
"Format Selected ..." menu item from the ‘Format” menu and make the appropriate changes in the ‘Mult-Colored’ tab.

Gradient Color Bars — Ability to color data series in a user defined color gradient based upon the bars relative range or
relative increase/decrease. To turn on this feature, select a data series on a chart, choose the "Format Selected ..." menu
item from the ‘Format’ menu and make the appropriate changes in the ‘Mult-Colored’ tab.

The gradient color shading is determined based upon the number of last bars chosen. So for instance if you choose 14
bars, the current bar’s color will be chosen based upon its value relative to the values over the last 14 bars. Ifitis at an
extreme min or max, then it will be colored in the appropriate min or max color, otherw ise it will be colored in a color shade
betw een the tw o colors in proportion to its distance from the maximum and minimum value over the last 14 days.

Out Of Sample Model Saving — Ability to choose w hether or not to keep the prediction or trading strategy model that did
best on the optimization data set or the model that did best on a subsequent paper trading (i.e. out of sample) data set.
Configuration of this feature is done on the dates tab of the prediction parameters and trading strategy parameters dialog.

If you choose to save the model that does best on subsequent paper trading, the model’s parameters are still optimized on the
optimization set, but each new optimal solution that is found by the GA is applied to the paper trading set. If that optimal
solution is found to get better results on the paper trading set than previous optimal solutions, then it is saved as the ‘best
model’. Optimal solutions that underperformed on the paper trading are still used in the GA optimization process to find an
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optimal solution on the optimal data set, but they are not used as the ‘best model’. The final model selected by the
optimization is the last saved ‘best model’.

The optimization data set show s on the chart and on the date selection dialog in gray bars, and the paper trading set show s
in orange bars.

Trading Data Set — Option to start a ‘trading’ data set before the last chart date in the prediction and trading strategy

w izards for additional statistical analysis of systems. To turn on this option, select the ‘Options’ menu item from the ‘Tools’
menu, select the ‘Advanced’ tab and select ‘Allow trading to begin before last chart date’. After this option is turned on, you
w ill see the ‘Start trading before last chart date’ checkbox on the dates tab of the prediction and trading strategy parameters
dialog.

By setting this option, the prediction and trading strategy dates interface will allow a ‘trading’ statistics data set to be
calculated after the optimization and paper trading data sets. This ‘trading’ data set will be a true "out-of-sample" data set. It
can be used if you do not wish to keep the model that did best on paper trading, but yet you still w ant to see how a model did
on data other than the optimization data set. This data set can also be used in conjunction w ith saving the model that did best
on subsequent paper trading to evaluate the model and yet another independent data set.

The Trading data set show s on the chart and in the data selection dialog in green bars.

Configurable Results — The statistics that are displayed in prediction and trading strategy w izard results page can now be
selected and the statistics columns reordered. To select w hich statistics are displayed in both w izards, choose the desired
statistics from the Results Screen Column section of the w izard options (‘options’ button) for the prediction and trading
strategy wizards. To reorder the statistics columns, simply drag and drop the column headers of the statistics list into the
desired order.

Existing Data/Calculations Tree View — The data in the Existing Data/Calculations dialog is now presented in a tree format
that can be expanded dow n unlimited indicator levels.

Simplified Prediction Interface — The confusing prediction optimal w alkforw ard and w alkforw ard interface of 4.0 has
been changed to match the trading strategy date interface. The optimal w alkforw ard and w alkforw ard capabilities of 4.0 are
now encapsulated in the ‘paper trading’ and ‘trading’ data sets that are selectable from the dates tab of the prediction
parameters screen.

Chart Page Indicators — A Chart Page Calculation indicator category has been added w hich contains the Chart Page Upper
Rank, Low er Rank, Percentile, Maximum, Minimum, Sum, Average, Count, Standard Deviation, and Z-Score.

These indicators calculate similar to their normal counterparts except that they calculate the statistics for each date/time
across all the chart pages in a chart as opposed to calculating back in time on one ticker symbol. So for instance the Chart
Page Average, calculates the average value for each date/time across all the chart pages.

Use these indicators in charts w ith multiple chart pages (i.e. ticker symbols) to compare the current chart page
indicators/value w ith all the other chart pages. So for instance you could use the Chart Page Upper Rank indicator to view
the rank of each chart page value relative to the other chart pages, as an input to a prediction that indicates how the ticker
is performing relative to others, or even as an input to a trading strategy w hich might limit trading to the top 3 tickers w ith the
most volume. The possible uses of these indicators is limitless.

Open Chart Multiple Selection — The Open File dialog now allow s multiple selection of charts.

Save Data in Chart — The Save As dialog now has a "Save data in chart" checkbox at bottom of the dialog. Turning on this
option will save the current underlying data with in the chart. Upon loading a chart w ith saved data, you have the option of
loading w ith the saved data or getting data from the normal sources (data feed, files, ...). Use this feature w hen sending
charts to other people (especially tech support), w hen you w ant to guarantee they are seeing exactly the same data w ithout
differences in files mapped, data feed provider, etc.

Deactivation at Shutdow n Option - Check box located at the bottom of the activation screen now allow s user to select
"Prompt for deactivation at shutdow n of Trader". Use this option if you are frequently running one license on multiple
computers, but sometimes forget to deactivate one computer before running the softw are on another computer.

Chart Drag - Charts can be scrolled left or right by dragging the chart in the desired direction w ith the left mouse button
depressed. Note that you must drag a blank portion of the chart, otherw ise the data series or annotation over w hich the
mouse cursor is positioned w ill get selected/dragged instead of the chart getting dragged.

Multiple Indicator Colors — Different indicators are now added to the chart in different colors instead of all the same
default indicator color of purple.
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Simultaneous Exit Stop and Limit Orders — Trading Strategies now allow simultaneous exit stop and exit limit orders.
This allow s for backtesting and trading of strategies that have a simultaneous price target limit order and trailing stop order in
the market at the same time.

Stop and Limit Order Rounding - Limit and Stop order prices are now rounded to the same precision/increment of price
stream. Avoids problem of having a limit and stop order calculation that provides a continuous range of values w ith very
small decimal places being placed at a price in betw een valid price increments for the underlying symbol being traded.

Point Values for each Ticker Symbol — Point Values for predictions and trading strategies are now entered on a ticker by
ticker basis. This allow s for backtesting and optimizing of strategies across multiple chart pages, with each chart page
having a different point value.

The point values for each ticker symbol are also saved and remembered for use in future charts, predictions and trading
strategies. To change the point values for the current chart pages, press the Point Values button in the Costs tab of a trading
strategy or prediction. You can also edit the list of all saved point values using the Point Values tab after selecting the
Options menu item on the Tools menu. Note that if charts from old versions of NeuroShell Trader that contain point value
specifications are loaded, the point values used in those charts will be automatically set for the appropriate ticker symbols if
no point value currently exists for that ticker symbol.

Trading Data Set Recalculates Statistics with Updated Data — As a chart is updated w ith more data, a Trading data set
is added to both the prediction and trading strategies w hich allow a user to view the trading statistics, trade by trade, etc.

w ith data going forw ard since the trading strategy or prediction w as last backtested. Each time a trading strategy or
prediction is modified w hen there is new data on the chart, the Trading Strategy Wizard and the Prediction Wizard will
recalculate the Trading data set statistics to include the lastest data.

Faster Optimization of Trailing Stop and Exit Indicators — Protective stop and exit signal indicators now process much
faster during optimization of a trading strategy. Note that the speed up w ill only occur if the indicators are inserted by
themselves and not if the indicators are used inside another indicator (for example the trailing stop in
Add2(TrailingPriceTarget(...),2) will not process faster). The indicators that optimize faster are:

Entry Price: Percent Activation
Entry Price: Point Activation
Price floor: Percent

Price floor: Points

Trailing price: Percent
Trailing price: Points

Bars Since Activated = X
Bars Since Activated >= X
Bars Since Filled = X

Bars Since Filled >= X
Price Target: Percent

Price Target: Points

Linear Time Regression: Predicted Value and Change — The Linear Time Regression: Predicted Value and Linear Time
Regression: Predicted Change indicators now accept both zero and negative values for the Periods Ahead parameter. This
allow s these indicators to not only obtain values and changes on the regression line into the future, but also obtain values and
changes on the regression line for the current bar (0) and past bars (negative periods ahead).

Renaming Data Series - Renaming of data series is now done in format data series interface. Additionally, a ‘Default’
button is now available to change the name back to the original default name.

Quote.com Server Selector — Quote.com has a large number of servers, but w e have found it useful to supply a small
program w hich determines w hich server is responding the fastest. This program has been improved for release 5.0.

Pop-up Menu Edit Commands - Cut, copy, paste and delete menu items are now listed in the pop-up menu that appears
w hen the mouse is positioned over a data series and the right mouse button is clicked.

Pop-up Menu Recalculate — A ‘Recalculate Chart” menu item is now listed in the pop-up menu that appears w hen the
mouse is positioned over a blank area of the chart and the right mouse button is clicked. Use the Recalculate Chart menu item
to reread data files and recalculate all the calculations in a chart.

When the chart is based on an external data file that is being updated by an external program, manually recalculating the
chart will allow new data from the data file to be incorporated into the chart w ithout having to load and unload the chart.

Manually recalculating is especially useful w hen developing external DLL calls and the DLL has been updated since the
chart w as loaded (Note that ‘UNLOADCUSTOMDLLS=" needs to be set to ‘True’ in the Nstparam.ini file in order to copy over
a dll being used by a chart)



Also use the ‘Recalculate Chart’ menu item to refire a trading strategy or prediction that has inputs of the form Lead(XXX,1)
w here XXX is raw data like the Open, High, Low, Close or Volume. Use of Lead(XXX,1) allow s for a trading strategy or
prediction to ‘peek’ into the next bar to make decisions. Without ‘Recalculate Chart’, leads w ork w ell w hen backtesting, but
not w hen used in real time since the trading strategies and predictions are fired at the end of each bar w hen no data exists
in upcoming bars. Use of the ‘Recalculate Chart’ menu item solves the problem, essentially telling NeuroShell Trader w hen
to ‘peek’ into the data of the red bar forming at the end of the chart in order to revaluate any Lead(XXX,1)’s.



Features in the NeuroShell Trader Professional

The follow ing are the primary new features in the NeuroShell Trader Professional:

I. An Overview of the NeuroShell Trader Professional

The Trader and the Professional Trader are actually the same program, but the softw are protection w ill determine w hether or
not a user can run the Professional features. Therefore, if you have the regular Trader release 2.0 or higher, you can easily
upgrade to the Professional by email or phone.

There are more details below , but as promised, the Professional Trader has features to optimize the inputs to nets. There have
been others w ho have used Genetic Algorithms (GAs) to find inputs to feed a net before, but w e are also finding optimum
parameters for the indicators you are using, as w ell as the buy/sell thresholds w hen training by profit. Additionally, there are
several new objective functions, not just simple profit.

How ever, the most exciting thing about the Professional Trader may not have anything to do with neural nets. The most exciting
thing may be the trading strategy optimizer, w hich optimizes systems by GA even if they don't have neural nets! For example,
you can enter a traditional trading strategy (using crossovers and breakouts, say) and then find optimal parameters for those
crossovers and breakouts. Not only that, but you can tell the optimizer to get rid of useless rules if you have provided several.
We have actually built some pretty good trading systems that didn't use nets at all.

Of course, you can use nets and re-optimize thresholds. This may be useful if your strategy has rules other than AB thresholds
that should be optimized w ith the AB, or you w ant to optimize on different periods.

II. A System for Professionals Only.

Precisely because of its pow er, the NeuroShell Trader Professional is not for everybody; that’s w hy w e call it "Professional”.
DO NOT ORDER THE NEUROSHELL TRADER PROFESSIONAL IF YOU ARE LOOKING FOR A SILVER BULLET! As you can see,
there will be a lot of fantastic features w ith w hich you can experiment. But in fact the NeuroShell Trader Professional is not a
panacea. You shouldn't just throw "everything but the kitchen sink" at it and expect immediate gratification in the form of
fantastic out-of-sample predictions. Although that w orks sometimes, it often does not.

As a pow erful optimizer, the NeuroShell Trader Professional can, w ith very little effort, build highly over-fit models much easier
than you can do it yourself! They will look great in-sample, but fall apart out-of-sample and during later trading. Also, even
genetic algorithms can take a great deal of time optimizing w ith too many variables. For these reasons, you must be professional
enough to recognize that pow erful optimizers can do this, and professional enough to experiment and take steps to avoid
over-fitting.

Among the suggestions w e have relative to the above are:

1. Start w ith pretty good models and use optimization to make modest improvements to them. Search only a little on either side of
the indicator parameters that are presently being used.

2. Make sure you stick to a very few inputs to neural nets (usually about 5). When finding an optimum set of inputs, tell the
optimizer to use at most 5 inputs.

3. Make sure that you do out of sample testing w hen you optimize trading strategies.
4. Experiment w ith stopping optimization not long after it has begun to avoid over optimizing.

5. When optimizing neural nets, consider optimizing on out of sample evaluation sets instead of the oldest w alk-forw ard training
set. (But don't go back too far in time w hen the market w as different.)

6. Consider and experiment w ith optimizing neural nets or trading strategies, but not both in the same trading system.

7. When optimizing neural nets, use very few hidden neurons. This will not only help prevent over-fitting, but will keep it from
taking forever to optimize.

8. Use different objective (fitness) functions w hen optimizing. These can make all the difference in the w orld. We are providing
plenty and considering offering more in the future. Unfortunately, there are no rules on w hen to use w hich ones.

The NeuroShell Trader Professional is a pow er tool, and like most pow er tools, it can help you but only if used properly and
carefully.

lll. How Are Genetic Algorithms Different than other Optimizers?

Most optimization techniques used today are simple "exhaustive search" methods, meaning that every possible combination is
tried to see w hat w as the best one. This is a very accurate approach, since you are bound to find the best combination of
variables - eventually. How ever, it is a very inefficient approach, because w henever there are more than a few thousand
combinations, it takes too long to try them all. That is w hy users of exhaustive search optimizers tend to limit the number of



variables they use, or tend to limit the number of values these variables can take.

The genetic algorithm, by contrast, does not try every possible combination. It attempts instead to intelligently get closer and
closer to the best solution. Therefore, far more variables can be utilized, and you can allow all values of a variable. Optimization
can still take a good deal of time if you give a GA a fair number of variables, but it will be doing much more w ork in that amount
of time.

More efficient optimizers than exhaustive search optimizers are in use. If they are not genetic algorithms, how ever, they are
most likely only searching one section of the search space at a time. Genetic algorithms are searching dozens or hundreds of
parts of the search space simultaneously. This means they are far less susceptible to becoming stuck in "local minima" as the
others quite often do. (Local minima are decent solutions that the optimizer can never "get out of" in order to find better
solutions.) How ever, many of these optimization techniques are faster than a GA provided the problem is easily solved, and not
subject to deep local minima.

IV. Features of the Professional Trader
The hallmark of the Professional Trader is the integration of genetic algorithms for a number of different optimizations. The
GeneHunter engine is now in the NeuroShell Trader. You can optimize the creation of netw orks or trading strategies. As

previously mentioned, optimization of trading strategies does not require that the strategy contain a neural netw ork.

A. Prediction Wizard Optimizations.

Prediction Whzard - Percent Change in Cloze 4 trading days into the future

Select the optimization method used to determine the best
inputs for the prediction.

& Full Dptimization Findz the best inputs and the best
parameters for each input,

i~ Parameter Search  Finds the best parameters for each input
wihen wzsing all the inputs.

" |nput Selection Finds the best inputz when using the
original parameters for each input,

™ Mo Optimization Uzes all the inputz and the original

parameters for each input,
LCancel |

v

Help ¢ Back

The Prediction Wizard now has a screen (above) that allow s one of the follow ing four options (not in this order):

1) Input selection. In this mode the genetic algorithm selects w hich of many inputs you have chosen are most useful. Only the
ones it decides are best are used in the final training. Note that the usefulness of an input is evaluated in conjunction w ith all
other inputs. In other w ords, the GA is really finding an optimum SET of inputs, not inputs that are by themselves necessarily
useful. These inputs do not have to be indicators built by the Trader. They can be any data stream you load. You load quite a
few more indicators than you w ant to eventually use (w e w ouldn't suggest many more than 20 to 60 for best results).

Elsew here in the wizard you w ill specify the maximum number of inputs that you w ant the GA to keep (w e like betw een 3 and
12 to enhance chances of good generalization). The GA will search through combinations looking for the set of inputs w hich is
less than or equal to the maximum number of inputs that you specified and w hich, as a set during training, optimizes the training
criteria (e.g., maximize profit, minimize error, etc.). No parameters of any inputs that are indicators are modified or optimized,;
they are used just as you have specified them.

2) Parameter Search. In this mode, the genetic algorithm will use all of the inputs you have chosen, but it will optimize the
parameters of all indicators you have used as inputs, even if they are embedded in other indicators. In other w ords, if one of
your inputs is the 10 period lag of the 5 period momentum of the close, the genetic algorithm may change the periods to 6 and 3
respectively if the resulting indicator w orks best. (You can even tell it to select among open, high, low, and close). Note that the
optimized parameters are evaluated in combination w ith the other optimized indicators and other inputs. In other w ords, it is
possible that the parameterization of an indicator does not produce an indicator that is useful by itself. It may only be useful in
combination w ith the entire set of optimized inputs. Note that optimization can only be accomplished on indicators w hich you
have entered using the Trader's Indicator Wizard (even if it w as entered from the Prediction Wizard). Other data streams used
as inputs wiill still be used during optimization, but not optimized. Keep your number of inputs betw een 5 and 30 for best results.

3) Full Optimization. In this mode, both input selection and parameter optimization are accomplished at the same time. This is a
very advanced concept, and w e are not currently aw are of any other programs capable of this using a GA. Note how ever, that
the GA is doing more w ork (i.e., using more variables) than in doing either input selection or parameter optimization separately.



Therefore, for best results, keep your number of inputs below about 30 if they are all indicators.

4) No Optimization. In this mode, neither input selection nor parameter optimization takes place. The inputs are used just as you
have selected them.

There is another form of optimization called threshold optimization that can take place or not in any of the modes above, including
the no optimization mode. More on threshold optimization later.

B. Setting Parameter Ranges for Input Indicator Optimization

When the GA needs to do parameter optimization, it needs to know an appropriate range of numbers in w hich to search. For
example, how far back is it reasonable to go for the periods in a lag or a regression slope?

After you enter an indicator into the list of neural netw ork (prediction) inputs, a default range is already set up for you, (e.g.,
periods might be 1 to 10.) These defaults are pretty reasonable, but you can change them if you w ish before the optimization
starts. If you narrow the range, (e.g., 1 to 5), the optimization may take less time to find a good solution. How ever, if the BEST
solution w as 15, you will not find it. If you expand the range, say 1 to 100, the optimization may take much longer because the
search space is larger. Longer lookbacks may not be reasonable to use in many predictions, so the GA is w asting time.

In order to change the range of a parameter, click in the plus sign (+) next to the indicator as listed in the input list (see below ).
The indicator will be "expanded" to show all of the parameters in it or its embedded indicators. If you double click on any
parameter, a dialog box w ill appear to allow you to set the range.

After you click on plus (+), the parameters are listed below the indicator in the order in w hich they appear in the indicator. E.g.,
for the indicator lag(momentum(close,5),5), the 5 for the momentum wiill be listed before the 5 for the lag.

Prediction Wizard - Percent Change in Cloze 4 trading days into the future

Make a list of all the instrument: and indicatorz which you think are
waluable inputs for predicting Percent Change in Cloze 4 trading days
into the future.

+ EEI[High F'riu:e Lo F'riu:e Elnsing P'riu_:e,F'eriu:uds,Devi_atiu:un kultiplier]

Tlme Seres SEarch Space Elu:use
Expéivgl Penods Search Space =1.40
Exptvg? Periods Search Space =1.40
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C. Controlling Optimizations - The General Tab
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Most of the General tab is familiar to previous users of the NeuroShell Trader. The new combo box labeled "Number of optimal
w alk-forw ards" is visible only in the Professional Trader. This box allow s you to decide w hich set of data is "in sample" for
evolution, the evolutionary "training" set if you will. You can choose either "Optimize on training set", as w as done in the picture
above, or you can choose "1 optimal w alk-forw ard test", "2 optimal w alk-forw ard tests", etc. Your choice determines how the
GA proceeds w ith evolution as follow s:

1. Optimize on Training Set - In this mode, the GA tries to get the best results it can on the oldest training set in all the

w alk-forw ards you have chosen to use during training. For example, if you have selected to use 3 w alk-forw ard tests, the GA
wi ill find the inputs that w ork best on the training set of w alk-forw ard #3. After optimization is finished, the inputs chosen will
also be utilized for the normal training of the other w alk-forw ard training sets and the current net. You may consider that you
are over fitting only on w alk-forw ard #3 training set. The GA is not really over fitting on w alk-forw ard #3 evaluation set, or the
other w alk-forw ards.

If there are no w alk-forw ards, the GA optimizes on the current net.

2. N w alk-forw ard tests - In this mode, N new w alk-forw ards are added, all older than the oldest you have already specified for
training. In other w ords, suppose you have specified 3 normal w alk-forw ard tests, and then for optimization you specify "2
optimal w alk-forw ard tests". The system w ill add w alk-forw ards 4 and 5, The GA wiill base its input selection on how w ell the
evaluation periods for BOTH w alk-forw ards 4 and 5 perform.

This mode provides an extra layer of generalization to keep the GA from over-fitting, because the optimization is done on the
neural netw orks' evaluation sets.

D. Controlling the Optimizations - The Objectives Tab
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IMaHimize Correlation j
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The objective tab gives the user a choice of training objective functions (genetic algorithm fitness functions). The combo box
has a broad assortment of built-in functions from w hich you can choose, including the familiar error minimization of the pervious
release. There are now quite a number of profit oriented functions, including:

return on account, net profit, ratio gross profit/loss, % profitable trades, average trade profit, max draw dow n, max open trade
draw dow n, ratio net profit/max draw dow n, average bar profit.

There are also some new error oriented functions, including:
correlation, mean squared error, and R squared.

Not all functions may result in the type of trading you like to accomplish, and how they perform could depend upon many factors,
like the issue you are trading, the inputs you have chosen, the time periods chosen, and many other things. If some objective
functions don't perform for you, try some others.

Note that even if you select minimize error, trading statistics for the net can still be calculated based on the trading rules on the
bottom of the dialog box. You can still choose w hether you w ant trading simulated w ith long positions, short positions, or both.

At the bottom of the dialog box, you may specify your ow n trading rule thresholds, or you may let the genetic algorithm find
them.

Note that the "profit" objective in the old Trader is the one that is now called "Return on Trades".

E. Controlling Optimizations — the Advanced Tab
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The advanced tab can play a very important role in how optimization is accomplished. Since this is a professional program, you
have some flexibility in determining how the program w orks. You also have a responsibility to experiment and find out w hat is
right for you; w e cannot do more than provide general guidelines.

Realize that during optimization, the genetic algorithm is choosing inputs, parameters, and thresholds (depending upon your
selections) and then training and applying a netw ork w ith each such choice. Hundreds or even thousands of netw orks might be
trained.

Understand too that the Turboprop 2 netw ork paradigm trains by adding hidden neurons one by one, up to a maximum of 80.
Zero hidden neurons produce a linear model, and the model becomes more and more non-linear the more hidden neurons are
added. Generally speaking, the more hidden neurons added, the "tighter" the fit becomes and the longer the training takes.
(Previous practitioners of older types of neural nets like the primitive "backpropagation" nets are cautioned not to try to equate
Turboprop 2 performance w ith a certain number of hidden neurons w ith backpropagation performance using the same number.
These are very different algorithms.)

Therefore, it should be obvious that the more hidden neurons that are added during training of the many nets of the optimization
phase, the longer optimization w ill take. We have therefore provided a sliding bar to allow you to set the maximum number that
can be added during the genetic optimization. The default is 15. It is under the heading Optimization Parameters.

After optimization, the net is trained one final time using another number of hidden neurons that you can set under Training
Parameters. If this number is set different than the number used during optimization, the final results w ill be different than the
optimal results found during optimization (perhaps better, perhaps w orse). The default is 80, meaning you w ill get a w ell trained
net after optimization. The default is 80 for compatibility w ith the old trader; you may do better setting this factor low er, probably
the same as the number of optimization neurons.

Next, if you have selected the Input Selection or Full Optimization mode of optimization, you may select the MAXIMUM number of
inputs that the GA is allow ed to use. The GA may determine that less is better. Remember that the more inputs in a netw ork, the
greater the chances of "over-fitting".

Finally, w e will discuss the small check box marked "Adjust training for trending markets by evenly distributing training bars."
Understand that neural netw orks are pattern recognition devices: they make predictions based upon w hat happened during
training w hen they encountered similar patterns. If your training set covered a period of a strong and sustained bull or bear
market, the majority of the patterns are likely to be all in one direction. Neural nets aren't likely to predict the other direction w ell at
all in such a case. Ideally, you'd like to have about half of your training patterns show ing uptrends, and the other half show ing
dow ntrends, to varying degrees.

Turning on this option w ill cause your training sets to be automatically balanced in this w ay. If you are predicting some output
that show s both positive and negative numbers (like percent change), the algorithm will produce a training set having roughly
the same number of both signs. If your output is an indicator that alw ays has the same sign (like an indicator that is alw ays

betw een 0 and 100) then the algorithm w ill select even numbers above and below the mean based on the data's distribution.

F. Optimization of Trading Strategies Using Genetic Algorithms.



As previously mentioned, this may be the most exciting feature of the Professional Trader, because it enables optimum trading
strategies to be built even if they do not involve neural nets. It will also optimize all of a strategy if some conditions use nets and
some do not. It means the Professional Trader is no longer just a neural netw ork package, but a complete artificial intelligence
driven trading system.

Trading Strategy Wizard

Select the optimization method used to determine the best entiy.
stop. and exit rules for the trading strategy.

& Full Dptimization Findz the best rules and the best
parameters far each rule.

" Parameter Search  Finds the best parameters for each ule
when wzing all the niles.

i~ Rule Selection Findz the best rules when uzging the
original parameters for each rule,

¢ Mo Optimization Uzez all the rules and the onginal
parameters far each rule.

< Hack Hest > LCancel

v

The Trading Strategy Wizard now has a dialog box like the one show n above. There are several choices for optimizing trading
strategies. Instead of selecting inputs, or selecting parameters of indicators used as inputs like the Prediction Wizard does, the
Trading Strategy Wizard does something different but similar.

Recall that trading strategies are essentially rules (conditions) that initiate buying or selling w henever some number that you
specify are true. The conditions are indicators that may have parameters associated w ith them, e.g., AB w here A is the net
prediction and B is lag(momentum(close,3),2). The GA will select amongst multiple conditions, and also select the parameters in
those conditions, as follow s:

1. Parameter Search - all of your conditions (rules) are used, but the GA evolves optimum parameters for you. These
parameters do not produce rules that are individually optimum, but optimal as a complete set.

2. Rule Selection - Chooses among all the rules you have specified, leaving you w ith only the ones that w ork best together.
3. Full Optimization - performs both Parameter Search and Rule Selection at the same time.

4. No Optimization - Performs just like the Trader's Trading Strategy, not modifying deleting any rules and not modifying any rule
parameters.

G. Controlling Trading Optimization - the General Tab
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Size of trades used to evaluate trading strategy
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o

Range of dates used to evaluate trading strategy
f* Uszer specified date ranges

" Match date ranges to prediction(z] used in trading strategy

Objective uzed to determine the best entry, stop. and exit
conditions during optmzation of the trading ztrategy
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ak. Cancel | Help

In this tab, the label "Range of dates Used to Evaluate Trading Strategy" is new . If you choose "User specified date ranges”,
then the Dates tab becomes active for more specific selections (see below ).

If you choose, "Match date ranges to prediction(s) used in trading strategy"”, then the wizard w ill match in-sample and
out-of-sample sets to those used by the Prediction Wizard. This feature is only available if you have nets somew here in your
trading strategy, and those nets had w alk-forw ards. The evolution optimization is performed on the in-sample data the nets used
(marked on the out-of-sample net as a gray line), and the backtest itself is done on the netw orks' out-of-sample data (show n on
the chart as a green prediction line). Using this option gives you the most protection against over-fitting, because the final
backtest is done on a time period that w as neither in-sample for the neural nets nor for the genetic algorithms.

H. Controlling Trading Optimizations - the Dates Tab

Trading Strategy Parameters

Start of backtest used to evaluate trading ztrategy

™ Beaqin at first date dizplayed on chart

" Beqin befare last date dizplaved on chart

& Begin at [10/30/97 E= B

Size of backtest uzed to evaluate trading strategy

"~ Backtest from start of trading to lagt date dizplaved on chart

{~ Backtest for after start date

¢ Backtestto [10/29/93 [2d~

Range of data used to optimize trading strategy

* Optimize across the zame data az the backtest

" Dptimize across aof data prior to backtest

" Optimize back to | |

] | Cancel | Help




This tab allow s you to set your ow n dates for both optimization (show n on the bottom of the dialog box) and for the subsequent
backtest. Only the bottom of this dialog box is new in the Professional Trader.

In the picture above, w e have elected to optimize over the same period as the subsequent backtest. This is a little risky, because
w e are really looking at in-sample results. On the other hand, the NeuroShell Professional Trader is, w e believe, the first

softw are to optimize trading strategies that actually offers an alternative. In other w ords, w e are the first to provide a backtest
out of sample from the optimization. Therefore, you might w ant to take some risk here since it has been standard practice for
some time.

If you do not w ant to take that risk, you can elect to optimize over a time period prior to the backtest (like tw o years as show n
above), or back to a specific date.

If you select the option back to a specific date, the optimization w ill end w hen the backtest begins, unless the specific date you
choose is actually w ithin the backtest period. In that case, the optimization period w ill end w hen the backtest ends.

|. Optimization Progress Bar.

During an optimization of a prediction or a trading strategy, there is a progress bar that show s approximately the progress of the
optimization and the amount of time remaining. Please don't set your w atch by this bar! Due to the method of genetic optimization
w e are using, it is impossible to know exactly w hen the optimization w ill end. Frequently, the bar will even be moved backw ards
w hen a better solution is found and the algorithm decides to continue longer. So the time estimate is very rough indeed.

J. Saving of Custom indicators.

Indicators you build can now be saved and used later in different charts. Saved indicators can also be loaded into the regular
Trader, meaning that you can now sell or distribute indicators to all NeuroShell Trader users. You can save them in existing
indicator categories, or invent your ow n.

To create a custom indicator, first build it in the Indicator Wizard as usual. In order to save your indicator, you use the Save
Indicator button in the Indicator Wizard. To activate this button, click on any level of the indicator as show n in the picture below :

Indicator Wizard - Momentum

Parameters for Momentum

® To leam mone about the indicater and its parameters, press the 'Indicator Help' button.

® hdore than one indicator will be created if you specify mubltiple parameters. For example,
specifying a moving average size of "5, 10, Z0° will create three mowving awerages.

& After an indicator has been added to 3 chart, you can make changes to it by selecting the
indizator with the mouse and choosing ‘hodify Indicator' on the "Bdit’ menu.

im eries = Cloze
Periods =5

Heb panameter | it parameterl Save [ndicator | Indizator Help |
Help | < Back | Einizhed I Cancel |
o

Then the follow ing dialog box appears:



Save Template - Lag[¥elocity[Time Series_Peniods). Periods ..

Enter the name and category of the custom indicator that
you want to zave.

M arne: ILag["v"elncit_l,l[Time Senes, Periods) Perio
Category: IEustnm Indicators j

MOTE: wou may type a new Cateqary name if 20 desired.

ok | LCancel | Help

Furthermore, if you distribute one of these custom indicators, you can specify the help topic and help file that will be displayed if
the end user presses "Indicator Help". Of course, you are responsible for w riting this help file yourself.

The Advanced button brings up the follow ing:

Save Template Advanced - Lag[¥elocity[Time Senes. Penods].Penods Back]

Define template zetup

Ok
[ Pazsword: ]
I~ Help File: | - Lancel
Topic 1D I
Help
Define the parameter's dizsplay properties
Component I F'aramﬁl M ame | Parameter Type | Default... |
Time Seriez 1 Time Seriez Diata Stream or... Close
Pernods 2 Perinds Integer »=1 10
Pernodz Back 3 Perodz Back  Integer »=1 A
Modify |

v

The parameters of those indicators can be hidden from end users, meaning that your proprietary secrets will be safe. Also,
parameters the user sees can be mapped to multiple parameters in the indicators. For example, if your custom indicator uses
close a lot, the user only had to define it once.

Modify Parameter's dizsplay properties

= Hidden fram uzer ok
¢ Dizplay az Parameter Mumber: |2 -
I J Cancel
Fararneter Marne: Iperiudg
Applies to the fallowing parameters: Help
Penods —
v Default Value: [10 J

K. Alerts

The Professional Trader can allow creation of sound and/or popup custom text alerts w hen an event occurs. Unlike some
packages that have a limited number of alerts available, the NeuroShell Trader alerts are unlimited in scope and can be based
upon any combination of indicators, predictions, and/or trading strategies.



Alerts are inserted from the Insert menu, just like indicators:

Alert Wizard

Lizt the conditions that must be true for an alert to occur
BE High Breakout[Close,20,2)

Edit Eonditian)... | Hemave Eonditian ] |

. Add Condition(s] ... !

Cancel |

7

Help < Back | Mewt » |

You can give your alerts special names and even notes to yourself:

Alert Wizard

Enter a name and description for the alert:

IBDIIinger breakout

Call the braker fast

Mame

D'escription

Select the achions taken by the alert:
¥ Popup Alert Window

¥ Play zound file

| APPLALSE Wity =

Cancel |

v

Help |

< Back Einizhed

Then, w hen you later view the Alert window , you are notified of all alerts (like all such layouts in the Trader, clicking on a
column sorts the display by that column):

Ohlert Window [_ O]
D ate Chart | Symbal | Alert | Deszcription -
11y § Daily Stoc...  BGEM Bollinger breakout Call the broker fast
8/6/93 Daily Stoc...  COKE Buallnger breakout Call the braker fast -
M58 Daily Stoz..  BGEM Buollinger breakout Call the braker fast
B/22/98  Daily Stoc..  BGEM Bollinger breakout Call the broker fast
EM8/98 Daily Stoz...  BGEM Buollinger breakout Call the braker fast
EAM2/98  Daily Stoc...  COKE Bollinger breakout Call the broker fast
E/3,/93 Daily Stoc...  COKE Buollinger breakout Call the braker faszt
41498 Daily Stoc...  COKE Bollinger breakout Call the broker fast
4,/9,/93 Daily Stoc...  COKE B ollinger breakout Call the broker fast >
1] v

Alerts can be modified in the same manner in w hich you modify indicators, predictions, and trading strategies.
L. Calls to NeuroShell 2 and Predictor/Classifier Nets

You can now call neural netw orks you created w ith NeuroShell 2, NeuroShell Predictor, or NeuroShell Classifier w ithin the



Trader. These net calls are special indicators in the ‘External Program & Library Calls’ category in the Indicator Wizard. You still
have to train these nets w ithin the respective programs, but they can be fired in the Trader, looking like an indicator. This
indicator can then be used in a trading strategy, another indicator, or even another net. It is easy to train nets in these programs
using Trader data if you use the Trader’s file export facility.

In order to call Predictor/Classifier netw orks, you must ow n the NeuroShell Run-Time Server.

When you call the indicator to fire NeuroShell 2 nets you must not only pass it the inputs to the net in the proper order, but the
path to the .DEF file as w ell. For Predictor and Classifier nets, you w ill need the path to the saved netw ork file as w ell as the
inputs.

Indicator Wizard - Neuro5hell 2 Meural Hetwork

Define HeuroShell 2 DEF File Setup

Eilename: [0 \NeuraShell 23EXAMPLES \Nyze. def

“Which MeuroShell 2 Mewral Metwark Output do pau want to use?

[ o]

Help | < Back | MNext > | Cancel |
A

Indicator Wizard - HeuroShell 2 Neural Hetwork

Parameters for NeuroShell 2 Neural Network

® To leam more about the indicator and its parameters, press the 'Indicator Help' button.

® tdore than one indicator will be created if you specify multiple parameters. For example,
specifying a8 moving average size of "4, 10, 2Z0° will create three mowing awverages.

® After an indicator has been added to a chart, ywou can make changes to it by selecting the
indicatar with the mouse and choosing ‘hodify Indicator' on the "Bdit’ menu.

- MeuroShel 2 Heural Metwiork, ﬂ
[nput #1 = Open
Input #2 = High
[rput #3 = Low

|nput #4 = Cloze
Set parameter | Moadify parameter Save Indicatar Indizatar Help
Help | ¢ Back Einizhed Cancel

M. Calls to user created DLL functions/subroutines

The NeuroShell Trader Professional now has indictors that can call external DLLs created (usually) in C or C++ (‘External
Program & Library Calls’ category in the Indicator Wizard). This is a very pow erful feature, because it means that now you can
build custom indicators and other functions and use them in the NeuroShell Trader. You can even build a business selling these
to NeuroShell Trader users. How ever, you will need to have a programmer available to help you set up the calls to the DLLs, and
the programmer w ill have to know something about the DLL he/she is trying to call.

There are tw o types of DLL calls:

1. Calling DLL by value. In this mode, the DLL is called once for each bar. The inputs to the DLL w ill usually be some current or
lagged values, and the output w ill be associated w ith that bar on the chart. This mode w ould be perfect for building a custom



indicator in C++.

Indicator Wizard - External DLL Call by Yalue

Parameters for External DLL Call by ¥alue

® To leam more about the indicator and its parameters, press the 'Indicator Help' button.

® tdore than one indicator will be created if you specify multiple parameters. For example,
specifying 3 mowing average size of 4, 10, 20° will create three mowing awverages.

® After an indicator has been added to a chart, ywou can make changes to it by selecting the
indizatar with the mouse and choosing ‘hodify Indicator' on the "Bdit' meno.

- Esternal DLL Call by Y alue
Param #1 =
FParam #2 =
Param #3 =

Sawe | hdizatar | |rdicaton Helm |

Cancel |

7

Indicator Wizard - External DLL Call by Yalue

Define DLL Setup

St parameter | rladify parameter

< Back

Help |

Filename: [C: 4w/ IND O'WwWS 4SS TEM 324 M 52-32.dIl _I

Frocedure Hame: I EBpTrain

[ Indicatar output is & boolean value
Procedure Type: IFun-:til:nn as Buval Integer [int) j

v Uze the function retum value az the indicator output
Murnber of Parameters: |3 j

M urnber | ze | Declaration Type | Yalue Type |
1 Input[Faram #1] Bt al Single [float] Time Senes
2 Input[Param #:] Bytfal Single [float] Time Senes
3 Input[Param #3] Bt al Single [float] Time Senes
todify Pararneter |
Help < Back Hest = Cancel |

v

2. Calling DLL by array. In this mode, the DLL is called only once for the entire chart. Each parameter is an array that is as large
as the number of bars loaded in the chart. The output is an array of the same size. This mode is for building some sort of
process that needs all the data at once. One example might be your ow n custom model, like a neural netw ork. Note, how ever,
that training a neural netw ork could take some time, during w hich the user is staring at a frozen chart. Also, the indicator is
called each time the chart is refreshed, so you will w ant to have a mechanism that is aw are that it shouldn’t retrain each time

the DLL is called.

N. New Indicators

We have added 10 Fast Fourier Transform indicators, 21 Principle Component Analysis indicators, and 12 Wavelet indicators (a

new indicator category exists for each type).



Features in the NeuroShell DayTrader Professional

Overview

This is the premier product for day traders and aspiring day traders. Now you can join the revolution and build systems that give
buy and sell signals on 1, 2, 5, 10, 15, 20, 30, and 60 minute bars, as opposed to the daily bars that are in the Trader and Trader
Pro. You can w atch each tick change the high, low, and close of the last bar on the chart, until the bar is finished and becomes
part of your trading system. Use your alerts to w ake you up from your nap, if you are one of the few w ho wiill be able to sleep
w hile the DayTrader is running!

You are going to need a special real time data feed to use the DayTrader. There are many such feeds available, and w e may
eventually support more of them, but this first version of the DayTrader only supports one. We could have held up the
DayTrader until more data feeds w ere supported, making more of you happy, but that w ould take a great deal more time. We
elected to release the product w ith only one feed supported, even though it may not be YOUR feed. If you are willing to use the
one w e now support, the DayTrader is for you. If you w ant to join the revolution later w hen w e can support something you like
better, you can do that too.

Data Feed
For this, the first version, w e are using Lycos-Quote.com (from them you'll need Qfeed or Qcharts. For info, see
w w w .quote.com). We chose Quote.com because they have historical tick data that w e can load from the Internet, and you

need historical data to build nets and backtest trading strategies.

In the future, w e may add more data services that can supply historical data online. We may add also some services that do
NOT supply the historical data, w hich will necessitate that w e supply some sort of historical data server of our ow n.

Currently, w e have not built such a server, and in fact, even charts made w ith Quote.com w ill require data reloading each time
you bring up the chart. This will not be an issue unless you will be one of those w ho use excessive amounts of data on slow

modems. For you, w e recommend DSL or cable model Internet feeds. Also, read "Simple Models and Less Data" below .

The bottom line is w e are looking, but w e are making no promises at this time about any other data feeds or interfaces.

Popular Issues are Now More Amenable to Modeling Technology

One interesting thing about the DayTrader is that it opens a w hole new w orld in terms of w hat stocks or other issues are
predictable. For the first time, you can use neural nets on rapidly rising stocks like Yahoo, AOL, and Dell, because they fluctuate
greatly during the day, even though they mostly go up on a daily basis (at least they did prior to the new year!).

Avoiding Overnight Price Jumps

Another interesting thing is that now you can avoid the gaps betw een today's close and tomorrow 's open, gaps that often aren't
explained by technical indicators. Get in and out of an issue as many times as you w ish during the day, and close the position at

the end of the day.

This "gap avoidance" is done in tw o w ays. First, w hen you insert an indicator, you can check a box that instructs that the
indicator NOT be computed across day boundaries. Neural nets w ill not train on bars w here the input indicators are missing.

Second, you can add trading strategy conditions based on time of day. For example, you can enter a trade if both of the
follow ing conditions are true:

Your Indicator > 50
Time < 3:30 PM

Then you might w ant to exit if either of the follow ing is true:
Your Indicator < -50
Time > 3:45 PM

Simple Models and Less Data

In our experience, the more complicated models that are needed for end of day position trading are not necessary for intraday
trading. Simple models often w ork w ell.

Furthermore, since you are dealing w ith shorter bars, you w on't have to go back years in time to build neural nets and backtest



strategies. That w ay you aren't using training sets on market conditions that are now ancient history. If you dow nload 2 days of
1 minute bars, you have the rough equivalent of 3 years of daily bars. Training sets of just the last few days are not only
feasible but also advisable in our opinion.

On the other hand, some w ill disagree w ith us (after all, that's w hat the Trader is all about: building models the w ay YOU w ant
them instead of how someone else tells you models should be built!). Some w ill feel that longer periods may be better for
training to pick up trends. If you use 90 trading days of 30 minute bars, you w ill have about 1170 bars, roughly equivalent to
around 4.5 years of daily bars! So still, you do not have to go back to the Stone Age for data.

Optimal Performance

The bottom line w ill be this: for optimal performance, limit charts to only a few stocks w ith a couple w eeks of intraday data if you
are using small bars. Excessive time frames of small bars w ill likely result in lengthy data loading and slow er program
performance.

Interface

The interface for the DayTrader has pretty much the same interface as the NeuroShell Trader Professional. The first difference
you may notice is that instead of just daily, w eekly, and monthly bars, you can chose smaller intraday bars dow n to 1 minute
bars. (Note: even though w e only go as low as 1 minute bars, you can still see the ticks as they change the current bar being
built.)

The next difference you will see is that the charts are no longer just daily. Since the bars occur all day, the charts can be
zoomed in to intervals less than one day.

The third difference is that other intervals such as training periods, evaluation periods, backtest periods, etc., can also be
chosen in smaller time intervals.

The fourth, and perhaps final MAJOR interface difference, is that w e have combined the Data Dow nload menu and the Data
Directories menu into a new menu called "Data Sources". It is here that you wiill also find a "Server" tab that enables you to
specify the real time server (w ith only Quote.com currently as a selection). Also, you can select those exchanges from w hich
you may w ant to dow nload. This interface is going to be the same interface for the regular Trader and Trader Professional in
release 3.0 - minus the

Servers tab.

Daily Data Too!
It is w orth noting that Quote.com can also supply daily data as w ell as intraday data. Just check the little box marked "Use

server as an end of day source". Then, w hen you load a daily, w eekly, or monthly chart, the Quote.com server w ill dow nload
the data. Dow nloading usually takes only a few seconds for about 10 or 12 years of data.
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